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Introduction to Streaming Signal Processing in MATLAB

1-2

This example shows how to do basic signal processing on an audio signal streamed
frame by frame from a file. The same framework applies to streaming live audio from a
microphone or audio line input.

Introduction

This example shows how to use components in the DSP System Toolbox called System
objects, which are optimized for streaming signal processing. The signals are read in and
processed frame by frame (or block by block). You control the frame size.

In this example, frames of 1024 samples are read from an audio file every time a while
loop executes. The audio in the file is sampled at 44.1 kHz and contains two channels
(stereo). Each frame of data is approximately 23.2 milliseconds.

The example filters the audio signal using a notch filter. Because filtering is done on each
frame, the state of the filter must be maintained from one frame to the next to ensure
smooth processing.

Initialization

Streaming components must be initialized before use. Initialize the audio file reader and
audio player to listen to the filtered audio.

FrameSize = 1024;
AR = dsp.AudioFileReader("Filename”, "guitarlOmin.ogg”, - -.
"SamplesPerFrame” ,FrameSize);

Fs = AR.SampleRate;

AP = dsp.AudioPlayer("SampleRate®,Fs, ...
"OutputNumUnderrunSamples®,true);

Notch Filter

This example uses a simple second order IIR notch filter with a biquad (second-order
sections) structure to filter the audio signal. The filter has a notch at 200 Hz and a Q-
factor of 35. The higher the Q-factor, the narrower the 3 dB bandwidth of the notch. You
can change these values and listen to the resulting audio for different filter specifications
if desired. The notch filter retains state each time it is executed making it well-suited for
streaming data.
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Wo = 200/(Fs/2);
Q = 35;
BW = Wo/Q;

[b,a] = 1irnotch(Wo,BW);
NotchFilter = dsp.BiquadFilter("SOSMatrix”,[b,a]);

Streaming

Next, stream in and process your signal. Construct a while loop to run for 20 seconds.

A counter keeps track of how many frames are processed during the 20-second period.
Because each frame is 23.2 ms of audio, at least 861 frames must be processed in the 20-
second period for the system to operate in real time or faster.

tic
Tstop = 20;
count = 0;
while toc < Tstop
audioln = step(AR);
audioOut = step(NotchFilter,audioln);
plot(audioOut)
drawnow
count = count + 1;
end
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On a reasonably fast computer, the value of count exceeds 861 frames meaning the

processing can be done in real time or faster.

Streaming Without DSP Components

Instead of using System objects, you can use the audioread and filter functions.
However, audioread is not well-suited for streaming, because the file name and position
must be provided at each call. As a result, the performance of audioread is considerably
slower than the performance of the System object file reader in a streaming application.
Filter provides adequate performance, but state must be passed in and out of Filter
for use in a streaming application. This can result in inefficient and complicated code if
there are many components with state that must be handled manually.

z = [1;

1-4
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tic
count = O;
while toc < Tstop
audioln = audioread("guitarlOmin.ogg”,count*FrameSize+[1 FrameSize]);
[audioOut,z] = Ffilter(b,a,audioln,z);
plot(audioOut)
drawnow
count = count + 1;
end

« 1074
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The plot update gives a visual indication of how much slower the code is with audioread
and Filter is compared to the System object implementation. In particular, count

is considerably less than 861 frames, and therefore processing real-time audio in this
fashion is not feasible.
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Listening to The Filtered Signal

On computers capable of processing the data in real time or better, you have to add only
a single line of code to listen to the filtered signal as it is being processed. A new variable,
dropped, keeps count of any dropped samples due to buffer underrun.

tic
dropped = 0;
count = 0;
while toc < Tstop
audioln = step(AR);
audioOut = step(NotchFilter,audioln);
plot(audioOut)
drawnow
count = count + 1;
dropped = dropped + step(AP,audioOut);
end
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On most machines, there are no dropped samples.
Better Way of Plotting

Rather than using plot and drawnow to monitor the audio signal, use a System object
time scope. The time scope provides better performance along with many other features,
for example, measurements and panning. If you want to plot the spectrum of the signal
in real time, you can use a spectrum analyzer (dsp.SpectrumAnalyzer).

TS = dsp.-TimeScope("YLimits",[-1,1], "SampleRate” ,Fs, ...
"TimeSpan®,FrameSize/Fs);

step(TS,audioOut);

tic

count = O;

1-7
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while toc < Tstop % Run for 20 seconds
audioln = step(AR);
audioOut = step(NotchFilter,audioln);
step(TS,audioOut);
count = count + 1;

dropped = dropped + step(AP,audioOut);
end

4| Time Scope
File  Tools View Playback Help
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However, for maximum performance, avoid plotting the signal in time or frequency.
Streaming Live Audio

To stream audio from a microphone or line input, use the audio recorder,
dsp.AudioRecorder. If you want to write the processed audio to disk, use the audio
file writer, dsp.AudioFileWriter. The audio file writer supports a number of the most
common audio formats such as WAV, OGG, FLAC, and M4A.

1-9
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Filter Frames of a Noisy Sine Wave Signal in MATLAB

1-10

This example shows how to lowpass filter a noisy signal and visualize the original and
filtered signals using a spectrum analyzer. There is a Simulink version of this example:
Filter Frames of a Noisy Signal in Simulink

Source

The input signal is the sum of two sine waves with frequencies of 1 kHz and 10 kHz. The
sampling frequency is 44.1 kHz.

Sinel = dsp.SineWave("Frequency”®,1le3, "SampleRate”,44_1e3);
Sine2 = dsp.SineWave("Frequency”,10e3, "SampleRate”,44._1e3);

-
n m

Lowpass Filter

The lowpass FIR filter uses a constrained equiripple filter design (firceqrip). The filter's
cutoff frequency is 5 kHz and the linear ripples in the passband and stopband are equal
to 0.05 and 0.001.

FIRLowPass = dsp.FIRFilter("Numerator”®,
firceqrip(30,5e3*2/44.1e3,[0.05 1e-3]));

Spectrum Analyzer

Set up the spectrum analyzer to compare the power spectra of the original and filtered
signals. The spectrum units are dBm.

SpecAna = dsp.SpectrumAnalyzer("PlotAsTwoSidedSpectrum® ,false,
“SampleRate” ,Sinel.SampleRate,
"ReducePlotRate” ,false,
“ShowLegend” , true,
"YLimits",[-145,45]);

SpecAna.ChannelNames = {"Original noisy signal®,"Low pass Tiltered signal"};

Frame-Based Processing

This example uses frame-based processing. In frame-based processing, the data is
processed one frame at a time. Each frame of data contains sequential samples from
an independent channel. Frame-based processing is advantageous for many signal
processing applications because you can process multiple samples at once. By buffering


filter-frames-of-a-noisy-sine-wave-signal-in-simulink.html

Filter Frames of a Noisy Sine Wave Signal in MATLAB

your data into frames and processing multi-sample frames of data, you often improve the
computational time of your signal processing algorithms. In this example, the number

of samples per frame is 4000. The FIR filter uses frame-based processing if the input is
frame based.

4000;
4000;

Sinel_SamplesPerFrame
Sine2_SamplesPerFrame

Simulation Results

Add zero-mean white Gaussian noise with a standard deviation of 0.1 to the sum of sine
waves and filter the result with the FIR filter. While running the simulation, you see in
the spectrum analyzer that frequencies above 4 kHz in the source signal are attenuated.
The resulting signal maintains the peak at 1 kHz because it falls in the passband of the
lowpass filter.

i 1 : 1000

X = step(Sinel)+step(Sine2)+0.1.*randn(Sinel.SamplesPerFrame,1);
y = step(FIRLowPass,Xx);

step(SpecAna, [x,y]);

for

end
release(SpecAna)

1-11
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Filter Frames of a Noisy Sine Wave Signal in Simulink

This example shows how to lowpass filter a noisy signal in Simulink® and visualize the

original and filtered signals with a spectrum analyzer. For a MATLAB® version of this
example, see “Filter Frames of a Noisy Sine Wave Signal in MATLAB” on page 1-10.

In this section...

“Open Model” on page 1-14
“Inspect Model” on page 1-15

“Compare Original and Filtered Signal” on page 1-18

1-13
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Open Model

p
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Open the Library Browser by typing simulink at the MATLAB command prompt.

2 Click the New Model button arrow i and select From Template.
3 Inthe Simulink Template Gallery, under DSP System Toolbox™, double-click Basic

Model.
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Inspect Model
Input Signal

Three source blocks comprise the input signal. The input signal consists of the sum of two
sine waves and white Gaussian noise with mean 0 and variance 0.05. The frequencies of
the sine waves are 1 kHz and 15 kHz. The sampling frequency is 44.1 kHz. The following
figure shows the block parameters for the 1 kHz sine wave. Open the other source blocks
to see their parameters.

1-15
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i h
i Source Block Parameters: 1KHz Sine Wave ﬁ

Sine Wave (mask) (link)

Output samples of a sinusoid. To generate more than one sinusoid
simultaneously, enter a vector of values for the Amplitude, Frequency, and
Phase offset parameters.

Main Data Types

Amplitude:
1

Frequency (Hz):
1000

Phase offset (rad):

0

Sample mode: [Di.screte ']
Output complexity: [R.eal ']
Computation method: ’Trlgonometrlc fcn ']
Sample time:

1/44100

Samples per frame:

256
Resetting states when re-enabled: [Rﬂstart at time zero h
‘)- [ 0K ] [ Cancel ] [ Help Apply
L% A
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Lowpass Filter

The lowpass filter is modeled using a Discrete FIR Filter block. The example uses a
constrained equiripple FIR filter design, Firceqrip. The filter's cutoff frequency is 10
kHz. The linear ripples in the passband and stopband are equal to 0.05 and 1e-3.

e

"% Function Block Parameters: Lowpass FIR Filter &
Discrete FIR Filter
Independently filter each channel of the input over time using an FIR filter. You can specify filter coefficients using
either tunable dialog parameters or separate input ports, which are useful for time-varying coefficients.
A DSP System Toolbox license is required to use a filter structure other than Direct Form.
Main Data Types
Coefficient source: ’Dialog parameters v]
Filter structure: ’Direct form v]
Coefficients: firceqrip(63,1e4*2/44.1e3,[0.05 1e-3])
Input processing: ’Columns as channels (frame based) v]
Initial states: 0
Sample time (-1 for inherited): -1
J [ oK ] [ Cancel ] ’ Help l Apply

The Lowpass FIR Filter block uses frame-based processing to process data one frame at
a time. Each frame of data contains sequential samples from an independent channel.
Frame-based processing is advantageous for many signal processing applications because
you can process multiple samples at once. By buffering your data into frames and
processing multisample frames of data, you can improve the computational time of

your signal processing algorithms. In this example, the number of samples per frame is

1-17
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256. Specify frame-based processing on the Lowpass FIR Filter block by setting Input
Processing to "Columns as channels (frame based)".

Compare Original and Filtered Signal

The power spectra of the original and filtered signals are compared using a Spectrum
Analyzer. The spectrum units are in dBm.

To run the simulation, click the Run button in the model. To stop the simulation, click
the Stop button in the Spectrum Analyzer. Alternatively, you can execute the following
code to run the simulation for 200 frames of data.

set_param(model, "StopTime~", "256/44100 * 2007)
sim(model);
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Frequencies above 10 kHz in the source signal are attenuated. The resulting signal
maintains the peak at 1 kHz because it falls in the passband of the lowpass filter.
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Lowpass Filter Design in MATLAB

1-20

This example shows how to design lowpass filters. The example highlights some of the
most commonly used command-line tools in the DSP System Toolbox. Alternatively, you
can use the Filter Builder app to implement all the designs presented here. For more
design options, see Designing Low Pass FIR Filters.

Introduction

When designing a lowpass filter, the first choice you make is whether to design an

FIR or IIR filter. You generally choose FIR filters when a linear phase response is
important. FIR filters also tend to be preferred for fixed-point implementations because
they are typically more robust to quantization effects. FIR filters are also used in many
high-speed implementations such as FPGAs or ASICs because they are suitable for
pipelining. IIR filters (in particular biquad filters) are used in applications (such as
audio signal processing) where phase linearity is not a concern. IIR filters are generally
computationally more efficient in the sense that they can meet the design specifications
with fewer coefficients than FIR filters. IIR filters also tend to have a shorter transient
response and a smaller group delay. However, the use of minimum-phase and multirate
designs can result in FIR filters comparable to IIR filters in terms of group delay and
computational efficiency.

FIR Lowpass Designs - Specifying the Filter Order

There are many practical situations in which you must specify the filter order. One

such case is if you are targeting hardware which has constrained the filter order to a
specific number. Another common scenario is when you have computed the available
computational budget (MIPS) for your implementation and this affords you a limited
filter order. FIR design functions in the Signal Processing Toolbox (including firl,
Firpm, and Firls) are all capable of designing lowpass filters with a specified order.

In the DSP System Toolbox, the preferred function for lowpass FIR filter design with a
specified order is firceqrip. This function designs optimal equiripple lowpass/highpass
FIR filters with specified passband/stopband ripple values and with a specified passband-
edge frequency. The stopband-edge frequency is determined as a result of the design.

Design a lowpass FIR filter for data sampled at 48 kHz. The passband-edge frequency is
8 kHz. The passband ripple is 0.01 dB and the stopband attenuation is 80 dB. Constrain
the filter order to 120.

N
Fs

120;
48e3;


../examples/designing-low-pass-fir-filters.html
../ref/firceqrip.html

Lowpass Filter Design in MATLAB

Magnitude (dB)

Fp = 8e3;
Ap = 0.01;
Ast = 80;

Obtain the maximum deviation for the passband and stopband ripples in linear units.

Rp

(10"M(Ap/20) - 1)/7(A0~N(Ap/20) + 1);
Rst

10" (-Ast/20);

Design the filter using Firceqrip and view the magnitude frequency response.

NUM = Firceqrip(N,Fp/(Fs/2),[Rp Rst], "passedge”);
fvtool (NUM, "Fs*,Fs, "Color”", "White®)

Magnitude Response (dB)
T T

\II |
A0k \

&
=]
T

I W i VlﬁlirJﬁVlVH M il M

Frequ ency (kHz)

The resulting stopband-edge frequency is about 9.64 kHz.
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Minimum-Order Designs

Another design function for optimal equiripple filters is Firgr. Firgr can design a

filter that meets passband/stopband ripple constraints as well as a specified transition
width with the smallest possible filter order. For example, if the stopband-edge frequency
is specified as 10 kHz, the resulting filter has an order of 100 rather than the 120th-
order filter designed with Firceqrip. The smaller filter order results from the larger
transition band.

Specify the stopband-edge frequency of 10 kHz. Obtain a minimum-order FIR filter with
a passband ripple of 0.01 dB and 80 dB of stopband attenuation.

Fst = 10e3;
NumMin = Firgr("minorder”,[0 Fp/(Fs/2) Fst/(Fs/2) 1], [1 1 0 0],[Rp,Rst]);

Plot the magnitude frequency responses for the minimum-order FIR filter obtained with
Firgr and the 120th-order filter designed with Firceqrip. The minimum-order design
results in a filter with order 100. The transition region of the 120th-order filter is, as
expected, narrower than that of the filter with order 100.

fvtool (NUM,1,NumMin,1,"Fs”,Fs, "Collor*","White");
legend("N = 1207,"N = 1007);
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Filtering Data

To apply the filter to data, you can use the fi lter command or you can use
dsp.FIRFilter. dsp.FIRFilter has the advantage of managing state when executed
in a loop. dsp.FIRFilter also has fixed-point capabilities and supports C code

generation, HDL code generation, and optimized code generation for ARM® Cortex® M
and ARM Cortex A.

Filter 10 seconds of white noise with zero mean and unit standard deviation in frames

of 256 samples with the 120th-order FIR lowpass filter. View the result on a spectrum
analyzer.

LP_FIR = dsp.FIRFilter(“Numerator® ,NUM);
SA = dsp-SpectrumAnalyzer("SampleRate” ,Fs, "SpectralAverages”,5);
tic
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while toc < 10
X = randn(256,1);
y = step(LP_FIR,X);

step(SA,y);
end
4| Spectrum Analyzer o | = &S
File Tools View Playback Help "
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Using dsp . LowpassFilter

dsp.LowpassFilter is an alternative to using Firceqrip and firgr in conjuction
with dsp.FIRFilter. Basically, dsp.LowpassFi lter condenses the two step process
into one. dsp.LowpassFi lter provides the same advantages that dsp.FIRFilter
provides in terms of fixed-point support, C code generation support, HDL code generation
support, and ARM Cortex code generation support.
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Design a lowpass FIR filter for data sampled at 48 kHz. The passband-edge frequency is
8 kHz. The passband ripple is 0.01 dB and the stopband attenuation is 80 dB. Constrain
the filter order to 120. Create a dsp.FIRFilter based on your specifications.

LP_FIR = dsp.LowpassFilter("SampleRate”,Fs, ...

"DesignForMinimumOrder*® ,false, "FilterOrder®,N, ...
"PassbandFrequency”,Fp, "PassbandRipple”,Ap, "StopbandAttenuation” ,Ast);

The coefficients in LP_FIR are identical to the coefficients in NUM.
NUM_LP = tF(LP_FIR);

You can use LP_FIR to filter data directly, as shown in the preceding example. You can
also analyze the filter using FVTool or measure the response using measure.

fvtool (LP_FIR, "Fs",Fs, "Color™,"White");
measure(LP_FIR)

ans =
Sample Rate : 48 kHz
Passband Edge - 8 kHz
3-dB Point : 8.5843 kHz
6-dB Point : 8.7553 kHz
Stopband Edge > 9.64 kHz
Passband Ripple =: 0.01 dB

Stopband Atten. : 79.9981 dB
Transition Width : 1.64 kHz
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Minimum-Order Designs with dsp.LowpassFilter

You can use dsp.LowpassFi lter to design minimum-order filters and use measure to

verify that the design meets the prescribed specifications. The order of the filter is again
100.

LP_FIR_minOrd = dsp.LowpassFilter("SampleRate”,Fs, ...

"DesignForMinimumOrder” ,true, "PassbandFrequency” ,Fp, .

"StopbandFrequency” ,Fst, "PassbandRipple” ,Ap, "StopbandAttenuation” ,Ast);
measure(LP_FIR_minOrd)

NIp = order(LP_FIR_minOrd)

ans =

Sample Rate : 48 kHz
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Passband Edge : 8 kHz

3-dB Point : 8.7136 kHz
6-dB Point T 8.922 kHz
Stopband Edge 10 kHz
Passband Ripple : 0.0098641 dB
Stopband Atten. : 80.122 dB

Transition Width : 2 kHz

NIp =

100

Designing IIR Filters

Elliptic filters are the IIR counterpart to optimal equiripple FIR filters. Accordingly, you
can use the same specifications to design elliptic filters. The filter order you obtain for an
IIR filter is much smaller than the order of the corresponding FIR filter.

Design an elliptic filter with the same sampling frequency, cutoff frequency, passband-
ripple constraint, and stopband attenuation as the 120th-order FIR filter. Reduce the
filter order for the elliptic filter to 10.

N = 10;

LP_IIR = dsp.LowpassFilter(“SampleRate”,Fs, "FilterType®,"1IR", ...
“DesignForMinimumOrder* ,false, "FilterOrder®,N, ...
"PassbandFrequency*®,Fp, "PassbandRipple®,Ap, "StopbandAttenuation® ,Ast);

Compare the FIR and IIR designs. Compute the cost of the two implementations.

hfvt = fvtool (LP_FIR,LP_IIR,"Fs”,Fs,"Color®,"White");
legend(hfvt, "FIR Equiripple, N = 120%, "1IR Elliptic, N = 107);

cost_FIR = cost(LP_FIR)
cost_IIR = cost(LP_IIR)
cost_FIR =

NumCoefficients: 121

NumStates: 120
MultiplicationsPerlInputSample: 121
AdditionsPerlInputSample: 120
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cost_IIR =

NumCoefficients: 25

NumStates: 20
MultiplicationsPerlInputSample: 25

AdditionsPerlInputSample: 20

Magnitude Response (dB)
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The FIR and IIR filters have similar magnitude responses. The cost of the IIR filter is
about 1/6 the cost of the FIR filter.

Running the IIR Filters

The IIR filter is designed as a biquad filter. To apply the filter to data, use the same
commands as in the FIR case.
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Filter 10 seconds of white Gaussian noise with zero mean and unit standard deviation
in frames of 256 samples with the 10th-order IIR lowpass filter. View the result on a
spectrum analyzer.

SA = dsp-SpectrumAnalyzer(*“SampleRate” ,Fs, "SpectralAverages”,5);
tic
while toc < 10

X = randn(256,1);

y = step(LP_IIR,Xx);

step(SA,y);
end
4| Spectrum Analyzer o | =28
File  Tools View Playback Help L

s @ | Q w & |4 [C]ES| S Ml (L G (X

Processing
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Variable Bandwidth FIR and IIR Filters
You can also design filters that allow you to change the cutoff frequency at run-time.

dsp.VariableBandwidthFIRFilter and dsp.VariableBandwidthl IRFilter can
be used for such cases.
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Lowpass IIR Filter Design in Simulink

In this section...

“Model” on page 1-31

“Butterworth Filter” on page 1-32
“Chebyshev Type I Filter” on page 1-34
“Chebyshev Type II Filter” on page 1-36
“Elliptic Filter” on page 1-38

“Minimum-Order Designs” on page 1-40

This example shows how to design classic lowpass IIR filters in Simulink. The initial
focus is on the situation in which the critical design parameter is the cutoff frequency
where the filter's power decays to half (-3 dB) the nominal passband value.

The example shows how to replace a Butterworth design with either a Chebyshev or
elliptic filter of the same order and obtain a steeper roll-off at the expense of some ripple
in the passband and/or stopband of the filter. The example also explores minimum-order
designs.

Model

This example is based on the Simulink model ex_iir_design. The model includes one
lowpass filter for each of the four designs: Butterworth, Chebyshev type 1, Chebyshev
type 2, and elliptic. You can use the link under Select Filter to switch between designs
at any point during the simulation.

A stereo audio signal sampled at 44.1 kHz is passed through the filter. The audio input is

corrupted by N(0,10”°) Gaussian noise passed through a highpass filter. The original and
filtered signals are displayed in a spectrum analyzer. You can listen to either the original
or filtered signal by toggling the Manual Switch at the input of the To Audio Device
block.

The filters in this example all use direct-form II second-order sections (SOS).

model = "ex_iir_design”;

open_system(model) ;

set_param(model, "StopTime*", "1024/44100 * 100%)
sim(model);
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Butterworth Filter

The first filter block is an 8-th order Butterworth lowpass filter with a cutoff frequency
of 5 kHz. This filter is maximally flat (no ripple in the passband or in the stopband).
Double click on the block to open the block dialog. You can visualize the filter's frequency
response by clicking the View Filter Response button on the block's dialog.
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Function Block Pararmneters: Butter

Lowpass Filter

Design a lowpass filter.

Filter specifications

Impulse response: [EIR *]

Order mode: [Speciﬁ.r T]

Order: g8 ("] Denominator order:
Filter type: Single-rate

Frequency specifications

20

=]

View Filter Response

Frequency constraints: [Half poweer (3dB) frequency

Frequency units: [Hz

Half power (3dB) frequency: 3000

Magnitude specifications

'] Input sample rate: 44100

Magnitude constraints: [Unconstrained

Algorithm

Design method: | Butterworth

Scale SOS filter coefficients to reduce chance of overflow

Filter implementation

Structure: Direct-form I SOS

[] Use basic elements to enable filter customization

["] Optimize for unit scale values

Input processing: | Columns as channels (frame based)

["] Use symbolic names for coefficients
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(4] Filter Visualization Tool - Figure 1: Magnitude Response (dB) =N B
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Chebyshev Type | Filter

A Chebyshev type I design allows you to control the passband. There are still no ripples
in the stopband. Larger ripples enable a steeper roll-off. In this model, the peak-to-peak
ripple is specified to be 0.5 dB.
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Function Elock Parameters: Chebyl

Lowpass Filter

Design a lowpass filter.

Filter specifications

=]

View Filter Response

Impulse response: [EIR

)

[ Denominator order: | 20

Order mode: [Speciﬁ.r T]
Order: B
Filter type: Single-rate

Frequency specifications

Frequency constraints: [Half power (3dB) frequency -

Frequency units: [Hz

'] Input sample rate: 44100

Half power (3dB) frequency: 3000

Magnitude specifications

Magnitude constraints: [F’assband ripple

Magnitude units: [dB
Passband ripple: 0.5
Algorithm

Design method: [Cheb*_.rshev type 1

Scale S05 filter coefficients to reduce chance of overflow

Filter implementation

Structure: [Direct—fcrrm o505

[] Use basic elements to enable filter customization

["| Optimize for unit scale values

Input processing: [Columns as channels (frame based) *]

[ 1128 evmhbalic names for coefficients
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Zooming in on the passband, you can see that the ripples are contained in the range [-0.5,
0] dB.

ZI Filter Visualization Tool - Figure 1: Magnitude Response (dB)
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Chebyshev Type Il Filter

A Chebyshev type II design allows you to control the stopband attenuation. There are no
ripples in the passband. A smaller stopband attenuation enables a steeper roll-off. In this
example, the stopband attenuation is 80 dB.
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Function Elock Parameters: Cheby2

Lowpass Filter

Design a lowpass filter.

Filter specifications

=]

View Filter Response

Impulse response: [EIR

)

[ Denominator order: | 20

Order mode: [Speciﬁ.r T]
Order: B
Filter type: Single-rate

Frequency specifications

Frequency constraints: [Half poweer (3dB) frequency -

Frequency units: [Hz

'] Input sample rate: 44100

Half power (3dB) frequency: 3000

Magnitude specifications

Magnitude constraints: [Stopband attenuation -

Magnitude units: [dB

Stopband attenuation: 80

Algorithm

Design method: [Cheb*_.rshev type I

Scale S05 filter coefficients to reduce chance of overflow

Filter implementation

Structure: [Direct—fcrrm o505

[] Use basic elements to enable filter customization

["| Optimize for unit scale values

Input processing: [Columns as channels (frame based) *]

[ 1128 evmhbalic names for coefficients
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Elliptic Filter

An elliptic filter can provide steeper roll-off compared to previous designs by allowing
ripples in both the stopband and passband. To illustrate this, use the same passband and
stopband characteristics specified in the Chebyshev designs.

1-38



Lowpass IR Filter Design in Simulink

Function Elock Parameters: Ellip

Lowpass Filter

Design a lowpass filter.

Filter specifications

=]

View Filter Response

Impulse response: [EIR

)

[ Denominator order: | 20

Order mode: [Speciﬁ.r T]
Order: B
Filter type: Single-rate

Frequency specifications

Frequency constraints: [Half poweer (3dB) frequency -

Frequency units: [Hz

'] Input sample rate: 44100

Half power (3dB) frequency: 3000

Magnitude specifications

Magnitude constraints: [F’assband ripple and stopband attenuation -
Magnitude units: [dB -
Passband ripple: 0.5 Stopband attenuation: 80

Algorithm

Design method: | Elliptic

Scale S05 filter coefficients to reduce chance of overflow

Filter implementation

Structure: [Direct—fcrrm o505

[] Use basic elements to enable filter customization

["| Optimize for unit scale values

Input processing: [Columns as channels (frame based) *]

[ 1128 evmhbalic names for coefficients
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74| Filter Visualization Tool - Figure 1: Magnitude Response (dB)
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Minimum-Order Designs

In cases where you specify the passband and stopband in terms of frequencies and the
amount of tolerable ripple, you can use a minimum-order design. As an example, the
Order mode of the Butterworth filter is set to Minimum. The normalized passband and
stopband frequencies are set to 0.1*22050 Hz and 0.3*22050 Hz. The passband ripple
is 1 dB and the stopband attenuation is 60 dB. A 7-th order filter is necessary to meet the
specifications with a Butterworth design. By following the same approach on the other
filter blocks, you can verify that a 5-th order filter is required for Chebyshev type I and

type II designs. A 4-th order filter is sufficient for the elliptic design.
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Function Block Pararmneters: Butter @

Lowpass Filter

Design a lowpass filter.

View Filter Response

Filter specifications

Impulse response: [EIR v]
Order mode: [Minimum ']
Filter type: Single-rate

Frequency specifications

Frequency units: Hz = | Input sample rate: 44100

Passband frequency: 0.1%22050 Stopband frequency: 0.3%22050

Magnitude specifications

Magnitude units: | dB -

Passband ripple: 1 Stopband attenuation: 60

Algorithm

Design method: | Butterworth -

Scale SOS filter coefficients to reduce chance of overflow

P Design options

Filter implementation

Structure: [Direct—fcrrm o505 hd ]

[] Use basic elements to enable filter customization

["| Optimize for unit scale values

Input processing: [Columns as channels (frame based) *]

41
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The following figure shows the magnitude response for the 7-th order Butterworth

design.
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The pole-zero plot for the 7-th order Butterworth design shows the expected clustering of
7 poles around an angle of zero radians on the unit circle and the corresponding 7 zeros
at angle of o radians.
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[4] Filter Visualization Tool - Figure 1: Pole/Zero Plot
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Close the model to finish the tutorial.

close_system(model ,0);
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Create Moving Average System object

1-44

In this section...

“Introduction” on page 1-44

“Create the Class Definition” on page 1-45
“Moving Average Filter Properties” on page 1-45
“Moving Average Filter Constructor” on page 1-46
“Moving Average Filter Setup” on page 1-47
“Moving Average Filter Step” on page 1-47
“Moving Average Filter Reset” on page 1-48
“Input Validation” on page 1-48

“Object Saving and Loading” on page 1-48
“System object Usage in MATLAB” on page 1-49
“Simulink Customization Methods” on page 1-50

“System object Usage in Simulink” on page 1-50

Introduction

This example shows how to create a System object™ that implements a moving average
filter. The example shows how to use the System object in MATLAB and Simulink
through the MATLAB System block. MovingAverageFilter is a simple moving
average System object filter, which computes the unweighted mean of the previous
WindowLength input samples, where WindowLength is the length of the moving
average window.

The System object accepts single-precision and double-precision 2-D input matrices.
Each column of the input matrix is treated as an independent (1-D) channel. The first
dimension of the input defines the length of the channel (or the input frame size).
MovingAverageFi lter independently computes the moving average of each input
channel over time.

“System object Usage in MATLAB” on page 1-49 and “System object Usage in
Simulink” on page 1-50 show how to use your System object with data.




Create Moving Average System object

Create the Class Definition

In the MATLAB Home tab select New -> System Object -> Simulink Extension to
open a System object template. This template includes customizations of the System
object for use in the MATLAB System block. You can edit the template file, using it as
guideline, to create your own System object.

Replace all occurrences of Untitled in the file with MovingAverageFi lter and save
the file as MovingAverageFi lter.min a folder where you have write permission. You
need to add this folder to the MATLAB path to use the System object. For convenience,
the entire System object is provided in the file dspdemo.MovingAverageFilter.m. To
view this file enter

edit dspdemo.MovingAverageFilter

at the MATLAB command prompt. The prefix dspdemo on
dspdemo.MovingAverageFi lter is a package name. Packages are special folders
that can contain class folders, function and class definition files, and other packages.
Package folders always begin with the + character such as +dspdemo. Packages define
the scope of the contents of the package folder (that is, a namespace in which names
must be unique). This means function and class names need to be unique only within
the package. Using a package provides a means to organize classes and functions and
to select names for these components that other packages can reuse. You do not have
to use packages when creating your System object. For more information on packages
in MATLAB, see “Packages Create Namespaces”. The remainder of this example shows
you how to create the MovingAverageFi lter object from the System object template
without using a package. However, you can also review and use the completed version,
dspdemo.MovingAverageFilter.

Moving Average Filter Properties

The MovingAverageFi lter object has one public property that controls the length of
the moving average. Because the algorithm depends on this value being constant once
data processing begins, the property is defined as nontunable. Additionally, the property
only accepts real, positive integers. To ensure correct input, add the Positivelnteger
attribute to the property. The default value of this property is 5.

properties (Positivelnteger, Nontunable)
% WindowLength Moving average filter length
% Specify the length of the moving average filter as a
% scalar positive integer value. The default value of this
% property is 5.
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WindowLength = 5
end

The state of the moving average filter is defined with the DiscreteState attribute. Get
the value of the state by calling the getDiscreteState method.

properties (DiscreteState)
State;
end

A moving average filter is an FIR Filter with numerator coefficients equal to
ones(WindowLength, 1)/WindowLength. Because the coefficients do not change
during the streaming operation, the coefficients are defined in a property for optimization
purposes. Additionally, to ensure the coefficients are not accessible to users of the System
object, use the private attribute.

properties (Access = private, Nontunable)
pCoefficients;
end

Finally, the System object operates on a possibly multichannel input and therefore
requires a property for the number of channels. This property is not accessible to users
and therefore you use the private attribute. The value of this property is determined
from the number of columns in the input.

properties (Access = private)
% pNumChannels Property used to cache the number of input channels
% (columns). Varying the number of channels during the streaming
% operation is not allowed (since it modifes the number of required
% states). The default of -1 means that the streaming operation has
% not started yet (i.e. the number ofo channels is still unknown).
pNumChannels = -1;

end

Moving Average Filter Constructor

The System object constructor is a method that has the same name as the class
(MovingAverageFi lter in this example). Within that method, use the setProperties
method to allow standard name-value pair handling at construction, Filt =
MovingAverageFilter("WindowLength*,10).

methods
% Constructor
function obj = MovingAverageFilter(varargin)



Create Moving Average System object

% Support name-value pair arguments when constructing the
% object.
setProperties(obj,nargin,varargin{:});
end
end

Moving Average Filter Setup

The setupImpl method sets up the object and implements one-time initialization tasks.
The filter coefficients are computed based on the specified window length. The filter's
states are initialized to zero. Note that there are WindowLength-1 states per input
channel. If you would like to initialize the states to a custom value, you can create a
public InitialConditions property and use the property value to set the object state
(obj .State) in setupImpl. Finally, the number of channels is determined from the
number of columns in the input.

function setuplmpl(obj,x)

numChannels = size(x,2);

obj.State = zeros(obj.WindowLength-1,numChannels,"like",x);

% Cache the number of channels

obj .pNumChannels = numChannels;

obj .pCoefficients = ones(1l,obj.-WindowLength)/obj .WindowLength;
end

Note: You must set Access = protected for this method.

Moving Average Filter Step

The object's algorithm is defined in the stepImpl method. The algorithm in stepImpl
1s executed when the user of the System object calls step at the command line. In this
example, stepImpl calculates the output and updates the object's state values using the
filter function.

function Y = steplmpl(obj,X)

% Compute output and update state

[Y,obj.State] = filter(obj.pCoefficients,1,X,0bj.State);
end

Note: You must set Access = protected for this method.
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Moving Average Filter Reset

The state reset equations are defined in the resetImpl method. In this example, the
states are reset to zero. If you want to reset the states to a custom value, you can create
a public InitialConditions property and use the property value to reset state in
resetimpl.

function resetimpl(obj)
obj.State(:) = 0;
end

Note: You must set methods(Access = protected) for this method.

Input Validation

validatelnputsImpl validates inputs to the step method at initialization and at each
subsequent call to step where the input attributes (such as dimensions, data type or
complexity) change. In this example, val idattributes ensures that the input is a 2-D
matrix with floating-point data.

function validatelnputsimpl(obj, u)

validateattributes(u,{"double”,"single®}, {"2d", ...

"nonsparse®}," ", "input®);

% The number of input channels is not allowed to change. IT

% pNumChannels = -1. This means that the streaming operation

% has not started yet (i.e. setuplmpl has not been invoked

% yet). Do not perform the check in that case.

coder.internal.errorlf(obj.pNumChannels~=-1 && obj.pNumChannels ~= size(u,
end

Note: You must set methods(Access = protected) for this method.

Obiject Saving and Loading

saveObjectImpl defines what property and state values are saved in a MAT-file when
you call save on that object. If you do not define a saveObjectImpl method for your
System object class, only public properties and properties with the DiscreteState
attribute are saved. Save the state of an object only if the object is locked. When you load
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the saved object, the object loads in that locked state. In this System object, the filter
coefficients are saved if the object is locked.

function s = saveObjectimpl(obj)
s = saveObjectimpl@matlab.System(obj);
if isLocked(obj)
s.pCoefficients = obj.pCoefficients;
s.pNumChannels = obj.pNumChannels;
end
end

loadObjectImpl defines what System object property and state values are loaded when
you load a MAT-file. loadObjectlImpl should correspond to your saveObjectimpl to
ensure that all saved properties and data are loaded.

function loadObjectiImpl(obj,s,wasLocked)
iT wasLocked
obj.pCoefficients = s.pCoefficients;
obj.pNumChannels = s.pNumChannels;
end
loadObjectImpl@matlab.System(obj,s,wasLocked);
end

Note: You must set Access = protected for this method.

System object Usage in MATLAB

This example uses the System object to remove noise from a noisy pulse

sequence. The length of the moving average filter is 30 samples. If you are using

the predefined dspdemo.MovingAverageFilter, substitute that name for
MovingAverageFilter in the class constructor, for example movingAverageFilter =
dspdemo.MovingAverageFilter("WindowLength®,30);.

movingAverageFilter = MovingAverageFilter("WindowLength®,30);
scope = dsp.TimeScope("SampleRate”,1le3, ...
"TimeSpan®,256 * .01,...
“ShowGrid”®,true, ...
"NumlnputPorts*,2, ..
"LayoutDimensions®,[2 1]);
for i=1:100
input = (A-2*randi([0 1],1)) * ones(256,1) + 0.5 * randn(256,1);
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output = step(movingAverageFilter,input);
step(scope, input,output)
end

Simulink Customization Methods

You need to define a few more methods to be able to use the System object in a Simulink
MATLAB System block. These methods are not required if you use the System object
only in MATLAB. getOutputSizelmpl returns the sizes of each output port. For
System objects with one input and one output and where you want the input and

output sizes to be the same, you do not need to implement this method. In the case of
MovingAverageFilter, there is one input and output and the size of each is the same.
Therefore, remove this method from the class definition of MovingAverageFilter.

getDiscreteStateSpecificationImpl returns the size, data type, and complexity of
a property. This property must be a discrete-state property. You must define this method
if your System object has discrete-state properties and is used in the MATLAB System
block. In this example, the method is used to define the State property.

function [sz,dt,cp] = getDiscreteStateSpecificationlmpl(obj,~)
inputSize = propagatedlnputSize(obj,1);

sz = [obj.-WindowLength-1 inputSize(2)];
dt = propagatedlnputDataType(obj,1);
cp = propagatedlnputComplexity(obj,1);

end

Note: You must set Access = protected for this method.

System object Usage in Simulink

To use your System object in a Simulink model, drag a MATLAB System block from the
User-Defined Functions library in Simulink to your model.

Open the block dialog box and set the System object name to MovingAverageFilter.
The model ex_movingaverage Filter illustrates the use of the System object in
Simulink to filter a noisy pulse sequence.

model = “ex_movingaverage_Tfilter";
open_system(model) ;
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'bi ex_movingaverage_filter E@
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Run the model by clicking the Run button in the model or entering:

sim(model)
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Tunable Lowpass Filtering of Audio Input in Simulink

In this section...

“Introduction” on page 1-53

“Simulation” on page 1-54

This example shows how to lowpass filter a streaming audio signal by dynamically
setting the passband frequency. A slider is used to set this parameter while the
simulation is running. The power spectrum of the input and filtered audio are compared
using a spectrum analyzer.

This example is based on the following Simulink model.

model = "ex_tunable_audio_lowpass”;
open_system(model);
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r ™y
‘Pi ex_tunable_audio_lowpass - Simulink lilﬂlg
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Introduction

The input signal in this example is audio sampled at 22.5 kHz. The audio is read in from
a file 256 samples at a time. The audio is passed through a lowpass variable bandwidth
IIR filter and the result is played through the system's default audio output device. You
can use the switch in the model to compare the filtered and unfiltered audio. The filter is
implemented in Variable Bandwidth IIR Filter block.
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Having a variable bandwidth filter allows you to change the filter parameters while the
simulation is running. In this example, the passband frequency of the lowpass filter is
tunable. The algorithm in Variable Bandwidth IIR Filter block works by using frequency
transformations to recompute the filter coefficients when the passband frequency is
changed. This removes the need to redesign the whole filter. This also explains why the
filter order, passband ripple, and stopband attenuation are not tunable in real time.

Simulation

Simulating the model, you can hear the filtered audio and compare the power spectrum
of the filtered audio to the original unfiltered version.



Tunable Lowpass Filtering of Audio Input in Simulink

s

4] Spectrum Analyzer =0 >
File Tools VWiew Simulation Help &
B @ Q< &|FAE]E| X & il e

CLA =

Ready

Power spectrum of original v/s filtered audio

Frequency (kHz)

RBW=10.76 Hz |T=67.779

You can also change the passband frequency of the filter while the simulation is running.
In order to do this, either double-click the Variable Bandwidth IIR Filter block or click on
the blue Tune passband frequency link. In the dialog that opens, change the value of
the Filter passband frequency. The effect of this change is immediately applied and
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you can observe the effects in the spectrum analyzer as well as hear the change in the
audio output.

i =

Functicn Block Parameters: Tunable Audio Lowpass Filter @
Variable Bandwidth IR Filter

Variable bandwidth IR filter

Source code

Farameters

Input sample rate: 22050

Filter type: [Lowpass h
IIR. filter order: 8

Filter passband frequency: 1000
Filter passband ripple: 1

Filter Stopband attenuation: &0

Simulate using: [Code generation -

[ 0K ][ Cancel H Help Apply

1-56



Desktop Real-time Audio Acceleration with MATLAB Coder

Desktop Real-time Audio Acceleration with MATLAB Coder

In this section...

“Introduction” on page 1-57
“Notch Filtering” on page 1-57
“C Code Generation Speedup” on page 1-58

This example shows how to accelerate a real-time audio application using C code
generation with MATLAB Coder™. You must have the MATLAB Coder software
installed to run this example.

Introduction

Replacing parts of your MATLAB code with an automatically generated MATLAB
executable (MEX-function) can speedup simulation. Using MATLAB Coder, you can
generate readable and portable C code and compile it into a MEX-function that replaces
the equivalent section of your MATLAB algorithm.

This example showcases code generation using an audio notch filtering application.

Notch Filtering

A notch filter is used to eliminate a specific frequency from a signal. Typical filter design
parameters for notch filters are the notch center frequency and the 3 dB bandwidth. The
center frequency is the frequency at which the filter has a linear gain of zero. The 3 dB
bandwidth measures the frequency width of the notch of the filter computed at the half-
power or 3 dB attenuation point.

The helper function used in this example is helperAudioToneRemoval. The

function reads an audio signal corrupted by a 250 Hz sinusoidal tone from a file.
helperAudioToneRemoval uses a notch filter to remove the interfering tone and writes
the filtered signal to a file.

You can visualize the corrupted audio signal using a spectrum analyzer.

scope = dsp.SpectrumAnalyzer("SampleRate”,44.1e3, ...
"RBWSource*®, "Property”, "RBW",5, . ..
"PlotAsTwoSidedSpectrum® ,false, . ..
"SpectralAverages®,10, ...
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"FrequencySpan”, "Start and stop frequencies”®, ...
"StartFrequency”,20, ...
"StopFrequency”,1000, ...
"Title", Audio signal corrupted by 250 Hz tone®);
reader = dsp.AudioFileReader("guitar_plus_tone.ogg”);
while ~isDone(reader)
audio = step(reader);
step(scope,audio(:,1));

end
4] Spectrum Analyzer feo |l e ]
File Tools View Playback Help k]

s @ | Q< & |4 [C]EA| X A M [ &

Audio signal corrupted by 250 Hz tone

Processing RBW=5Hz T=114.242

C Code Generation Speedup

Measure the time it takes to read the audio file, filter out the interfering tone, and write
the filtered output using MATLAB code. Because helperAudioToneRemoval writes
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an audio file output, you must have write permission in the current directory. To ensure
write access, change directory to your system’s temporary folder.

mydir = pwd; addpath(mydir); cd(tempdir);
tic;

helperAudioToneRemoval ;

tl = toc;

fprintf("MATLAB Simulation Time: %d\n",tl);

Next, generate a MEX-function from helperAudioToneRemoval using the MATLAB
Coder function, codegen.

codegen helperAudioToneRemoval
Measure the time it takes to execute the MEX-function and calculate the speedup gain
with a compiled function.

tic;

helperAudioToneRemoval_mex

t2 = toc;

fprintf("Code Generation Simulation Time: %d\n",t2);
fprintf("Speedup factor: %6.2F\n",tl/t2);

cd(mydir);
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Fixed-Point Filter Design in MATLAB

1-60

This example shows how to design filters for use with fixed-point input. The example
analyzes the effect of coefficient quantization on filter design. You must have the Fixed-
Point Designer software™ to run this example.

Introduction

Fixed-point filters are commonly used in digital signal processors where data storage
and power consumption are key limiting factors. With the constraints you specify, DSP
System Toolbox software allows you to design efficient fixed-point filters. The filter for
this example is a lowpass equiripple FIR filter. Design the filter first for floating-point
input to obtain a baseline. You can use this baseline for comparison with the fixed-point
filter.

FIR Filter Design

The lowpass FIR filter has the following specifications:

+  Sample rate: 2000 Hz

+ Center frequency: 450 Hz

* Transition width: 100 Hz

*  Equiripple design

*+ Maximum 1 dB of ripple in the passband

*  Minimum 80 dB of attenuation in the stopband
samplingFrequency = 2000;

centerFrequency 450;

transitionWidth 100;

passbandRipple = 1;
stopbandAttenuation = 80;

designSpec = fdesign.lowpass("Fp,Fst,Ap,Ast", ...
centerFrequency-transitionWidth/2,
centerFrequency+transitionWidth/2,
passbandRipple,stopbandAttenuation,
samplingFrequency);

LPF = design(designSpec, "equiripple”, "SystemObject”,true)
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Magnitude (dB)

LPF =
System: dsp.FIRFilter

Properties:
Structure: "Direct form®
NumeratorSource: "Property”

Numerator: [1x52 double]
InitialConditions: O

View the baseline frequency response. The dotted red lines show the design specifications

used to create the filter.

fvtool (LPF)

Magnitude Response (dB)
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Full-Precision Fixed-Point Operation

The fixed-point properties of the filter are contained in the Fixed-point properties
section in the display of the object. By default, the filter uses full-precision arithmetic
to deal with fixed-point inputs. With full-precision arithmetic, the filter uses as many
bits for the product, accumulator, and output as needed to prevent any overflow

or rounding. If you do not want to use full-precision arithmetic, you can set the
FullPrecisionOverride property to False and then set the product, accumulator,
and output data types independently.

rng default

inputWordLength = 16;

fixedPointlnput = fi(randn(100,1),true, inputWordLength);
floatingPointlnput = double(fixedPointlnput);
floatingPointOutput = step(LPF,floatingPointinput);

release(LPF)
TfullPrecisionOutput = step(LPF,fixedPointlnput);
norm(floatingPointOutput-double(fullPrecisionOutput), "inf")

ans =

6.8994e-05

The result of full-precision fixed-point filtering comes very close to floating point, but
the results are not exact. The reason for this is coefficient quantization. In the fixed-
point filter, the CoefFicientsDataType property has the same word length (16) for
the coefficients and the input. The frequency response of the filter in full-precision mode
shows this more clearly. The measure function shows that the minimum stopband
attenuation of this filter with quantized coefficients is 76.6913 dB, less than the 80 dB
specified for the floating-point filter.

LPF._CoefficientsDataType
fvtool (LPF)
measure(LPF)

ans =

Same word length as input
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Magnitude {dB)

ans =

Sample Rate 2 kHz
Passband Edge : 400 Hz
3-dB Point : 416.2891 Hz
6-dB Point : 428.1081 Hz
Stopband Edge : 500 Hz
Passband Ripple : 0.96325 dB
Stopband Atten. : 76.6913 dB

Transition Width : 100 Hz

Magnitude Response (dB)
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The filter was last used with fixed-point input and is still in a locked state. For that
reason, Fvtool displays the fixed-point frequency response. The dash-dot response is
that of the reference floating-point filter, and the solid plot is the response of the filter
that was used with fixed-point input. The desired frequency response cannot be matched
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because the coefficient word length has been restricted to 16 bits. This accounts for the
difference between the floating-point and fixed-point designs. Increasing the number of
bits allowed for the coefficient word length makes the quantization error smaller and
enables you to match the design requirement for 80 dB of stopband attenuation. Use a
coefficient word length of 24 bits to achieve an attenuation of 80.1275 dB.

LPF24bitCoeff = design(designSpec, "equiripple”, "SystemObject”,true);

LPF24bitCoeff._CoefficientsDataType = "Custom”;

coeffNumerictype = numerictype(fi(LPF24bitCoeff_Numerator,true,24));

LPF24bitCoeff.CustomCoefficientsDataType = numerictype(true,
coeffNumerictype._WordLength,coeffNumerictype.FractionLength);

fullPrecisionOutput32bitCoeff = step(LPF24bitCoeff, fixedPointinput);

norm(floatingPointOutput-double(fullPrecisionOutput32bitCoeff), " inf")

fvtool (LPF24bitCoeff)
measure(LPF24bitCoeff)

ans =
4_.1077e-07

ans =

Sample Rate : 2 kHz
Passband Edge : 400 Hz
3-dB Point : 416.2901 Hz
6-dB Point : 428.1091 Hz
Stopband Edge : 500 Hz
Passband Ripple : 0.96329 dB
Stopband Atten. : 80.1275 dB

Transition Width : 100 Hz
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Magnitude Response (dB)
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Design Parameters and Coefficient Quantization

In many fixed-point design applications, the coefficient word length is not flexible.

For example, supposed you are restricted to work with 14 bits. In such cases, the
requested minimum stopband attenuation of 80 dB cannot be reached. A filter with 14-
bit coefficient quantization can achieve a minimum attenuation of only 67.2987 dB.

LPF1l4bitCoeff = design(designSpec, "equiripple”, "SystemObject”,true);

coeffNumerictype = numerictype(fi(LPFl14bitCoeff_Numerator,true,14));
LPF1l4bitCoeff._CoefficientsDataType = “Custom”;

LPF14bitCoeff.CustomCoefficientsDataType = numerictype(true,

coeffNumerictype.WordLength,coeffNumerictype.FractionLength);
measure(LPF14bitCoeff, "Arithmetic”, " fixed")

ans =
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Sample Rate 2 kHz
Passband Edge : 400 Hz
3-dB Point : 416.2939 Hz
6-dB Point : 428.1081 Hz
Stopband Edge : 500 Hz
Passband Ripple : 0.96405 dB
Stopband Atten. : 67.2987 dB
Transition Width : 100 Hz

For FIR filters in general, each bit of coefficient word length provides approximately 5 dB
of stopband attenuation. Accordingly, if your filter's coefficients are always quantized to
14 bits, you can expect the minimum stopband attenuation to be only around 70 dB. In
such cases, it is more practical to design the filter with stopband attenuation less than 70
dB. Relaxing this requirement results in a design of lower order.

designSpec.Astop = 60;

LPF60dBStopband = design(designSpec, "equiripple”, "SystemObject”,true);

LPF60dBStopband.CoefficientsDataType = "Custom”;

coeffNumerictype = numerictype(Ffi(LPF60dBStopband.Numerator,true,14));

LPF60dBStopband.CustomCoefficientsDataType = numerictype(true,
coeffNumerictype.WordLength,coeffNumerictype.FractionLength);

measure(LPF60dBStopband, "Arithmetic®, "fixed")

order(LPFl4bitCoeff)
order (LPF60dBStopband)

ans =
Sample Rate : 2 kHz
Passband Edge : 400 Hz
3-dB Point : 419.3391 Hz
6-dB Point : 432.9718 Hz
Stopband Edge : 500 Hz
Passband Ripple : 0.92801 dB
Stopband Atten. : 59.1829 dB
Transition Width : 100 Hz

ans =

51
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ans =

42

The filter order decreases from 51 to 42, implying that fewer taps are required to
implement the new FIR filter. If you still want a high minimum stopband attenuation
without compromising on the number of bits for coefficients, you must relax the other
filter design constraint: the transition width. Increasing the transition width might
enable you to get higher attenuation with the same coefficient word length. However, it is
almost impossible to achieve more than 5 dB per bit of coefficient word length, even after
relaxing the transition width.

designSpec.Astop = 80;

transitionWidth = 200;

designSpec.Fpass = centerFrequency-transitionWidth/2;

designSpec.Fstop = centerFrequency+transitionWidth/2;

LPF300TransitionWidth = design(designSpec, "equiripple”,
"SystemObject” ,true);

LPF300TransitionWidth.CoefficientsDataType = "Custom”;

coeffNumerictype = numerictype(Ffi(LPF300TransitionWidth.Numerator,

true, 14));
LPF300TransitionWidth.CustomCoefficientsDataType = numerictype(true,
coeffNumerictype.WordLength,coeffNumerictype.FractionLength);
measure(LPF300TransitionWidth, "Arithmetic”, "fixed")

ans =
Sample Rate : 2 kHz
Passband Edge : 350 Hz
3-dB Point : 385.4095 Hz
6-dB Point : 408.6465 Hz
Stopband Edge : 550 Hz
Passband Ripple : 0.74045 dB
Stopband Atten. : 74.439 dB

Transition Width : 200 Hz

As you can see, increasing the transition width to 200 Hz allows 74.439 dB of stopband
attenuation with 14-bit coefficients, compared to the 67.2987 dB attained when the
transition width was set to 100 Hz. An added benefit of increasing the transition width is
that the filter order also decreases, in this case from 51 to 27.
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order (LPF300TransitionWidth)

ans =

27
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Sample Rate Conversion of Audio Signal in MATLAB and Simulink

In this section...

“Introduction” on page 1-69

“Design and Analysis of Sample Rate Converter” on page 1-69
“Using the Sample Rate Converter in MATLAB” on page 1-71
“Using the Sample Rate Converter in Simulink” on page 1-73

“Specifying Tolerance to Reduce Filter Order” on page 1-76

Introduction

This example shows how to use a multistage/multirate approach to sample rate
conversion between different audio rates. The example features both MATLAB and
Simulink implementations.

Digital audio recordings use many different sample rates. Examples include: 8 kHz,
11.025 kHz, 16 kHz, 22.05 kHz, 24 kHz, 44.1 kHz, 48 kHz, and 96 kHz. The lower
rates are used for speech or low fidelity audio, while the higher rates are primarily
used for high fidelity audio. Data is commonly resampled for use with different media
or equipment. When lower fidelity is acceptable, resampling can reduce data storage
requirements.

This example uses simple-to-design polyphase filters to convert a speech signal sampled

at 44.1 kHz (CD quality) to a signal sampled at 8 kHz (telephone systems).

Design and Analysis of Sample Rate Converter

You are required to specify three parameters:

* Audio input sampling frequency
+ Audio output sampling frequency

* Two-sided bandwidth of interest, for example [-3600, 3600] or 7200 Hz.

inFs = 44100;
outFs = 8000;

1-69



1 DSP Tutorials

1-70

bw = 7200;

SRC = dsp.SampleRateConverter("Bandwidth® ,bw, " InputSampleRate”,

“OutputSampleRate” ,outFs);

Obtain information on the filters and visualize the filter responses.

info(SRC)
visualizeFilterStages(SRC)
ans =
Overall Interpolation Factor : 80
Overall Decimation Factor : 441
Number of Filters : 2
Multiplications per Input Sample 23.619048
Number of Coefficients : 7350
Filters:
Filter 1
dsp.FIRDecimator - Decimation Factor -3
Filter 2:
dsp.FIRRateConverter - Interpolation Factor: 80

- Decimation Factor o 147

inFs, ...
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The sample rate converter is a cascade of two stages: a FIR decimator followed by a
FIR fractional rate converter. The sample rate converter preserves the band of interest
between 0 and 3600 Hz, and suppresses the spectral replicas outside that band.

Using the Sample Rate Converter in MATLAB

To execute the following example, change to a directory where you have write permission.

Read in an audio file sampled at 44100 Hz in frames of 441 samples at a time. Use a
sample-rate converter to lowpass filter the input and convert the sample rate to 8000 Hz.
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View the short-time Fourier transform (spectrogram) of the sample-rate converter output
in a spectrum analyzer and write the output to a FLAC file in the current directory.

afr = dsp.AudioFileReader("dft_speech44100.wav”, "SamplesPerFrame®,441);
afw = dsp.AudioFileWriter("dft_speech8000.flac", "SampleRate” ,outFs, . ..
"FileFormat®,"FLAC", "DataType”,"intl6");
specana = dsp.SpectrumAnalyzer("SpectrumType®, "Spectrogram”, ...
"SampleRate” ,outFs, . ..
"PlotAsTwoSidedSpectrum® ,false, . ..
"FrequencyResolutionMethod®, “WindowLength®, ...
"WindowLength®",441, ...
"FFTLengthSource®, "Property”", ...
"FFTLength®,512,. ..
"OverlapPercent®,25);
while ~isDone(afr)
audio = step(afr);
audioconvert = step(SRC, audio);
step(specana,audioconvert);
step(afw, audioconvert);
end
release(afr);
release(afw);
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E Spectrum Analyzer EI@

File Tools View Playback Help k!

g @ | & w & [ b | (1] (A [l [ [

Processing RBW=27.21 Hz |Time res.=35.75 ms Offset=4.7788 = T=4.8

Using the Sample Rate Converter in Simulink

You can use the sample rate converter in Simulink with a MATLAB System block. The
model ex_audio_src, which is a Simulink version of “Using the Sample Rate Converter
in MATLAB?”, is provided for convenience. The model writes an audio file output so make
sure you run the example from a folder where you have write permission.

open_system("ex_audio_src");
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To run the model, click the Run button on the model toolbar or enter the following

command.

sim("ex_audio_src")
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The model reads in a speech signal sampled at 44.1 kHz. The sample rate is converted to
8 kHz and the short-time Fourier transform (spectrogram) of the output is displayed in
a spectrum analyzer. A FLAC file (dft_speech8000.flac) is written containing the output
sampled at 8 kHz. You can verify the sample rate of the output file after you run the
model with the following code.

audioinfo("dft_speech8000.flac™)
ans =
Filename: "tmp/\dft_speech8000.flac"

CompressionMethod: "FLAC*
NumChannels: 1
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SampleRate: 8000
TotalSamples: 41280
Duration: 5.1600

Title: []
Comment: []
Artist: []

BitsPerSample: 16

Specifying Tolerance to Reduce Filter Order

If you do not have an exact requirement for the output sample rate, you can allow for a
certain tolerance by setting the “OutputRateTolerance” property to a non-zero value.
Setting a non-zero tolerance for the output rate can often result in a filter design with
fewer coefficients. Compare the filter design with and without a specified output rate
tolerance.

tol = 0.01;

SRCwithTolerance = dsp.SampleRateConverter("Bandwidth®, bw, ...
"InputSampleRate”, inFs, ...
"OutputSampleRate”, outFs, ...
"OutputRateTolerance®, tol);

info(SRC)
info(SRCwithTolerance)
ans =
Overall Interpolation Factor : 80
Overall Decimation Factor : 441
Number of Filters : 2
Multiplications per Input Sample 23.619048
Number of Coefficients : 7350
Filters:
Filter 1
dsp.FIRDecimator - Decimation Factor -3
Filter 2:
dsp.FIRRateConverter - Interpolation Factor: 80
- Decimation Factor : 147
ans =
Output Sample Rate Tolerance : 1.000000 %
Adjusted Output Sample Rate - 8018.181818
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Overall Interpolation Factor : 2
Overall Decimation Factor 11
Number of Filters -1
Multiplications per Input Sample: 45.363636
Number of Coefficients : 499
Filters:
Filter 1:
dsp.FIRRateConverter - Interpolation Factor: 2
- Decimation Factor - 11

With a 0.01 tolerance, the number of coefficients of the sample rate converter reduces
from 7350 to 499. One of the stages in the cascade is eliminated and the interpolation
and decimation factors are reduced. Using this tolerance, the output sample rate is
8018.18 Hz, which may be an acceptable approximation in most cases to the desired rate
of 8000 Hz.
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Visualizing Multiple Signals Using Logic Analyzer

This example shows how to visualize multiple signals of a programmable FIR filter using
a logic analyzer. For more information on the model used in this example and how to
configure the model to generate HDL code, see “Generate HDL Code for Programmable
FIR Filter”.

Model Programmable FIR Filter

Open the example model.

modelname = “dspprogfirhdl”;
open_system(modelname) ;

L.

>

4

In numiz) T Refou

0.4, chirp zd H_IE —
fiter inpu ot
Repesting Chirp ToF ot Stariup Delay A
Signaks N
coeffs FIR Behavioral v -
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host_write_data P coeffs_in -

Progammable FIR Filter
—»

L

host_write_address

rite_address

This model shows a FIR filter whose

coefficients are programmable by the
host interface. Select fully or serial host_write_enable | write_enable filter_out
architecture implementation for Discrete
FIR Filter block in HDL Block Properties.

dut cutput

host_write_done = write_done

See the Model Properties InitFen Callback i
function to set the filter coefficients. A=t Behavioral Model ..

Programmatle FIR via Registers
write_snable

write_done

Launch HDL Dialog

Info

Run Demo
Copyright 2011-2012 The MathWorks, Inc.

Consider two FIR filters, one with a lowpass response and the other with a highpass
response. The coefficients can be specified using the InitFen* callback function. To
specify the callback, select File > Model Properties > Model Properties. In the dialog
box, in the Callbacks tab, select InitFen®*.
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The Programmable FIR via Registers block loads the lowpass coefficients from the Host
Behavioral Model block and processes the input chirp samples first. The block then loads
the highpass coefficients and processes the same chirp samples again.

Open the Programmable FIR via Registers block.

systemname = [modelname °/Programmable FIR via Registers™];
open_system(systemname) ;

N

coeffﬂ_in I
# Coeffin " numiz)

coeffs_in T
.—b 1 write_address coeffs_out u Hut .(D
T - - Lt el 1 Fiber Out
- Wirite: Adddr —¥ — i Hum filter_out
write,_addr s E - coefE_chadow -

B ‘Witz En rite_enable shadow_regs Dicrete FIR Filter

write_enable

coeffs_registers

1
@ Wrie Done
write_done
Simulation

Run the example model.

sim(modelname)

Open the scope.

open_system([modelname "/Scope”]);
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nScope EI@
g a<@)EN% DaF €

Compare the DUT (Design under Test) output with the reference output.

Use the Logic Analyzer

The logic analyzer enables you to view multiple signals in one window. It also makes it
easy to detect signal transitions.

The signals of interest (input coefficient, write address, write enable, write

done, filter in, filter out, reference out, and error) have been logged to a
Simulink.SimulationData.Dataset named dspprogfirhdl_logsout in the
MATLAB workspace.

The helper function dspprogfirhdlReorderDataset creates a waveform for every
input provided in the dspprogfirhdl_logsout data set. Tto make the default order of
display more meaningful, the data set is reordered to make the coefficient signals appear
first and the data signals next. The error values are converted to logical values.

1-80



Visualizing Multiple Signals Using Logic Analyzer

logsout_r = dspprogfirhdlReorderDataset(dspprogfirhdl_logsout);

Display the data in the logic analyzer. Use the helper function
analyzelLogicFromSimul ink, which launches a logic analyzer, adds in a waveform for
every input, labels the waveform, and displays the data. analyzelLogicFromSimulink
returns a handle to the logic analyzer that you can use to modify the display.

analyzer = analyzelLogicFromSimulink(logsout_r);
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Modify the Display

In the logic analyzer, you can modify the height of all the displayed channels, the spacing
between the channels, and the time span of the display.

analyzer _DisplayChannelSpacing = 2;
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analyzer _DisplayChannelHeight = 2;
analyzer_TimeSpan = 12;

B dspprogfirhdl_logsout = |l= =]
File Edit View Playback Help k.
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Filter Cut DOOCY 0000
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Processing T=0

You can also control the display on a per-waveform or per-divider basis. To
modify an individual waveform or divider, use the tag associated with it. You
can obtain the tag associated with a waveform or divider as the return value
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of addWave and addDivider, or you can get all the tags for the waveforms and dividers
using the getDisplayChannelTags method

Get the tags for all the displayed waveforms.

displayTags = analyzer.getDisplayChannelTags;
View the write address (second waveform in the display) in decimal mode.

modifyDisplayChannel (analyzer, "DisplayChannelTag®, displayTags{2},
"Radix®, "Signed decimal®);
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Another useful mode of visualization in the logic analyzer is the analog format. View the
Filter In, Filter Out, and Ref Out signals in analog format.

modifyDisplayChannel (analyzer, “DisplayChannelTag®, displayTags{5}, ---
"Format®, “Analog”);

modifyDisplayChannel (analyzer, “DisplayChannelTag®, displayTags{6}, ---
"Format®, “Analog”);
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modifyDisplayChannel (analyzer, “DisplayChannelTag®, displayTags{7}, ---
"Format®, “Analog”);
analyzer_TimeSpan = 500;
dspprogfirhdl_logsout = [=][=]
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Processing

You can also add dividers and waveforms. By default, a new waveform or divider is
added to the bottom of the display. If you want, you can pass in the display channel while
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adding in the waveform or divider. You can also move the waveform or divider after it
has been added to the display.

Add dividers for the coefficient and data signals. The divider for the coefficient signals
is set to be shown in Display Channel 1. The divider for the data signals is added to the
bottom of the display.

addDivider(analyzer, “DisplayChannel®, 1, "Name®, "Coeff");
divTagData = addDivider(analyzer, "Name®, "Data”);
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Increase the size of the window so that all the waveforms and dividers are visible.
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pos = analyzer_Position;
analyzer _Position = [pos(1l) pos(2) pos(3) pos(4)+100];

Using the tag for a given waveform or divider, you can use moveDisplayChannel to
move it to the display channel of your choice.

Move the data signal divider to display channel 6.

moveDisplayChannel (analyzer, "DisplayChannelTag”, divTagData, "DisplayChannel”, 6);
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You can also operate on individual channels by right-clicking the channel name.
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See dsp.LogicAnalyzer for more details.
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This example shows how to visualize and measure signals in the time and frequency
domain in MATLAB using a time scope and spectrum analyzer. This example does not
demonstrate the full capabilities of the time scope or spectrum analyzer. To learn more
about the measurement capabilites of the time scope, see the Simulink example Time
Scope Measurements. To learn more about the use of measurements with the spectrum
analyzer, see the Simulink example Spectrum Analyzer Measurements.

Signal Visualization in Time and Frequency Domains

Create a sine wave with a frequency of 100 Hz sampled at 1000 Hz. Generate five
seconds of the 100-Hz sine wave with additive white Gaussian noise with mean 0 and
standard deviation 0.05. The signal is processed in one-second frames. Send the signal to
a time scope and spectrum analyzer for display and measurement.

SampPerFrame = 1000;
Fs = 1000;
SW = dsp.SineWave("Frequency”, 100,
"SampleRate”, Fs, "SamplesPerFrame®, SampPerFrame);
TS = dsp-TimeScope("SampleRate”, Fs, "TimeSpan®, 0.1,
"YLimits", [-2, 2], "ShowGrid", true);
SA = dsp.SpectrumAnalyzer("SampleRate”, Fs);
tic;
while toc < 5
sigData = step(SW) + 0.05*randn(SampPerFrame,1);
step(TS, sigData);
step(SA, sigData);
end
release(TS);
release(SA);


../examples/time-scope-measurements.html
../examples/time-scope-measurements.html
../examples/spectrum-analyzer-measurements.html
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Time-Domain Measurements

Using the time scope, you can make a number of signal measurements.
The following measurements are available:

+  Cursor Measurements - puts screen cursors on all scope displays.

Signal Statistics - displays maximum, minimum, peak-to-peak difference, mean,
median, RMS values of a selected signal, and the times at which the maximum and
minimum occur.

Bilevel Measurements - displays information about a selected signal's transitions,
overshoots or undershoots, and cycles.

1-94




Signal Visudlization and Measurements in MATLAB

* Peak Finder - displays maxima and the times at which they occur.

You can enable and disable these measurements from the time scope toolbar or from the

Tools > Measurements menu.
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To illustrate the use of measurements in the time scope, simulate an ECG signal. Use
the ecg function to generate 2700 samples of the signal. Use a Savitzky-Golay filter to
smooth the signal and periodically extend the data to obtain approximately 11 periods.

X = 3.5%ecg(2700).";
y = repmat(sgolayfilt(x,0,21),[1 13]);
sigbata = y(1:30000)";
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Display the signal in the time scope and use the Peak Finder, Cursor and Signal
Statistics measurements. Assume a sample rate of 4 kHz.

TS_ECG = dsp.-TimeScope(~“SampleRate®, 4000,
"TimeSpanSource®, "Auto®, "ShowGrid", true);

step(TS_ECG, sigData);

TS_ECG.YLimits = [-4, 4];

release(TS_ECG);
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Peak Measurements

Enable Peak Measurements by clicking the corresponding toolbar icon or by clicking
the Tools > Measurements > Peak Finder menu item. Click Settings in the Peak
Finder panel to expand the Settings pane. Enter 10 for Max Num of Peaks and press

Enter. The time scope displays in the Peaks pane a list of 10 peak amplitude values and
the times at which they occur.
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There is a constant time difference of 0.675 seconds between each heartbeat. Therefore,
the heart rate of the ECG signal is given by the following equation:

G0 sec/min 88.89 beats /min (1 \
o .89 beats /min (bpm
0.675 sec/heat ' :

Cursor Measurements

Enable Cursor Measurements by clicking the corresponding toolbar icon or by

clicking the Tools > Measurements > Cursor Measurements menu item. The Cursor
Measurements panel opens and displays two cursors in the time scope. You can drag

the cursors and use them to measure the time between events in the waveform. In the
following figure, cursors are used to measure the time interval between peaks in the ECG
waveform. The AT measurement in the Cursor Measurements panel demonstrates that
the time interval between the two peaks is 0.675 seconds corresponding to a heart rate of
1.482 Hz or 88.9 beats/min.
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Signal Statistics and Bilevel Measurements

You can also select Signal Statistics and Bilevel Measurements from the Tools >
Measurements menu. Signal Statistics can be used to determine the signal's minimum
and maximum values as well as other metrics like the peak-to-peak, mean, median, and
RMS values. Bilevel Measurements can be used to determine information about rising
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and falling transitions, transition aberrations, overshoot and undershoot information,
pulse width, and duty cycle.

Frequency-Domain Measurements

This section explains how to make frequency domain measurements with the spectrum
analyzer.

The spectrum analyzer provides the following measurements:

* Cursor Measurements - places cursors on the spectrum display.
* Peak Finder - displays maxima and the frequencies at which they occur.

* Channel Measurements - displays occupied bandwidth and ACPR channel
measurements.

* Distortion Measurements - displays harmonic and intermodulation distortion
measurements.

+ CCDF Measurements - displays complimentary cumulative distribution function
measurements.

You can enable and disable these measurements from the spectrum analyzer toolbar or
from the Tools > Measurements menu.
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Distortion Measurements

To illustrate the use of measurements with the spectrum analyzer, create a 2.5 kHz
sine wave sampled at 48 kHz with additive white Gaussian noise. Evaluate a high-order
polynomial (9th degree) at each signal value to model non-linear distortion. Display the
signal in a spectrum analyzer.

Fs = 48e3;
SW = dsp.-SineWave("Frequency®, 2500, ...

"SampleRate”, Fs, "SamplesPerFrame®, SampPerFrame);
SA_Distortion = dsp.SpectrumAnalyzer(“SampleRate®, Fs, ...

"PlotAsTwoSidedSpectrum®, false);

y = [1le-6 1le-9 le-5 l1le-9 le-6 5e-8 0.5e-3 le-6 1 3e-3];
tic
i

ic;
while toc < 5
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X = step(SW) + le-8*randn(SampPerFrame,l1);
sigbata = polyval(y, X);
step(SA_Distortion, sigData);

end

clear SA Distortion;

Enable the harmonic distortion measurements by clicking the corresponding icon in
the toolbar or by clicking the Tools > Measurements > Distortion Measurements
menu item. In the Distortion Measurements, change the value for Num. Harmonics
to 9 and check the Label Harmonics checkbox. In the panel, you see the value of the
fundamental close to 2500 Hz and 8 harmonics as well as their SNR, SINAD, THD and
SFDR values, which are referenced with respect to the fundamental output power.

File Tools View Playback Help k]
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Peak Finder
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You can track time-varying spectral components by using the Peak Finder measurement
dialog. You can show and optionally label up to 100 peaks. You can invoke the Peak
Finder dialog from the Tools > Measurements > Peak Finder menu item, or by
clicking the corresponding icon in the toolbar.

To illustrate the use of Peak Finder, create a signal consisting of the sum of three
sine waves with frequencies of 5, 15, and 25 kHz and amplitudes of 1, 0.1, and 0.01

respectively. The data is sampled at 100 kHz. Add N(0,1077) white Gaussian noise
to the sum of sine waves and display the one-sided power spectrum in the spectrum
analyzer.

Fs = 100e3;
Swi dsp.SineWave(1e0, 5e3, 0, "SampleRate”, Fs, "SamplesPerFrame®, SampPerFrame);
Sw2 dsp.SineWave(le-1, 15e3, 0, "SampleRate”, Fs, "SamplesPerFrame®, SampPerFrame);
SW3 dsp.SineWave(le-2, 25e3, 0, "SampleRate”, Fs, "SamplesPerFrame®, SampPerFrame);
SA_Peak = dsp.SpectrumAnalyzer("SampleRate”, Fs, "PlotAsTwoSidedSpectrum®, false);
tic;
whille toc < 5
sigData = step(SW1) + step(SW2) + step(SW3) + le-4*randn(SampPerFrame,l);
step(SA_Peak, sigbata);
end
clear SA_Peak;

Enable the Peak Finder to label the three sine wave frequencies. The frequency values
and powers in dBm are displayed in the Peak Finder panel. You can increase or
decrease the maximum number of peaks, specify a minimum peak distance, and change
other settings from the Settings pane in the Peak Finder Measurement panel.
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Filier Frames of a Noisy Sine Wave Signal using Testbench
Generator

This example shows how to use the Streaming Testbench Generator app to generate
DSP algorithm testbenches. The DSP algorithm generated in this example is similar to
the algorithm in the Filter Frames of a Noisy Sine Wave Signal in MATLAB example.
That example filters a noisy sine wave signal using a FIR lowpass filter and displays the
power spectrum using a spectrum analyzer.

Streaming Testbench Generator Example App

The Streaming Testbench Generator app helps you develop and test streaming signal
processing algorithms by enabling you to quickly generate testbenches. To launch
the Testbench Generator, enter testbenchGeneratorExampleApp at the MATLAB
command prompt. The command launches an interface through which you can:

1  Select a set of sources and sinks.

2 Enter the function name of your custom User Algorithm.

3 Customize the properties of each of the added sources and sinks.

Each source is treated as a separate input to your algorithm, but you can associate more
than one sink with the same output from your algorithm.

testbenchGeneratorExampleApp
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Streaming Testbench Generator E@

Settings  Help u

Ve

In2: Wwhite Moise (randn)

Audio File Reader -

Inputs - Sine Waves and White Noise

By default, the testbench generator selects a two-channel sine wave source and a white
Gaussian noise source. The two channels of the sine wave source have frequencies of 1
kHz and 10 kHz. The sampling frequency is 44.1 kHz. The white Gaussian noise input
has mean 0 and standard deviation 0.1. The data is processed in frames of 1024 samples.
To add more sources, use the list under Add a new source to the above list of inputs
to select one of the supported sources. Alternatively, you can add your custom System
object source by selecting Custom System object from the list and clicking Add. The
added source appears in the list of inputs.
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After adding a source, you can select it and click Configure to change the selected
source's properties.
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User Algorithm - Lowpass Filter

The default user algorithm dspStreamingPassthrough is a generic function that just
passes through the inputs to the outputs. The user algorithm used in this example is a
more meaningful function hTestbenchLowpass. You can view the code for this function
by entering

edit hTestbenchLowpass

at the MATLAB command prompt. hTestbenchLowpass accepts two inputs, lowpass
filters the sum of those two inputs, and returns the filtered signal. It uses a constrained
equiripple FIR filter design with a cutoff frequency of 5 kHz. The ripples in the passband
and stopband are equal to 0.05 and 0.001. Filtering is performed using dsp.FIRFilter,
which is optimized for streaming.

Type hTestbenchLowpass in the User Algorithm text box replacing the default
dspStreamingPassthrough. Alternatively, you can bring up a new testbench generator
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session by entering testbenchGeneratorExampleApp("hTestbenchLowpass®) at
the MATLAB command prompt.

hTestbenchLowpass

e

Audio File Reader -

Output

The power spectrum of the output is displayed on a spectrum analyzer in dBm. You can
add more sinks to visualize or post-process the outputs. Similar to inputs, you can use
the list under Add a new sink to the above list of outputs to add a new sink, and
click Configure to modify the properties of the selected sink.

You can associate a single output from the user algorithm with one or more sinks. For
example, you can visualize the same output signal with both a time scope and spectrum
analyzer. To do this, add the required sinks and make sure you associate all of the sinks
to desired output from the user algorithm by changing the value under the Associate
selected sink with list.
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Generate Code and Simulate

After you add and configure the sources and sinks and enter a function name in the User
Algorithm text box, the testbench generator is ready to generate testbench MATLAB
code. To generate code, click on the Generate MATLAB Code button. A new untitled
document opens in the MATLAB editor containing the generated testbench code.

You can edit the generated code to customize it before executing it. For the default
example, the generated code is included below. Executing this testbench code, you see
in the spectrum analyzer that the frequencies above 4 kHz in the source signal are
attenuated. The resulting signal maintains the peak at 1 kHz because 1 kHz falls in the
passband of the lowpass filter.

% Streaming testbench script
% Generated by Streaming Testbench Generator

% Initialization
numlterations = 10000;

% Construct sources (for all inputs)
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srcl = dsp.SineWave("Frequency®,[1000 10000], ---
“SampleRate”,44100, ...
"SamplesPerFrame®,1024);

% Construct sinks (for all outputs)

sinkl = dsp.SpectrumAnalyzer("“SampleRate”,44100, ...
"PlotAsTwoSidedSpectrum®,false, ...
“ShowLegend” ,true);

% Stream processing loop
clear hTestbenchLowpass;
for 1 = l1:numlterations

% Sources

inl = step(srcl);

in2 0.1*randn(1024,2);

% User Algorithm
outl = hTestbenchLowpass(inl,in2);

% Sinks
step(sinkl,outl);
end

% Clean up
release(srcl);
release(sinkl);
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More Customizations in Testbench Generator
The testbench generator offers additional top-level customizations, which you can

configure using the Testbench Generator Settings dialog box. To open this dialog box,
select Settings > Testbench Generator Settings ....
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) Streaming Testbench Generator: Settings E =] @
Signal streaming stop mode
Stop signal streaming based on: |jtaration count -
Mumber of iterations: 10000
Generated code format
Generate MATLAB code as: Script -
| Ok | | Cancel

You can also tune some of the parameters used in your algorithm during testbench
execution. To use the Parameter Tuning U, check the Enable parameter tuning
check box under the User Algorithm and click Edit parameters table to add the
details of your tunable parameters before you generate testbench code. Also, make sure
that your user algorithm handles parameter tuning during execution. See the MATLAB
code for hTestbenchVariableBandwithFIR for an example of how to make your user
algorithm work with parameter tuning.
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This example shows how to create a System object composed of other System objects.
In this example, build a multi-notch filter using two dsp.NotchPeakFilter System
objects. Multi-notch filters are used in many applications. Examples include audio
phasers and applications that require the removal of multiple interfering tones.

Create MultiNotchFilter

“Create Moving Average System object” on page 1-44 explains in detail how to write a
System object using a template file. In this example, the entire System object is provided
for convenience in dspdemo.MultiNotchFilter. To view the MATLAB code, at the
command prompt enter:

edit dspdemo.MultiNotchFilter

dspdemo.MultiNotchFi lter has five public properties. Public properties are
accessible to every user. The first property, SampleRate, is a nontunable property.
Nontunable properties cannot change when the filter is locked (after you use step

on the filter). The remaining properties, CenterFrequencyl, CenterFrequency2,
QualityFactorl, and Qual ityFactor2 control settings in the two notch filters
contained in dspdemo.MultiNotchFilter. These four properties are tunable. You can
change the values of these properties while streaming data.

Contain System Obijects as Private Properties

dspdemo.MultiNotchFilter uses dsp.NotchPeakFi lter to design the two notch
filters. The notch filters are created in the class constructor.

methods
function obj = MultiNotchFilter(varargin)

% Construct two notch Filters with default values
obj _NotchFilterl = dsp.NotchPeakFilter(...
"Specification®, "Quality factor and center frequency”®,...
"CenterFrequency”,400);
obj _NotchFilter2 = dsp.NotchPeakFilter(...
"Specification®, "Quality factor and center frequency”®,...
"CenterFrequency®,800);
% Support name-value pailr arguments
setProperties(obj,nargin,varargin{:});



Create Composite System object

end

The ability to create more than one instance of a System object and having each instance
manage its own state is one of the biggest advantages of using System objects over
functions. The private properties NotchFilterl and NotchFilter2 are used to store
the two notch filters.

properties (Access=private)
% This example class contains two notch filters (more can be added
% In the same way)
NotchFilterl
NotchFilter2
end

Work with Dependent Properties

The SampleRate property as well as the remaining four public properties are
implemented as dependent properties in this example. Whenever you assign a value to
one of the dependent properties, the value is set in the corresponding single-notch filter.
When you read one of the dependent properties, the value is read from the corresponding
single-notch filter. Find the following code block in dspdemo.MultiNotchFilter.

properties (Dependent)
%CenterFrequencyl Center frequency of first notch
% Specify the first notch center frequency as a finite positive
% numeric scalar in Hertz. The default is 400 Hz. This property
% is tunable.
CenterFrequencyl;
%QualityFactorl Quality factor of first notch
% Specify the quality factor (Q factor) for the Tirst notch
%  Filter. The default value is 5. This property is tunable.
QualityFactorl;
%CenterFrequency2 Center frequency of second notch
% Specify the second notch center frequency as a finite positive
% numeric scalar in Hertz. The default is 800 Hz. This property
% is tunable.
CenterFrequency?2;
%Qual ityFactor2 Quality factor of second notch
% Specify the quality factor (Q factor) for the Tirst notch
%  Filter. The default value is 5. This property is tunable.
QualityFactor?2;

end
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Use the Multi-Notch Filter - Initialization

To use dspdemo.MultiNotchFi lter, initialize the filter and any other required
components. In this example, initialize an audio file reader, a multi-notch filter, a
transfer function estimator, an array plotter, and an audio player.

FrameSize = 1024;

AFR = dsp.AudioFileReader("guitarlOmin.ogg”, "SamplesPerFrame”,FrameSize);
Fs = AFR.SampleRate;

MNF = dspdemo.MultiNotchFilter("SampleRate”,Fs);

TFE = dsp.TransferFunctionEstimator(...

"FrequencyRange”, "onesided", "SpectralAverages”,5);

AP = dsp.ArrayPlot("PlotType®,"Line","YLimits",[-85 15], ...
"Samplelncrement” ,Fs/FrameSize);

P = dsp.AudioPlayer;

Use the Multi-Notch Filter - Streaming

To illustrate the tunability of the two notch filter center frequencies, vary the center
frequencies sinusoidally in a loop. The starting center frequencies are 500 and 2000
Hz. The first center frequency oscillates over the range [100, 900] Hz with a frequency
of 0.2 Hz. The second center frequency oscillates over the range [1200, 2800] Hz with

a frequency of 0.5 Hz. Because CenterFrequencyl and CenterFrequency?2 are
dependent properties, modifying their values in the loop changes the center frequencies
in the two notch filters contained in dspdemo.MultiNotchFilter. To visualize the
multi-notch filter, estimate and plot the transfer function continuously. The quality
factors remain constant. The simulation runs for 20 seconds.

MNF._.QualityFactorl = .5;
MNF.QualityFactor2 = 1;
fO = 0.2;
f1 = 0.5;
k = 0;
tic,
while toc <20
X = step(AFR);
t = k*FrameSize/Fs;
k = k+1;
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MNF._CenterFrequencyl = 500 + 400*sin(2*pi*f0*t);
MNF.CenterFrequency2 = 2000 + 800*sin(2*pi*fl*t);
CF1(k) MNF.CenterFrequencyl;
CF2(k) MNF.CenterFrequency?2;

step(MNF,x);

y

H = step(TFE,x(:,1),y(:,1));
magdB = 20*logl0(abs(H));
step(AP,magdB) ;
step(P,y);

end

4. Array Plot oSl P S
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Execute this code to show how the two notch center frequencies varied over the
simulation.
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subplot(2,1,1)

plot(CF1);

title("Center Frequency 17);
ylabel ("Notch CF (Hz)");
subplot(2,1,2)

plot(CF2);

title("Center Frequency 27);
ylabel ("Notch CF (Hz)");
xlabel (" Iteration®)
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Measure Audio Latency in MATLAB and Simulink

This example shows how to measure the latency introduced in audio signals when using
the audio player and audio recorder in MATLAB or Simulink. The procedure presented
here allows you to tune certain parameters that affect latency and observe the effect

in a simple measurement. The specific parameters are discussed in detail later in the
example.

Introduction

In general terms, latency is defined as the time it takes for the audio to be heard or
recorded after it has been played. There are multiple factors that influence latency. For

example:

1 Hardware: CPU, memory, and sound card.

2 Audio drivers that communicate with the system's sound card.

3 Algorithmic complexity of any audio processing between playback and recording.
4  Software used to process the audio: MATLAB or Simulink in this example.

This example shows you how to measure the overall latency with a focus on what
parameters determine the latency effect of using MATLAB or Simulink. There are two
variants of this example: one uses the audio System objects in MATLAB and the other
uses the Simulink audio input and output blocks.

Set-up Experiment

In this example, measure the latency by playing an audio signal through
dsp.AudioPlayer (or the To Audio Device block), recording the audio through
dsp.AudioRecorder (or the From Audio Device block), and measuring the delay by
the cross-correlation of the two signals. No other processing is done on the audio signal.
A loopback cable is used to physically connect the audio-out port of the sound card to its
audio-in port. The set-up is shown in the following illustration.
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Sound card (Computer)
Audio-Out Audio-In

Port Port

Loopback cable
Lo

The set-up for another common application is to record live audio with a microphone,
process the audio on the computer, and play the audio back in a streaming fashion. In
that set-up, the hardware interface latency is the same as the set-up involving the audio
System objects or blocks: a sum of latencies due to the player and the recorder.

Measure Latency

The audioLatencyMeasurementBasicExampleApp function measures the latency for
the set-up where an audio signal is played and recorded with System objects or Simulink
blocks. Inputs to this function are:

+ plotFlag: Set this to true to visualize the input to the dsp.AudioPlayer object and
the output from the dsp.AudioRecorder object.

+ frameSize: Number of audio samples that constitute a single frame. This sets the
SamplesPerFrame property of the dsp.AudioFileReader object.

* bufferSize: The value of this parameter is copied to the BufferSize property of the
dsp.AudioPlayer and the dsp.AudioRecorder System objects.

+ useSimulink: Set this to true to use the Simulink model
audiolatencybasicmeasurement.slx to measure the latency.

Most of these inputs are parameters that affect audio latency in MATLAB or Simulink.
You can try different values and measure the latency for each set. The various sections in
the MATLAB code for the audioLatencyMeasurementBasicExampleApp function are:

1 Initialization: The default values for the input parameters are assigned. The audio
System objects are created with appropriate parameter values.
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2 Loopback simulation: For a duration of 10 seconds, audio is read from a
file and sent to the computer's audio-out port through dsp.AudioPlayer.
Through the loopback cable and audio-in port, the audio is read in using
the dsp.AudioRecorder object. When the useSimulink input is
true, the loopback simulation is performed through the Simulink model
audiolatencybasicmeasurement.slx. The signal read from the file and the
recorded signal are stored in a signal sink.

3 Cross-correlation: Using the xcorr function, the cross-correlation sequence is
computed between the audio signal sent to the player and the one received by the
recorder. The received signal lags the played signal. The time shift corresponding to
the maximum value of the cross-correlation sequence is the latency. Additionally, if
the plotFlag input is true, the two audio signals are plotted in a figure so you can
observe the lag.

If the queue is overrun or underrun, a corresponding message is displayed in the
command window for the MATLAB version of this example. For the Simulink version,
you must monitor the logged variables APunderrun and ARoverrun to determine
overrun or underrun.
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Parameters in MATLAB/Simulink Affecting Latency
Frame size

This is not an explicit property of the audio player or audio recorder System objects. The
frame size is the number of samples passed to those objects in each call to their step
methods. The bigger the frame size, the longer you must wait to collect the samples.

BufferSize

The BufferSize is a property of both the dsp.AudioPlayer and dsp.AudioRecorder
System objects. The buffer size value is half the size of the sound card buffer. The smaller
the BufferSize, the quicker you can send samples to the sound card. However, there is a
trade-off because a small buffer can also easily underrun (for the player) or overrun (for
the recorder).
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QueueDuration

Both dsp.AudioPlayer and dsp.AudioRecorder System objects have the property,
QueueDuration. The queue is a storage space between the System object and the
sound card buffer. The main use of QueueDuration is to match the throughput of the
algorithm in MATLAB and the device. A proper setting for QueueDuration can help
prevent buffer underruns and overruns. QueueDuration should be set to a value as
small as possible to maintain acceptable latency while not introducing glitches in the
audio. The optimal value for the queue size is typically twice the size of the audio frame.
Based on this, the QueueDuration is kept to a value of (2*FrameSize+1)/SampleRate.

The same parameters are also applicable in the Simulink version that uses audio
blocks instead of System objects. More details about BufferSize and QueueDuration
can be found in the documentation for the System objects dsp.AudioPlayer and
dsp.AudioRecorder, and the blocks To Audio Device and From Audio Device.

Sound Card and Drivers

Additionally, latency is affected by the sound card and drivers. For low-latency
applications, use a low-latency sound card. Drivers can also have an impact on latency.
For example, on the Windows™ platform, DirectSound creates an additional virtual
device layer between the application and the sound card, increasing latency. On the
other hand, ASIO™ drivers communicate with the device directly, which helps to reduce
delays.

Obtain Parameter Values for Low Latency

The latency of your system can depend on multiple parameters. In order to discover the
set of parameter values that provides the smallest latency, first fix an audio frame size.
Typically, this is 1024 or 512 samples for a sample rate of 44.1 kHz. Initially set the
buffer size the same value as the frame size and keep reducing it until the queue starts to
overrun or underrun. The smallest buffer size that satisfies this criterion is generally 64
or 128 samples for an audio frame size of 512 or 1024 at 44.1 kHz. Repeat the experiment
by starting with a smaller frame size.

Sample Results

Here are some results obtained by running
audioLatencyMeasurementBasicExampleApp with different input parameters

on a Mac OS X 10.8.5 system with a 3.4 GHz Core 17 processor and 16 GB of RAM.
Measurements were made using the built in audio I/O. The audio is stereo sampled at
44.1 kHz.
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Decrease in latency on decreasing buffer size for constant frame size:

latency = audiolLatencyMeasurementBasicExampleApp(0,1024,1024,0);
Result: Latency of 43 ms

latency = audiolLatencyMeasurementBasicExampleApp(0,1024,512,0);
Result: Latency of 34 ms

latency = audiolLatencyMeasurementBasicExampleApp(0,1024,64,0);
Result: Latency of 14.3 ms

Decreasing the frame size further:

latency = audiolLatencyMeasurementBasicExampleApp(0,512,512,0);
Result: Latency of 28 ms

latency = audiolLatencyMeasurementBasicExampleApp(0,512,64,0);
Result: Latency of 13.9 ms

Running the Simulink version:

latency = audiolLatencyMeasurementBasicExampleApp(0,512,64,1);
Result: Latency of 13.9 ms

Plotting the player and recorder audio signals along with latency
measurement:

latency = audiolLatencyMeasurementBasicExampleApp(1,512,64,0);
Result: Latency of 13.9 ms.

You can also zoom into the plot to see the delay between the player and recorder
waveforms.
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Summary

This example discussed the concept of latency in audio signals and demonstrated a
way in MATLAB and Simulink to quantify latency. The example also described various
parameters that influence audio latency. Some sample results obtained on a specific
computer were presented. Note that results vary based on machine configuration. You
can follow the advice in this example and experiment with different values to find the
combination that best suits your system and application.
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Learn how to input, output and display data and signals with DSP System Toolbox.

+  “Discrete-Time Signals” on page 2-2

+ “Continuous-Time Signals” on page 2-11

+ “Create Sample-Based Signals” on page 2-12

+ “Sample-Based Row Vector Processing Changes” on page 2-17

+ “Create Frame-Based Signals” on page 2-19

+ “Create Multichannel Sample-Based Signals” on page 2-26

+ “Create Multichannel Frame-Based Signals” on page 2-32

* “Deconstruct Multichannel Sample-Based Signals” on page 2-36
+ “Deconstruct Multichannel Frame-Based Signals” on page 2-43
* “Import and Export Sample-Based Signals” on page 2-52

* “Import and Export Frame-Based Signals” on page 2-64

*  “Musical Instrument Digital Interface” on page 2-72

+ “Display Time-Domain Data” on page 2-77

+ “Display Frequency-Domain Data in Spectrum Analyzer” on page 2-93
+ “Visualize Central Limit Theorem in Array Plot” on page 2-100
* “Display Multiple Signals in the Time Scope” on page 2-105
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Discrete-Time Signals

In this section...

“Time and Frequency Terminology” on page 2-2

“Recommended Settings for Discrete-Time Simulations” on page 2-3

“Other Settings for Discrete-Time Simulations” on page 2-6

Time and Frequency Terminology

Simulink models can process both discrete-time and continuous-time signals. Models
built with DSP System Toolbox software are often intended to process discrete-time
signals only. A discrete-time signal is a sequence of values that correspond to particular
instants in time. The time instants at which the signal is defined are the signal's sample
times, and the associated signal values are the signal's samples. Traditionally, a discrete-
time signal is considered to be undefined at points in time between the sample times. For
a periodically sampled signal, the equal interval between any pair of consecutive sample
times is the signal's sample period, T,. The sample rate, F,, is the reciprocal of the sample
period, or 1/T;. The sample rate is the number of samples in the signal per second.

The 7.5-second triangle wave segment below has a sample period of 0.5 second,
and sample times of 0.0, 0.5, 1.0, 1.5, ...,7.5. The sample rate of the sequence is
therefore 1/0.5, or 2 Hz.

—*‘T, e
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A number of different terms are used to describe the characteristics of discrete-time
signals found in Simulink models. These terms, which are listed in the following table,
are frequently used to describe the way that various blocks operate on sample-based and
frame-based signals.

Term Symbol | Units Notes
Sample period T, Seconds The time interval between consecutive samples in a
T, sequence, as the input to a block (T§;) or the output
from a block (T\,).
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Term Symbol | Units Notes
TSO

Frame period Ty Seconds The time interval between consecutive frames in a
Ty sequence, as the input to a block (Tg) or the output
T from a block (Ty,).

Signal period T Seconds The time elapsed during a single repetition of a

periodic signal.

Sample frequency

Hz (samples
per second)

The number of samples per unit time, F - 1/T.

Frequency f Hz (cycles per | The number of repetitions per unit time of a periodic
second) signal or signal component, /= 1/T.

Nyquist rate Hz (cycles per | The minimum sample rate that avoids aliasing,
second) usually twice the highest frequency in the signal being

sampled.

Nyquist . Hz (cycles per |Half the Nyquist rate.

frequency second)

Normalized fn Two cycles Frequency (linear) of a periodic signal normalized to

frequency per sample half the sample rate, f, = o/m = 2f/F,.

Angular Q Radians per |Frequency of a periodic signal in angular units,

frequency second Q = 2mf.

Digital ® Radians per |Frequency (angular) of a periodic signal normalized to

(normalized sample the sample rate, ® = Q/F, = uf,.

angular)

frequency

Note In the Block Parameters dialog boxes, the term sample time is used to refer to
the sample period, T,. For example, the Sample time parameter in the Signal From
Workspace block specifies the imported signal's sample period.

Recommended Settings for Discrete-Time Simulations

Simulink allows you to select from several different simulation solver algorithms. You
can access these solver algorithms from a Simulink model:
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1 In the Simulink model window, from the Simulation menu, select Model
Configuration Parameters. The Configuration Parameters dialog box opens.

2 In the Select pane, click Solver.
The selections that you make here determine how discrete-time signals are processed
in Simulink. The recommended Solver options settings for signal processing
simulations are
Type: Fixed-step
* Solver: Discrete (no continuous states)
Fixed step size (fundamental sample time): auto

+ Tasking mode for periodic sample times: SingleTasking
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‘&4 Configuration Parameters: untitled1/Configuration (Active) = | B eS|
Category List =
Select: Simulation time
Start time: 0.0 Stop time: inf
Data Import/Export art time op time: in
4 QOptimization i
Signals and Parameters Solver options
Stateflow
» Diagnostics Type: [F|xed—step 'I Solver: [d|screte (no continuous states) =
Hard Impl tati
araviare mp ementation Fixed-step size (fundamental sample time): auto

Model Referencing
> Simulation Target
> Code Generation
> HDL Code Generation

m

Tasking and sample time options

Periodic sample time constraint: [Unconstrained ']

Tasking mode for periodic sample times: [SingIeTasking ']

[T Automatically handle rate transition for data transfer

[Z] Higher priority value indicates higher task priority

J‘ l oK ][ Cancel ][ Help ] Apply

You can automatically set the above solver options for all new models by using DSP
Simulink model templates. For more information, see “Configure the Simulink
Environment for Signal Processing Models” in the DSP System Toolbox documentation.

In Fixed-step SingleTasking mode, discrete-time signals differ from the prototype
described in “Time and Frequency Terminology” on page 2-2 by remaining defined
between sample times. For example, the representation of the discrete-time triangle
wave looks like this.
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The above signal's value at t=3.112 seconds is the same as the signal's value at =3
seconds. In Fixed-step SingleTasking mode, a signal's sample times are the
instants where the signal is allowed to change values, rather than where the signal is
defined. Between the sample times, the signal takes on the value at the previous sample
time.

As a result, in Fixed-step SingleTasking mode, Simulink permits cross-rate
operations such as the addition of two signals of different rates. This is explained further
in “Cross-Rate Operations” on page 2-7.

Other Settings for Discrete-Time Simulations

It is useful to know how the other solver options available in Simulink affect discrete-
time signals. In particular, you should be aware of the properties of discrete-time signals
under the following settings:

+ Type: Fixed-step, Mode: MultiTasking
+ Type: Variable-step (the Simulink default solver)
+ Type: Fixed-step, Mode: Auto

When the Fixed-step MultiTasking solver is selected, discrete signals in Simulink
are undefined between sample times. Simulink generates an error when operations
attempt to reference the undefined region of a signal, as, for example, when signals with
different sample rates are added.

When the Variable-step solver is selected, discrete time signals remain defined
between sample times, just as in the Fixed-step SingleTasking case described in
“Recommended Settings for Discrete-Time Simulations” on page 2-3. When the
Variable-step solver is selected, cross-rate operations are allowed by Simulink.

In the Fixed-step Auto setting, Simulink automatically selects a tasking mode, single-
tasking or multitasking, that is best suited to the model. See“Simulink Tasking Mode”
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for a description of the criteria that Simulink uses to make this decision. For the typical
model containing multiple rates, Simulink selects the multitasking mode.

Cross-Rate Operations

When the Fixed-step MultiTasking solver is selected, discrete signals in Simulink
are undefined between sample times. Therefore, to perform cross-rate operations like the
addition of two signals with different sample rates, you must convert the two signals to

a common sample rate. Several blocks in the Signal Operations and Multirate Filters
libraries can accomplish this task. See “Convert Sample and Frame Rates in Simulink”
for more information. Rate change can happen implicitly, depending on diagnostic
settings. See “Multitask rate transition”, “Single task rate transition”. However, this

is not recommended. By requiring explicit rate conversions for cross-rate operations in
discrete mode, Simulink helps you to identify sample rate conversion issues early in the
design process.

When the Variable-step solver or Fixed-step SingleTasking solver is selected,
discrete time signals remain defined between sample times. Therefore, if you sample the
signal with a rate or phase that is different from the signal's own rate and phase, you will
still measure meaningful values:

1 At the MATLAB command line, type ex_sum_tutl.

The Cross-Rate Sum Example model opens. This model sums two signals with
different sample periods.
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o
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2 Double-click the upper Signal From Workspace block. The Block Parameters:
Signal From Workspace dialog box opens.

3 Set the Sample time parameter to 1.

This creates a fast signal, (7,=1), with sample times 1, 2, 3, ...
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Double-click the lower Signal From Workspace block

Set the Sample time parameter to 2.

This creates a slow signal, (T,=2), with sample times 1, 3, 5, ...
From the Display menu choose Sample Time > Colors.
Checking the Colors option allows you to see the different sampling rates in action.

For more information about the color coding of the sample times see “View Sample
Time Information” in the Simulink documentation.

Run the model.

Note Using the DSP Simulink model templates with cross-rate operations generates
errors even though the Fixed-step SingleTasking solver is selected. This is due
to the fact that Single task rate transition is set to error in the Sample Time
pane of the Diagnostics section of the Configuration Parameters dialog box.

At the MATLAB command line, type dsp_examples_yout.

The following output is displayed:

dsp_examples_yout =
1 1

O©COOoOOUTWN

11
12
14
15

6

[y
QO VWO ~NOOUDMWN

ONUABRADPWWNNLE

The first column of the matrix is the fast signal, (75=1). The second column of the
matrix is the slow signal (75=2). The third column is the sum of the two signals.
As expected, the slow signal changes once every 2 seconds, half as often as the fast
signal. Nevertheless, the slow signal is defined at every moment because Simulink
holds the previous value of the slower signal during time instances that the block
doesn't run.
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In general, for Variable-step and Fixed-step SingleTasking modes, when you
measure the value of a discrete signal between sample times, you are observing the value
of the signal at the previous sample time.
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Continuous-Time Signals

In this section...

“Continuous-Time Source Blocks” on page 2-11

“Continuous-Time Nonsource Blocks” on page 2-11

Continuous-Time Source Blocks

Most signals in a signal processing model are discrete-time signals. However, many
blocks can also operate on and generate continuous-time signals, whose values vary
continuously with time. Source blocks are those blocks that generate or import signals
in a model. Most source blocks appear in the Sources library. The sample period for
continuous-time source blocks is set internally to zero. This indicates a continuous-time
signal. The Simulink Signal Generator and Constant blocks are examples of continuous-
time source blocks. Continuous-time signals are rendered in black when, from the
Display menu, you point to Sample Time and select Colors.

When connecting continuous-time source blocks to discrete-time blocks, you might need
to interpose a Zero-Order Hold block to discretize the signal. Specify the desired sample
period for the discrete-time signal in the Sample time parameter of the Zero-Order Hold

block.
oooo 4 4
Wrong: oo > T? ) Errar: Continuaus sample fimes
nat allowed far upsample blacks.
figna Upzamale To Wakspace
Ganaraior
uuuu
Cored: | oo g —|—|_ - TS ot
Signa Zaro-Ohdar Uprampls To Wadapacs
2 enzrator Hale

Continuous-Time Nonsource Blocks

Most nonsource blocks in DSP System Toolbox software accept continuous-time signals,
and all nonsource blocks inherit the sample period of the input. Therefore, continuous-
time inputs generate continuous-time outputs. Blocks that are not capable of accepting
continuous-time signals include the Biquad Filter, Discrete FIR Filter, FIR Decimation,
and FIR Interpolation blocks.
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Create Sample-Based Signals

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Create Signals Using Constant Block” on page 2-12

“Create Signals Using Signal from Workspace Block” on page 2-14

Create Signals Using Constant Block

A constant sample-based signal has identical successive samples. The Sources library
provides the following blocks for creating constant sample-based signals:

+ Constant

+ Identity Matrix

The most versatile of the blocks listed above is the Constant block. This topic discusses
how to create a constant sample-based signal using the Constant block:

Create a new Simulink model.

From the Sources library, click-and-drag a Constant block into the model.

From the Sinks library, click-and-drag a Display block into the model.

Connect the two blocks.

A b WN -

Double-click the Constant block, and set the block parameters as follows:

+ Constant value=[1 2 3; 4 5 6]

+ Interpret vector parameters as 1-D = Clear this check box
+ Sampling Mode = Sample based

+ Sample time =1

Based on these parameters, the Constant block outputs a constant, discrete-valued,
sample-based matrix signal with a sample period of 1 second.
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The Constant block's Constant value parameter can be any valid MATLAB
variable or expression that evaluates to a matrix.

6 Save these parameters and close the dialog box by clicking OK.
From the Display menu, point to Signals & Ports and select Signal Dimensions.

8 Run the model and expand the Display block so you can view the entire signal.

You have now successfully created a six-channel, constant sample-based signal with
a sample period of 1 second.

To view the model you just created, and to learn how to create a 1-D vector signal
from the block diagram you just constructed, continue to the next section.

Create an Unoriented Vector Signal

You can create an unoriented vector by modifying the block diagram you constructed in
the previous section:

1 To add another sample-based signal to your model, copy the block diagram you
created in the previous section and paste it below the existing sample-based signal in
your model.

2 Double-click the Constantl block, and set the block parameters as follows:

Constant value=[1 2 3 4 5 6]
+ Interpret vector parameters as 1-D = Check this box
+ Sample time =1
3 Save these parameters and close the dialog box by clicking OK.
4 Run the model and expand the Display1 block so you can view the entire signal.

Your model should now look similar to the following figure. You can also open this
model by typing ex_usingcnstblksb at the MATLAB command line.
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The Constant1 block generates a length-6 unoriented vector signal. This means that the
output is not a matrix. However, most nonsource signal processing blocks interpret a
length-M unoriented vector as an M-by-1 matrix (column vector).

Create Signals Using Signal from Workspace Block

This topic discusses how to create a four-channel sample-based signal with a sample
period of 1 second using the Signal From Workspace block:
1 Create a new Simulink model.

2 From the Sources library, click-and-drag a Signal From Workspace block into the
model.
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From the Simulink Sinks library, click-and-drag a To Workspace block into the
model.

Connect the two blocks.
Double-click the Signal From Workspace block, and set the block parameters as
follows:
+ Signal =cat(3,[1 -1;0 5],[2 -2;0 5],.[3 -3;0 5])
Sample time =1
+ Samples per frame =1

Form output after final data value by = Setting to zero

Based on these parameters, the Signal From Workspace block outputs a four-channel
sample-based signal with a sample period of 1 second. After the block has output the
signal, all subsequent outputs have a value of zero. The four channels contain the
following values:
*+ Channel 1: 1, 2, 3, 0, O,...
+ Channel 2: -1, -2, -3, 0, 0,...

Channel 3: 0, 0, 0, 0, 0,...

Channel 4: 5, 5, 5, 0, 0,...
Save these parameters and close the dialog box by clicking OK.
From the Display menu, point to Signals & Ports, and select Signal Dimensions.
Run the model.

The following figure is a graphical representation of the model's behavior during
simulation. You can also open the model by typing ex_usingsfwblksb at the
MATLAB command line.
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Creating Sample-Based Signals Using the Signal From Workspace Block
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9 At the MATLAB command line, type yout.

The following is a portion of the output:

yout(:,:,1) =
1 -1
0 5
yout(:,:,2) =
2 -2
0 5
yout(:,:,3) =
3 -3
0 5
yout(:,:,4) =
0 0
0 0

You have now successfully created a four-channel sample-based signal with sample
period of 1 second using the Signal From Workspace block.
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Sample-Based Row Vector Processing Changes

There are DSP System Toolbox blocks that handle sample-based row vector inputs in a
special way.

One category of these blocks have a Treat sample-based row input as a column
check box which allows you to explicitly specify how the block should treat sample-based
row vector inputs. Expand the following section for a full list of these blocks.

Blocks with a Check Box
* Maximum

* Mean

* Median

* Minimum

* Normalization

+ RMS

+ Standard Deviation

* Variance

In a future release these blocks will produce a warning when you provide them with a
sample-based row vector input, and eventually, their behavior will change.

You can prepare your models for the upcoming change by using slupdate. If the
function detects any blocks that have a Treat sample-based row input as a column
check box, it performs the following actions:

+ If the input to the block is a sample-based row vector, and the Treat sample-based
row input as a column check box is selected, the slupdate function places a
Transpose block in front of the affected block. The Transpose block transposes the
sample-based row vector into a column vector, which is then input into the affected
block. Transposing the input signal ensures that your model will produce the same
results in future releases.

+ If the Treat sample-based row input as a column check box is not selected, or if
the input to the block is not a sample-based row vector, function takes no action. Your
model will continue to work as expected in future releases.

If the slupdate function detects any blocks that automatically treat sample-based row
vectors as a column, it performs the following actions:
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If the input to the block is a sample-based row vector, the slupdate function places
a Transpose block in front of the affected block. The Transpose block transposes the
sample-based row vector into a column vector, which is then input into the affected
block. Transposing the input signal ensures that your model will produce the same
results in future releases.

If the input to the block is not a sample-based row vector, the slupdate function
takes no action. Your model will continue to work as expected in future releases.
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Create Frame-Based Signals

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Create Signals Using Sine Wave Block” on page 2-19

“Create Signals Using Signal from Workspace Block” on page 2-22

Create Signals Using Sine Wave Block

A frame-based signal is propagated through a model in batches of samples called frames.
Frame-based processing can significantly improve the performance of your model by
decreasing the amount of time it takes your simulation to run.

One of the most commonly used blocks in the Sources library is the Sine Wave block. This
topic describes how to create a three-channel frame-based signal using the Sine Wave
block:

Create a new Simulink model.
2 From the Sources library, click-and-drag a Sine Wave block into the model.

3 From the Matrix Operations library, click-and-drag a Matrix Sum block into the
model.

4  From the Simulink Sinks library, click-and-drag a To Workspace block into the
model.

5 Connect the blocks in the order in which you added them to your model.
6 Double-click the Sine Wave block, and set the block parameters as follows:

+ Amplitude=[1 3 2]
Frequency = [100 250 500]
Sample time = 1/5000

Samples per frame = 64
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Based on these parameters, the Sine Wave block outputs three sinusoids with
amplitudes 1, 3, and 2 and frequencies 100, 250, and 500 hertz, respectively. The
sample period, 1/5000, is 10 times the highest sinusoid frequency, which satisfies the
Nyquist criterion. The frame size is 64 for all sinusoids, and, therefore, the output
has 64 rows.

Save these parameters and close the dialog box by clicking OK.

You have now successfully created a three-channel frame-based signal using the Sine
Wave block. The rest of this procedure describes how to add these three sinusoids
together.

Double-click the Matrix Sum block. Set the Sum over parameter to Specified
dimension, and set the Dimension parameter to 2. Click OK.

From the Display menu, point to Signals & Ports, and select Signal Dimensions.
Run the model.

Your model should now look similar to the following figure. You can also open the
model by typing ex_usingsinwaveblkfb at the MATLAB command line.
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The three signals are summed point-by-point by a Matrix Sum block. Then, they are
exported to the MATLAB workspace.

11 At the MATLAB command line, type plot(yout(1:100)).

Your plot should look similar to the following figure.
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This figure represents a portion of the sum of the three sinusoids. You have now added
the channels of a three-channel frame-based signal together and displayed the results in

a figure window.

Create Signals Using Signal from Workspace Block

A frame-based signal is propagated through a model in batches of samples called frames.
Frame-based processing can significantly improve the performance of your model by
decreasing the amount of time it takes your simulation to run. This topic describes how
to create a two-channel frame-based signal with a sample period of 1 second, a frame
period of 4 seconds, and a frame size of 4 samples using the Signal From Workspace

block:
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Create a new Simulink model.

From the Sources library, click-and-drag a Signal From Workspace block into the
model.

From the Simulink Sinks library, click-and-drag a To Workspace block into the
model.

Connect the two blocks.
Double-click the Signal From Workspace block, and set the block parameters as
follows:
.+ Signal=[1:10; 11001100 1 1]"
Sample time =1
+ Samples per frame =4

* Form output after final data value by = Setting to zero

Based on these parameters, the Signal From Workspace block outputs a two-
channel, frame-based signal has a sample period of 1 second, a frame period of 4
seconds, and a frame size of four samples. After the block outputs the signal, all
subsequent outputs have a value of zero. The two channels contain the following
values:

Channel 1: 1, 2, 3,4, 5,6, 7, 8,9, 10, 0, 0,...

Channel 2:1,1,0,0,1,1,0,0,1,1,0,0,...
Save these parameters and close the dialog box by clicking OK.
From the Display menu, point to Signals & Ports, and select Signal Dimensions.

Run the model.
The following figure is a graphical representation of the model's behavior during

simulation. You can also open the model by typing ex_usingsfwblkfb at the
MATLAB command line.
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9 At the MATLAB command line, type yout.

The following is the output displayed at the MATLAB command line.

yout =

[EEY
COVWONOOUDMWNLER
ORFRPOORRPROORLR
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0 0

Note that zeros were appended to the end of each channel. You have now successfully
created a two-channel frame-based signal and exported it to the MATLAB workspace.
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In this section...

“Multichannel Sample-Based Signals” on page 2-26
“Create Multichannel Signals by Combining Single-Channel Signals” on page 2-26
“Create Multichannel Signals by Combining Multichannel Signals” on page 2-29

Multichannel Sample-Based Signals

When you want to perform the same operations on several independent signals, you can
group those signals together as a multichannel signal. For example, if you need to filter
each of four independent signals using the same direct-form II transpose filter, you can
combine the signals into a multichannel signal, and connect the signal to a single Digital
Filter Design block. The block applies the filter to each channel independently.

A sample-based signal with M*N channels is represented by a sequence of M-by-N
matrices. Multiple sample-based signals can be combined into a single multichannel
sample-based signal using the Concatenate block. In addition, several multichannel
sample-based signals can be combined into a single multichannel sample-based signal
using the same technique.

Create Multichannel Signals by Combining Single-Channel Signals

You can combine individual sample-based signals into a multichannel signal by using the
Matrix Concatenate block in the Simulink Math Operations library:

1  Open the Matrix Concatenate Example 1 model by typing

ex_cmbsnglchsbsigs

at the MATLAB command line.
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=

2 Double-click the Signal From Workspace block, and set the Signal parameter to
1:10. Click OK.

3 Double-click the Signal From Workspacel block, and set the Signal parameter to
-1:-1:-10. Click OK.
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Double-click the Signal From Workspace2 block, and set the Signal parameter to
zeros(10,1). Click OK.

Double-click the Signal From Workspace3 block, and set the Signal parameter to
5*ones(10,1). Click OK.

Double-click the Matrix Concatenate block. Set the block parameters as follows, and
then click OK:
Number of inputs =4
* Mode = Multidimensional array
Concatenate dimension = 1
Double-click the Reshape block. Set the block parameters as follows, and then click
OK:
Output dimensionality = Customize
* Output dimensions = [2,2]
Run the model.

Four independent sample-based signals are combined into a 2-by-2 multichannel
matrix signal.

Each 4-by-1 output from the Matrix Concatenate block contains one sample from
each of the four input signals at the same instant in time. The Reshape block
rearranges the samples into a 2-by-2 matrix. Each element of this matrix is a
separate channel.

Note that the Reshape block works columnwise, so that a column vector input is
reshaped as shown below.

1

) |::> |::> [1 3}
= Reshape

3 24
4

Reshape

The 4-by-1 matrix output by the Matrix Concatenate block and the 2-by-2 matrix
output by the Reshape block in the above model represent the same four-channel
sample-based signal. In some cases, one representation of the signal may be more
useful than the other.
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9 At the MATLAB command line, type dsp_examples_yout.

The four-channel, sample-based signal is displayed as a series of matrices in the
MATLAB Command Window. Note that the last matrix contains only zeros. This
is because every Signal From Workspace block in this model has its Form output
after final data value by parameter set to Setting to Zero.

Create Multichannel Signals by Combining Multichannel Signals

You can combine existing multichannel sample-based signals into larger multichannel
signals using the Simulink Matrix Concatenate block:

1  Open the Matrix Concatenate Example 2 model by typing

ex_cmbmltichsbsigs

at the MATLAB command line.
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s
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2 Double-click the Signal From Workspace block, and set the Signal parameter to
[1:10;-1:-1:-10]". Click OK.
3 Double-click the Signal From Workspacel block, and set the Signal parameter to

[zeros(10,1) 5*ones(10,1)]. Click OK.
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Double-click the Matrix Concatenate block. Set the block parameters as follows, and
then click OK:
Number of inputs = 2
Mode = Multidimensional array
+ Concatenate dimension =1
Run the model.

The model combines both two-channel sample-based signals into a four-channel
signal.

Each 2-by-2 output from the Matrix Concatenate block contains both samples from
each of the two input signals at the same instant in time. Each element of this
matrix is a separate channel.
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Create Multichannel Frame-Based Signals

In this section...

“Multichannel Frame-Based Signals” on page 2-32

“Create Multichannel Signals Using Concatenate Block” on page 2-32

Multichannel Frame-Based Signals

When you want to perform the same operations on several independent signals, you can
group those signals together as a multichannel signal. For example, if you need to filter
each of four independent signals using the same direct-form II transpose filter, you can
combine the signals into a multichannel signal, and connect the signal to a single Digital
Filter Design block. The block applies the filter to each channel independently.

A frame-based signal with N channels and frame size M is represented by a sequence of
M-by-N matrices. Multiple individual frame-based signals, with the same frame rate and
size, can be combined into a multichannel frame-based signal using the Simulink Matrix
Concatenate block. Individual signals can be added to an existing multichannel signal in
the same way.

1 1 1 1

2 2 2 2

3 3 3 3

4 4 4 4

£+l 5 il 5

G ] (5] G
e L

sinl sipf sigd sipd

Four frame -hased signals: Multichannel frame-hased signal:
1 thannel eoch, 4 thunne s,
b somples per frome b samples par frame

Create Multichannel Signals Using Concatenate Block

You can combine existing frame-based signals into a larger multichannel signal by
using the Simulink Concatenate block. All signals must have the same frame rate and
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frame size. In this example, a single-channel frame-based signal is combined with a two-
channel frame-based signal to produce a three-channel frame-based signal:

1  Open the Matrix Concatenate Example 3 model by typing
ex_combiningfbsigs

at the MATLAB command line.
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2 Double-click the Signal From Workspace block. Set the block parameters as follows:

+ Signal=[1:10;-1:-1:-10]"

+ Sample time =1
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+ Samples per frame =4

Based on these parameters, the Signal From Workspace block outputs a frame-based
signal with a frame size of four.

Save these parameters and close the dialog box by clicking OK.
Double-click the Signal From Workspacel block. Set the block parameters as follows,
and then click OK:
+ Signal = 5*ones(10,1)
Sample time = 1
Samples per frame =4
The Signal From Workspacel block has the same sample time and frame size as
the Signal From Workspace block. When you combine frame-based signals into

multichannel signals, the original signals must have the same frame rate and frame
size.

Double-click the Matrix Concatenate block. Set the block parameters as follows, and
then click OK:
* Number of inputs = 2
Mode = Multidimensional array
+ Concatenate dimension = 2
Run the model.

The 4-by-3 matrix output from the Matrix Concatenate block contains all three input
channels, and preserves their common frame rate and frame size.
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Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Split Multichannel Signals into Individual Signals” on page 2-36
“Split Multichannel Signals into Several Multichannel Signals” on page 2-39

Split Multichannel Signals into Individual Signals

Multichannel signals, represented by matrices in the Simulink environment, are
frequently used in signal processing models for efficiency and compactness. Though
most of the signal processing blocks can process multichannel signals, you may need
to access just one channel or a particular range of samples in a multichannel signal.
You can access individual channels of the multichannel signal by using the blocks in
the Indexing library. This library includes the Selector, Submatrix, Variable Selector,
Multiport Selector, and Submatrix blocks.

You can split a multichannel sample-based signal into single-channel sample-based
signals using the Multiport Selector block. This block allows you to select specific rows
and/or columns and propagate the selection to a chosen output port. In this example, a
three-channel sample-based signal is deconstructed into three independent sample-based
signals:

1  Open the Multiport Selector Example 1 model by typing
ex_splitmltichsbsigsind at the MATLAB command line.
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2 Double-click the Signal From Workspace block, and set the block parameters as
follows:

+ Signal = randn(3,1,10)

+ Sample time =1
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+ Samples per frame =1

Based on these parameters, the Signal From Workspace block outputs a three-
channel, sample-based signal with a sample period of 1 second.

Save these parameters and close the dialog box by clicking OK.
Double-click the Multiport Selector block. Set the block parameters as follows, and
then click OK:
+ Select = Rows
Indices to output = {1,2,3}

Based on these parameters, the Multiport Selector block extracts the rows of the
input. The Indices to output parameter setting specifies that row 1 of the input
should be reproduced at output 1, row 2 of the input should be reproduced at
output 2, and row 3 of the input should be reproduced at output 3.

Run the model.
At the MATLAB command line, type dsp_examples_yout.
The following is a portion of what is displayed at the MATLAB command line.

Because the input signal is random, your output might be different than the output
show here.

dsp_examples_yout(:,:,1)

-0.1199

dsp_examples_yout(:,:,2)

-0.5955

dsp_examples_yout(:,:,3)
-0.0793

This sample-based signal is the first row of the input to the Multiport Selector
block. You can view the other two input rows by typing dsp_examples_youtl and
dsp_examples_yout2, respectively.

You have now successfully created three, single-channel sample-based signals from a
multichannel sample-based signal using a Multiport Selector block.
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Split Multichannel Signals into Several Multichannel Signals

Multichannel signals, represented by matrices in the Simulink environment, are
frequently used in signal processing models for efficiency and compactness. Though
most of the signal processing blocks can process multichannel signals, you may need
to access just one channel or a particular range of samples in a multichannel signal.
You can access individual channels of the multichannel signal by using the blocks in
the Indexing library. This library includes the Selector, Submatrix, Variable Selector,
Multiport Selector, and Submatrix blocks.

You can split a multichannel sample-based signal into other multichannel sample-based
signals using the Submatrix block. The Submatrix block is the most versatile of the
blocks in the Indexing library because it allows arbitrary channel selections. Therefore,
you can extract a portion of a multichannel sample-based signal. In this example, you
extract a six-channel, sample-based signal from a 35-channel, sample-based signal (5-
by-7 matrix):

1  Open the Submatrix Example model by typing ex_splitmltichsbsigsev at the
MATLAB command line.
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2 Double-click the Constant block, and set the block parameters as follows:

* Constant value = rand(5,7)

* Interpret vector parameters as 1-D = Clear this check box

+ Sampling mode = Sample based

+ Sample Time =1
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Based on these parameters, the Constant block outputs a constant-valued, sample-
based signal.

Save these parameters and close the dialog box by clicking OK.
Double-click the Submatrix block. Set the block parameters as follows, and then click
OK:
- Row span = Range of rows
+ Starting row = Index
+ Starting row index =3
Ending row = Last
+ Column span = Range of columns
Starting column = Offset from last
+ Starting column offset = 1
Ending column = Last
Based on these parameters, the Submatrix block outputs rows three to five, the last

row of the input signal. It also outputs the second to last column and the last column
of the input signal.

Run the model.

The model should now look similar to the following figure.
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Notice that the output of the Submatrix block is equivalent to the matrix created by
rows three through five and columns six through seven of the input matrix.

You have now successfully created a six-channel, sample-based signal from a 35-channel
sample-based signal using a Submatrix block.
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Deconstruct Multichannel Frame-Based Signals

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Split Multichannel Signals into Individual Signals” on page 2-43

“Reorder Channels in Multichannel Frame-Based Signals” on page 2-48

Split Multichannel Signals into Individual Signals

Multichannel signals, represented by matrices in the Simulink environment, are
frequently used in signal processing models for efficiency and compactness. Though
most of the signal processing blocks can process multichannel signals, you may need

to access just one channel or a particular range of samples in a multichannel signal.
You can access individual channels of the multichannel signal by using the blocks in
the Indexing library. This library includes the Selector, Submatrix, Variable Selector,
Multiport Selector, and Submatrix blocks. It is also possible to use the Permute Matrix
block, in the Matrix operations library, to reorder the channels of a frame-based signal.

You can use the Multiport Selector block in the Indexing library to extract the individual
channels of a multichannel frame-based signal. These signals form single-channel frame-

based signals that have the same frame rate and size of the multichannel signal.

The figure below is a graphical representation of this process.
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In this example, you use the Multiport Selector block to extract a single-channel and a
two channel frame-based signal from a multichannel frame-based signal:

1 Open the Multiport Selector Example 2 model by typing
ex_splitmltichfbsigsind

at the MATLAB command line.



Deconstruct Multichannel Frame-Based Signals
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2 Double-click the Signal From Workspace block, and set the block parameters as

follows:

+ Signal=[1:10;-1:-1:-10;5*ones(1,10)]"
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+ Samples per frame =4

Based on these parameters, the Signal From Workspace block outputs a three-
channel, frame-based signal with a frame size of four.

Save these parameters and close the dialog box by clicking OK.

Double-click the Multiport Selector block. Set the block parameters as follows, and
then click OK:

* Select = Columns
Indices to output = {[1 37,2}

Based on these parameters, the Multiport Selector block outputs the first and third
columns at the first output port and the second column at the second output port of
the block. Setting the Select parameter to Columns ensures that the block preserves
the frame rate and frame size of the input.

Run the model.
The figure below is a graphical representation of how the Multiport Selector block

splits one frame of the three-channel frame-based signal into a single-channel signal
and a two-channel signal.
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The Multiport Selector block outputs a two-channel frame-based signal, comprised of the
first and third column of the input signal, at the first port. It outputs a single-channel
frame-based signal, comprised of the second column of the input signal, at the second
port.

You have now successfully created a single-channel and a two-channel frame-based
signal from a multichannel frame-based signal using the Multiport Selector block.
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Reorder Channels in Multichannel Frame-Based Signals

Multichannel signals, represented by matrices in Simulink, are frequently used in signal
processing models for efficiency and compactness. Though most of the signal processing
blocks can process multichannel signals, you may need to access just one channel or a
particular range of samples in a multichannel signal. You can access individual channels
of the multichannel signal by using the blocks in the Indexing library. This library
includes the Selector, Submatrix, Variable Selector, Multiport Selector, and Submatrix
blocks. It is also possible to use the Permute Matrix block, in the Matrix operations
library, to reorder the channels of a frame-based signal.

Some DSP System Toolbox blocks have the ability to process the interaction of channels.
Typically, DSP System Toolbox blocks compare channel one of signal A to channel one
of signal B. However, you might want to correlate channel one of signal A with channel
three of signal B. In this case, in order to compare the correct signals, you need to use
the Permute Matrix block to rearrange the channels of your frame-based signals. This
example explains how to accomplish this task:

1  Open the Permute Matrix Example model by typing ex_reordermltichfbsigs at
the MATLAB command line.
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2 Double-click the Signal From Workspace block, and set the block parameters as

follows:

+ Signal=[1:10;-1:-1:-10;5*ones(1,10)]"

+ Sample time =1

+ Samples per frame =

4
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Based on these parameters, the Signal From Workspace block outputs a three-
channel, frame-based signal with a sample period of 1 second and a frame size of 4.
The frame period of this block is 4 seconds.

Save these parameters and close the dialog box by clicking OK.
Double-click the Constant block. Set the block parameters as follows, and then click
OK:
+ Constant value =[1 3 2]
+ Interpret vector parameters as 1-D = Clear this check box
Sampling mode = Frame based
* Frame period =4
The discrete-time, frame-based vector output by the Constant block tells the
Permute Matrix block to swap the second and third columns of the input signal.

Note that the frame period of the Constant block must match the frame period of the
Signal From Workspace block.

Double-click the Permute Matrix block. Set the block parameters as follows, and
then click OK:
* Permute = Columns

Index mode = One-based

Based on these parameters, the Permute Matrix block rearranges the columns of the
input signal, and the index of the first column is now one.

Run the model.

The figure below is a graphical representation of what happens to the first input
frame during simulation.
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The second and third channel of the frame-based input signal are swapped.

7 At the MATLAB command line, type yout.

You can now verify that the second and third columns of the input signal are

rearranged.

You have now successfully reordered the channels of a frame-based signal using the
Permute Matrix block.
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Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Import Sample-Based Vector Signals” on page 2-52
“Import Sample-Based Matrix Signals” on page 2-55

“Export Sample-Based Signals” on page 2-59

Import Sample-Based Vector Signals

The Signal From Workspace block generates a sample-based vector signal when the
variable or expression in the Signal parameter is a matrix and the Samples per frame
parameter is set to 1. Each column of the input matrix represents a different channel.
Beginning with the first row of the matrix, the block outputs one row of the matrix at
each sample time. Therefore, if the Signal parameter specifies an M-by-N matrix, the
output of the Signal From Workspace block is M 1-by-N row vectors representing N
channels.

The figure below is a graphical representation of this process for a 6-by-4 workspace
matrix, A.
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In the following example, you use the Signal From Workspace block to import a sample-
based vector signal into your model:

1  Open the Signal From Workspace Example 3 model by typing
ex_importsbvectorsigs at the MATLAB command line.
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3 eximporsbectorsig E=SER
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from works pace matric "dsp_eesmples_A" and one channel from
— works pace column vector "dsp_ssamples B
[dsp_examples_Adsp_examples B] p| dsp_examples_yout
Signal From To Workspace
‘Workspace
Mote: This model oreated works pace varisbles called "dsp_sxamples _A" "dsp_scamples_B" and "dsp_sxemples_yout”
‘Warigbles will be cleared when the modelis closed.
»

2 At the MATLAB command line, type A = [1:100;-1:-1:-100]";

The matrix A represents a two column signal, where each column is a different
channel.

3 At the MATLAB command line, type B = 5*ones(100,1);

The vector B represents a single-channel signal.

4  Double-click the Signal From Workspace block, and set the block parameters as
follows:

+ Signal = [A B]

+ Sample time =1
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+ Samples per frame =1
Form output after final data value = Setting to zero

The Signal expression [A B] uses the standard MATLAB syntax for horizontally
concatenating matrices and appends column vector B to the right of matrix A. The
Signal From Workspace block outputs a sample-based signal with a sample period of
1 second. After the block has output the signal, all subsequent outputs have a value
of zero.

5 Save these parameters and close the dialog box by clicking OK.
6 Run the model.

The following figure is a graphical representation of the model's behavior during

simulation.

mel H=El 4 4 5)— (a3 -3 5]—[2 -2 5]—[1 -1 5] —m| yeut
Signal Fram t=3 t=1 t=1 t=0 To Wokspace
Waksp ace

Four comse cutive som ples from o
3-thunnel somple-bosed signal

The first row of the input matrix [A B] is output at time t=0, the second row of the
input matrix is output at time t=1, and so on.

You have now successfully imported a sample-based vector signal into your signal
processing model using the Signal From Workspace block.

Import Sample-Based Matrix Signals

The Signal From Workspace block generates a sample-based matrix signal when the
variable or expression in the Signal parameter is a three-dimensional array and the
Samples per frame parameter is set to 1. Beginning with the first page of the array,
the block outputs a single page of the array to the output at each sample time. Therefore,
if the Signal parameter specifies an M-by-N-by-P array, the output of the Signal From
Workspace block is P M-by-N matrices representing M*N channels.

The following figure is a graphical illustration of this process for a 6-by-4-by-5 workspace
array A.
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In the following example, you use the Signal From Workspace block to import a four-
channel, sample-based matrix signal into a Simulink model:

1  Open the Signal From Workspace Example 4 model by typing
ex_importsbmatrixsigs at the MATLAB command line.
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d=p_sxamples_sigl dsp_examples_sig2
d=p_sxamples_sigl dsp_sxamples_sigs
d=p_sxamples_sigl2” “dsp_sxamples_sig3s
Variables will be cleared when the model s closed.
»

Also, the following variables are loaded into the MATLAB workspace:

Fs 1x1 8 double array
dsp_examples A 2x2x100 3200 double array
dsp_examples_sigl 1x1x100 800 double array
dsp_examples_sigl2 1x2x100 1600 double array
dsp_examples_sig2 1x1x100 800 double array
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dsp_examples_sig3 1x1x100 800 double array
dsp_examples_sig34 1x2x100 1600 double array
dsp_examples_sig4 1x1x100 800 double array
mtlb 4001x1 32008 double array

2 Double-click the Signal From Workspace block. Set the block parameters as follows,
and then click OK:

Signal = dsp_examples_A
+ Sample time =1
Samples per frame = 1

* Form output after final data value = Setting to zero

The dsp_examples_A array represents a four-channel, sample-based signal with
100 samples in each channel. This is the signal that you want to import, and it was
created in the following way:

dsp_examples_sigl = reshape(1:100,[1 1 100])
dsp_examples_sig2 = reshape(-1:-1:-100,[1 1 100])
dsp_examples_sig3 = zeros(1,1,100)

dsp_examples_sig4 = 5*ones(1,1,100)

dsp_examples_sigl2 = cat(2,sigl,sig2)

dsp_examples_sig34 = cat(2,sig3,sig4)

dsp_examples_A = cat(l,sigl2,sig34) % 2-by-2-by-100 array

3 Run the model.

The figure below is a graphical representation of the model's behavior during
simulation.
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The Signal From Workspace block imports the four-channel sample based signal
from the MATLAB workspace into the Simulink model one matrix at a time.

You have now successfully imported a sample-based matrix signal into your model using
the Signal From Workspace block.

Export Sample-Based Signals

The To Workspace and Triggered To Workspace blocks are the primary blocks for
exporting signals of all dimensions from a Simulink model to the MATLAB workspace.

A sample-based signal, with M*N channels, is represented in Simulink as a sequence of
M-by-N matrices. When the input to the To Workspace block is a sample-based signal,
the block creates an M-by-N-by-P array in the MATLAB workspace containing the P
most recent samples from each channel. The number of pages, P, is specified by the
Limit data points to last parameter. The newest samples are added at the end of the
array.

The following figure is the graphical illustration of this process using a 6-by-4 sample-
based signal exported to workspace array A.
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Sample-based matrix signal: MATLAB workspace array, A:
&-by-4 |24 channels) 6-bry-3-by-P (24 channels, P = 5)

The workspace array always has time running along its third dimension, P. Samples
are saved along the P dimension whether the input is a matrix, vector, or scalar (single
channel case).

In the following example you use a To Workspace block to export a sample-based matrix
signal to the MATLAB workspace:

1  Open the Signal From Workspace Example 6 model by typing ex_exportsbsigs at
the MATLAB command line.
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Also, the following variables are loaded into the MATLAB workspace:

dsp_examples_A 2x2x100 3200 double array
dsp_examples_sigl 1x1x100 800 double array
dsp_examples_sigl2 1x2x100 1600 double array
dsp_examples_sig2 1x1x100 800 double array
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dsp_examples_sig3 1x1x100 800 double array
dsp_examples_sig34  1x2x100 1600 double array
dsp_examples_sig4 1x1x100 800 double array

In this model, the Signal From Workspace block imports a four-channel sample-
based signal called dsp_examples_A. This signal is then exported to the MATLAB
workspace using a To Workspace block.

Double-click the Signal From Workspace block. Set the block parameters as follows,
and then click OK:

+ Signal =dsp_examples_A
+ Sample time =1
Samples per frame = 1
Form output after final data value = Setting to zero
Based on these parameters, the Signal From Workspace block outputs a sample-

based signal with a sample period of 1 second. After the block has output the signal,
all subsequent outputs have a value of zero.

Double-click the To Workspace block. Set the block parameters as follows, and then
click OK:

* Variable name = dsp_examples_yout

+ Limit data points to last parameter to inf

* Decimation=1

Based on these parameters, the To Workspace block exports its sample-based input
signal to a variable called dsp_examples_yout in the MATLAB workspace. The

workspace variable can grow indefinitely large in order to capture all of the input
data. The signal is not decimated before it is exported to the MATLAB workspace.

Run the model.
At the MATLAB command line, type dsp_examples_yout.

The four-channel sample-based signal, dsp_examples_A, is output at the MATLAB
command line. The following is a portion of the output that is displayed.

dsp_examples_yout(:,:,1) =

1 -1
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0 5

dsp_examples_yout(:,:,2)

2 -2
0 5

dsp_examples_yout(:,:,3)

3 -3
0 5

dsp_examples_yout(:,:,4)

4 -4
0 5

Each page of the output represents a different sample time, and each element of the
matrices is in a separate channel.

You have now successfully exported a four-channel sample-based signal from a Simulink
model to the MATLAB workspace using the To Workspace block.
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Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Import Frame-Based Signals” on page 2-64

“Export Frame-Based Signals” on page 2-67

Import Frame-Based Signals

The Signal From Workspace block creates a frame-based multichannel signal when the
Signal parameter is a matrix, and the Samples per frame parameter, M, is greater
than 1. Beginning with the first M rows of the matrix, the block releases M rows of the
matrix (that is, one frame from each channel) to the output port every M*T, seconds.
Therefore, if the Signal parameter specifies a W-by-N workspace matrix, the Signal
From Workspace block outputs a series of M-by-N matrices representing N channels.
The workspace matrix must be oriented so that its columns represent the channels of the
signal.

The figure below is a graphical illustration of this process for a 6-by-4 workspace
matrix, A, and a frame size of 2.
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Note: Although independent channels are generally represented as columns, a single-
channel signal can be represented in the workspace as either a column vector or row
vector. The output from the Signal From Workspace block is a column vector in both

cases.

In the following example, you use the Signal From Workspace block to create a three-
channel frame-based signal and import it into the model:

1  Open the Signal From Workspace Example 5 model by typing
ex_importfbsigs
at the MATLAB command line.

[1:100;-1:-1:-100]"; % 100-by-2 matrix
5*ones(100,1); % 100-by-1 column vector

dsp_examples_A
dsp_examples_B

The variable called dsp_examples_A represents a two-channel signal with 100
samples, and the variable called dsp_examples_B represents a one-channel signal
with 100 samples.

Also, the following variables are defined in the MATLAB workspace:
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Mote: This model oreates workspace varisbles called "dsp_sx@amgples _A°, "dsp_examples B, and "dsp_sxamples yout™.
Variables will be cleared when the model & closed.
»

2 Double-click the Signal From Workspace block. Set the block parameters as follows,
and then click OK:
+ Signal parameter to [dsp_examples_A dsp_examples_B]
+ Sample time parameter to 1
+ Samples per frame parameter to 4
* Form output after final data value parameter to Setting to zero
Based on these parameters, the Signal From Workspace block outputs a frame-based
signal with a frame size of 4 and a sample period of 1 second. The signal's frame

period is 4 seconds. The Signal parameter uses the standard MATLAB syntax for
horizontally concatenating matrices to append column vector dsp_examples_B
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to the right of matrix dsp_examples_A. After the block has output the signal, all
subsequent outputs have a value of zero.

3 Run the model.

The figure below is a graphical representation of how your three-channel, frame-
based signal is imported into your model.

" In this example, the Signal From Waokspace blodk impaorts
|S|gnal From workspace Example 5 I a three-channel frame-bazed signal comprising twe channels
from wortkspace matrix"dsp_examples_A&" and one channel from
wofspace column wector "dsp_examples_B".

9 -9 3 5353 1-135
— = 2-25
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11-115 T-T75 3-35
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Mote: This model creates wodspace variables called "dsp_examples_ A", "dsp_examples_B", and "dsp_examples_yout".

You have now successfully imported a three-channel frame-based signal into your model
using the Signal From Workspace block.

Export Frame-Based Signals

The To Workspace and Triggered To Workspace blocks are the primary blocks for
exporting signals of all dimensions from a Simulink model to the MATLAB workspace.

A frame-based signal with N channels and frame size M is represented by a sequence

of M-by-N matrices. When the input to the To Workspace block is a frame-based signal,
the block creates a P-by-IN array in the MATLAB workspace containing the P most
recent samples from each channel. The number of rows, P, is specified by the Limit data
points to last parameter. The newest samples are added at the bottom of the matrix.

The following figure is a graphical illustration of this process for three consecutive

frames of a frame-based signal with a frame size of 2 that is exported to matrix A in the
MATLAB workspace.
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In the following example, you use a To Workspace block to export a frame-based signal to
the MATLAB workspace:

1  Open the Signal From Workspace Example 7 model by typing ex_exportfbsigs at
the MATLAB command line.
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Note: This model creates workspace variables called "dsp_examples_A" "dsp_examples B”, and "dsp_examples_yout”.
“ariables will be cleared when the model is closed.

Also, the following variables are defined in the MATLAB workspace:

The variable called dsp_examples_A represents a two-channel signal with 100
samples, and the variable called dsp_examples_B represents a one-channel signal
with 100 samples.

dsp_examples_A = [1:100;-1:-1:-100]"; % 100-by-2 matrix

dsp_examples_B = 5*ones(100,1); % 100-by-1 column vector

Double-click the Signal From Workspace block. Set the block parameters as follows,
and then click OK:

+ Signal = [dsp_examples_A dsp_examples_B]

+ Sample time =1
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+ Samples per frame =4

Form output after final data value = Setting to zero

Based on these parameters, the Signal From Workspace block outputs a frame-based
signal with a frame size of 4 and a sample period of 1 second. The signal's frame
period is 4 seconds. The Signal parameter uses the standard MATLAB syntax for
horizontally concatenating matrices to append column vector dsp_examples_B

to the right of matrix dsp_examples_A. After the block has output the signal, all
subsequent outputs have a value of zero.

Double-click the To Workspace block. Set the block parameters as follows, and then
click OK:

* Variable name = dsp_examples_yout
+ Limit data points to last = inf
* Decimation=1

+ Frames = Concatenate frames (2-D array)

Based on these parameters, the To Workspace block exports its frame-based input
signal to a variable called dsp_examples_yout in the MATLAB workspace. The
workspace variable can grow indefinitely large in order to capture all of the input
data. The signal is not decimated before it is exported to the MATLAB workspace,
and each input frame is vertically concatenated to the previous frame to produce a 2-
D array output.

Run the model.

The following figure is a graphical representation of the model's behavior during
simulation.
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Mote: Thizs madel creates wotspace wariables called "dsp_examples_&", "dsp_examples_B", and "dsp_examples_yout'.

5 At the MATLAB command line, type dsp_examples_yout.

The output is shown below:

dsp_examples_yout =

-1
-2
-3
-4
-5
-6
-7
-8
-9
10 -10
11 -11
12 -12

O©CO~NOUA WNE
aoooooooo oo

The frames of the signal are concatenated to form a two-dimensional array.

You have now successfully output a frame-based signal to the MATLAB workspace using
the To Workspace block.
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In this section...

“About MIDI” on page 2-72
“MIDI Control Surfaces” on page 2-72
“Using MIDI Control Surfaces with MATLAB and Simulink” on page 2-73

About MIDI

The Musical Instrument Digital Interface (MIDI) was originally developed to
interconnect electronic musical instruments. This interface is very flexible and has many
uses in many applications far beyond musical instruments. Its simple unidirectional
messaging protocol supports many different kinds of messaging.

Windows, Macintosh, and Linux platforms all have native support for MIDI, so software
on any of these platforms can send and receive MIDI messages. See http://www.midi.org
for more information about MIDI.

MIDI Control Surfaces

One kind of MIDI message is the Control Change message, used to communicate changes
in controls, such as knobs, sliders, and buttons. A MIDI Control Surface is a device

with controls that sends MIDI Control Change messages when you turn a knob, move

a slider, or push a button on a MIDI control surface. This Control Change message
indicates which control changed and what its new position is. MIDI control surfaces are
quite generic because the interpretation of the Control Change message is entirely up

to the message recipient. Even though some control surfaces are tailored for particular
applications, the messages they send can be used to control anything.

Hardware MIDI control surfaces are widely available in a range of configurations and

prices. MIDI control apps can turn a smartphone or tablet into a virtual MIDI control

surface. For custom applications, MIDI control surfaces are not difficult to build using,
for example, Arduino boards.

Because the MIDI messaging protocol is unidirectional, determining a particular
control’s position requires that the receiver listen for Control Change messages that
control sends. The protocol does not support querying the control for its position.


http://www.midi.org
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The simplest MIDI control surfaces are unidirectional; they end MIDI Control Change
messages, but do not receive them. More sophisticated control surfaces are bidirectional:
They can both send and receive Control Change messages. These control surfaces have
knobs or sliders that can be operated automatically. For example, a control surface can
have sliders or knobs that are motorized. When it receives a Control Change message,
the appropriate control is moved to the position in the message. You can use this feature
to synchronize software GUI with MIDI control surface. For example, moving a slider on
the MIDI control surface sends a Control Change message to a GUI slider, which then
moves to match the control surface. Similarly, moving the GUI slider sends a Control
Change message to the MIDI control surface, which then moves to match the GUI slider.

Using MIDI Control Surfaces with MATLAB and Simulink

The DSP System Toolbox product enables you to use MIDI control surfaces to control
MATLAB programs and Simulink models by providing the capability to listen to Control
Change messages. The toolbox also provides a limited capability to send Control Change
messages to support synchronizing MIDI controls. The DSP System Toolbox interface to
MIDI control surfaces includes five functions and one block:

* midiid function

+ midicontrols function
+ midiread function

+ midisync function

+ midicallback function
* MIDI Controls block

Initial Setup

Your MIDI control surface should be connected to your computer, and turned on, before
starting MATLAB. Instructions for connecting your MIDI device to your computer vary
from device to device. See the instructions that came with your particular device. If you
start MATLAB before connecting your device, MATLAB may not recognize your device
when you connect it. To correct the problem, restart MATLAB with the device already
connected.

Next, set the MATLAB preference, specifying the name of the default MIDI device.
Use midiid to determine the name of the device, and then use setpref to set the
preference:
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>> [control, device] = midiid
Move the control you wish to identify; type ~C to abort.
Waiting for control message... done
control =
1082
device =
BCF2000
>> setpref("midi®, "DefaultDevice®, device)
>>

This preference persists across MATLAB sessions, so you only have to set it once, unless
you want to change devices.

If you do not set this preference, MATLAB and the host operating system choose a device
for you. However, such autoselection can cause unpredictable results because many
computers have “virtual” (software) MIDI devices installed that you may not be aware of.
For predictable behavior, you should set the preference.

You can always override this default and explicitly specify a device name. Thus, you can
use multiple MIDI devices simultaneously.

Identifying Controls

Before you can connect a MIDI control with MATLAB or Simulink, you must know the
identifiers for that particular control:

*  Control number

* Device name

The control number is a fixed integer assigned by the device manufacturer. Some devices
may change the assigned number based on various modes, or you can reprogram the
number. The device name is determined by the manufacturer and the host operating
system. You use midiid to determine both.

You do not usually have to use midi id repeatedly. If you use a single device in most
cases, then specify that device as the default hardware. the You can save the control
numbers in a function, a .mat file, or whatever form you find convenient. This example
shows a function returning a struct with all the control numbers for a Behringer
BCF2000:

function ctls = BCF2000
% BCF2000 return MIDI control number assignments
% for Behringer BCF2000 MIDI control surface
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ctls.knobs = 1001:1008;
ctls.buttons [1065:1072;1073:1080] ;
ctls.sliders 1081:1088;

end
MATLAB Interface

To use the MATLAB interface functions, first call midicontrols to specify any devices
or controls to listen to. midicontrols returns an object, which you pass to the other
functions for subsequent operations. You can now read the values of the specified MIDI
controls by calling midiread with that object. MATLAB can respond to changes in MIDI
controls by periodically calling midiread.

You can also set a callback on the specified MIDI controls by calling midical Iback with
that object and a function handle. The next time the MIDI controls change value, the
function handle is invoked and passed to the object. The callback function typically calls
midiread to determine the new value of the MIDI controls. You can use this callback
when you want a MIDI control to trigger an action (such as update a GUI). Using this
approach prevents having a continuously running MATLAB program in the command
window.

Synchronization

If midiread is called before the MIDI control sends a Control Change message, the
midicontrols object has no information about the actual state of the MIDI control.
During this time, the midicontrols object and the actual MIDI control are out of sync
with each other. Thus, calling midiread returns the initial value that was specified in
the call to midicontrols (0 by default). You can synchronize the object with the control
by moving the MIDI control. The MIDI control responds by sending a Control Change
message causing the midicontrols object to sync to the MIDI control. If your MIDI
control surface is bidirectional, you can sync in the other direction by calling midisync
to send the midicontrols object’s initial value to the actual MIDI control. The MIDI
control responds by moving into sync with the midicontrols object.

It is generally harmless to call midisync even if the MIDI control surface is not
bidirectional, so it is usually good practice to call midisync immediately after calling
midicontrols.

Synchronization is also useful to link a MIDI control with a GUI control (a uicontrol
slider, for example), so that when one control is changed, the other control tracks it.
Typically, you implement such tracking by setting callback functions on both the MIDI
control (using midical Iback) and the GUI control. The MIDI control callback sends its
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new value to the GUI control and the GUI control sends its value to the MIDI control,
using midisync.

Simulink Interface

The MIDI Controls block provides the Simulink interface. See the block reference page
MIDI Controls for more details.
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Display Time-Domain Data

In this section...

“Use the Simulation Controls” on page 2-83
“Modify the Time Scope Display” on page 2-84

“Manage Multiple Time Scopes” on page 2-89

“Configure the Time Scope Properties” on page 2-78

“Inspect Your Data (Scaling the Axes and Zooming)” on page 2-86

The following tutorial shows you how to configure the Time Scope blocks in the
ex_timescope_tut model to display time-domain signals. To get started with this

tutorial, open the model by typing

ex_timescope_tut
at the MATLAB command line.

1 ex_timescope_tut [F=% B8~
File Edit View Display Diagram Simulation Analysis Code Tools Help
= 4] = bii
= -8 He-E-40p 2 @ - @t
ex_timescope_tut
®
@)
El - Digital -
" Filter "
N ]
Source Digital Filter - Highpass Dini
l gital el
Filter "
Time
lJ—LIDSF' Digital Filter - Lowpass Scope
»
Sine Wave
Add I—‘
L
Tme
Copyright 20092012 The MathiWorks, Inc. Scopel
»
Ready 100% FixedStepDiscrete
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Use the following workflow to configure the Time Scope blocks in the
ex_timescope_tut model:

“Configure the Time Scope Properties” on page 2-78
“Use the Simulation Controls” on page 2-83

“Inspect Your Data (Scaling the Axes and Zooming)” on page 2-86

1

2

3 “Modify the Time Scope Display” on page 2-84
4

5 “Manage Multiple Time Scopes” on page 2-89

Configure the Time Scope Properties

The Configuration Properties dialog box provides a central location from which you can

change the appearance and behavior of the Time Scope block. To open the Configuration
Properties dialog box, you must first open the Time Scope window by double-clicking the
Time Scope block in your model. When the window opens, select View > Configuration
Properties. Alternatively, in the Time Scope toolbar, click the Configuration Properties

{@ button.

P

-

4 Configuration Properties: Time Scope @

Main | Time | Display | Logging

Open at simulation start
["] Display the full path

Mumber of input ports: 1

Sample time: -1

Input processing: [Cnlumns as channels (frame based) T]

Maximize axes: [Auto *]

Axes scaling: [Manual T] Configure ...
J [ oK ] [ Cancel ] Apply
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The Configuration Properties dialog box has four different tabs, Main, Time, Display,
and Logging, each of which offers you a different set of options. For more information
about the options available on each of the tabs, see the Time Scope block reference page.

Note: As you progress through this workflow, notice the blue question mark icon ( J )
in the lower-left corner of the subsequent dialog boxes. This icon indicates that context-
sensitive help is available. You can get more information about any of the parameters on
the dialog box by right-clicking the parameter name and selecting What's This?

Configure Appearance and Specify Signal Interpretation

First, you configure the appearance of the Time Scope window and specify how the Time
Scope block should interpret input signals. In the Configuration Properties dialog box,
click the Main tab. Choose the appropriate parameter settings for the Main tab, as
shown in the following table.

Parameter Setting

Open at Checked
simulation start

Number of input |2
ports

Input Columns as channels (frame based)
processing

Maximize axes |Auto

Axes scaling Manual

In this tutorial, you want the block to treat the input signal as frame-based, so you must
set the Input processing parameter to Columns as channels (frame based).

Configure Axes Scaling and Data Alignment

The Main tab also allows you to control when and how Time Scope scales the axes. These
options also control how Time Scope aligns your data with respect to the axes. Click the
link labeled Configure... to the right of the Axes scaling parameter to see additional
options for axes scaling. After you click this button, the label changes to Hide... and new
parameters appear. The following table describes these additional options.
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Parameter

Description

Axes scaling

Specify when the scope automatically scales the axes. You can select
one of the following options:

* Manual — When you select this option, the scope does not
automatically scale the axes. You can manually scale the axes in
any of the following ways:

Select Tools > Axes Scaling Properties.
Press one of the Scale Axis Limits toolbar buttons.

*  When the scope figure is the active window, press Ctrl and A
simultaneously.

*  Auto — When you select this option, the scope scales the axes as
needed, both during and after simulation. Selecting this option
shows the Do not allow Y-axis limits to shrink check box.

+ After N Updates — Selecting this option causes the scope to
scale the axes after a specified number of updates. This option is
useful and more efficient when your scope display starts with one
axis scale, but quickly reaches a different steady state axis scale.
Selecting this option shows the Number of updates edit box.

By default, this property is set to Auto. This property is Tunable.

Scale axes limits
at stop

Select this check box to scale the axes when the simulation stops.
The y-axis is always scaled. The x-axis limits are only scaled if you
also select the Scale X-axis limits check box.

Data range (%)

Allows you to specify how much white space surrounds your signal
in the Time Scope window. You can specify a value for both the

y- and x-axis. The higher the value you enter for the y-axis Data
range (%), the tighter the y-axis range is with respect to the
minimum and maximum values in your signal. For example, to have
your signal cover the entire y-axis range when the block scales the
axes, set this value to 100.

Align

Allows you to specify where the block should align your data with
respect to each axis. You can choose to have your data aligned with
the top, bottom, or center of the y-axis. Additionally, if you select the
Autoscale X-axis limits check box, you can choose to have your
data aligned with the right, left, or center of the x-axis.




Set the parameters to the values shown in the following table.

Parameter

Setting

Axes scaling

Manual

Scale axes limits
at stop

Checked

Data range (%)

80

Align

Center

Autoscale X-axis

Unchecked

Display Time-Domain Data

limits

Set Time Domain Properties

In the Configuration Properties dialog box, click the Time tab. Set the parameters to the
values shown in the following table.

Parameter Setting

Time span One frame period

Time span Wrap

overrun action

Time units Metric (based on Time Span)

Time display 0
offset

Time-axis labels

All
Checked

Show time-axis
label

The Time span parameter allows you to enter a numeric value, a variable that evaluates
to a numeric value, or select the One frame period menu option. You can also select
the Auto menu option; in this mode, Time Scope automatically calculates the appropriate
value for time span from the difference between the simulation “Start time” and “Stop
time” parameters. The actual range of values that the block displays on the time-axis
depends on the value of both the Time span and Time display offset parameters. See
the following figure.
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If the Time display offset parameter is a scalar, the value of the minimum ¢ime-axis
limit is equal to the Time display offset. In addition, the value of the maximum time-
axis limit is equal to the sum of the Time display offset parameter and the Time span
parameter. For information on the other parameters in the Time Scope window, see the
Time Scope reference page.

In this tutorial, the values on the time-axis range from O to One frame period, where
One frame periodis 0.05 seconds (50 ms).

Set Display Properties

In the Configuration Properties dialog box, click the Display tab. Set the parameters to
the values shown in the following table.

Parameter Setting
Active display 1

Title

Show legend Checked
Show grid Checked
Plot signal(s) as magnitude and phase |Unchecked
Y-limits (Minimum) -2.5
Y-limits (Maximum) 2.5
Y-label Amplitude
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Set Logging Properties

In the Configuration Properties dialog box, click the Logging tab. Set Log data to
workspace to unchecked.

Click OK to save your changes and close the Configuration Properties dialog box.

Note: If you have not already done so, repeat all of these procedures for the Time Scopel
block (except leave the Number of input ports on the Main tab as 1) before continuing
with the other sections of this tutorial.

Use the Simulation Controls

One advantage to using the Time Scope block in your models is that you can control
model simulation directly from the Time Scope window. The buttons on the Simulation
Toolbar of the Time Scope window allow you to play, pause, stop, and take steps forward
or backward through model simulation. Alternatively, there are several keyboard
shortcuts you can use to control model simulation when the Time Scope is your active
window.

You can access a list of keyboard shortcuts for the Time Scope by selecting Help >
Keyboard Command Help. The following procedure introduces you to these features.

1 If the Time Scope window is not open, double-click the block icon in the
ex_timescope_tut model. Start model simulation. In the Time Scope window, on
the Simulation Toolbar, click the Run button ((_;_-}) on the Simulation Toolbar. You
can also use one of the following keyboard shortcuts:

« Ctrl+T
P
+ Space

2 While the simulation is running and the Time Scope is your active window, pause
the simulation. Use either of the following keyboard shortcuts:

P
* Space

Alternatively, you can pause the simulation in one of two ways:
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* In the Time Scope window, on the Simulation Toolbar, click the Pause button
(Qu).
*  From the Time Scope menu, select Simulation > Pause.

3  With the model simulation still paused, advance the simulation by a single time step.
To do so, in the Time Scope window, on the Simulation Toolbar, click the Next Step

button ( [ ).

Next, try using keyboard shortcuts to achieve the same result. Press the Page
Down key to advance the simulation by a single time step.

4 Resume model simulation using any of the following methods:

From the Time Scope menu, select Simulation > Continue.

* In the Time Scope window, on the Simulation Toolbar, click the Continue button
(®).

Use a keyboard shortcut, such as P or Space.

Modify the Time Scope Display

You can control the appearance of the Time Scope window using options from the display
or from the View menu. Among other capabilities, these options allow you to:

*  Control the display of the legend

+ Edit the line properties of your signals

* Show or hide the available toolbars
Change Signal Names in the Legend

You can change the name of a signal by double-clicking the signal name in the legend. By
default, the Time Scope names the signals based on the block they are coming from. For
this example, set the signal names as shown in the following table.

Block Name Original Signal Name New Signal Name

Time Scope Add Noisy Sine Wave

Time Scope Digital Filter — Lowpass Filtered Noisy Sine Wave
Time Scopel Sine Wave Original Sine Wave




Display Time-Domain Data

Modify Axes Colors and Line Properties

Use the Style dialog box to modify the appearance of the axes and the lines for each of
the signals in your model. In the Time Scope menu, select View > Style.

Figure color: Plot type: - -
Active display: :1 v:
Axes colors:
Properties for line: :Nuisy Sine Wawve v:
[¥] Visible
Line: » |05 A i"
Marker: :ncune v:

’ OK ] ’ Cancel l ’ Apply ]

1 Change the Plot Type parameter to Auto for each Time Scope block. This setting
ensures that Time Scope displays a line graph if the signal is continuous and a
stairstep graph if the signal is discrete.

2 Change the Axes colors parameters for each Time Scope block. Leave the axes
background color as black and set the ticks, labels, and grid colors to white.

3 Set the Properties for line parameter to the name of the signal for which you
would like to modify the line properties. Set the line properties for each signal
according to the values shown in the following table.

Block Name Signal Name Line Line Width /Marker | Color
Time Scope Noisy Sine _ 0.5 none White
Wave
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Block Name Signal Name Line Line Width /Marker | Color

Time Scope Filtered Noisy |—— 0.5 & Red
Sine Wave

Time Scopel |Original Sine |— 0.5 * Yellow
Wave

Show and Hide Time Scope Toolbars

You can also use the options on the View menu to show or hide toolbars on the Time
Scope window. For example:

* To hide the simulation controls, select View > Toolbar. Doing so removes the
simulation toolbar from the Time Scope window and also removes the check mark
from next to the Toolbar option in the View menu.

* You can choose to show the simulation toolbar again at any time by selecting View >
Toolbar.

Verify that all toolbars are visible before moving to the next section of this tutorial.

Inspect Your Data (Scaling the Axes and Zooming)

Time Scope has plot navigation tools that allow you to scale the axes and zoom in or out
on the Time Scope window. The axes scaling tools allow you to specify when and how
often the Time Scope scales the axes.

So far in this tutorial, you have configured the Time Scope block for manual axes scaling.

Use one of the following options to manually scale the axes:

*  From the Time Scope menu, select Tools > Scale Axes Limits.

*  Press the Scale Axes Limits toolbar button ([:] ).

*  With the Time Scope as your active window, press Ctrl + A.
Adjust White Space Around the Signal

You can control how much space surrounds your signal and where your signal appears in
relation to the axes. To adjust the amount of space surrounding your signal and realign



Display Time-Domain Data

it with the axes, you must first open the Tools—Plot Navigation Properties dialog box.
From the Time Scope menu, select Tools > Axes Scaling Properties .

In the Tools:Plot Navigation options dialog box, set the Data range (%) and Align
parameters. In a previous section, you set these parameters to 80 and Center,
respectively.

+ To decrease the amount of space surrounding your signal, set the Data range (%)
parameter on the Tools:Plot Navigation Options dialog box to 90.

+ To align your signal with the bottom of the Y-axis, set the Align parameter to
Bottom.

The next time you scale the axes of the Time Scope window, the window appears as
follows.
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Use the Zoom Tools

The zoom tools allow you to zoom in simultaneously in the directions of both the x- and y-
axes , or in either direction individually. For example, to zoom in on the signal between
5010 ms and 5020 ms, you can use the Zoom X option.

* To activate the Zoom X tool, select Tools > Zoom X, or press the corresponding
toolbar button (*3*). The Time Scope indicates that the Zoom X tool is active by

depressing the toolbar button and placing a check mark next to the Tools > Zoom X
menu option.

* To zoom in on the region between 5010 ms and 5020 ms, in the Time Scope window,
click and drag your cursor from the 10 ms mark to the 20 ms mark.

*  While zoomed in, to activate the Pan tool, select Tools > Pan, or press the

corresponding toolbar button ({mj' ).

* To zoom out of the Time Scope window, right-click inside the window, and select
Zoom Out. Alternatively, you can return to the original view of your signal by right-
clicking inside the Time Scope window and selecting Reset to Original View.

Manage Multiple Time Scopes

The Time Scope block provides tools to help you manage multiple Time Scope blocks in
your models. The model used throughout this tutorial, ex_timescope_tut, contains
two Time Scope blocks, labeled Time Scope and Time Scopel. The following sections
discuss the tools you can use to manage these Time Scope blocks.

Open All Time Scope Windows

When you have multiple windows open on your desktop, finding the one you need can

be difficult. The Time Scope block offers a View > Bring All Time Scopes Forward
menu option to help you manage your Time Scope windows. Selecting this option brings
all Time Scope windows into view. If a Time Scope window is not currently open, use this
menu option to open the window and bring it into view.

To try this menu option in the ex_timescope_tut model, open the Time Scope window,
and close the Time Scopel window. From the View menu of the Time Scope window,
select Bring All Time Scopes Forward. The Time Scopel window opens, along with
the already active Time Scope window. If you have any Time Scope blocks in other open
Simulink models, then these also come into view.
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Open Time Scope Windows at Simulation Start

When you have multiple Time Scope blocks in your model, you may not want all Time
Scope windows to automatically open when you start simulation. You can control
whether or not the Time Scope window opens at simulation start by selecting File >
Open at Start of Simulation from the Time Scope window. When you select this
option, the Time Scope GUI opens automatically when you start the simulation. When
you do not select this option, you must manually open the scope window by double-
clicking the corresponding Time Scope block in your model.

Find the Right Time Scope Block in Your Model

Sometimes, you have multiple Time Scope blocks in your model and need to find the
location of one that corresponds to the active Time Scope window. In such cases, you can
use the View > Highlight Simulink Block menu option or the corresponding toolbar

button ( E}). When you do so, the model window becomes your active window, and the
corresponding Time Scope block flashes three times in the model window. This option can
help you locate Time Scope blocks in your model and determine to which signals they are
attached.

To try this feature, open the Time Scope window, and on the simulation toolbar, click the
Highlight Simulink Block button. Doing so opens the ex_timescope_tut model. The
Time Scope block flashes three times in the model window, allowing you to see where in
your model the block of interest is located.

Docking Time Scope Windows in the Scopes Group Container

When you have multiple Time Scope blocks in your model you may want to see them in
the same window and compare them side-by-side. In such cases, you can select the Dock
Time Scope button (¥ ) at the top-right corner of the Time Scope window for the Time
Scope block.

= e
®
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The Time Scope window now appears in the Scopes group container. Next, press the Dock
Time Scope button at the top-right corner of the Time Scope window for the Time Scopel
block.

By default, the Scopes group container is situated above the MATLAB Command
Window. However, you can undock the Scopes group container by pressing the Show
Actions button ( at the top-right corner of the container and selecting Undock. The
Scopes group container is now independent from the MATLAB Command Window.

B Scopes ==

File Tools View Simulation Debug Desktop Window Help k

@-|la0P® =-4a-0-|F4- =] =Nl
Time Scope .W.

Ready Offset=5 (secs) [T=5.000 |Ready Offset=5 (secs) [T=5.000
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Once docked, the Scopes group container displays the toolbar and menu bar of the Time
Scope window. If you open additional instances of Time Scope, a new Time Scope window
appears in the Scopes group container.

You can undock any instance of Time Scope by pressing the corresponding Undock button
() in the title bar of each docked instance. If you close the Scopes group container, all
docked instances of Time Scope close but the Simulink model continues to run.

Close All Time Scope Windows

If you save your model with Time Scope windows open, those windows will reopen the
next time you open the model. Reopening the Time Scope windows when you open your
model can increase the amount of time it takes your model to load. If you are working
with a large model, or a model containing multiple Time Scopes, consider closing all Time
Scope windows before you save and close that model. To do so, use the File > Close All
Time Scope Windows menu option.

To use this menu option in the ex_timescope_tut model, open the Time Scope or Time
Scopel window, and select File > Close All Time Scope Windows. Both the Time
Scope and Time Scopel windows close. If you now save and close the model, the Time
Scope windows do not automatically open the next time you open the model. You can
open Time Scope windows at any time by double-clicking a Time Scope block in your
model. Alternatively, you can choose to automatically open the Time Scope windows at
simulation start. To do so, from the Time Scope window, select File > Open at Start of
Simulation.
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Display Frequency-Domain Data in Spectrum Analyzer

You can use DSP System Toolbox blocks to work with signals in both the time and
frequency domain. To display frequency-domain signals, you can use blocks from
the Sinks library, such as the Vector Scope, Spectrum Analyzer, Matrix Viewer, and
Waterfall Scope blocks.

With the Spectrum Analyzer block, you can display the frequency spectra of time-domain
input data. In contrast to the Vector Scope block, the Spectrum Analyzer block computes

the Fast Fourier Transform (FFT) of the input signal internally, transforming the signal

into the frequency domain.

This example shows how you can use a Spectrum Analyzer block to display the frequency
content of two frame-based signals simultaneously:

1 At the MATLAB command prompt, type ex_spectrumanalyzer_tut.

The Spectrum Analyzer example opens, and the variables, Fs and mtlb, are loaded
into the MATLAB workspace.
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2 Double-click the Signal From Workspace block. Set the block parameters as follows,
and then click OK:
Signal = mtlb
+ Sample time =1
Samples per frame = 16
* Form output after final data value = Cyclic Repetition

Based on these parameters, the Signal From Workspace block repeatedly outputs the
input signal, mtlb, as a frame-based signal with a sample period of 1 second.
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3 Create two distinct signals to send to the Spectrum Analyzer block. Use the Digital
Filter Design block to filter the input signal, using the default parameters.

File  Edit

Analysis

Targets

Block Parameters: Digital Filter Design

View Window Help

— Magnitude Response (dB).

[o o ==

Dedsl @< 300 A RN 40 - BiaRF| N

— Current Fitter Information

| Design Method

IR | Butterworth

@ FIR |Equiripple

Structure: Direct-Form FIR o
Order: 16 =
Stable: Yes §
Source: Designed =
o
(1]
=
[ Store Filter .. | 0 0.1 02 03 0.4 05 0686 0.8 0.9
i v. 4 f
| Fiter anager .. | Normalized Frequency (xz rad/sample)
— Response Type. — Fitter Order — Freguency Specifications. — Magnitude Specifications.
@ |Lowpass - Specify order: |10 Units: | Normalized (0 to 1) = Units: | dB -
Highpazs T
@) Minimurm order B
Bandpass Apass: |1
— { ;|2
Bandstop Options Wpass: Astop: a0
A ) . T
Differentiator Density Factor: wstop: |5

Input processing:

Ready

Inherited (this cheice will be removed - see release notes) -

4 Double-click the Matrix Concatenate block. Set the block parameters as follows, and

then click OK:

* Number of inputs = 2

* Mode =Multidimensional

array

2-95




2 Input, Output, and Display

2-96

+ Concatenate dimension = 2

The Matrix Concatenate block combines the two signals so that each column
corresponds to a different signal.

Double-click the Spectrum Analyzer block. The Spectrum Analyzer figure appears. In
the menu, select View > Spectrum Settings. The Spectrum Settings panel opens.

+ Expand the Main options pane, if it is not already expanded.

+ Set Type to Power.
+ Select the Full frequency span check box.
+ Set RBW (Hz) to 5.91e-3.

Expand the Trace options pane, if it is not already expanded.

+  Set Units to dBW.
+ Set Averages to 2.

+  Expand the Window options pane, if it is not already expanded.

+  Set Overlap (%) to 50.
+  Set Window to Hann.

Based on these parameters, the Spectrum Analyzer uses 128 samples from each
input channel to calculate a new windowed data segment, as shown in the following
equation.

_ NENBWxF,  1512x1Hz

D 3
RBW  11.8125x10°Hz

=128samples

There are also 128 frequency points in the FFT. Also, because Overlap (%) is set to
50, there is a buffer overlap length of 64 samples in each spectral estimate, as shown
in the following equation.

O, = O—Px L= ﬂ>< 128 = 64samples
100 100

Every time the scope updates the display, 64 points are plotted for each channel. At
16 samples per frame, Spectrum Analyzer waits for 3 frames or 48 samples before
displaying the first power spectral estimate.
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Fit all the calculated data points into the display. In the Spectrum Analyzer menu,
select Tools > Automatically Scale Axes Limits.

In the Spectrum Analyzer menu, select View > Configuration Properties. Then,
select the Show legend check box.

Run the model. The Spectrum Analyzer block computes the FFT of each of the input
signals. It then displays the power spectra of the frequency-domain signals in the
Spectrum Analyzer window.
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’

ex_spectrumanalyzer_tut/Spectrum Analyzer = || =) ER
File  Tools  View Simulation Help o

a[@Fe| &< &|3| A XM HE
® > ®| 5 @
¥ ¥ Spectrum Settings A X

¥ Main options
:

Sample rate (Hz): 1
Full frequency span
Samplesiupdate:
dow options

Owverlap |

MENBW: -
ptions
Units:

Averages:

-100 Reference load:

8 Linear

100 400 500

Paused |[RBW=5.91 mHz [T=235248.000
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The power spectrum of the first input signal, from column one, is the yellow line. The
power spectrum of the second input signal, from column two, is the blue line.
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Visualize Central Limit Theorem in Array Plot

2-100

In this section...

“Display a Uniform Distribution” on page 2-100
“Display the Sum of Many Uniform Distributions” on page 2-101

“Inspect Your Data by Zooming” on page 2-103

Display a Uniform Distribution

This example shows how to use and configure the dsp.ArrayPlot to visualize
the Central Limit Theorem. This theorem states that the mean of a large number
of independent random variables with finite mean and variance exhibits a normal
distribution.

First, generate uniformly distributed random variables in MATLAB using the rand
function. Find their distributions using the hist function. At the MATLAB command
line, type:

numsamples = le4;

numbins = 20;

r = rand(numsamples,1);

hst = hist(r,numbins);

Create a new Array Plot object.

hap3 = dsp.ArrayPlot;

Configure the properties of the Array Plot object to plot a histogram.
hap3 = dsp.ArrayPlot;

hap3.XO0ffset = O;

hap3.Samplelncrement = 1/numbins;
hap3.PlotType = "Stem”;

hap3.YLimits = [0, max(hst)+1];

Call the step method to plot the uniform distribution.
step(hap3,hst™);

The following Array Plot figure appears, showing a uniform distribution.
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A plitude
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Processing

Display the Sum of Many Uniform Distributions

Next, calculate the mean of multiple uniformly distributed random variables. As the
number of random variables increases, the distribution more closely resembles a normal

curve. Run the release method to let property values and input characteristics change.
At the MATLAB command line, type:

release(hap3l);

Change the configuration of the Array Plot properties for the display of a distribution
function.

numbins = 201;
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numtrials = 100;

r = zeros(numsamples,1);
hap3.Samplelncrement = 1/numbins;
hap3.PlotType = "Stairs”;

Call the step method repeatedly to plot the uniform distribution.

for 1i = l:numtrials
r = rand(numsamples,1)+r;
hst = hist(r/ii,0:1/numbins:1);
hap3.YLimits = [min(hst)-1, max(hst)+1];
step(hap3,hst™);
pause(0.1);

end

When the simulation has finished, the Array Plot figure displays a bell curve, indicating
a distribution that is close to normal.
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Inspect Your Data by Zooming

The zoom tools allow you to zoom in simultaneously in the directions of both the x- and
y-axes or in either direction individually. For example, to zoom in on the distribution
between 0.3 and 0.7, you can use the Zoom X option.

To activate the Zoom X tool, select Tools > Zoom X, or press the corresponding
toolbar button (*3"). You can determine if the Zoom X tool is active by looking for an
indented toolbar button or a check mark next to the Tools > Zoom X menu option.

Next, zoom in on the region between 0.3 and 0.7. In the Array Plot window, click on
the 0.3-second mark, and drag to the 0.7-second mark. The display reflects this new x-
axis setting, as shown in the following figure.
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Display Multiple Signals in the Time Scope

In this section...

“Multiple Signal Input” on page 2-105
“Multiple Time Offsets” on page 2-107
“Multiple Displays” on page 2-108

Multiple Signal Input

You can configure the Time Scope block to show multiple signals within the same display
or on separate displays. By default, the signals appear as different-colored lines on the
same display. The signals can have different dimensions, sample rates, and data types.
Each signal can be either real or complex valued. You can set the number of input ports
on the Time Scope block in the following ways:

* Right-click the Time Scope block in your model to bring up the context menu. Point
your cursor to the Signals & Ports > Number of Input Ports item on the context
menu. You can then select the number of input ports for the Time Scope block. If the
desired number of input signals is 1, 2, or 3, then click on the appropriate value. To
configure a Time Scope block to have more than three input ports, select More, and
enter a number for the Number of input ports parameter.

*  Open the Time Scope window by double-clicking the Time Scope block in your model.
In the scope menu, select File > Number of Input Ports.

*  Open the Time Scope window by double-clicking the Time Scope block in your model.
In the scope menu, select View > Configuration Properties and set the Number
of input ports on the Main tab.

An input signal may contain multiple channels, depending on its dimensions. Multiple
channels of data are always shown as different-colored lines on the same display.

Multiple Signal Names

By default, the scope names each channel according to either its signal name or the
name of the block from which it comes. If the signal has multiple channels, the scope
uses an index number to identify each channel of that signal. For example, a 2-channel
signal named Signall would have the following default names in the channel legend:
Signall:1, Signall:2. In the following example, there is one 3-channel input signal
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and one 4-channel input signal to the scope block, one signal named Signall and one
unnamed signal coming from a block named Block2.

1:3

Y

Signali

Blodk 1

4.7

Y

Block 2

Scope

To see all the signal names, run the simulation and show the legend. To show the legend,
select View > Configuration Properties, click the Display tab, and select the Show
Legend check box. The following legend appears in the display.

Note: Continuous signals appear as straight lines in the legend. Discrete signals appear
as step-shaped lines.

The scope does not display signal names that were labeled within an unmasked
subsystem. You must label all input signals to the scope block that originate from an
unmasked subsystem.

Multiple Signal Colors

By default, the scope has a black axes background and chooses line colors for each
channel in the same manner as the Simulink Scope block. When the scope axes
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background is black, it assigns each channel of each input signal a line color in the order
shown above.

If there are more than 7 channels, then the scope repeats this order to assign line colors
to the remaining channels. To choose line colors for each channel in the same manner
as the MATLAB plot function, change the axes background color to any color except
black. To change the axes background color to white, select View > Style, click the

Axes background color button (|ﬁ 7 ), and select white from the color palette. Run the
simulation again. The following legend appears in the display.

When the scope axes background is not black, it assigns each channel of each input
signal a line color in order shown above.If there are more than 7 channels, then the scope
repeats this order to assign line colors to the remaining channels. To manually modify
any line color, select View > Style to open the Style dialog box. Next to Properties for
line, select the signal name whose color you want to change. Then, next to Line, click

the Line color button ( -~ ) and select any color from the palette.

Multiple Time Offsets

You can offset all channels of an input signal by the same number of seconds or

offset each channel independently. To offset all channels equally, select View >
Configuration Properties, and specify a scalar value for the Time display offset
parameter on the Main pane. To offset each channel independently, specify a vector
of offset values. When you specify a Time display offset vector of length N, the scope
offsets the input channels as follows:

* When N is equal to the number of input channels, the scope offsets each channel
according to its corresponding value in the offset vector.

* When N is less than the number of input channels, the scope applies the values you
specify in the offset vector to the first NV input channels. The scope does not offset the
remaining channels.
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* When N is greater than the number of input channels, the scope offsets each input
channel according to the corresponding value in the offset vector. The scope ignores
all values in the offset vector that do not correspond to a channel of the input.

Multiple Displays

You can display multiple channels of data on different displays in the scope window.
In the scope toolbar, select View > Layout, or select the Layout button (F]) in the
dropdown below the Configuration Properties button.

Note: The Layout menu item and button are not available when the scope is in snapshot
mode.

This feature allows you to tile the window into a number of separate displays, up to a
grid of 4 rows and 4 columns. For example, if there are three inputs to the scope, you can
display the signals in separate displays by selecting row 3, column 1, as shown in the
following figure.

After you select row 3, column 1, the scope window 1s partitioned into three separate
displays, as shown in the following figure.
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When you use the Layout option to tile the window into multiple displays, the display
highlighted in yellow is referred to as the active display. The scope dialog boxes reference
the active display.
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Data and Signal Management

Learn concepts such as sample- and frame-based processing, sample rate, delay and

latency.

“Sample- and Frame-Based Concepts” on page 3-2

“Inspect Sample and Frame Rates in Simulink” on page 3-8
“Convert Sample and Frame Rates in Simulink” on page 3-19
“Buffering and Frame-Based Processing” on page 3-43

“Delay and Latency” on page 3-59
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Sample- and Frame-Based Concepts

3-2

In this section...

“Sample- and Frame-Based Signals” on page 3-2
“Model Sample- and Frame-Based Signals in MATLAB and Simulink” on page 3-3
“What Is Sample-Based Processing?” on page 3-3

“What Is Frame-Based Processing?” on page 3-4

Sample- and Frame-Based Signals

Sample-based signals are the most basic type of signal and are the easiest to construct
from a real-world (physical) signal. You can create a sample-based signal by sampling

a physical signal at a given sample rate, and outputting each individual sample as it is
received. In general, most Digital-to-Analog converters output sample-based signals.

You can create frame-based signals from sample-based signals. When you buffer a batch
of N samples, you create a frame of data. You can then output sequential frames of data
at a rate that is 1/N times the sample rate of the original sample-based signal. The rate

at which you output the frames of data is also known as the frame rate of the signal.

Frame-based data is a common format in real-time systems. Data acquisition hardware
often operates by accumulating a large number of signal samples at a high rate. The
hardware then propagates those samples to the real-time system as a block of data.
Doing so maximizes the efficiency of the system by distributing the fixed process
overhead across many samples. The faster data acquisition is suspended by slower
interrupt processes after each frame is acquired, rather than after each individual
sample. See “Benefits of Frame-Based Processing” on page 3-6 for more information.

DSP System Toolbox Source Create Sample-Based Signals | Create Frame-Based Signals
Blocks

Chirp X X

Constant X X

Discrete Impulse X X

DSP Constant (Obsolete) X

From Audio Device X X
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DSP System Toolbox Source Create Sample-Based Signals |Create Frame-Based Signals
Blocks

From Multimedia File X X
Identity Matrix X

MIDI Controls X

Multiphase Clock X X
N-Sample Enable X X
Random Source X

Signal From Workspace X X
Sine Wave X X
UDP Receive X

Model Sample- and Frame-Based Signals in MATLAB and Simulink

When you process signals using DSP System Toolbox software, you can do so in either

a sample- or frame-based manner. When you are working with blocks in Simulink,

you can specify, on a block-by-block basis, which type of processing the block performs.

In most cases, you specify the processing mode by setting the Input processing
parameter. When you are using System objects in MATLAB, only frame-based processing
is available. . The following table shows the common parameter settings you can use to
perform sample- and frame-based processing in MATLAB and Simulink.

Sample-Based Processing

Frame-Based Processing

Simulink — Blocks

Input processing =
Elements as channels
(sample based)

Input processing =
Columns as channels
(frame based)

What Is Sample-Based Processing?

In sample-based processing, blocks process signals one sample at a time. Each element
of the input signal represents one sample in a distinct channel. For example, from a
sample-based processing perspective, the following 3-by-2 matrix contains the first
sample in each of six independent channels.
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ST

111
~ 1| 1 -
Channel)  t-0

When you configure a block to perform sample-based processing, the block interprets
scalar input as a single-channel signal. Similarly, the block interprets an M-by-N matrix
as multichannel signal with M*N independent channels. For example, in sample-based
processing, blocks interpret the following sequence of 3-by-2 matrices as a six-channel
signal.

3|3
3-22
{2
o2 . 111
1]1
t=1 1
t=0

For more information about the recent changes to frame-based processing, see the
“Frame-Based Processing” section of the DSP System Toolbox Release Notes.

What Is Frame-Based Processing?

In frame-based processing, blocks process data one frame at a time. Each frame of data
contains sequential samples from an independent channel. Each channel is represented
by a column of the input signal. For example, from a frame-based processing perspective,
the following 3-by-2 matrix has two channels, each of which contains three samples.
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[Channel 1] [Channel 2]

R
114
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2 channels per frame

When you configure a block to perform frame-based processing, the block interprets an
M-by-1 vector as a single-channel signal containing M samples per frame. Similarly,

the block interprets an M-by-N matrix as a multichannel signal with N independent
channels and M samples per channel. For example, in frame-based processing, blocks
interpret the following sequence of 3-by-2 matrices as a two-channel signal with a frame
size of 3.

| Third frame
7 1 (samples 7-9)
g E4 4 Second frame
t=2 1515 (samples 4-6)
t=1 i ; ; - First frame
373 (samples1-3)
T
[Channel 1| [Channel 2]

Using frame-based processing is advantageous for many signal processing applications
because you can process multiple samples at once. By buffering your data into frames
and processing multisample frames of data, you can often improve the computational
time of your signal processing algorithms. To perform frame-based processing, you must
have a DSP System Toolbox license.

For more information about the recent changes to frame-based processing, see the
“Frame-Based Processing” section of the DSP System Toolbox Release Notes.
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Benefits of Frame-Based Processing

Frame-based processing is an established method of accelerating both real-time systems
and model simulations.

Accelerate Real-Time Systems

Frame-based data is a common format in real-time systems. Data acquisition hardware
often operates by accumulating a large number of signal samples at a high rate, and
then propagating those samples to the real-time system as a block of data. This type

of propagation maximizes the efficiency of the system by distributing the fixed process
overhead across many samples; the faster data acquisition is suspended by slower
interrupt processes after each frame is acquired, rather than after each individual
sample is acquired.

The following figure illustrates how frame-based processing increases throughput. The
thin blocks each represent the time elapsed during acquisition of a sample. The thicker
blocks each represent the time elapsed during the interrupt service routine (ISR) that
reads the data from the hardware.

In this example, the frame-based operation acquires a frame of 16 samples between each
ISR. Thus, the frame-based throughput rate is many times higher than the sample-based
alternative.

Sonple-based operation

I5R
—h

L L ) A ) B R

I—n:quiresnmple

Frome-based oporation
acquire 16 samples ISR
e —h
PRV A P P LA P A A
A 0 W M fime
latency

Be aware that frame-based processing introduces a certain amount of latency into
a process due to the inherent lag in buffering the initial frame. In many instances,
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however, you can select frame sizes that improve throughput without creating
unacceptable latencies. For more information, see “Delay and Latency” on page 3-59.

Accelerate Model Simulations
The simulation of your model also benefits from frame-based processing. In this case,

you reduce the overhead of block-to-block communications by propagating frames of data
rather than individual samples.
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Inspect Sample and Frame Rates in Simulink
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Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Sample Rate and Frame Rate Concepts” on page 3-8

“Inspect Sample-Based Signals Using Probe Block” on page 3-9
“Inspect Frame-Based Signals Using Probe Block” on page 3-11
“Inspect Sample-Based Signals Using Color Coding” on page 3-13

“Inspect Frame-Based Signals Using Color Coding” on page 3-15

Sample Rate and Frame Rate Concepts

Sample rates and frame rates are important issues in most signal processing models.
This is especially true with systems that incorporate rate conversions. Fortunately, in
most cases when you build a Simulink model, you only need to set sample rates for the
source blocks. Simulink automatically computes the appropriate sample rates for the
blocks that are connected to the source blocks. Nevertheless, it is important to become
familiar with the sample rate and frame rate concepts as they apply to Simulink models.

The input frame period (Tf) of a frame-based signal is the time interval between
consecutive vector or matrix inputs to a block. Similarly, the output frame period (T,) is
the time interval at which the block updates the frame-based vector or matrix value at
the output port.

In contrast, the sample period, T, is the time interval between individual samples in a
frame, this value is shorter than the frame period when the frame size is greater than 1.
The sample period of a frame-based signal is the quotient of the frame period and the
frame size, M:

T, =T I M
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More specifically, the sample periods of inputs (7};) and outputs (T}, are related to their
respective frame periods by

T =T/ M;

Tso = Tfo /Mo

where M; and M, are the input and output frame sizes, respectively.

The illustration below shows a single-channel, frame-based signal with a frame size (M,)
of 4 and a frame period (1) of 1. The sample period, T§;, is therefore 1/4, or 0.25 second.

Ti=1
e r First input frame

Al
15| 11

124

t=12

yout

L
e

To Wokspace

t=1 =0

The frame rate of a signal is the reciprocal of the frame period. For instance, the input
frame rate would be 1/ Ty . Similarly, the output frame rate would be 1/ Ty, .

The sample rate of a signal is the reciprocal of the sample period. For instance, the
sample rate would be 1/T.

In most cases, the sequence sample period T; is most important, while the frame rate
is simply a consequence of the frame size that you choose for the signal. For a sequence

with a given sample period, a larger frame size corresponds to a slower frame rate, and
vice versa.

Inspect Sample-Based Signals Using Probe Block

You can use the Probe block to display the sample period of a sample-based signal. For
sample-based signals, the Probe block displays the label Ts, the sample period of the
sequence, followed by a two-element vector. The left element is the period of the signal
being measured. The right element is the signal's sample time offset, which is usually 0.
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Note Simulink offers the ability to shift the sample time of a signal by an arbitrary
value, which is equivalent to shifting the signal's phase by a fractional sample period.
However, sample-time offsets are rarely used in signal processing systems, and DSP

System Toolbox blocks do not support them.

In this example, you use the Probe block to display the sample period of a sample-based

signal:

1

At the MATLAB command prompt, type ex_probe_tutl.

The Probe Example 1 model opens.

— S
File Edit View Display Diagram Simulation Analysis Code Tools Help
®-8a LO-BEOP = © -~ -
] EE 2 2/ =33
ex_probe_tutl
® |[Pa|ex_probe_tutl hd
G—l In this example, the Probe blocks display the sample pericd of asignal that is
|Pr0be Example 1 | repestedly ups smpled by = factor of 2.
| Ter minator | Ter minator | Tex minator2
:g
Probe| Ts:[-1, 0] | Probel ‘ Ts[-1, 0] | Probe2 | Ts:[-1, 0] |
1:1000 L TZ 4 TZ P dsp_examples_yout
Signal From Upsample Upsampie1 To Waorkspace
Workspace
Mote: This model orested works pace _v_a_iacc:}p,'rightzDDB—zjw The: MathiV oris, Inc.

»

Run the model.

The figure below illustrates how the Probe blocks display the sample period of the

signal before and after each upsample operation.
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¥ ex_probe_tutl (=% BoR ==
File Edit View Display Diagram Simulation Analysis Code Tools Help
=] Eim = | (el . (223
- = -8 4o b &~ » (P 7|~
ex_probe_tutl
® ||Pa|ex_probe_tutl A
G-l In this example, the Probe blodks display the sample period of 8 signal that is
|F'rObe Example 1 | repestedly ups ampled by a factor of 2.
| Ter minator | Ter minatord | Texr minator2
:g
Probe Ts1 | Probel ‘ T=0.5 | F'mb-aﬂ‘ Ts:0.25 |
1:1000 - TE » T"J_ | dsp_examples_yout
Signal From Upsample Upsample1 To'Workspace
Works pace
Mote: This model created works pace va 'i3=r=_=. :al.lal:i. "j';;:;a'; :quas_'.-;‘:.ilt'.imms' Inc.

»

As displayed by the Probe blocks, the output from the Signal From Workspace block
is a sample-based signal with a sample period of 1 second. The output from the first
Upsample block has a sample period of 0.5 second, and the output from the second
Upsample block has a sample period of 0.25 second.

Inspect Frame-Based Signals Using Probe Block

You can use the Probe block to display the frame period of a frame-based signal. For
frame-based signals, the block displays the label TF, the frame period of the sequence,
followed by a two-element vector. The left element is the period of the signal being
measured. The right element is the signal's sample time offset, which is usually 0.

Note Simulink offers the ability to shift a signal's sample times by an arbitrary value,
which is equivalent to shifting the signal's phase by a fractional sample period. However,
sample-time offsets are rarely used in signal processing systems, and DSP System
Toolbox blocks do not support them.
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In this example, you use the Probe block to display the frame period of a frame-based
signal:

1 At the MATLAB command prompt, type ex_probe_tut2.

The Probe Example 2 model opens.

¥ ex probe tut2 [F=%(EoR ~>3
File Edit View Display Diagram Simulation Analysis Code Tools Help
S]] == (ol . 1223
- J = o @& - = NN &~ » P - @~
ex_probe_tut2
® |[Pa|ex_probe_tut2 -
In this =xample, the Probe blocks display the frame period of 3 signal thatis
Q |Pr0l:le Example 2| repestedhy ups smpled by a factor of 2.
Tan'inat{x Tan'inata1 Tan'inataZ
=
F'mbe‘ Tsi[-1, 0] | F‘mbe1‘ Ts:[-1, 0] | F‘mb-al‘ Ts:[-1, 0] |
1:1000 » TZ | T;_ P dsp_examples_ycut
Signal From Upsample U psample1 ToWorkspace
Weorkspace
Mote: This model oreated works pace ‘{.g,igbC:p,-'rightED{?IB_—END.TI'E_I\-iathW:}Ns, Inc.
»

2 Run the model.

The figure below illustrates how the Probe blocks display the frame period of the
signal before and after each upsample operation.
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& ecprobe tut? * [F=5 [Eol ==
File Edit View Display Diagram Simulation Analysis Code Tools Help
HE _ “ B r P
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In this example, the Probe blocks display the frame period of 3 signal that is
Q |F'rObe Example 2. repestedly ups ampled by a factor of 2.
E3
Tan'inat{x Tan'inata1 Tan-.'nata:_
=
Probe TR16 | F‘labe1‘ Tf.8 | F‘rﬂb—al‘ T4 |
1:1000 > T;,_ > TZ | dsp_examples_yout
Signal From Upsample U psample1 To Workspace
Weorkspace
Mote: This model created works pace variables called "dsp_scamples _youf'.
»
Ready 100% oded5

As displayed by the Probe blocks, the output from the Signal From Workspace block
is a frame-based signal with a frame period of 16 seconds. The output from the first
Upsample block has a frame period of 8 seconds, and the output from the second
Upsample block has a sample period of 4 seconds.

Note that the sample rate conversion is implemented through a change in the frame
period rather than the frame size.

Inspect Sample-Based S

ignals Using Color Coding

In the following example, you use sample time color coding to view the sample rate of a

sample-based signal:

1

At the MATLAB command prompt, type ex_color_tutl.
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The Sample Time Color Example 1 model opens.

¥ ex_color_tutl oo ]
File Edit VYiew Display Diagram Simulation Analysis Code Tools Help
= ] == | (ol
-8 a w2 4O @ »C
ex_color_tutl
® ex_color_tuﬂ. -
In this example, sample time color coding highlights the rate
Q | Sample -rlme Cdor Example 1 | change of a signal that is repestedly upsampled by = factor of 2
=
1:1000 L4 ;_ L4 b | dsp_examples yout
Signal From: Upsample Upsample1 To Workspace
Workspace
Copyright 2008-2010 The MathW orks, Inc.
Mote: This model oreates 8 WoTKS PEOE VENIL i warrc e e pe_ s eporme_y e
b

2 From the Display menu, point to Sample Time, and select Colors.

This selection turns on sample time color coding. Simulink now assigns each sample
rate a different color.
3 Run the model.

The model should now look similar to the following figure:

3-14



Inspect Sample and Frame Rates in Simulink

=

'P'i ex_color_tutl El@

File Edit View Display Diagram Simulation Analysis Code Tools  Help
-8 & -2 EOP " © Q- |aE-
ex_color_tutl

W E®| e

bd

" ex_color_tutl

In this example, sample time color coding highlights the rate
| Sample TImE Cdﬂr Example 1 | change of asignal that 5 repeatedly upsampled by a factor of 2
1:1000 - ] > 2 | dsp_examples_yout
Signal From Upsample Upsample To Workspace
Workspace

Copyright 2008-2010 The MathiW orks, Inc.
Mote: This model oreates 8 WOrKSDEOE VBNL cie comrea we s e p o

Every sample-based signal in this model has a different sample rate. Therefore, each
signal is assigned a different color.

For more information about sample time color coding, see “View Sample Time
Information” in the Simulink documentation.

Inspect Frame-Based Signals Using Color Coding

In this example, you use sample time color coding to view the frame rate of a frame-based
signal:

1 At the MATLAB command prompt, type ex_color_tut2.
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The Sample Time Color Example 2 model opens.

3 eccolor_tut2 [F=1 EER
File Edit VYiew Display Diagram Simulation Analysis Code Tools Help
= ] = (el id
-8 & Ed B2 d® b & - » DT g 7
ex_color_tut2
® ex_color_tutZ hd
In this example. sample time oolor coding highlights the frame rate
Q |samp|e -rlme Cdor Example 2| change of a signal that is repestedly upsampled by = factor of 2
=
1:1000 d 2 g 2 | dsp_sxamples_yout
Signal From Upsample U psample1 To Warkspace
Workspace
Mote: This model oreates s workspace variable called ::Isp_a(smpls_s_\,':ui s, ne.
»

To turn on sample time color coding, from the Display menu, point to Sample
Time, and select Colors.

Simulink now assigns each frame rate a different color.
Run the model.

The model should now look similar to the following figure:
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p

Because the Rate options parameter in the Upsample blocks is set to Al low
multirate processing, each Upsample block changes the frame rate. Therefore,
each frame-based signal in the model is assigned a different color.

4 Double-click on each Upsample block and change the Rate options parameter to
Enforce single-rate processing.

5 Run the model.

Every signal is coded with the same color. Therefore, every signal in the model now
has the same frame rate.
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Ji6x1] 32x1]

1:1000 » 15 » 1= S

L

dsp_examples_yout

Signal From Upsamgle Up=ample1 To' Workspace
Workspace

For more information about sample time color coding, see “View Sample Time
Information” in the Simulink documentation.
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Convert Sample and Frame Rates in Simulink

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Rate Conversion Blocks” on page 3-19

“Rate Conversion by Frame-Rate Adjustment” on page 3-20
“Rate Conversion by Frame-Size Adjustment” on page 3-24
“Avoid Unintended Rate Conversion” on page 3-28

“Frame Rebuffering Blocks” on page 3-34

“Buffer Signals by Preserving the Sample Period” on page 3-36
“Buffer Signals by Altering the Sample Period” on page 3-39

Rate Conversion Blocks

There are two common types of operations that impact the frame and sample rates of

a signal: direct rate conversion and frame rebuffering. Direct rate conversions, such as
upsampling and downsampling, can be implemented by altering either the frame rate

or the frame size of a signal. Frame rebuffering, which is used alter the frame size of a
signal in order to improve simulation throughput, usually changes either the sample rate
or frame rate of the signal as well.

The following table lists the principal rate conversion blocks in DSP System Toolbox
software. Blocks marked with an asterisk (*) offer the option of changing the rate by
either adjusting the frame size or frame rate.

Block Library

Downsample * Signal Operations

Dyadic Analysis Filter Bank Filtering / Multirate Filters
Dyadic Synthesis Filter Bank Filtering / Multirate Filters
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Block Library

FIR Decimation * Filtering / Multirate Filters
FIR Interpolation * Filtering / Multirate Filters
FIR Rate Conversion Filtering / Multirate Filters
Repeat * Signal Operations
Upsample * Signal Operations

Direct Rate Conversion

Rate conversion blocks accept an input signal at one sample rate, and propagate the
same signal at a new sample rate. Several of these blocks contain a Rate options
parameter offering two options for multirate versus single-rate processing:

+ Enforce single-rate processing: When you select this option, the block
maintains the input sample rate.

+ Allow multirate processing: When you select this option, the block
downsamples the signal such that the output sample rate is K times slower than the
input sample rate.

Note: When a Simulink model contains signals with various frame rates, the model is
called multirate. You can find a discussion of multirate models in “Excess Algorithmic
Delay (Tasking Latency)” on page 3-67. Also see “Time-Based Scheduling and Code
Generation” in the Simulink Coder documentation.

Rate Conversion by Frame-Rate Adjustment

One way to change the sample rate of a signal, 1/T%,, is to change the output frame rate
(T}, # T}), while keeping the frame size constant (M, = M;). Note that the sample rate of a
signal is defined as 1/Ts, = M,/ T},

1 At the MATLAB command prompt, type ex_downsample_tutl.

The Downsample Example T1 model opens.
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¥

'P'i ex_downsample_tutl EI@

File Edit View Display Diagram Simulation Analysis Code Tools Help

-8 a -2 40P @ »QrE-

| ex_downsample_tutl |

(] ex_downsample_tutl hd
In this =cample, the Downsample block downsamples the signal to half
Q |D0msample Example T1 | its original sample rate by reducing the frame rate by thast factor.
=* Terminator Ter minator
z z
T:1 FProbe T2 Probe1
et ] =y
i[M] |[5x1] [Ex1]
1:1000 | FFT dsp_examples_yout
) B| 7 ] =
Signal From Downs ample FFT ToWorkspace
Works pace1
Mote: This model oreates 5 works pace variable called "dsp_sscamples_yout”™
Wariables will be cleared when the model B closed. 'orks, Inc.
=

2 From the Display menu, point to Signals & Ports, and select Signal Dimensions.
When you run the model, the dimensions of the signals appear next to the lines
connecting the blocks.

3 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

4  Set the block parameters as follows:

+ Sample time =0.125

+ Samples per frame =8
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Based on these parameters, the Signal From Workspace block outputs a frame-based
signal with a sample period of 0.125 second and a frame size of 8.

Save these parameters and close the dialog box by clicking OK.

Double-click the Downsample block. The Function Block Parameters:
Downsample dialog box opens.

Set the Rate options parameter to Allow multirate processing, and then
click OK.

The Downsample block is configured to downsample the signal by changing the
frame rate rather than the frame size.

Run the model.

After the simulation, the model should look similar to the following figure.
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Works pace1
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]
Ready 100% FixedStepDiscrete

Because Ty; = M; xT;;, the input frame period, Tj , is T =8x0.125 =1 second. This

value is displayed by the first Probe block. Therefore the input frame rate, 1/ 7T}, is

also 1 second.

The second Probe block in the model verifies that the output from the Downsample
block has a frame period, T, , of 2 seconds, twice the frame period of the input.
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However, because the frame rate of the output, 1/ Tz 1s 0.5 second, the Downsample

block actually downsampled the original signal to half its original rate. As a result,
the output sample period, Ty, =Ty, / M, , is doubled to 0.25 second without any

change to the frame size. The signal dimensions in the model confirm that the frame
size did not change.

Rate Conversion by Frame-Size Adjustment

One way to change the sample rate of a signal is by changing the frame size (that is
M, # M), but keep the frame rate constant (T, = Tj;). Note that the sample rate of a
signal is defined as 1/Ts, = M,/T},:

1 At the MATLAB command prompt, type ex_downsample_tut2.

The Downsample Example T2 model opens.
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2 From the Display menu, point to Signals & Ports, and select Signal Dimensions.
When you run the model, the dimensions of the signals appear next to the lines
connecting the blocks.

3 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

4  Set the block parameters as follows:

+ Sample time =0.125

+ Samples per frame =8
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Based on these parameters, the Signal From Workspace block outputs a frame-based
signal with a sample period of 0.125 second and a frame size of 8.

Save these parameters and close the dialog box by clicking OK.

Double-click the Downsample block. The Function Block Parameters:
Downsample dialog box opens.

Set the Rate options parameter to Enforce single-rate processing, and
then click OK.

The Downsample block is configured to downsample the signal by changing the
frame size rather than the frame rate.

Run the model.

After the simulation, the model should look similar to the following figure.
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Because Ty = M; xTy;

St

the input frame period, Ts ,1s Tp =8%0.125 =1 second. This

value is displayed by the first Probe block. Therefore the input frame rate, 1/ 7T}, is

also 1 second.

The Downsample block downsampled the input signal to half its original frame
size. The signal dimensions of the output of the Downsample block confirm that the
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downsampled output has a frame size of 4, half the frame size of the input. As a
result, the sample period of the output, Ty, = Ty, / M, , now has a sample period of

0.25 second. This process occurred without any change to the frame rate (T =Tp).

Avoid Unintended Rate Conversion

It is important to be aware of where rate conversions occur in a model. In a few cases,
unintentional rate conversions can produce misleading results:

1 At the MATLAB command prompt, type ex_vectorscope_tutl.

The Vector Scope Example model opens.

2 Double-click the upper Sine Wave block. The Source Block Parameters: Sine
Wave dialog box opens.

3 Set the block parameters as follows:

* Frequency (Hz) =1
Sample time =0.1

Samples per frame = 128

Based on the Sample time and the Samples per frame parameters, the Sine Wave
outputs a sinusoid with a frame period of 128*0.1 or 12.8 seconds.

4 Save these parameters and close the dialog box by clicking OK.
Double-click the lower Sine Wave block.
6 Set the block parameters as follows, and then click OK:

(8.}

* Frequency (Hz) =2
+ Sample time=0.1

Samples per frame = 128

Based on the Sample time and the Samples per frame parameters, the Sine Wave
outputs a sinusoid with a frame period of 128%0.1 or 12.8 seconds.

7 Double-click the Magnitude FFT block. The Function Block Parameters:
Magnitude FFT dialog box opens.

8 Select the Inherit FFT length from input dimensions check box, and then click
OK.
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10

11

This setting instructs the block to use the input frame size (128) as the FFT length
(which 1is also the output size).

Double-click the Vector Scope block. The Sink Block Parameters: Vector Scope
dialog box opens.

Set the block parameters as follows, and then click OK:

+  Click the Scope Properties tab.

* Input domain = Frequency
Click the Axis Properties tab.
Minimum Y-limit = -10

* Maximum Y-limit = 40

Run the model.

The model should now look similar to the following figure. Note that the signal
leaving the Magnitude FFT block is 128-by-1.
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The Vector Scope window displays the magnitude FFT of a signal composed of two
sine waves, with frequencies of 1 Hz and 2 Hz.
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The Vector Scope block uses the input frame size (128) and period (12.8) to deduce
the original signal's sample period (0.1), which allows it to correctly display the
peaks at 1 Hz and 2 Hz.

Double-click the Magnitude FFT block. The Function Block Parameters:
Magnitude FFT dialog box opens.

Set the block parameters as follows:

Clear the Inherit FFT length from input dimensions check box.
* Set the FFT length parameter to 256.

Based on these parameters, the Magnitude FFT block zero-pads the length-128 input
frame to a length of 256 before performing the FFT.
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14 Run the model.

The model should now look similar to the following figure. Note that the signal
leaving the Magnitude FFT block is 256-by-1.
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The Vector Scope window displays the magnitude FFT of a signal composed of two
sine waves, with frequencies of 2 Hz and 4 Hz.
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In this case, based on the input frame size (256) and frame period (12.8), the Vector
Scope block incorrectly calculates the original signal's sample period to be (12.8/256)
or 0.05 second. As a result, the spectral peaks appear incorrectly at 2 Hz and 4 Hz

rather than 1 Hz and 2 Hz.

The source of the error described above is unintended rate conversion. The zero-
pad operation performed by the Magnitude FFT block halves the sample period of
the sequence by appending 128 zeros to each frame. To calculate the spectral peaks
correctly, the Vector Scope block needs to know the sample period of the original

signal.

15 To correct for the unintended rate conversion, double-click the Vector Scope block.

16 Set the block parameters as follows:
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+ Click the Axis Properties tab.
Clear the Inherit sample time from input check box.

+  Set the Sample time of original time series parameter to the actual sample
period of 0.1.

17 Run the model.
The Vector Scope block now accurately plots the spectral peaks at 1 Hz and 2 Hz.

In general, when you zero-pad or overlap buffers, you are changing the sample period
of the signal. If you keep this in mind, you can anticipate and correct problems such as
unintended rate conversion.

Frame Rebuffering Blocks

There are two common types of operations that impact the frame and sample rates of

a signal: direct rate conversion and frame rebuffering. Direct rate conversions, such as
upsampling and downsampling, can be implemented by altering either the frame rate

or the frame size of a signal. Frame rebuffering, which is used alter the frame size of a
signal in order to improve simulation throughput, usually changes either the sample rate
or frame rate of the signal as well.

Sometimes you might need to rebuffer a signal to a new frame size at some point in a
model. For example, your data acquisition hardware may internally buffer the sampled
signal to a frame size that is not optimal for the signal processing algorithm in the model.
In this case, you would want to rebuffer the signal to a frame size more appropriate for
the intended operations without introducing any change to the data or sample rate.

The following table lists the principal DSP System Toolbox buffering blocks.

Block Library

Buffer Signal Management/ Buffers
Delay Line Signal Management/ Buffers
Unbuffer Signal Management/ Buffers
Variable Selector Signal Management/ Indexing

Blocks for Frame Rebuffering with Preservation of the Signal

Buffering operations provide another mechanism for rate changes in signal processing
models. The purpose of many buffering operations is to adjust the frame size of the
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signal, M, without altering the signal's sample rate T;. This usually results in a change to
the signal's frame rate, T}, according to the following equation:

Ty = MT,

However, the equation above is only true if no samples are added or deleted from the
original signal. Therefore, the equation above does not apply to buffering operations that
generate overlapping frames, that only partially unbuffer frames, or that alter the data
sequence by adding or deleting samples.

There are two blocks in the Buffers library that can be used to change a signal's frame
size without altering the signal itself:

+ Buffer — redistributes signal samples to a larger or smaller frame size

*  Unbuffer — unbuffers a frame-based signal to a sample-based signal (frame size = 1)

The Buffer block preserves the signal's data and sample period only when its Buffer
overlap parameter is set to 0. The output frame period, T}, is

M,T}
Ty = —2 1
Py

l

where T is the input frame period, M, is the input frame size, and M, is the output frame
size specified by the Output buffer size (per channel) parameter.

The Unbuffer block unbuffers a frame-based signal to its sample-based equivalent, and
always preserves the signal's data and sample period

Tso =Ts I M;

where T}; and M; are the period and size, respectively, of the frame-based input.

Both the Buffer and Unbuffer blocks preserve the sample period of the sequence in the
conversion (T, = T%;).

Blocks for Frame Rebuffering with Alteration of the Signal

Some forms of buffering alter the signal's data or sample period in addition to adjusting
the frame size. This type of buffering is desirable when you want to create sliding
windows by overlapping consecutive frames of a signal, or select a subset of samples from
each input frame for processing.
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The blocks that alter a signal while adjusting its frame size are listed below. In this list,
T;; is the input sequence sample period, and T} and 7}, are the input and output frame
periods, respectively:

* The Buffer block adds duplicate samples to a sequence when the Buffer overlap
parameter, L, is set to a nonzero value. The output frame period is related to the
input sample period by

Tfo =M, -L)T

where M, is the output frame size specified by the Output buffer size (per
channel) parameter. As a result, the new output sample period is

_ (M, - DTy
M

(o]

TS (o)

* The Delay Line block adds duplicate samples to the sequence when the Delay line
size parameter, M,, is greater than 1. The output and input frame periods are the
same, Ty, = T = Ty, and the new output sample period is

* The Variable Selector block can remove, add, and/or rearrange samples in the input
frame when Select is set to Rows. The output and input frame periods are the same,
T, = T}, and the new output sample period is

_ MiT
M

o

TS (o)

where M, is the length of the block's output, determined by the Elements vector.

In all of these cases, the sample period of the output sequence is not equal to the sample
period of the input sequence.

Buffer Signals by Preserving the Sample Period

In the following example, a signal with a sample period of 0.125 second is rebuffered
from a frame size of 8 to a frame size of 16. This rebuffering process doubles the

3-36



Convert Sample and Frame Rates in Simulink

frame period from 1 to 2 seconds, but does not change the sample period of the signal
(T, = T,;; = 0.125). The process also does not add or delete samples from the original
signal:

1 At the MATLAB command prompt, type ex_buffer_ tutl.

The Buffer Example T1 model opens.

P e buffer_tutl E=% EER =<
File Edit View Display Diagram Simulation Analysis Code  Tools  Help
= ZE @) - = i i bid
-8 = [E] M= IR O N &~ » (@~ @y~
ex_buffer_tuti
® | Pa|ex_buffer_tutl -
Q |Buffer Example T1 | In this example, the Buffer block rebuffers the signal to a larger frame size.
=
Tan'inat{l Tan'inat{ﬂ
Ts:[-1, 0] [Probe Ts[-1, 0] [Probel
1:1000 i | FFT | sp_examples yout
Signal F FFT -
m?c“':s ";: Bufer Signal To
pa Workspace
MNote: This mode| oreates aworkspace variable called sp_sxamples_yout”
Closing the modelclears the "sp_sxamplesyout” variable from your workspace.
»

2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3 Set the parameters as follows:
+ Signal =1:1000
+ Sample time =0.125

+ Samples per frame =8
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+ Form output after final data value = Setting to zero

Based on these parameters, the Signal from Workspace block outputs a frame-
based signal with a sample period of 0.125 second. Each output frame contains eight
samples.

Save these parameters and close the dialog box by clicking OK.

Double-click the Buffer block. The Function Block Parameters: Buffer dialog box
opens.

Set the parameters as follows, and then click OK:

*  Output buffer size (per channel) = 16
+ Buffer overlap =0
Initial conditions =0
Based on these parameters, the Buffer block rebuffers the signal from a frame size
of 8 to a frame size of 16.

Run the model.

The following figure shows the model after simulation.
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Note that the input to the Buffer block has a frame size of 8 and the output of the
block has a frame size of 16. As shown by the Probe blocks, the rebuffering process
doubles the frame period from 1 to 2 seconds.

Buffer Signals by Altering the Sample Period
Some forms of buffering alter the signal's data or sample period in addition to adjusting

the frame size. In the following example, a signal with a sample period of 0.125 second is
rebuffered from a frame size of 8 to a frame size of 16 with a buffer overlap of 4:

1 At the MATLAB command prompt, type ex_buffer_tut2.

The Buffer Example T2 model opens.
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2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3 Set the parameters as follows:

+ Signal =1:1000
Sample time = 0.125
Samples per frame = 8
Form output after final data value = Setting to zero

Based on these parameters, the Signal from Workspace block outputs a frame-
based signal with a sample period of 0.125 second. Each output frame contains eight
samples.

4 Save these parameters and close the dialog box by clicking OK.
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Double-click the Buffer block. The Function Block Parameters: Buffer dialog box
opens.

Set the parameters as follows, and then click OK:

*  Output buffer size (per channel) = 16

+ Buffer overlap =4

+ Initial conditions =0

Based on these parameters, the Buffer block rebuffers the signal from a frame size

of 8 to a frame size of 16. Also, after the initial output, the first four samples of each
output frame are made up of the last four samples from the previous output frame.

Run the model.

The following figure shows the model after the simulation has stopped.
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»
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Note that the input to the Buffer block has a frame size of 8 and the output of the

block has a frame size of 16. The relation for the output frame period for the Buffer
block is

Ty, = (M, ~L)Ty;

T, 1s (16-4)*0.125, or 1.5 seconds, as confirmed by the second Probe block. The
sample period of the signal at the output of the Buffer block is no longer 0.125

second. It is now Ty, =Ty, / M, =1.5/16 =0.0938 second. Thus, both the signal's

data and the signal's sample period have been altered by the buffering operation.
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Buffering and Frame-Based Processing

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Frame Status” on page 3-43

“Buffer Sample-Based Signals into Frame-Based Signals” on page 3-43

“Buffer Sample-Based Signals into Frame-Based Signals with Overlap” on page 3-46
“Buffer Frame-Based Signals into Other Frame-Based Signals” on page 3-51

“Buffer Delay and Initial Conditions” on page 3-54

“Unbuffer Frame-Based Signals into Sample-Based Signals” on page 3-54

Frame Status

The frame status of a signal refers to whether the signal is sample based or frame

based. In a Simulink model, the frame status is symbolized by a single line ,—, for a
sample-based signal and a double line, = for a frame-based signal. One way to convert a
sample-based signal to a frame-based signal is by using the Buffer block. You can convert
a frame-based signal to a sample-based signal using the Unbuffer block. To change

the frame status of a signal without performing a buffering operation, use the Frame
Conversion block in the Signal Attributes library.

Buffer Sample-Based Signals into Frame-Based Signals

Multichannel sample-based and frame-based signals can be buffered into multichannel
frame-based signals using the Buffer block.

The following figure is a graphical representation of a sample-based signal being
converted into a frame-based signal by the Buffer block.
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In the following example, a two-channel sample-based signal is buffered into a two-
channel frame-based signal using a Buffer block:

1 At the MATLAB command prompt, type ex_buffer_tut.

The Buffer Example model opens.
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2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3 Set the parameters as follows:

Signal =[1:10;-1:-1:-10]"
+ Sample time =1
Samples per frame = 1

* Form output after final data value = Setting to zero

Based on these parameters, the Signal from Workspace block outputs a sample-
based signal with a sample period of 1 second. Because you set the Samples per
frame parameter setting to 1, the Signal From Workspace block outputs one two-
channel sample at each sample time.

4 Save these parameters and close the dialog box by clicking OK.
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Double-click the Buffer block. The Function Block Parameters: Buffer dialog box
opens.

Set the parameters as follows:

*  Output buffer size (per channel) =4
+ Buffer overlap =0
Initial conditions =0

Because you set the Output buffer size parameter to 4, the Buffer block outputs a

frame-based signal with frame size 4.
7 Run the model.

Note that the input to the Buffer block is sample based (represented as a single line)
while the output is frame-based (represented by a double line).

The figure below is a graphical interpretation of the model behavior during
simulation.

[1:10;-1:-1:-10])"

Signal From
Workspace

1-1
-1
0 [g4) (3 -3]-[2 -2 -1 -1] —» LELIE 2 [ =p_exampies your
t=3 t=2 t=1 t=0 4 -4 Signal To
Buffer Workspace

T

Four consecutive samples from a ;
2-channel frame-based signal

2-channel sample-based signal

Note: Alternatively, you can set the Samples per frame parameter of the Signal From
Workspace block to 4 and create the same frame-based signal shown above without using
a Buffer block. The Signal From Workspace block performs the buffering internally, in
order to output a two-channel frame-based signal.

Buffer Sample-Based Signals into Frame-Based Signals with Overlap

In some cases it is useful to work with data that represents overlapping sections of an
original sample-based or frame-based signal. For example, in estimating the power
spectrum of a signal, it is often desirable to compute the FFT of overlapping sections of
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data. Overlapping buffers are also needed in computing statistics on a sliding window, or
for adaptive filtering.

The Buffer overlap parameter of the Buffer block specifies the number of overlap
points, L. In the overlap case (L > 0), the frame period for the output is (M,-L)*T,;, where
T,; is the input sample period and M, is the Buffer size.

Note: Set the Buffer overlap parameter to a negative value to achieve output frame
rates slower than in the nonoverlapping case. The output frame period is still Ty;*(M,-L),
but now with L < 0. Only the M, newest inputs are included in the output buffers. The
previous L inputs are discarded.

In the following example, a four-channel sample-based signal with sample period 1 is
buffered to a frame-based signal with frame size 3 and frame period 2. Because of the
buffer overlap, the input sample period is not conserved, and the output sample period
is 2/3:

1 At the MATLAB command prompt, type ex_buffer_ tut3.

The Buffer Example T3 model opens.
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Also, the variable sp_examples_src is loaded into the MATLAB workspace. This
variable is defined as follows:

sp_examples_src=[1 15 -1; 215 -2; 305 -3; 405 -4;515-5;615 -6];

2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3 Set the block parameters as follows:
+ Signal =sp_examples_src
+ Sample time =1

Samples per frame = 1
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* Form output after final data value by = Setting to zero

Based on these parameters, the Signal from Workspace block outputs a sample-
based signal with a sample period of 1 second. Because you set the Samples per
frame parameter setting to 1, the Signal From Workspace block outputs one four-
channel sample at each sample time.

Save these parameters and close the dialog box by clicking OK.

Double-click the Buffer block. The Function Block Parameters: Buffer dialog box
opens.

Set the block parameters as follows, and then click OK:

* Output buffer size (per channel) =3
Buffer overlap = 1
* Initial conditions =0
Because you set the Output buffer size parameter to 3, the Buffer block outputs
a frame-based signal with frame size 3. Also, because you set the Buffer overlap

parameter to 1, the last sample from the previous output frame is the first sample in
the next output frame.

Run the model.

Note that the input to the Buffer block is sample based (represented as a single line)
while the output is frame based (represented by a double line).

The following figure is a graphical interpretation of the model's behavior during
simulation.

3-49



3 Data and Signal Management

3-50

thl th3
[h]—| |_[h11
t=5 [6 1 5 g
}'TS;:]
t=4 [5 1 5
t=3 [+ 0 5
<2305 firstsumple-bosed
=1 [2 1 59 input
t=0 [1 L5 —1] J

b

L
Buffer
(M=3, =1)

Frame-hased output,

Sample-hased input,
somple period = Ty

frome perind = [M,-L)*+T4

thl
thi
ch3
chd

[—|

(- T
A -1
L LnoLn
& b L

t=h

chl

[—

LR O]

At the MATLAB command prompt, type sp_examples_yout.

The following is displayed in the MATLAB Command Window.
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OO0 O0OO0ORrRrRFRPRFRPROOORFRRFRPPFRPROOOO
eNeoNoNeoNoNONONONORONONGNG NG NeoleoNelNo)

0
0
0
0

-1

-2

-2

-3

-4

-4

-5

-6

-6
0
0
0
0
0

OO0 O0OO0O0OO0OUNMDMWNNREFLPOOOO

first
frome -bos ed
output

0000
0000
0000

=0



Buffering and Frame-Based Processing

Notice that the inputs do not begin appearing at the output until the fifth row, the
second row of the second frame. This is due to the block's latency.

See “Excess Algorithmic Delay (Tasking Latency)” on page 3-67 for general

information about algorithmic delay. For instructions on how to calculate buffering delay,
see “Buffer Delay and Initial Conditions” on page 3-54.

Buffer Frame-Based Signals into Other Frame-Based Signals
In the following example, a two-channel frame-based signal with frame size 4 is

rebuffered to a frame-based signal with frame size 3 and frame period 2. Because of the
overlap, the input sample period is not conserved, and the output sample period is 2/3:

1 At the MATLAB command prompt, type ex_buffer_tut4.

The Buffer Example T4 model opens.
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Also, the variable sp_examples_src is loaded into the MATLAB workspace. This
variable is defined as
sp_examples_src = [1 1; 2 1; 3 0; 40; 51; 6 1; 7 0; 8 0]

2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3  Set the block parameters as follows:

+ Signal = sp_examples_src

Sample time =1
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+ Samples per frame =4

Based on these parameters, the Signal From Workspace block outputs a two-
channel, frame-based signal with a sample period of 1 second and a frame size of 4.
Save these parameters and close the dialog box by clicking OK.

Double-click the Buffer block. The Function Block Parameters: Buffer dialog box
opens.

Set the block parameters as follows, and then click OK:

*  Output buffer size (per channel) = 3
Buffer overlap = 1
+ Initial conditions =0
Based on these parameters, the Buffer block outputs a two-channel, frame-based
signal with a frame size of 3.
Run the model.

The following figure is a graphical representation of the model's behavior during
simulation.
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Note that the inputs do not begin appearing at the output until the last row of the
third output matrix. This is due to the block's latency.

See “Excess Algorithmic Delay (Tasking Latency)” on page 3-67 for general
information about algorithmic delay. For instructions on how to calculate buffering delay,
and see “Buffer Delay and Initial Conditions” on page 3-54.
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Buffer Delay and Initial Conditions

In the examples “Buffer Sample-Based Signals into Frame-Based Signals with Overlap”
on page 3-46 and “Buffer Frame-Based Signals into Other Frame-Based Signals” on
page 3-51, the input signal is delayed by a certain number of samples. The initial
output samples correspond to the value specified for the Initial condition parameter.
The initial condition is zero in both examples mentioned above.

Under most conditions, the Buffer and Unbuffer blocks have some amount of delay or
latency. This latency depends on both the block parameter settings and the Simulink
tasking mode. You can use the rebuffer_delay function to determine the length of the
block's latency for any combination of frame size and overlap.

The syntax rebuffer_delay(f,n,Vv) returns the delay, in samples, introduced by the
buffering and unbuffering blocks during multitasking operations, where T is the input
frame size, n is the Output buffer size parameter setting, and v is the Buffer overlap
parameter setting.

For example, you can calculate the delay for the model discussed in the “Buffer Frame-
Based Signals into Other Frame-Based Signals” on page 3-51 using the following
command at the MATLAB command line:

d
d

rebuffer_delay(4,3,1)
8

This result agrees with the block's output in that example. Notice that this model was
simulated in Simulink multitasking mode.

For more information about delay, see “Excess Algorithmic Delay (Tasking Latency)” on
page 3-67. For delay information about a specific block, see the “Latency” section of

the block reference page. For more information about the rebuffer_delay function, see
rebuffer_delay.

Unbuffer Frame-Based Signals into Sample-Based Signals

You can unbuffer multichannel frame-based signals into multichannel sample-based
signals using the Unbuffer block. The Unbuffer block performs the inverse operation of
the Buffer block's “sample-based to frame-based” buffering process, and generates an N-
channel sample-based output from an N-channel frame-based input. The first row in each
input matrix is always the first sample-based output.
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The following figure is a graphical representation of this process.
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The sample period of the sample-based output, T, is related to the input frame
period, T}, by the input frame size, M;.

Tso = Tfi /Mi

The Unbuffer block always preserves the signal's sample period (Ty, = Ty;). See “Convert
Sample and Frame Rates in Simulink” on page 3-19 for more information about rate
conversions.

In the following example, a two-channel frame-based signal is unbuffered into a two-
channel sample-based signal:

1 At the MATLAB command prompt, type ex_unbuffer_tut.

The Unbuffer Example model opens.
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2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3 Set the block parameters as follows:

* Signal=[1:10;-1:-1:-10]"
+ Sample time =1
+ Samples per frame =4
Form output after final data value by = Setting to zero

Based on these parameters, the Signal From Workspace block outputs a two-
channel, frame based-signal with frame size 4.

4 Save these parameters and close the dialog box by clicking OK.

5 Double-click the Unbuffer block. The Function Block Parameters: Unbuffer
dialog box opens.
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6 Set the Initial conditions parameter to 0, and then click OK.

The Unbuffer block unbuffers the frame-based signal into a two-channel sample-
based signal.

7 Run the model.

The following figures is a graphical representation of what happens during the model

simulation.
1-1
[1:10;-1:-1:-10] i g :; = | [1x2] [4 -4]—[3 -3] —[2 -2] —/[1 -1] — sp_examples_yout
Signal From 4 -4 t=7 t=6 t=5 t=4 Signal To
Workspace Unbuffer Worspace

T

. Four consecutive samples from a
2-channel frame-based signal P

2-channel sample-based signal

Note: The Unbuffer block generates initial conditions not shown in the figure below
with the value specified by the Initial conditions parameter. See the Unbuffer
reference page for information about the number of initial conditions that appear in
the output.

8 At the MATLAB command prompt, type sp_examples_yout.

The following is a portion of the output.

sp_examples_yout(:,:,1)

0 0

sp_examples_yout(:,:,2)

0 0

sp_examples_yout(:,:,3)

0 0
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sp_examples_yout(:,:,4)

0 0

sp_examples_yout(:,:,5)

1 -1

sp_examples_yout(:,:,6)

2 -2

sp_examples_yout(:,:,7)
3 -3

The Unbuffer block unbuffers the frame-based signal into a two-channel, sample-
based signal. Each page of the output matrix represents a different sample time.
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Delay and Latency

Note: Starting in R2010b, many DSP System Toolbox blocks received a new parameter to
control whether they perform sample- or frame-based processing. The following content
has not been updated to reflect this change. For more information, see the “Frame-Based
Processing” section of the Release Notes.

In this section...

“Computational Delay” on page 3-59

“Algorithmic Delay” on page 3-61

“Zero Algorithmic Delay” on page 3-61

“Basic Algorithmic Delay” on page 3-64

“Excess Algorithmic Delay (Tasking Latency)” on page 3-67
“Predict Tasking Latency” on page 3-69

Computational Delay

The computational delay of a block or subsystem is related to the number of operations
involved in executing that block or subsystem. For example, an FFT block operating

on a 256-sample input requires Simulink software to perform a certain number of
multiplications for each input frame. The actual amount of time that these operations
consume depends heavily on the performance of both the computer hardware and
underlying software layers, such as the MATLAB environment and the operating system.
Therefore, computational delay for a particular model can vary from one computer
platform to another.

The simulation time represented on a model's status bar, which can be accessed via the
Simulink Digital Clock block, does not provide any information about computational
delay. For example, according to the Simulink timer, the FFT mentioned above executes
instantaneously, with no delay whatsoever. An input to the FFT block at simulation time
t=25.0 is processed and output at simulation time t=25.0, regardless of the number of
operations performed by the FFT algorithm. The Simulink timer reflects only algorithmic
delay, not computational delay.
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Reduce Computational Delay

There are a number of ways to reduce computational delay without actually running
the simulation on faster hardware. To begin with, you should familiarize yourself with
“Manual Performance Optimization” in the Simulink documentation, which describes
some basic strategies. The following information discusses several options for improving
performance.

A first step in improving performance is to analyze your model, and eliminate or simplify
elements that are adding excessively to the computational load. Such elements might
include scope displays and data logging blocks that you had put in place for debugging
purposes and no longer require. In addition to these model-specific adjustments, there
are a number of more general steps you can take to improve the performance of any
model:

+  Use frame-based processing wherever possible. It is advantageous for the entire
model to be frame based. See “Benefits of Frame-Based Processing” for more
information.

*  Use the DSP Simulink model templates to tailor Simulink for digital signal processing
modeling. For more information, see Configure the Simulink Environment for Signal
Processing Models in DSP System Toolbox documentation.

*  Turn off the Simulink status bar by deselecting the Status bar option in the View
menu. Simulation speed will improve, but the time indicator will not be visible.

*  Run your simulation from the MATLAB command line by typing
sim(gcs)

This method of starting a simulation can greatly increase the simulation speed, but
also has several limitations:
* You cannot interact with the simulation (to tune parameters, for instance).

You must press Ctrl+C to stop the simulation, or specify start and stop times.

There are no graphics updates in M-file S-functions, which include blocks such as
Vector Scope, etc.

+ Use Simulink Coder code generation software to generate generic real-time (GRT)
code targeted to your host platform, and run the model using the generated
executable file. See the Simulink Coder documentation for more information.
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Algorithmic Delay

Algorithmic delay is delay that is intrinsic to the algorithm of a block or subsystem and
is independent of CPU speed. In this guide, the algorithmic delay of a block is referred to
simply as the block's delay. It is generally expressed in terms of the number of samples
by which a block's output lags behind the corresponding input. This delay is directly
related to the time elapsed on the Simulink timer during that block's execution.

The algorithmic delay of a particular block may depend on both the block parameter
settings and the general Simulink settings. To simplify matters, it is helpful to categorize
a block's delay using the following categories:

+  “Zero Algorithmic Delay” on page 3-61

+  “Basic Algorithmic Delay” on page 3-64

+ “Excess Algorithmic Delay (Tasking Latency)” on page 3-67

The following topics explain the different categories of delay, and how the simulation and
parameter settings can affect the level of delay that a particular block experiences.

Zero Algorithmic Delay

The FFT block is an example of a component that has no algorithmic delay. The Simulink
timer does not record any passage of time while the block computes the FFT of the input,
and the transformed data is available at the output in the same time step that the input
is received. There are many other blocks that have zero algorithmic delay, such as the
blocks in the Matrices and Linear Algebra libraries. Each of those blocks processes its
input and generates its output in a single time step.

The Normalization block is an example of a block with zero algorithmic delay:

1 At the MATLAB command prompt, type ex_normalization_tut.

The Normalization Example T1 model opens.
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2 Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

3  Set the block parameters as follows:

+ Signal =1:100
Sample time = 1/4
+ Samples per frame =4
Save these parameters and close the dialog box by clicking OK.

5 Double-click the Frame Conversion block. The Function Block Parameters:
Frame Conversion dialog box opens.

6 Set the Sampling mode of output signal parameter to Sample based, and then
click OK.

7 Run the model.
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The model prepends the current value of the Simulink timer output from the Digital
Clock block to each output frame. The Frame Conversion block converts the frame-
based signal to a sample-based signal so that the output in the MATLAB Command
Window is more easily readable.

The Signal From Workspace block generates a new frame containing four samples
once every second (T, = m*4). The first few output frames are:

(t=0) [1 2 3 4]"
(t=1) [5 6 7 8]"
(t=2) [ 9 10 11 12]"
(t=3) [13 14 15 16]"
(t=4) [17 18 19 20]"

At the MATLAB command prompt, type squeeze(dsp_examples_yout)”.

The normalized output, dsp_examples_yout, is converted to an easier-to-read
matrix format. The result, ans, is shown in the following figure:

ans =
0 0.0333 0.0667 0.1000 0.1333
1.0000 0.0287 0.0345 0.0402 0.0460
2.0000 0.0202 0.0224 0.0247 0.0269
3.0000 0.0154 0.0165 0.0177 0.0189
4.0000 0.0124 0.0131 0.0138 0.0146
5.0000 0.0103 0.0108 0.0113 0.0118

The first column of ans is the Simulink time provided by the Digital Clock block. You
can see that the squared 2-norm of the first input,

[123 4] .7 sun([1 2 3 4]"."2)

appears in the first row of the output (at time =0), the same time step that the input
was received by the block. This indicates that the Normalization block has zero
algorithmic delay.

Zero Algorithmic Delay and Algebraic Loops

When several blocks with zero algorithmic delay are connected in a feedback loop,
Simulink may report an algebraic loop error and performance may generally suffer.
You can prevent algebraic loops by injecting at least one sample of delay into a feedback
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loop , for example, by including a Delay block with Delay > 0. For more information, see
“Algebraic Loops” in the Simulink documentation.

Basic Algorithmic Delay

The Variable Integer Delay block is an example of a block with algorithmic delay. In the
following example, you use this block to demonstrate this concept:

1 At the MATLAB command prompt, type ex_variableintegerdelay tut.

The Variable Integer Delay Example T1 opens.

'bi ex_variableintegerdelay_tut EI@
File Edit View Display Diagram Simulation Analysis Code Tools Help
]| = (il { (223

-@ & @2 4P & > T
| ex_variableintegerdelay_tut |

® ||Pa|ex_variableintegerdelay_tut hd

- In this example, the Variable Integer Delsy blodk

@ | [Variable Integer Delay Example T1| o ~7Pe "=

£

—+

[l
=}
=

j
0 W
Ea

1:100 | In . dsp_examples_yout
Z" Outfb— ol
Delay

To Waorkspace

Maotz: This mode| oreates a workspace va"DB’I.ET_‘DP.“:EwTE.T?ﬁWDNS Inc:

2

2 Double-click the Signal From Workspace block. The Source Block Parameters:

Signal From Workspace dialog box opens.

3  Set the block parameters as follows:

+ Signal=1:100

+ Sample time =1
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10

+ Samples per frame =1
Save these parameters and close the dialog box by clicking OK.

Double-click the Constant block. The Source Block Parameters: Constant dialog
box opens.

Set the block parameters as follows:

+ Constant value = 3
+ Interpret vector parameters as 1-D = Clear this check box
+ Sampling mode = Sample based

Sample time =1
Click OK to save these parameters and close the dialog box.

The input to the Delay port of the Variable Integer Delay block specifies the number
of sample periods that should elapse before an input to the In port is released to the
output. This value represents the block's algorithmic delay. In this example, since
the input to the Delay port is 3, and the sample period at the In and Delay ports

is 1, then the sample that arrives at the block's In port at time ¢=0 is released to the
output at time ¢=3.

Double-click the Variable Integer Delay block. The Function Block Parameters:
Variable Integer Delay dialog box opens.

Set the Initial conditions parameter to -1, and then click OK.

From the Display menu, point to Signals & Ports, and select Signal Dimensions
and Wide Nonscalar Lines.

Run the model.

The model should look similar to the following figure.
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11 At the MATLAB command prompt, type dsp_examples_yout

The output is shown below:

dsp_examples_yout =

-1
-1
-1
1
2
3

abrhwWNELO

The first column is the Simulink time provided by the Digital Clock block. The
second column is the delayed input. As expected, the input to the block at =0 is
delayed three samples and appears as the fourth output sample, at t=3. You can also
see that the first three outputs from the Variable Integer Delay block inherit the
value of the block's Initial conditions parameter, —-1. This period of time, from the
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start of the simulation until the first input is propagated to the output, is sometimes
called the initial delay of the block.

Many DSP System Toolbox blocks have some degree of fixed or adjustable algorithmic
delay. These include any blocks whose algorithms rely on delay or storage elements, such
as filters or buffers. Often, but not always, such blocks provide an Initial conditions
parameter that allows you to specify the output values generated by the block during the
initial delay. In other cases, the initial conditions are internally set to O.

Consult the block reference pages for the delay characteristics of specific DSP System
Toolbox blocks.

Excess Algorithmic Delay (Tasking Latency)

Under certain conditions, Simulink may force a block to delay inputs longer than is
strictly required by the block's algorithm. This excess algorithmic delay is called tasking
latency, because it arises from synchronization requirements of the Simulink tasking
mode. A block's overall algorithmic delay is the sum of its basic delay and tasking
latency.

Algorithmic delay = Basic algorithmic delay + Tasking latency

The tasking latency for a particular block may be dependent on the following block and
model characteristics:

* “Simulink Tasking Mode” on page 3-67

+  “Block Rate Type” on page 3-68

+ “Model Rate Type” on page 3-68

+ “Block Sample Mode” on page 3-68

Simulink Tasking Mode
Simulink has two tasking modes:

* Single-tasking

*  Multitasking

To select a mode, from the Simulation menu, select Model Configuration
Parameters. In the Select pane, click Solver. From the Type list, select Fixed-step.

From the Tasking mode for periodic sample times list, choose SingleTasking
or MultiTasking. If, from the Tasking mode for periodic sample times list you
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select Auto, the simulation runs in single-tasking mode if the model is single-rate, or
multitasking mode if the model is multirate.

Note: Many multirate blocks have reduced latency in the Simulink single-tasking mode.
Check the “Latency” section of a multirate block's reference page for details. Also see
“Time-Based Scheduling and Code Generation” in the Simulink Coder documentation.

Block Rate Type

A block is called single-rate when all of its input and output ports operate at the same
frame rate. A block is called multirate when at least one input or output port has a
different frame rate than the others.

Many blocks are permanently single-rate. This means that all input and output ports
always have the same frame rate. For other blocks, the block parameter settings
determine whether the block is single-rate or multirate. Only multirate blocks are subject
to tasking latency.

Note: Simulink may report an algebraic loop error if it detects a feedback loop composed
entirely of multirate blocks. To break such an algebraic loop, insert a single-rate block
with nonzero delay, such as a Unit Delay block. See the Simulink documentation for
more information about “Algebraic Loops”.

Model Rate Type

When all ports of all blocks in a model operate at a single frame rate, the model is called
single-rate. When the model contains blocks with differing frame rates, or at least one
multirate block, the model is called multirate. Note that Simulink prevents a single-rate
model from running in multitasking mode by generating an error.

Block Sample Mode

Many blocks can operate in either sample-based or frame-based modes. In source blocks,
the mode is usually determined by the Samples per frame parameter. If, for the
Samples per frame parameter, you enter 1, the block operates in sample-based mode.
If you enter a value greater than 1, the block operates in frame-based mode. In nonsource
blocks, the sample mode is determined by the input signal. See the block reference pages
for additional information about specific blocks.
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Predict Tasking Latency

The specific amount of tasking latency created by a particular combination of block
parameter and simulation settings is discussed in the “Latency” section of a block's
reference page. In this topic, you use the Upsample block's reference page to predict the
tasking latency of a model:

1 At the MATLAB command prompt, type ex_upsample_tutl.

The Upsample Example T1 model opens.

¥ ox_upsample_tutl o]l -]
File Edit View Display Diagram Simulation  Analysis Code Tools Help
= o] = (3 ( 1413
-8 a2 e84 b @~ » D e
ex_upsample_tutl
® |[*a ex_upsample_tutl h
& |Upsamp|e Example T1 | In this scample, the Upsample block introduces 17 semples of delay.
=
Digital C lock
| | To I—b dsp_examples_yout
1:100 v T4 | Sample —>
- To Workspace
Signal From Upsample Frame Conversion
‘Works pace
h ¥
Probe | Ts:[-1,0] Probel | Ts:[-1, 0]
v v
TEll'niI'lEtEl Terminator1
. . Copyright 2008-2010 The MathW orks, Inc.
Mote: This model oreates 8 wWorks PEOS VAN Dt comew ws e o -

»

2 From the Simulation menu, select Model Configuration Parameters.

3 Inthe Solver pane, from the Type list, select Fixed-step. From the Solver list,
select discrete (no continuous states).

4 From the Tasking mode for periodic sample times list, select MultiTasking,
and then click OK.
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Most multirate blocks experience tasking latency only in the Simulink multitasking
mode.

Double-click the Signal From Workspace block. The Source Block Parameters:
Signal From Workspace dialog box opens.

Set the block parameters as follows, and then click OK:

Signal =1:100
+ Sample time = 1/4
+ Samples per frame =4
Form output after final data value by = Setting to zero

Double-click the Upsample block. The Function Block Parameters: Upsample
dialog box opens.

Set the block parameters as follows, and then click OK:

+ Upsample factor, L =4
+ Sample offset (0 to L-1) =0
Input processing = Columns as channels (frame based)
+ Rate options = Allow multirate processing
Initial condition = -1
The Rate options parameter makes the model multirate, since the input and output
frame rates will not be equal.

Double-click the Digital Clock block. The Source Block Parameters: Digital
Clock dialog box opens.

Set the Sample time parameter to 0.25, and then click OK.

This matches the sample period of the Upsample block's output.

Double-click the Frame Conversion block. The Function Block Parameters:
Frame Conversion dialog box opens.

Set the Sampling mode of output signal parameter to Sample based, and then
click OK.

Run the model.

The model should now look similar to the following figure.
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'Pi ex_upsample_tutl EI@
File Edit View Display Diagram Simulation Analysis Code Tools Help
HE — o _ i

-8 & e MEIRYON 2 &~ » @~ @
ex_upsample_tutl

® ||"a|ex_upsample_tutl -
@ |Upsamp|e Example T1 | In this example, the Upsample blodk intreduces 17 samples of delay.

E3

=

Digital C lock

4xi] fax1] To J4xi] Iﬂb dsp_examples_yout
1:100 el T“' Hxi]| Sample

- To Waorkspace
Signal From Upsample Frame Conversion
Workspace
Py [l
Probe THA Probel | T0.25
Terminator Terminatort
o srim bk T D W AR T Rdekid!
Mote: This model crestes 8 works pace varisble called "dsp_scamples_yout :'}r’(s. Inc.

»

The model prepends the current value of the Simulink timer, from the Digital Clock
block, to each output frame. The Frame Conversion block converts the frame-based
signal into a sample-based signal so that the output in the MATLAB Command
Window is easily readable.

In the example, the Signal From Workspace block generates a new frame containing
four samples once every second (T, = m*4). The first few output frames are:

(t=0) [1 2 3 4]
(t=1) [5 6 7 8]
(t=2) [ 9 10 11 12]
(t=3) [13 14 15 16]
(t=4) [17 18 19 20]

The Upsample block upsamples the input by a factor of 4, inserting three zeros

between each input sample. The change in rates is confirmed by the Probe blocks in
the model, which show a decrease in the frame period from Ty = 1 to Ty, = 0.25.
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At the MATLAB command prompt, type squeeze(dsp_examples_yout)".

The output from the simulation is displayed in a matrix format. The first few
samples of the result, ans, are:

ans =

] -1.0000 0 0 0 lstautputframe
0.2500 -1.0000 0 0 0
0.5000 -1.0000 0 0 0
0.7500  -1.0000 0 0 0

1.0000 0 0 0 Sthoutput frame
1.2500 2.0000 0 0 0
1.5000 3.0000 0 0 0
1.7500 4.,0000 0 0 0
2.0000 5.0000 0 0 0

fime

“Latency and Initial Conditions” in the Upsample block's reference page indicates
that when Simulink is in multitasking mode, the first sample of the block's frame-
based input appears in the output as sample M;LL+D+1, where M; is the input frame
size, L 1s the Upsample factor, and D is the Sample offset. This formula predicts
that the first input in this example should appear as output sample 17 (that is,
4*44+0+1).

The first column of the output is the Simulink time provided by the Digital Clock
block. The four values to the right of each time are the values in the output frame at
that time. You can see that the first sample in each of the first four output frames
inherits the value of the Upsample block's Initial conditions parameter. As a result
of the tasking latency, the first input value appears as the first sample of the 5th
output frame (at ¢t=1). This is sample 17.

Now try running the model in single-tasking mode.

From the Simulation menu, select Model Configuration Parameters.

In the Solver pane, from the Type list, select Fixed-step. From the Solver list,
select Discrete (no continuous states).

From the Tasking mode for periodic sample times list, select SingleTasking.
Run the model.

The model now runs in single-tasking mode.
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19 At the MATLAB command prompt, type squeeze(dsp_examples_yout)”.

The first few samples of the result, ans, are:

ans =

] 1.0000 0 0 0 lstautputframe
0.2500 2.0000 ] ] ]
0.5000 3.0000 ] ] ]
0.7500 4.0000 ] ] ]

1.0000 5.0000 0 0 o Sthaoutpet frame
1.2500 6.0000 ] ] ]
1.5000 7.0000 ] ] ]
1.7500 8.0000 ] ] ]
2.0000 9.0000 ] ] ]

fime

“Latency and Initial Conditions” in the Upsample block's reference page indicates
that the block has zero latency for all multirate operations in the Simulink single-
tasking mode.

The first column of the output is the Simulink time provided by the Digital Clock
block. The four values to the right of each time are the values in the output frame

at that time. The first input value appears as the first sample of the first output
frame (at t=0). This is the expected behavior for the zero-latency condition. For the
particular parameter settings used in this example, running upsample_tutl in
single-tasking mode eliminates the 17-sample delay that is present when you run the
model in multitasking mode.

You have now successfully used the Upsample block's reference page to predict the
tasking latency of a model.
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Implementation

* “Design a Filter in Fdesign — Process Overview” on page 4-2

* “Design a Filter in the Filterbuilder GUI” on page 4-10

+ “Use FDATool with DSP System Toolbox Software” on page 4-14

+  “Digital Frequency Transformations” on page 4-77

+  “Digital Filter Design Block” on page 4-111

+  “Filter Realization Wizard” on page 4-121

+  “Digital Filter Implementations” on page 4-133

* “Analog Filter Design Block” on page 4-143

+ “Removing High-Frequency Noise from an ECG Signal” on page 4-145
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Design a Filter in Fdesign — Process Overview

4-2

Process Flow Diagram and Filter Design Methodology

+  “Exploring the Process Flow Diagram” on page 4-2

+ “Select a Response” on page 4-4

+ “Select a Specification” on page 4-4

+ “Select an Algorithm” on page 4-6

+ “Customize the Algorithm” on page 4-7

+  “Design the Filter” on page 4-8

+ “Design Analysis” on page 4-9

+ “Realize or Apply the Filter to Input Data” on page 4-9

Note: You must minimally have the Signal Processing Toolbox™ installed to use
fdesign and design. Some of the features described below may be unavailable if your
installation does not additionally include the DSP System Toolbox license. The DSP
System Toolbox significantly expands the functionality available for the specification,
design, and analysis of filters. You can verify the presence of both toolboxes by typing
ver at the command prompt.

Exploring the Process Flow Diagram

The process flow diagram shown in the following figure lists the steps and shows the
order of the filter design process.
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Select Response
help fdesignéesponzes

Select Specification
zetizpecOh), 'specification”)

Select Algorithm
designmethods(specObj)

Customize Algorithm
help (specobj, butter')

llllllllllllllllll+lllllllllllllllllllllllllllllﬂ

Design Filter
help fdesignidesign

Analysis and
Verification
help diitfanalysis
help
mfitifunctiors

Realize or
Apply Filter
to Input

Data
help diitifiter

e

Fessssesseeeennnsennnnnnun®

> Specifications Object

Implementation Ohbject
> (rofiltidfilt)

The first four steps of the filter design process relate to the filter Specifications Object,
while the last two steps involve the filter Implementation Object. Both of these objects
are discussed in more detail in the following sections. Step 5 - the design of the filter, is
the transition step from the filter Specifications Object to the Implementation object. The
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analysis and verification step is completely optional. It provides methods for the filter
designer to ensure that the filter complies with all design criteria. Depending on the
results of this verification, you can loop back to steps 3 and 4, to either choose a different
algorithm, or to customize the current one. You may also wish to go back to steps 3 or 4
after you filter the input data with the designed filter (step 7), and find that you wish to
tweak the filter or change it further.

The diagram shows the help command for each step. Enter the help line at the MATLAB
command prompt to receive instructions and further documentation links for the
particular step. Not all of the steps have to be executed explicitly. For example, you could
go from step 1 directly to step 5, and the interim three steps are done for you by the
software.

The following are the details for each of the steps shown above.
Select a Response

If you type:

help fdesign/responses
at the MATLAB command prompt, you see a list of all available filter responses. The
responses marked with an asterisk require the DSP System Toolbox.

You must select a response to initiate the filter. In this example, a bandpass filter
Specifications Object is created by typing the following:

d = fdesign.bandpass
Select a Specification

A specification is an array of design parameters for a given filter. The specification is a
property of the Specifications Object.

Note: A specification is not the same as the Specifications Object. A Specifications Object
contains a specification as one of its properties.

When you select a filter response, there are a number of different specifications available.
Each one contains a different combination of design parameters. After you create a

filter Specifications Object, you can query the available specifications for that response.
Specifications marked with an asterisk require the DSP System Toolbox.
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>> d = fdesign.bandpass; % step 1 - choose
>> set (d, “specification®)
ans =

"Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2”
“N,F3dB1,F3dB2*
"N,F3dB1,F3dB2,Ap*
“N,F3dB1,F3dB2,Ast"
"N,F3dB1,F3dB2,Astl,Ap,Ast2"
*N,F3dB1,F3dB2,BWp*"
“N,F3dB1,F3dB2,BWst*"
*N,Fcl,Fc2*

*N,Fpl,Fp2,Ap"
“N,Fpl,Fp2,Astl,Ap,Ast2*
*N,Fstl,Fpl,Fp2,Fst2*
“N,Fstl,Fpl,Fp2,Fst2,Ap*
“N,Fstl,Fst2,Ast"
“Nb,Na,Fstl,Fpl,Fp2,Fst2*

>> d=fdesign.arbmag;
>> set(d, "specification®)

ans

“N,F,A"
"N,B,F,A"

the response

The set command can be used to select one of the available specifications as follows:

>> d = fdesign.lowpass; % step 1
>> % step 2: get a list of available specifications

>> set (d,

ans

"specification®)

“"Fp,Fst,Ap,Ast"
“N,F3dB*
*N,F3dB,Ap*
"N,F3dB,Ap,Ast”
“N,F3dB,Ast"
“N,F3dB,Fst*
“N,Fc*
"N,Fc,Ap,Ast”
"N,Fp,Ap”
“N,Fp,Ap,Ast”
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*N,Fp,F3dB*
“N,Fp,Fst”
“N,Fp,Fst,Ap*
“N,Fp,Fst,Ast”
"N,Fst,Ap,Ast”
"N, Fst,Ast"
“*Nb,Na,Fp,Fst”

>> Ystep 2: set the required specification

>> set (d, “specification®, "N,Fc")

If you do not perform this step explicitly, Fdesign returns the default specification for
the response you chose in “Select a Response” on page 4-4, and provides default

values for all design parameters included in the specification.

Select an Algorithm

The availability of algorithms depends the chosen filter response, the design parameters,
and the availability of the DSP System Toolbox. In other words, for the same lowpass
filter, changing the specification string also changes the available algorithms. In the
following example, for a lowpass filter and a specification of *N, Fc", only one algorithm
is available—window.

>> Ystep 2: set the required specification

>> set (d, "specification®, "N,Fc")
>> designmethods (d) %step3: get available algorithms

Design Methods for class fdesign.lowpass (N,Fc):

window

However, for a specification of "Fp,Fst,Ap,Ast", a number of algorithms are available.
If the user has only the Signal Processing Toolbox installed, the following algorithms are
available:

>>set (d, “"specification®, "Fp,Fst,Ap,Ast")
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
chebyl
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cheby?2

ellip

equiripple

kaiserwin

If the user additionally has the DSP System Toolbox installed, the number of available
algorithms for this response and specification string increases:

>>set(d, "specification”, "Fp,Fst,Ap,Ast")
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter

chebyl

cheby?2

ellip

equiripple

ifir

kaiserwin

multistage

The user chooses a particular algorithm and implements the filter with the design

function.

>>Hd=design(d, "butter®);
The preceding code actually creates the filter, where Hd is the filter Implementation
Object. This concept i1s discussed further in the next step.

If you do not perform this step explicitly, design automatically selects the optimum
algorithm for the chosen response and specification.

Customize the Algorithm

The customization options available for any given algorithm depend not only on the
algorithm itself, selected in “Select an Algorithm” on page 4-6, but also on the
specification selected in “Select a Specification” on page 4-4. To explore all the
available options, type the following at the MATLAB command prompt:

help (d, "algorithm-name®)

where d is the Filter Specification Object, and algorithm-name is the name of the
algorithm in single quotes, such as "butter” or "chebyl”.
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The application of these customization options takes place while “Design the Filter”
on page 4-8, because these options are the properties of the filter Implementation
Object, not the Specification Object.

If you do not perform this step explicitly, the optimum algorithm structure is selected.
Design the Filter

This next task introduces a new object, the Filter Object, or dfi It. To create a filter, use
the design command:

>> % design Filter w/o specifying the algorithm

>> Hd = design(d);

where Hd is the Filter Object and d is the Specifications Object. This code creates a filter
without specifying the algorithm. When the algorithm is not specified, the software
selects the best available one.

To apply the algorithm chosen in “Select an Algorithm” on page 4-6, use the same
design command, but specify the Butterworth algorithm as follows:

>> Hd = design(d, "butter®);
where Hd is the new Filter Object, and d is the Specifications Object.

To obtain help and see all the available options, type:

>> help fdesign/design

This help command describes not only the options for the design command itself, but
also options that pertain to the method or the algorithm. If you are customizing the
algorithm, you apply these options in this step. In the following example, you design a
bandpass filter, and then modify the filter structure:

>> Hd = design(d, "butter®, "filterstructure®, "df2sos")
f =

FilterStructure: "Direct-Form 11, Second-Order Sections”
Arithmetic: “"double”
sosMatrix: [7x6 double]
ScaleValues: [8x1 double]
PersistentMemory: false

The filter design step, just like the first task of choosing a response, must be performed
explicitly. A Filter Object is created only when design is called.
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Design Analysis

After the filter is designed you may wish to analyze it to determine if the filter satisfies
the design criteria. Filter analysis is broken into three main sections:

*  Frequency domain analysis — Includes the magnitude response, group delay, and
pole-zero plots.
* Time domain analysis — Includes impulse and step response

* Implementation analysis — Includes quantization noise and cost
To display help for analysis of a discrete-time filter, type:

>> help dfilt/analysis
To display help for analysis of a multirate filter, type:

>> help mfilt/functions
To analyze your filter, you must explicitly perform this step.

Realize or Apply the Filter to Input Data

After the filter is designed and optimized, it can be used to filter actual input data. The
basic filter command takes input data X, filters it through the Filter Object, and produces
output y:

>> y = filter (FilterObj, x)
This step is never automatically performed for you. To filter your data, you must
explicitly execute this step. To understand how the filtering commands work, type:

>> help dfilt/filter

Note: If you have Simulink, you have the option of exporting this filter to a Simulink
block using the realizemdl command. To get help on this command, type:

>> help realizemdl
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Design a Filter in the Filterbuilder GUI

4-10

The Graphical Interface to Fdesign

*  “Introduction to Filterbuilder” on page 4-10

+  “Filterbuilder Design Process” on page 4-10

+ “Select a Response” on page 4-11

+ “Select a Specification” on page 4-11

+ “Select an Algorithm” on page 4-12

* “Customize the Algorithm” on page 4-12

+  “Analyze the Design” on page 4-12

+ “Realize or Apply the Filter to Input Data” on page 4-13

Introduction to Filterbuilder

The filterbui lder function provides a graphical interface to the fdesign object-
oriented filter design paradigm and is intended to reduce development time during the
filter design process. Filterbuilder uses a specification-centered approach to find the
best filter for the desired response.

Note: filterbuilder requires the Signal Processing Toolbox. The functionality of
Filterbuilder is greatly expanded by the DSP System Toolbox. Some of the features
described or displayed below are only available if the DSP System Toolbox is installed.
You may verify your installation by typing ver at the command prompt.

Filterbuilder Design Process

The design process when using Filterbuilder is similar to the process outlined in
the section titled “Process Flow Diagram and Filter Design Methodology” in the Getting
Started guide. The idea is to choose the constraints and specifications of the filter, and
to use those as a starting point in the design. Postponing the choice of algorithm for

the filter allows the best design method to be determined automatically, based upon
the desired performance criteria. The following are the details of each of the steps for
designing a filter with filterbuilder.
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Select a Response

When you open the Filterbuilder tool by typing:

filterbuilder

at the MATLAB command prompt, the Response Selection dialog box appears, listing
all possible filter responses available in the software. If you have the DSP System
Toolbox software installed, you have access to the full complement of filter responses.

Note: This step cannot be skipped because it is not automatically completed for you by
the software. You must select a response to initiate the filter design process.

After you choose a response, say bandpass, you start the design of the Specifications
Object, and the Bandpass Design dialog box appears. This dialog box contains a Main
pane, a Data Types pane and a Code Generation pane. The specifications of your filter
are generally set in the Main pane of the dialog box.

The Data Types pane provides settings for precision and data types, and the Code
Generation pane contains options for various implementations of the completed filter
design.

For the initial design of your filter, you will mostly use the Main pane.

The Bandpass Design dialog box contains all the parameters you need to determine
the specifications of a bandpass filter. The parameters listed in the Main pane depend
upon the type of filter you are designing. However, no matter what type of filter you have
chosen in the Response Selection dialog box, the filter design dialog box contains the
Main, Data Types, and Code Generation panes.

Select a Specification

To choose the specification for the bandpass filter, you can begin by selecting an Impulse
Response, Order Mode, and Filter Type in the Filter Specifications frame of the
Main Pane. You can further specify the response of your filter by setting frequency and
magnitude specifications in the appropriate frames on the Main Pane.

Note: Frequency, Magnitude, and Algorithm specifications are interdependent
and may change based upon your Filter Specifications selections. When choosing
specifications for your filter, select your Filter Specifications first and work your
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way down the dialog box- this approach ensures that the best settings for dependent
specifications display as available in the dialog box.

Select an Algorithm

The algorithms available for your filter depend upon the filter response and design
parameters you have selected in the previous steps. For example, in the case of a
bandpass filter, if the impulse response selected 1s IIR and the Order Mode field is set
toMinimum, the design methods available are Butterworth, Chebyshev type I or II,
or Elliptic, whereas if the Order Mode field is set to Specify, the design method
available is 1R least p-norm.

Customize the Algorithm

By expanding the Design options section of the Algorithm frame, you can further
customize the algorithm specified. The options available will depend upon the algorithm
and settings that have already been selected in the dialog box. In the case of a bandpass
IIR filter using the Butterworth method, design options such as Match Exactly are
available.

Analyze the Design

To analyze the filter response, click on the View Filter Response button. The Filter
Visualization Tool opens displaying the magnitude plot of the filter response.

lMagnitude Responze (dB)

Magnitude [dB)

i
0 0.1 0z 0.3 0.4 0.5 06 o7 0.5 (U]

Mormalized Fregquency (=nrad/zample)
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Realize or Apply the Filter to Input Data

When you have achieved the desired filter response through design iterations and
analysis using the Filter Visualization Tool, apply the filter to the input data. Again,
this step is never automatically performed for you by the software. To filter your data,
you must explicitly execute this step. In the Filter Visualization Tool, click OK and
DSP System Toolbox software creates the filter object with the name specified in the
Save variable as field and exports it to the MATLAB workspace.

The filter is then ready to be used to filter actual input data. The basic filter command
takes input data X, filters it through the Filter Object, and produces output y:

>> y = filter (FilterObj, x)
To understand how the filtering commands work, type:

>> help dfilt/filter

Tip If you have Simulink, you have the option of exporting this filter to a Simulink block
using the realizemdl command. To get help on this command, type:

>> help realizemdl
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Use FDATool with DSP System Toolbox Software

In this section...

“Design Advanced Filters in FDATool” on page 4-14

“Access the Quantization Features of FDATool” on page 4-18
“Quantize Filters in FDATool” on page 4-20

“Analyze Filters with a Noise-Based Method” on page 4-28
“Scale Second-Order Section Filters” on page 4-33

“Reorder the Sections of Second-Order Section Filters” on page 4-37
“View SOS Filter Sections” on page 4-42

“Import and Export Quantized Filters” on page 4-47
“Generate MATLAB Code” on page 4-52

“Import XILINX Coefficient ((COE) Files” on page 4-53
“Transform Filters Using FDATool” on page 4-53

“Design Multirate Filters in FDATool” on page 4-62

“Realize Filters as Simulink Subsystem Blocks” on page 4-74

Design Advanced Filters in FDATool

* “Overview of FDATool Features” on page 4-14
+ “Use FDATool with DSP System Toolbox Software” on page 4-15
+ “Design a Notch Filter” on page 4-16

Overview of FDATool Features

DSP System Toolbox software adds new dialog boxes and operating modes, and

new menu selections, to the Filter Design and Analysis Tool (FDATool) provided by
Signal Processing Toolbox software. From the additional dialog boxes, one titled Set
Quantization Parameters and one titled Frequency Transformations, you can:

* Design advanced filters that Signal Processing Toolbox software does not provide the
design tools to develop.
+  View Simulink models of the filter structures available in the toolbox.

* Quantize double-precision filters you design in this GUI using the design mode.
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* Quantize double-precision filters you import into this GUI using the import mode.
* Analyze quantized filters.
* Scale second-order section filters.

+ Select the quantization settings for the properties of the quantized filter displayed by
the tool:

+  Coefficients — select the quantization options applied to the filter coefficients
Input/output — control how the filter processes input and output data
Filter Internals — specify how the arithmetic for the filter behaves
* Design multirate filters.
*  Transform both FIR and IIR filters from one response to another.

After you import a filter into FDATool, the options on the quantization dialog box let you
quantize the filter and investigate the effects of various quantization settings.

Options in the frequency transformations dialog box let you change the frequency
response of your filter, keeping various important features while changing the response
shape.

Use FDATool with DSP System Toolbox Software

Adding DSP System Toolbox software to your tool suite adds a number of filter design
techniques to FDATool. Use the new filter responses to develop filters that meet more
complex requirements than those you can design in Signal Processing Toolbox software.
While the designs in FDATool are available as command line functions, the graphical
user interface of FDATool makes the design process more clear and easier to accomplish.

As you select a response type, the options in the right panes in FDATool change to let
you set the values that define your filter. You also see that the analysis area includes
a diagram (called a design mask) that describes the options for the filter response you
choose.

By reviewing the mask you can see how the options are defined and how to use them.
While this is usually straightforward for lowpass or highpass filter responses, setting
the options for the arbitrary response types or the peaking/notching filters is more
complicated. Having the masks leads you to your result more easily.

Changing the filter design method changes the available response type options.
Similarly, the response type you select may change the filter design methods you can
choose.
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Design a Notch Filter

Notch filters aim to remove one or a few frequencies from a broader spectrum. You
must specify the frequencies to remove by setting the filter design options in FDATool
appropriately:
* Response Type
* Design Method
*  Frequency Specifications
*  Magnitude Specifications
Here is how you design a notch filter that removes concert A (440 Hz) from an input
musical signal spectrum.
Select Notching from the Differentiator list in Response Type.
2 Select IIR in Filter Design Method and choose Single Notch from the list.

For the Frequency Specifications, set Units to Hz and Fs, the full scale
frequency, to 1000.

4  Set the location of the center of the notch, in either normalized frequency or Hz. For
the notch center at 440 Hz, enter 440.

5 To shape the notch, enter the bandwidth, bw, to be 40.

Leave the Magnitude Specification in dB (the default) and leave Apass as 1.
7  Click Design Filter.

FDATool computes the filter coefficients and plots the filter magnitude response in
the analysis area for you to review.

When you design a single notch filter, you do not have the option of setting the filter
order — the Filter Order options are disabled.

Your filter should look about like this:
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Chck and drag to move the document bar...

For more information about a design method, refer to the online Help system. For
instance, to get further information about the Q setting for the notch filter in FDATool,
enter

doc iirnotch

at the command line. This opens the Help browser and displays the reference page for
function iirnotch.
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4-18

Designing other filters follows a similar procedure, adjusting for different design
specification options as each design requires.

Any one of the designs may be quantized in FDATool and analyzed with the available
analyses on the Analysis menu.

Access the Quantization Features of FDATool

You use the quantization panel in FDATool to quantize filters. Quantization

represents the fourth operating mode for FDATool, along with the filter design, filter
transformation, and import modes. To switch to quantization mode, open FDATool from
the MATLAB command prompt by entering

fdatool

When FDATool opens, click the Set Quantization Parameters button on the side bar.
FDATool switches to quantization mode and you see the following panel at the bottom of
FDATool, with the default double-precision option shown for Filter arithmetic.
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There are no additional settings for Double-precision fleating-point arithmetic.

Loading the Filter Quantization panel ... done

The Filter arithmetic option lets you quantize filters and investigate the effects of

changing quantization settings. To enable the quantization settings in FDATool, select

Fixed-point from the Filter Arithmetic.

The quantization options appear in the lower panel of FDATool. You see tabs that access
various sets of options for quantizing your filter.

You use the following tabs in the dialog box to perform tasks related to quantizing filters

in FDATool:

+ Coefficients provides access the settings for defining the coefficient quantization.

This is the default active panel when you switch FDATool to quantization mode
without a quantized filter in the tool. When you import a fixed-point filter into

FDATool, this is the active pane when you switch to quantization mode.
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4-20

+  Input/Output switches FDATool to the options for quantizing the inputs and outputs
for your filter.

+ Filter Internals lets you set a variety of options for the arithmetic your filter
performs, such as how the filter handles the results of multiplication operations or
how the filter uses the accumulator.

+ Apply — applies changes you make to the quantization parameters for your filter.

Quantize Filters in FDATool

+  “Set Quantization Parameters” on page 4-20

+ “Coefficients Options” on page 4-20

*  “Input/Output Options” on page 4-22

+  “Filter Internals Options” on page 4-24

+  “Filter Internals Options for CIC Filters” on page 4-26

Set Quantization Parameters

Quantized filters have properties that define how they quantize data you filter. Use
the Set Quantization Parameters dialog box in FDATool to set the properties. Using
options in the Set Quantization Parameters dialog box, FDATool lets you perform a
number of tasks:

+ Create a quantized filter from a double-precision filter after either importing the filter
from your workspace, or using FDATool to design the prototype filter.

* Create a quantized filter that has the default structure (Direct form II transposed) or
any structure you choose, and other property values you select.

+ Change the quantization property values for a quantized filter after you design the
filter or import it from your workspace.

When you click Set Quantization Parameters, and then change Filter arithmetic
to Fixed-point, the quantized filter panel opens in FDATool, with the coefficient
quantization options set to default values.

Coefficients Options

To let you set the properties for the filter coefficients that make up your quantized
filter, FDATool lists options for numerator word length (and denominator word length
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if you have an IIR filter). The following table lists each coefficients option and a short
description of what the option setting does in the filter.

Option Name

When Used

Description

Numerator Word Length

FIR filters only

Sets the word length used to
represent numerator coefficients in
FIR filters.

Numerator Frac. Length FIR/TIR Sets the fraction length used to
Interpret numerator coefficients in
FIR filters.

Numerator Range (+/-) FIR/TIR Lets you set the range the

numerators represent. You use this
instead of the Numerator Frac.
Length option to set the precision.
When you enter a value x, the
resulting range is -x to x. Range must
be a positive integer.

Coefficient Word Length

IIR filters only

Sets the word length used to
represent both numerator and
denominator coefficients in IIR
filters. You cannot set different
word lengths for the numerator and
denominator coefficients.

Denominator Frac. Length

IIR filters

Sets the fraction length used to
interpret denominator coefficients in
IIR filters.

Denominator Range (+/-)

IIR filters

Lets you set the range the
denominator coefficients represent.
You use this instead of the
Denominator Frac. Length option
to set the precision. When you enter a
value x, the resulting range is -x to x.
Range must be a positive integer.

Best-precision fraction
lengths

All filters

Directs FDATool to select the
fraction lengths for numerator (and
denominator where available) values
to maximize the filter performance.
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Option Name

When Used

Description

Selecting this option disables all of
the fraction length options for the
filter.

Scale Values frac. length

SOS IIR filters

Sets the fraction length used to
interpret the scale values in SOS
filters.

Scale Values range (+/-)

SOS IIR filters

Lets you set the range the SOS scale
values represent. You use this with
SOS filters to adjust the scaling used
between filter sections. Setting this
value disables the Scale Values
frac. length option. When you enter
a value x, the resulting range is -x to
x. Range must be a positive integer.

Use unsigned
representation

All filters

Tells FDATool to interpret the
coefficients as unsigned values.

Scale the numerator
coefficients to fully utilize
the entire dynamic range

All filters

Directs FDATool to scale the
numerator coefficients to effectively
use the dynamic range defined by the
numerator word length and fraction
length format.

Input/Ovutput Options

The options that specify how the quantized filter uses input and output values are listed

in the table below.

Option Name When Used

Description

Input Word Length All filters

Sets the word length used to represent the
input to a filter.

Input fraction length |All filters

Sets the fraction length used to interpret
input values to filter.

4-22

Input range (+/-) All filters

Lets you set the range the inputs
represent. You use this instead of the
Input fraction length option to set the
precision. When you enter a value x, the
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Option Name

When Used

Description

resulting range is -x to x. Range must be a
positive integer.

Output word length

All filters

Sets the word length used to represent the
output from a filter.

Avoid overflow

All filters

Directs the filter to set the fraction length
for the input to prevent the output values
from exceeding the available range as
defined by the word length. Clearing

this option lets you set Output fraction
length.

Output fraction length

All filters

Sets the fraction length used to represent
output values from a filter.

Output range (+/-)

All filters

Lets you set the range the outputs
represent. You use this instead of the
Output fraction length option to set the
precision. When you enter a value x, the
resulting range is -x to x. Range must be a
positive integer.

Stage input word
length

SOS filters only

Sets the word length used to represent the
input to an SOS filter section.

Avoid overflow

SOS filters only

Directs the filter to use a fraction length
for stage inputs that prevents overflows

in the values. When you clear this option,
you can set Stage input fraction length.

Stage input fraction
length

SOS filters only

Sets the fraction length used to represent
input to a section of an SOS filter.

Stage output word
length

SOS filters only

Sets the word length used to represent the
output from an SOS filter section.

Avoid overflow

SOS filters only

Directs the filter to use a fraction length
for stage outputs that prevents overflows
in the values. When you clear this option,
you can set Stage output fraction
length.
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Option Name When Used

Description

Stage output fraction |SOS filters only
length

Sets the fraction length used to represent
the output from a section of an SOS filter.

Filter Internals Options

The options that specify how the quantized filter performs arithmetic operations are

listed in the table below.

4-24

Option Equivalent Filter Property Description
(Using Wildcard *)

Round towards RoundMode Sets the mode the filter uses to quantize
numeric values when the values lie
between representable values for the data
format (word and fraction lengths). Choose
from one of:

+ celil - Round toward positive infinity.

+ convergent - Round to the closest
representable integer. Ties round to the
nearest even stored integer. This is the
least biased of the methods available in
this software.
fix/zero - Round toward zero.

Floor - Round toward negative
infinity.

+ nearest - Round toward nearest. Ties
round toward positive infinity.

+ round - Round toward nearest. Ties
round toward negative infinity for
negative numbers, and toward positive
infinity for positive numbers.

Overflow Mode OverflowMode Sets the mode used to respond to overflow
conditions in fixed-point arithmetic.
Choose from either saturate (limit
the output to the largest positive or
negative representable value) or wrap
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Option

Equivalent Filter Property
(Using Wildcard *)

Description

(set overflowing values to the nearest
representable value using modular
arithmetic.

Filter Product (Multiply) Options

Product Mode

ProductMode

Determines how the filter handles the
output of product operations. Choose
from full precision (Ful lPrecision),

or whether to keep the most significant
bit (KeepMSB) or least significant bit
(KeepLSB) in the result when you need to
shorten the word length. Specify all
lets you set the fraction length applied to
the results of product operations.

Product word length

*ProdWordLength

Sets the word length applied to interpret
the results of multiply operations.

Num. fraction length

NumProdFracLength

Sets the fraction length used to interpret
the results of product operations that
involve numerator coefficients.

Den. fraction length

DenProdFracLength

Sets the fraction length used to interpret
the results of product operations that
involve denominator coefficients.

Filter Sum Options

Accum. mode

AccumMode

Determines how the accumulator outputs
stored values. Choose from full precision
(FullPrecision), or whether to keep the
most significant bits (KeepMSB) or least
significant bits (KeepLSB) when output
results need shorter word length than

the accumulator supports. To let you set
the word length and the precision (the
fraction length) used by the output from
the accumulator, set this to Specify all.

Accum. word length

*AccumWordLength

Sets the word length used to store data in
the accumulator/buffer.
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Option Equivalent Filter Property Description
(Using Wildcard *)

Num. fraction length |NumAccumFraclLength Sets the fraction length used to interpret
the numerator coefficients.

Den. fraction length DenAccumFraclLength Sets the fraction length the filter uses to
interpret denominator coefficients.

Cast signals before CastBeforeSum Specifies whether to cast numeric data to

sum the appropriate accumulator format (as
shown in the signal flow diagrams for each
filter structure) before performing sum
operations.

Filter State Options

State word length *StateWordLength Sets the word length used to represent the
filter states. Applied to both numerator-
and denominator-related states

Avoid overflow None Prevent overflows in arithmetic
calculations by setting the fraction length
appropriately.

State fraction length |*StateFraclLength Lets you set the fraction length applied

to interpret the filter states. Applied to
both numerator- and denominator-related
states

Note: When you apply changes to the values in the Filter Internals pane, the plots for
the Magnitude response estimate and Round-off noise power spectrum analyses
update to reflect those changes. Other types of analyses are not affected by changes to
the values in the Filter Internals pane.

Filter Internals Options for CIC Filters

CIC filters use slightly different options for specifying the fixed-point arithmetic in the
filter. The next table shows and describes the options.
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Quantize Double-Precision Filters

When you are quantizing a double-precision filter by switching to fixed-point or single-
precision floating point arithmetic, follow these steps.

1

Click Set Quantization Parameters to display the Set Quantization
Parameters pane in FDATool.

Select Single-precision floating point or Fixed-point from Filter
arithmetic.

When you select one of the optional arithmetic settings, FDATool quantizes the
current filter according to the settings of the options in the Set Quantization
Parameter panes, and changes the information displayed in the analysis area to
show quantized filter data.

In the quantization panes, set the options for your filter. Set options for
Coefficients, Input/Output, and Filter Internals.

Click Apply.

FDATool quantizes your filter using your new settings.

Use the analysis features in FDATool to determine whether your new quantized
filter meets your requirements.

Change the Quantization Properties of Quantized Filters

When you are changing the settings for the quantization of a quantized filter, or after
you import a quantized filter from your MATLAB workspace, follow these steps to set the
property values for the filter:

Verify that the current filter is quantized.

Click Set Quantization Parameters to display the Set Quantization
Parameters panel.

Review and select property settings for the filter quantization: Coefficients, Input/
Output, and Filter Internals. Settings for options on these panes determine how
your filter quantizes data during filtering operations.

Click Apply to update your current quantized filter to use the new quantization
property settings from Step 3.

Use the analysis features in FDATool to determine whether your new quantized
filter meets your requirements.
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Analyze Filters with a Noise-Based Method

+  “Analyze Filters with the Magnitude Response Estimate Method” on page 4-28
+ “Compare the Estimated and Theoretical Magnitude Responses” on page 4-31
+  “Select Quantized Filter Structures” on page 4-31

+ “Convert the Structure of a Quantized Filter” on page 4-32

+ “Convert Filters to Second-Order Sections Form” on page 4-32
Analyze Filters with the Magnitude Response Estimate Method

After you design and quantize your filter, the Magnitude Response Estimate option
on the Analysis menu lets you apply the noise loading method to your filter. When
you select Analysis > Magnitude Response Estimate from the menu bar, FDATool
immediately starts the Monte Carlo trials that form the basis for the method and runs
the analysis, ending by displaying the results in the analysis area in FDATool.

With the noise-based method, you estimate the complex frequency response for your
filter as determined by applying a noise- like signal to the filter input. Magnitude
Response Estimate uses the Monte Carlo trials to generate a noise signal that contains
complete frequency content across the range 0 to F's. The first time you run the analysis,
magnitude response estimate uses default settings for the various conditions that define
the process, such as the number of test points and the number of trials.

Analysis Parameter Default Setting Description

Number of Points 512 Number of equally spaced points
around the upper half of the unit circle.

Frequency Range 0 to Fs/2 Frequency range of the plot x-axis.

Frequency Units Hz Units for specifying the frequency
range.

Sampling Frequency 48000 Inverse of the sampling period.

Frequency Scale dB Units used for the y-axis display of the
output.

Normalized Frequency |OfF Use normalized frequency for the
display.

After your first analysis run ends, open the Analysis Parameters dialog box and adjust
your settings appropriately, such as changing the number of trials or number of points.

4-28



Use FDATool with DSP System Toolbox Software

To open the Analysis Parameters dialog box, use either of the next procedures when
you have a quantized filter in FDATool:

+ Select Analysis > Analysis Parameters from the menu bar

+ Right-click in the filter analysis area and select Analysis Parameters from the
context menu

Whichever option you choose opens the dialog box. Notice that the settings for the options
reflect the defaults.

Noise Method Applied to a Filter

To demonstrate the magnitude response estimate method, start by creating a quantized
filter. For this example, use FDATool to design a sixth-order Butterworth IIR filter.

To Use Noise-Based Analysis in FDATool
Enter fdatool at the MATLAB prompt to launch FDATool.

Under Response Type, select Highpass.
Select 11R in Design Method. Then select Butterworth.

B W N —

To set the filter order to 6, select Specify order under Filter Order. Enter 6 in the
text box.

5 Click Design Filter.
In FDATool, the analysis area changes to display the magnitude response for your
filter.

6 To generate the quantized version of your filter, using default quantizer settings,
click 2 on the side bar.

FDATool switches to quantization mode and displays the quantization panel.

7 From Filter arithmetic, select Fixed-point.
Now the analysis areas shows the magnitude response for both filters — your
original filter and the fixed-point arithmetic version.

8 Finally, to use noise-based estimation on your quantized filter, select Analysis >

Magnitude Response Estimate from the menu bar.

FDATool runs the trial, calculates the estimated magnitude response for the filter,
and displays the result in the analysis area as shown in this figure.
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In the above figure you see the magnitude response as estimated by the analysis
method.

View the Noise Power Spectrum

When you use the noise method to estimate the magnitude response of a filter, FDATool
simulates and applies a spectrum of noise values to test your filter response. While the
simulated noise is essentially white, you might want to see the actual spectrum that
FDATool used to test your filter.

From the Analysis menu bar option, select Round-off Noise Power Spectrum. In the
analysis area in FDATool, you see the spectrum of the noise used to estimate the filter
response. The details of the noise spectrum, such as the range and number of data points,
appear in the Analysis Parameters dialog box.

For more information, refer to McClellan, et al., Computer-Based Exercises for Signal
Processing Using MATLAB 5, Prentice-Hall, 1998. See Project 5: Quantization Noise in
Digital Filters, page 231.

Change Your Noise Analysis Parameters

In “Noise Method Applied to a Filter” on page 4-29, you used synthetic white noise

to estimate the magnitude response for a fixed-point highpass Butterworth filter. Since
you ran the estimate only once in FDATool, your noise analysis used the default analysis
parameters settings shown in “Analyze Filters with the Magnitude Response Estimate
Method” on page 4-28.
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To change the settings, follow these steps after the first time you use the noise estimate
on your quantized filter.

1 With the results from running the noise estimating method displayed in the
FDATool analysis area, select Analysis > Analysis Parameters from the menu
bar.

To give you access to the analysis parameters, the Analysis Parameters dialog box
opens (with default settings).

2 To use more points in the spectrum to estimate the magnitude response, change
Number of Points to 1024 and click OK to run the analysis.

FDATool closes the Analysis Parameters dialog box and reruns the noise estimate,
returning the results in the analysis area.

To rerun the test without closing the dialog box, press Enter after you type your new
value into a setting, then click Apply. Now FDATool runs the test without closing
the dialog box. When you want to try many different settings for the noise-based
analysis, this is a useful shortcut.

Compare the Estimated and Theoretical Magnitude Responses

An important measure of the effectiveness of the noise method for estimating the
magnitude response of a quantized filter is to compare the estimated response to the
theoretical response.

One way to do this comparison is to overlay the theoretical response on the estimated
response. While you have the Magnitude Response Estimate displaying in FDATool,
select Analysis > Overlay Analysis from the menu bar. Then select Magnitude
Response to show both response curves plotted together in the analysis area.

Select Quantized Filter Structures

FDATool lets you change the structure of any quantized filter. Use the Convert
structure option to change the structure of your filter to one that meets your needs.

To learn about changing the structure of a filter in FDATool, refer to “Converting the
Filter Structure” in your Signal Processing Toolbox documentation.
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Convert the Structure of a Quantized Filter

You use the Convert structure option to change the structure of filter. When the
Source is Designed(Quantized) or Imported(Quantized), Convert structure lets
you recast the filter to one of the following structures:

* “Direct Form II Transposed Filter Structure”

* “Direct Form I Transposed Filter Structure”

* “Direct Form II Filter Structure”

+ “Direct Form I Filter Structure”

* “Direct Form Finite Impulse Response (FIR) Filter Structure”

+ “Direct Form FIR Transposed Filter Structure”

+  “Lattice Autoregressive Moving Average (ARMA) Filter Structure”

+ dfilt.calattice

+ dfilt._calatticepc

* “Direct Form Antisymmetric FIR Filter Structure (Any Order)”

Starting from any quantized filter, you can convert to one of the following representation:

*  Direct form I

*  Direct form IT

+ Direct form I transposed
*  Direct form II transposed
*  Lattice ARMA

Additionally, FDATool lets you do the following conversions:

*  Minimum phase FIR filter to Lattice MA minimum phase
*  Maximum phase FIR filter to Lattice MA maximum phase

+ Allpass filters to Lattice allpass
Refer to “FilterStructure” for details about each of these structures.
Convert Filters to Second-Order Sections Form

To learn about using FDATool to convert your quantized filter to use second-order
sections, refer to “Converting to Second-Order Sections” in your Signal Processing
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Toolbox documentation. You might notice that filters you design in FDATool, rather than
filters you imported, are implemented in SOS form.

View Filter Structures in FDATool

To open the demonstration, click Help > Show filter structures. After the Help
browser opens, you see the reference page for the current filter. You find the filter
structure signal flow diagram on this reference page, or you can navigate to reference
pages for other filter.

Scale Second-Order Section Filters

+ “Use the Reordering and Scaling Second-Order Sections Dialog Box” on page 4-33
+ “Scale an SOS Filter” on page 4-35

Use the Reordering and Scaling Second-Order Sections Dialog Box

FDATool provides the ability to scale SOS filters after you create them. Using options on
the Reordering and Scaling Second-Order Sections dialog box, FDATool scales either or
both the filter numerators and filter scale values according to your choices for the scaling
options.
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Parameter

Description and Valid Value

Scale

Apply any scaling options to the filter. Select this when
you are reordering your SOS filter and you want to scale it
at the same time. Or when you are scaling your filter, with
or without reordering. Scaling is disabled by default.

No Overflow — High
SNR slider

Lets you set whether scaling favors reducing arithmetic
overflow in the filter or maximizing the signal-to-noise
ratio (SNR) at the filter output. Moving the slider to the
right increases the emphasis on SNR at the expense of
possible overflows. The markings indicate the P-norm
applied to achieve the desired result in SNR or overflow
protection. For more information about the P-norm
settings, refer to norm for details.

Maximum Numerator

Maximum allowed value for numerator coefficients after
scaling.

Numerator Constraint

Specifies whether and how to constrain numerator
coefficient values. Options are none, normalize,

power of 2, and unit. Choosing none lets the scaling
use any scale value for the numerators by removing

any constraints on the numerators, except that the
coefficients will be clipped if they exceed the Maximum
Numerator. With Normal ize the maximum absolute
value of the numerator is forced to equal the Maximum
Numerator value (for all other constraints, the
Maximum Numerator is only an upper limit, above
which coefficients will be clipped). The power of 2 option
forces scaling to use numerator values that are powers of
2, such as 2 or 0.5. With unit, the leading coefficient of
each numerator is forced to a value of 1.

Overflow Mode

Sets the way the filter handles arithmetic overflow
situations during scaling. Choose from either saturate
(limit the output to the largest positive or negative
representable value) or wrap (set overflowing values to the
nearest representable value using modular arithmetic.
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Parameter

Description and Valid Value

Scale Value Constraint

Specify whether to constrain the filter scale values, and
how to constrain them. Valid options are unit, power of
2, and none. Choosing unit for the constraint disables the
Max. Scale Value setting and forces scale values to equal
1. Power of 2 constrains the scale values to be powers of
2, such as 2 or 0.5, while hone removes any constraint on
the scale values, except that they cannot exceed the Max.
Scale Value.

Max. Scale Value

Sets the maximum allowed scale values. SOS filter scaling
applies the Max. Scale Value limit only when you set
Scale Value Constraint to a value other than unit (the
default setting). Setting a maximum scale value removes
any other limits on the scale values.

Revert to Original Filter

Returns your filter to the original scaling. Being able to
revert to your original filter makes it easier to assess the
results of scaling your filter.

Various combinations of settings let you scale filter numerators without changing the
scale values, or adjust the filter scale values without changing the numerators. There is
no scaling control for denominators.

Scale an SOS Filter

Start the process by designing a lowpass elliptical filter in FDATool.

Launch FDATool.

o 0 A WN —

In Response Type, select Lowpass.

In Design Method, select IIR and ElNliptic from the ITR design methods list.
Select Minimum Order for the filter.

Switch the frequency units by choosing Normalized(0 to 1) from the Units list.

To set the passband specifications, enter 0.45 for wpass and 0.55 for wstop.

Finally, in Magnitude Specifications, set Astop to 60.
7 Click Design Filter to design the filter.

After FDATool finishes designing the filter, you see the following plot and settings in

the tool.
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You kept the Options setting for Match exactly as both, meaning the filter design
matches the specification for the passband and the stopband.

8 To switch to scaling the filter, select Edit > Reorder and Scale Second-Order
Sections from the menu bar.

9 To see the filter coefficients, return to FDATool and select Filter Coefficients from
the Analysis menu. FDATool displays the coefficients and scale values in FDATool.

With the coefficients displayed you can see the effects of scaling your filter directly in the
scale values and filter coefficients.
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Now try scaling the filter in a few different ways. First scale the filter to maximize the
SNR.

1 Return to the Reordering and Scaling Second-Order Sections dialog box
and select None for Reordering in the left pane. This prevents FDATool from
reordering the filter sections when you rescale the filter.

2 Move the No Overflow—High SNR slider from No Overflow to High SNR.
3 Click Apply to scale the filter and leave the dialog box open.

After a few moments, FDATool updates the coefficients displayed so you see the new
scaling.

All of the scale factors are now 1, and the SOS matrix of coefficients shows that
none of the numerator coefficients are 1 and the first denominator coefficient of each
section is 1.

4 Click Revert to Original Filter to restore the filter to the original settings for
scaling and coefficients.

Reorder the Sections of Second-Order Section Filters
Reorder Filters Using FDATool

FDATool designs most discrete-time filters in second-order sections. Generally, SOS
filters resist the effects of quantization changes when you create fixed-point filters. After
you have a second-order section filter in FDATool, either one you designed in the tool, or
one you imported, FDATool provides the capability to change the order of the sections
that compose the filter. Any SOS filter in FDATool allows reordering of the sections.

To reorder the sections of a filter, you access the Reorder and Scaling of Second-Order
Sections dialog box in FDATool.

With your SOS filter in FDATool, select Edit > Reorder and Scale from the menu bar.
FDATool returns the reordering dialog box shown here with the default settings.
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Controls on the Reordering and Scaling of Second-Order Sections dialog box

In this dialog box, the left-hand side contains options for reordering SOS filters. On
the right you see the scaling options. These are independent — reordering your filter
does not require scaling (note the Scale option) and scaling does not require that you
reorder your filter (note the None option under Reordering). For more about scaling
SOS filters, refer to “Scale Second-Order Section Filters” on page 4-33 and to scale in
the reference section.

Reordering SOS filters involves using the options in the Reordering and Scaling of
Second-Order Sections dialog box. The following table lists each reorder option and
provides a description of what the option does.

Control Option Description

Auto Reorders the filter sections to minimize the output noise
power of the filter. Note that different ordering applies
to each specification type, such as lowpass or highpass.
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Control Option

Description

Automatic ordering adapts to the specification type of your
filter.

None

Does no reordering on your filter. Selecting None lets you
scale your filter without applying reordering at the same
time. When you access this dialog box with a current filter,
this is the default setting — no reordering is applied.

Least selective section
to most selective section

Rearranges the filter sections so the least restrictive
(lowest Q) section is the first section and the most
restrictive (highest Q) section is the last section.

Most selective section to
least selective section

Rearranges the filter sections so the most restrictive
(highest Q) section is the first section and the least
restrictive (lowest Q) section is the last section.

Custom reordering

Lets you specify the section ordering to use by enabling the
Numerator Order and Denominator Order options

Numerator Order

Specify new ordering for the sections of your SOS filter.
Enter a vector of the indices of the sections in the order in
which to rearrange them. For example, a filter with five
sections has indices 1, 2, 3, 4, and 5. To switch the second
and fourth sections, the vector would be [1,4,3,2,5].

Use Numerator Order

Rearranges the denominators in the order assigned to the
numerators.

Specify

Lets you specify the order of the denominators, rather than
using the numerator order. Enter a vector of the indices of
the sections to specify the order of the denominators to use.
For example, a filter with five sections has indices 1, 2, 3, 4,
and 5. To switch the second and fourth sections, the vector
would be [1,4,3,2,5].

Use Numerator Order

Reorders the scale values according to the order of the
numerators.

Specify

Lets you specify the order of the scale values, rather than
using the numerator order. Enter a vector of the indices of
the sections to specify the order of the denominators to use.
For example, a filter with five sections has indices 1, 2, 3, 4,
and 5. To switch the second and fourth sections, the vector
would be [1,4,3,2,5].
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Control Option Description

Revert to Original Filter |Returns your filter to the original section ordering. Being

able to revert to your original filter makes comparing
the results of changing the order of the sections easier to
assess.

Reorder an SOS Filter

With FDATool open a second-order filter as the current filter, you use the following
process to access the reordering capability and reorder you filter. Start by launching
FDATool from the command prompt.

1
2

Enter fdatool at the command prompt to launch FDATool.

Design a lowpass Butterworth filter with order 10 and the default frequency
specifications by entering the following settings:

* Under Response Type select Lowpass.
Under Design Method, select IIR and Butterworth from the list.
Specify the order equal to 10 in Specify order under Filter Order.
Keep the default F's and Fe values in Frequency Specifications.
Click Design Filter.

FDATool designs the Butterworth filter and returns your filter as a Direct-Form
II filter implemented with second-order sections. You see the specifications in the
Current Filter Information area.

With the second-order filter in FDATool, reordering the filter uses the Reordering
and Scaling of Second-Order Sections feature in FDATool (also available in
Filter Visualization Tool, fvtool).

To reorder your filter, select Edit > Reorder and Scale Second-Order Sections
from the FDATool menus.

Now you are ready to reorder the sections of your filter. Note that FDATool performs the
reordering on the current filter in the session.

Use Least Selective to Most Selective Section Reordering

To let FDATool reorder your filter so the least selective section is first and the most
selective section is last, perform the following steps in the Reordering and Scaling of
Second-Order Sections dialog box.
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In Reordering, select Least selective section to most selective section.
To prevent filter scaling at the same time, clear Scale in Scaling.

In FDATool, select View > SOS View Settings from the menu bar so you see the
sections of your filter displayed in FDATool.

In the SOS View Settings dialog box, select Individual sections. Making this
choice configures FDATool to show the magnitude response curves for each section of
your filter in the analysis area.

Back in the Reordering and Scaling of Second-Order Sections dialog box, click
Apply to reorder your filter according to the Qs of the filter sections, and keep the
dialog box open. In response, FDATool presents the responses for each filter section
(there should be five sections) in the analysis area.

In the next two figures you can compare the ordering of the sections of your filter. In

the first figure, your original filter sections appear. In the second figure, the sections
have been rearranged from least selective to most selective.
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You see what reordering does, although the result is a bit subtle. Now try custom
reordering the sections of your filter or using the most selective to least selective
reordering option.

View SOS Filter Sections

+ “Using the SOS View Dialog Box” on page 4-42
+ “View the Sections of SOS Filters” on page 4-44

Using the SOS View Dialog Box

Since you can design and reorder the sections of SOS filters, FDATool provides the
ability to view the filter sections in the analysis area — SOS View. Once you have a
second-order section filter as your current filter in FDATool, you turn on the SOS View
option to see the filter sections individually, or cumulatively, or even only some of the
sections. Enabling SOS View puts FDATool in a mode where all second-order section
filters display sections until you disable the SOS View option. SOS View mode applies
to any analysis you display in the analysis area. For example, if you configure FDATool
to show the phase responses for filters, enabling SOS View means FDATool displays the
phase response for each section of SOS filters.

Controls on the SOS View Dialog Box
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SOS View uses a few options to control how FDATool displays the sections, or which
sections to display. When you select View > SOS View from the FDATool menu bar, you
see this dialog box containing options to configure SOS View operation.

_ SO0S Yiewy

=101 x|

{+ Overall fitter
" Individual sections
{ Cumulative sections

" User defined

Ji1,1:23

[~ Uze secondary-scaling poitts

Ok I Cancell Help I

Spply |

By default, SOS View shows the overall response of SOS filters. Options in the SOS View
dialog box let you change the display. This table lists all the options and describes the

effects of each.

Option

Description

Overall Filter

This is the familiar display in FDATool. For a second-
order section filter you see only the overall response
rather than the responses for the individual sections.
This is the default configuration.

Individual sections

When you select this option, FDATool displays the
response for each section as a curve. If your filter
has five sections you see five response curves, one for
each section, and they are independent. Compare to
Cumulative sections.

Cumulative sections

When you select this option, FDATool displays the
response for each section as the accumulated response
of all prior sections in the filter. If your filter has five
sections you see five response curves:
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Option

Description

+ The first curve plots the response for the first filter
section.

* The second curve plots the response for the
combined first and second sections.

* The third curve plots the response for the first,
second, and third sections combined.

And so on until all filter sections appear in the display.
The final curve represents the overall filter response.
Compare to Cumulative sections and Overall
Filter.

User defined

Here you define which sections to display, and in
which order. Selecting this option enables the text box
where you enter a cell array of the indices of the filter
sections. Each index represents one section. Entering
one index plots one response. Entering something like
{1:2} plots the combined response of sections 1 and

2. If you have a filter with four sections, the entry
{1:4} plots the combined response for all four sections,
whereas {1,2,3,4} plots the response for each section.
Note that after you enter the cell array, you need to
click OK or Apply to update the FDATool analysis
area to the new SOS View configuration.

Use secondary-scaling
points

This directs FDATool to use the secondary scaling
points in the sections to determine where to split the
sections. This option applies only when the filter is a
df2sos or dfltsos filter. For these structures, the
secondary scaling points refer to the scaling locations
between the recursive and the nonrecursive parts of
the section (the "middle" of the section). By default,
secondary-scaling points is not enabled. You use this
with the Cumulative sections option only.

View the Sections of SOS Filters

After you design or import an SOS filter in to FDATool, the SOS view option lets you see
the per section performance of your filter. Enabling SOS View from the View menu in
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FDATool configures the tool to display the sections of SOS filters whenever the current
filter is an SOS filter.

These next steps demonstrate using SOS View to see your filter sections displayed in
FDATool.

Launch FDATool.
2 Create a lowpass SOS filter using the Butterworth design method. Specify the filter
order to be 6. Using a low order filter makes seeing the sections more clear.

3 Design your new filter by clicking Design Filter.

FDATool design your filter and show you the magnitude response in the analysis
area. In Current Filter Information you see the specifications for your filter. You
should have a sixth-order Direct-Form II, Second-Order Sections filter with three

sections.
4 To enable SOS View, select View > SOS View from the menu bar.

By default the analysis area in FDATool shows the overall filter response, not the
individual filter section responses. This dialog box lets you change the display
configuration to see the sections.

5 To see the magnitude responses for each filter section, select Individual sections.

6 Click Apply to update FDATool to display the responses for each filter section. The
analysis area changes to show you something like the following figure.
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If you switch FDATool to display filter phase responses (by selecting Analysis >
Phase Response), you see the phase response for each filter section in the analysis

area.
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7 To define your own display of the sections, you use the User defined option and
enter a vector of section indices to display. Now you see a display of the first section
response, and the cumulative first, second, and third sections response:

+  Select User defined to enable the text entry box in the dialog box.

+  Enter the cell array {1,1:3} to specify that FDATool should display the response
of the first section and the cumulative response of the first three sections of the

filter.

8 To apply your new SOS View selection, click Apply or OK (which closes the SOS
View dialog box).

In the FDATool analysis area you see two curves — one for the response of the first
filter section and one for the combined response of sections 1, 2, and 3.
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__Magnitude Fespanse (dE)

Magnitude (clB)

Lowpass Butterworth Section #1 _E_ b
Lowpass Butterworth Sections #[1 2 3] '

(W] 5 {0 {5 20

Frequency (kHz)

Import and Export Quantized Filters

* “Overview and Structures” on page 4-47
* “Import Quantized Filters” on page 4-48
* “To Export Quantized Filters” on page 4-50

Overview and Structures

When you import a quantized filter into FDATool, or export a quantized filter from
FDATool to your workspace, the import and export functions use objects and you specify
the filter as a variable. This contrasts with importing and exporting nonquantized filters,
where you select the filter structure and enter the filter numerator and denominator for

the filter transfer function.

You have the option of exporting quantized filters to your MATLAB workspace, exporting
them to text files, or exporting them to MAT-files.

For general information about importing and exporting filters in FDATool, refer to
“Importing a Filter Design”, and “Exporting a Filter Design”.

FDATool imports quantized filters having the following structures:

+ Direct form I
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+ Direct form II

+ Direct form I transposed

+  Direct form II transposed

+ Direct form symmetric FIR

* Direct form antisymmetric FIR
* Lattice allpass

+ Lattice AR

+  Lattice MA minimum phase
+  Lattice MA maximum phase
+ Lattice ARMA

+ Lattice coupled-allpass

* Lattice coupled-allpass power complementary
Import Quantized Filters

After you design or open a quantized filter in your MATLAB workspace, FDATool lets
you import the filter for analysis. Follow these steps to import your filter in to FDATool:

Open FDATool.

2 Select File > Import Filter from Workspace from the menu bar, or choose the
Import Filter from Workspace icon in the side panel:

=l

In the lower region of FDATool, the Design Filter pane becomes Import Filter,
and options appear for importing quantized filters, as shown.
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— Filter Coefficients

Fitter Structure: Sampling Frequency:
Direct-Form ||l Transposed - Numerator: [0.028 0.053 0.071 0.0530.) | Clear Units: | yormalized (0 to . =
Import as second-order sections Denominator: [1.000 -2.026 2.148-1.159 0| | Clear Fs

Import Fitter

3 From the Filter Structure list, select Filter object.

The options for importing filters change to include:

+ Discrete filter — Enter the variable name for the discrete-time, fixed-point
filter in your workspace.

* Frequency units — Select the frequency units from the Units list under
Sampling Frequency, and specify the sampling frequency value in Fs if needed.
Your sampling frequency must correspond to the units you select. For example,
when you select Normalized (0 to 1), Fs defaults to one. But if you choose
one of the frequency options, enter the sampling frequency in your selected units.
If you have the sampling frequency defined in your workspace as a variable, enter
the variable name for the sampling frequency.

4  Click Import to import the filter.
FDATool checks your workspace for the specified filter. It imports the filter if it finds

it, displaying the magnitude response for the filter in the analysis area. If it cannot
find the filter it returns an FDATool Error dialog box.

Note: If, during any FDATool session, you switch to quantization mode and create

a fixed-point filter, FDATool remains in quantization mode. If you import a double-
precision filter, FDATool automatically quantizes your imported filter applying the most
recent quantization parameters.
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When you check the current filter information for your imported filter, it will indicate
that the filter is Source: imported (quantized) even though you did not import a
quantized filter.

To Export Quantized Filters

To save your filter design, FDATool lets you export the quantized filter to your MATLAB
workspace (or you can save the current session in FDATool). When you choose to save the
quantized filter by exporting it, you select one of these options:

+  Export to your MATLAB workspace

+  Export to a text file

+  Export to a MAT-file

Export Coefficients, Objects, or System Objects to the Workspace

You can save the filter as filter coefficients variables, dfi It filter object variables, or
System object variables.

To save the filter to the MATLAB workspace:

Select Export from the File menu. The Export dialog box appears.
2 Select Workspace from the Export To list.

From the Export As list, select one of the following options:

Select CoefFicients to save the filter coefficients.
+ Select Objects to save the filter in a filter object.
Select System Objects to save the filter in a filter System object.

The System Objects option does not appear in the drop-down list when the current
filter structure is not supported by System objects.

4  Assign a variable name:
For coefficients, assign variable names using the Numerator and Denominator
options under Variable Names.

For objects or System objects, assign the variable name in the Discrete Filter
option.
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If you have variables with the same names in your workspace and you want to
overwrite them, select the Overwrite Variables box.

5 Click Export.

Do not try to export the filter to a variable name that exists in your workspace
without selecting Overwrite existing variables, in the previous step. If you do so,
FDATool stops the export operation. The tool returns a warning that the variable
you specified as the quantized filter name already exists in the workspace.

+ To continue to export the filter to the existing variable, click OK to dismiss the
warning.

* Then select the Overwrite existing variables check box and click Export.
Getting Filter Coefficients After Exporting

To extract the filter coefficients from your quantized filter after you export the filter to
MATLAB, use the cel ldisp function in MATLAB. For example, create a quantized
filter in FDATool, and export the filter as Hg. To extract the filter coefficients for Hq, use

celldisp(Hq.referencecoefficients)

which returns the cell array containing the filter reference coefficients, or
celldisp(Hg-quantizedcoefficients

to return the quantized coefficients.

Export Filter Coefficients as a Text File

To save your quantized filter as a text file, follow these steps:

Select Export from the File menu.
2 Select Text-file under Export to.

3 Click OK to export the filter and close the dialog box. Click Apply to export the
filter without closing the Export dialog box. Clicking Apply lets you export your
quantized filter to more than one name without leaving the Export dialog box.

The Export Filter Coefficients to Text-file dialog box appears. This is the
standard Microsoft Windows® save file dialog box.

4 Choose or enter a folder and filename for the text file, and click OK.
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FDATool exports your quantized filter as a text file with the name you provided, and
the MATLAB editor opens, displaying the file for editing.

Export Filter Coefficients as a MAT-File
To save your quantized filter as a MAT-file, follow these steps:

Select Export from the File menu.
Select MAT-Fi le under Export to.
Assign a variable name for the filter.

Click OK to export the filter and close the dialog box. Click Apply to export the
filter without closing the Export dialog box. Clicking Apply lets you export your
quantized filter to more than one name without leaving the Export dialog box.

AW N —

The Export Filter Coefficients to MAT-file dialog box appears. This dialog box is
the standard Microsoft Windows save file dialog box.

5 Choose or enter a folder and filename for the text file, and click OK.

FDATool exports your quantized filter as a MAT-file with the specified name.

Generate MATLAB Code

You can generate MATLAB code using the File > Generate MATLAB Code menu. This
menu has three options:

* Filter Design Function

This option creates MATLAB code that generates the DFILT/MFILT object currently
designed in FDATool.

+ Filter Design Function (with System Objects)

This option is similar to the previous option with the difference that a System object is
generated instead of a DFILT/MFILT object. The option is disabled when the current
filter is not supported by system objects.

* Data Filtering Function (with System Objects)

This option generates MATLAB code that filters input data with the current filter
design. The MATLAB code is ready to be converted to C/C++ code using the codegen
command. This option is disabled when the current filter is not supported by system
objects.
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Import XILINX Coefficient (.COE) Files
Import XILINX .COE Files into FDATool

You can import XILINX coefficients (.coe) files into FDATool to create quantized filters
directly using the imported filter coefficients.

To use the import file feature:

1 Select File > Import Filter From XILINX Coefficient (.COE) File in FDATool.

2 Inthe Import Filter From XILINX Coefficient (COE) File dialog box, find and
select the .coe file to import.

3 Click Open to dismiss the dialog box and start the import process.
FDATool imports the coefficient file and creates a quantized, single-section, direct-
form FIR filter.

Transform Filters Using FDATool

+  “Filter Transformation Capabilities of FDATool” on page 4-53
* “Original Filter Type” on page 4-54

* “Frequency Point to Transform” on page 4-57

* “Transformed Filter Type” on page 4-58

+ “Specify Desired Frequency Location” on page 4-59

Filter Transformation Capabilities of FDATool

The toolbox provides functions for transforming filters between various forms. When
you use FDATool with the toolbox installed, a side bar button and a menu bar option
enable you to use the Transform Filter panel to transform filters as well as using the
command line functions.

From the selection on the FDATool menu bar — Transformations — you can transform
lowpass FIR and IIR filters to a variety of passband shapes.

You can convert your FIR filters from:

+ Lowpass to lowpass.

* Lowpass to highpass.

For IIR filters, you can convert from:
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+ Lowpass to lowpass.
* Lowpass to highpass.
* Lowpass to bandpass.

+ Lowpass to bandstop.

When you click the Transform Filter button, , on the side bar, the Transform
Filter panel opens in FDATool, as shown here.

— Frequency Transformatior
Original fiter type: Lowpass w | | Transformed fiter type: Lowpass -
Freguency point to transform: |98 kHz Specify desired frequency location: |7.2 kHz
Trans form Fitter

Your options for Original filter type refer to the type of your current filter to transform.
If you select lowpass, you can transform your lowpass filter to another lowpass filter or to
a highpass filter, or to numerous other filter formats, real and complex.

Note: When your original filter is an FIR filter, both the FIR and IIR transformed filter
type options appear on the Transformed filter type list. Both options remain active
because you can apply the IIR transforms to an FIR filter. If your source is as IIR filter,
only the IIR transformed filter options show on the list.

Original Filter Type

Select the magnitude response of the filter you are transforming from the list. Your
selection changes the types of filters you can transform to. For example:

*  When you select Lowpass with an IIR filter, your transformed filter type can be

Lowpass
Highpass
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Bandpass

Bandstop

Multiband

Bandpass (complex)

Bandstop (complex)

Multiband (complex)

When you select Lowpass with an FIR filter, your transformed filter type can be

Lowpass

Lowpass (FIR)

Highpass

Highpass (FIR) narrowband
Highpass (FIR) wideband
Bandpass

Bandstop

Multiband

Bandpass (complex)
Bandstop (complex)
Multiband (complex)

In the following table you see each available original filter type and all the types of filter
to which you can transform your original.

Original Filter

Available Transformed Filter Types

Lowpass FIR

Lowpass

Lowpass (FIR)

Highpass

Highpass (FIR) narrowband
Highpass (FIR) wideband
Bandpass

Bandstop

Multiband
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Original Filter

Available Transformed Filter Types

Bandpass (complex)
Bandstop (complex)
Multiband (complex)

Lowpass IIR

Lowpass

Highpass

Bandpass

Bandstop

Multiband
Bandpass (complex)
Bandstop (complex)
Multiband (complex)

Highpass FIR

Lowpass

Lowpass (FIR) narrowband
Lowpass (FIR) wideband
Highpass (FIR)
Highpass

Bandpass

Bandstop

Multiband

Bandpass (complex)
Bandstop (complex)
Multiband (complex)
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Original Filter Available Transformed Filter Types
Highpass IIR + Lowpass

+ Highpass

+ Bandpass

+ Bandstop

*  Multiband

+ Bandpass (complex)
+ Bandstop (complex)
* Multiband (complex)

Bandpass FIR + Bandpass

+ Bandpass (FIR)
Bandpass IIR Bandpass
Bandstop FIR + Bandstop

* Bandstop (FIR)
Bandstop IIR Bandstop

Note also that the transform options change depending on whether your original filter is
FIR or IIR. Starting from an FIR filter, you can transform to IIR or FIR forms. With an
IIR original filter, you are limited to IIR target filters.

After selecting your response type, use Frequency point to transform to specify the
magnitude response point in your original filter to transfer to your target filter. Your
target filter inherits the performance features of your original filter, such as passband
ripple, while changing to the new response form.

For more information about transforming filters, refer to “Frequency Transformations for
Real Filters” on page 4-85 and “Frequency Transformations for Complex Filters” on
page 4-99.

Frequency Point o Transform

The frequency point you enter in this field identifies a magnitude response value (in dB)
on the magnitude response curve.
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When you enter frequency values in the Specify desired frequency location option,
the frequency transformation tries to set the magnitude response of the transformed
filter to the value identified by the frequency point you enter in this field.

While you can enter any location, generally you should specify a filter passband or
stopband edge, or a value in the passband or stopband.

The Frequency point to transform sets the magnitude response at the values you
enter in Specify desired frequency location. Specify a value that lies at either the
edge of the stopband or the edge of the passband.

If, for example, you are creating a bandpass filter from a highpass filter, the
transformation algorithm sets the magnitude response of the transformed filter at

the Specify desired frequency location to be the same as the response at the
Frequency point to transform value. Thus you get a bandpass filter whose response
at the low and high frequency locations is the same. Notice that the passband between
them is undefined. In the next two figures you see the original highpass filter and the
transformed bandpass filter.

For more information about transforming filters, refer to “Digital Frequency
Transformations” on page 4-77.

Transformed Filter Type

Select the magnitude response for the target filter from the list. The complete list of
transformed filter types is:

* Lowpass

+ Lowpass (FIR)

+ Highpass

+ Highpass (FIR) narrowband
* Highpass (FIR) wideband

+ Bandpass

+ Bandstop

* Multiband

+ Bandpass (complex)

* Bandstop (complex)

* Multiband (complex)
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Not all types of transformed filters are available for all filter types on the Original filter
types list. You can transform bandpass filters only to bandpass filters. Or bandstop
filters to bandstop filters. Or IIR filters to IIR filters.

For more information about transforming filters, refer to “Frequency Transformations for
Real Filters” on page 4-85 and “Frequency Transformations for Complex Filters” on
page 4-99.

Specify Desired Frequency Location

The frequency point you enter in Frequency point to transform matched a magnitude
response value. At each frequency you enter here, the transformation tries to make the
magnitude response the same as the response identified by your Frequency point to
transform value.

While you can enter any location, generally you should specify a filter passband or
stopband edge, or a value in the passband or stopband.

For more information about transforming filters, refer to “Digital Frequency
Transformations” on page 4-77.

Transform Filters

To transform the magnitude response of your filter, use the Transform Filter option on
the side bar.

1 Design or import your filter into FDATool.

2 It
Click Transform Filter, , on the side bar.

FDATool opens the Transform Filter panel in FDATool.

3 From the Original filter type list, select the response form of the filter you are
transforming.

When you select the type, whether is lowpass, highpass, bandpass, or bandstop,
FDATool recognizes whether your filter form is FIR or ITR. Using both your filter
type selection and the filter form, FDATool adjusts the entries on the Transformed
filter type list to show only those that apply to your original filter.

4 Enter the frequency point to transform value in Frequency point to transform.
Notice that the value you enter must be in kHz; for example, enter 0.1 for 100 Hz or
1.5 for 1500 Hz.
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5 From the Transformed filter type list, select the type of filter you want to
transform to.

Your filter type selection changes the options here.

When you pick a lowpass or highpass filter type, you enter one value in Specify
desired frequency location.

When you pick a bandpass or bandstop filter type, you enter two values — one in
Specify desired low frequency location and one in Specify desired high
frequency location. Your values define the edges of the passband or stopband.

When you pick a multiband filter type, you enter values as elements in a vector
in Specify a vector of desired frequency locations — one element for each
desired location. Your values define the edges of the passbands and stopbands.

After you click Transform Filter, FDATool transforms your filter, displays
the magnitude response of your new filter, and updates the Current Filter
Information to show you that your filter has been transformed. In the filter
information, the Source is Transformed.

For example, the figure shown here includes the magnitude response curves for
two filters. The original filter is a lowpass filter with rolloff between 0.2 and 0.25.
The transformed filter is a lowpass filter with rolloff region between 0.8 and 0.85.
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To demonstrate the effects of selecting Narrowband Highpass or Wideband
Highpass, the next figure presents the magnitude response curves for a source
lowpass filter after it is transformed to both narrow- and wideband highpass
filters. For comparison, the response of the original filter appears as well.
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Magnitude Response
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For the narrowband case, the transformation algorithm essentially reverses the
magnitude response, like reflecting the curve around the y-axis, then translating
the curve to the right until the origin lies at 1 on the x-axis. After reflecting and
translating, the passband at high frequencies is the reverse of the passband of the
original filter at low frequencies with the same rolloff and ripple characteristics.

Design Multirate Filters in FDATool

*  “Introduction” on page 4-63

+ “Switch FDATool to Multirate Filter Design Mode” on page 4-63
+ “Controls on the Multirate Design Panel” on page 4-64

* “Quantize Multirate Filters” on page 4-71

+ “Export Individual Phase Coefficients of a Polyphase Filter to the Workspace” on page
4-73
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Introduction

Not only can you design multirate filters from the MATLAB command prompt, FDATool
provides the same design capability in a graphical user interface tool. By starting
FDATool and switching to the multirate filter design mode you have access to all of the
multirate design capabilities in the toolbox — decimators, interpolators, and fractional
rate changing filters, among others.

Switch FDATool to Multirate Filter Design Mode

The multirate filter design mode in FDATool lets you specify and design a wide range of
multirate filters, including decimators and interpolators.

With FDATool open, click Create a Multirate Filter, , on the side bar. You see
FDATool switch to the design mode showing the multirate filter design options. Shown
in the following figure is the default multirate design configuration that designs an

interpolating filter with an interpolation factor of 2. The design uses the current FIR
filter in FDATool.
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Type: | Interpolator - @ Use current FIR filter
= Use a default Nyguist FIR filter
Interpolation Factor: 2=
Cascaded Integrator-Comb (CIC)
Decimation Factor: 1= Hold interpolator (Zero-order)

Sampling Freguency:

Units:

Fs:

Linear Interpolator (First-order)

Hz hd

48000

Create Multirate Fitter

omputing Response ... Done

When the current filter in FDATool is not an FIR filter, the multirate filter design panel
removes the Use current FIR filter option and selects the Use default Nyquist FIR
filter option instead as the default setting.

Controls on the Multirate Design Panel

You see the options that allow you to design a variety of multirate filters. The Type
option is your starting point. From this list you select the multirate filter to design.
Based on your selection, other options change to provide the controls you need to specify
your filter.

Notice the separate sections of the design panel. On the left is the filter type area
where you choose the type of multirate filter to design and set the filter performance
specifications.

In the center section FDATool provides choices that let you pick the filter design method
to use.
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The rightmost section offers options that control filter configuration when you select
Cascaded-Integrator Comb (CIC) as the design method in the center section. Both the
Decimator type and Interpolator type filters let you use the Cascaded-Integrator
Comb (CIC) option to design multirate filters.

Here are all the options available when you switch to multirate filter design mode. Each
option listed includes a brief description of what the option does when you use it.

Select and Configure Your Filter

Option Description

Type Specifies the type of multirate filter to design. Choose
from Decimator, Interpolator, or Fractional-rate
convertor.

* When you choose Decimator, set Decimation Factor to
specify the decimation to apply.

* When you choose Interpolator, set Interpolation
Factor to specify the interpolation amount applied.

* When you choose Fractional-rate convertor,
set both Interpolation Factor and Decimation
Factor. FDATool uses both to determine the fractional
rate change by dividing Interpolation Factor by
Decimation Factor to determine the fractional
rate change in the signal. You should select values
for interpolation and decimation that are relatively
prime. When your interpolation factor and decimation
factor are not relatively prime, FDATool reduces the
interpolation/decimation fractional rate to the lowest
common denominator and issues a message in the status
bar in FDATool. For example, if the interpolation factor
is 6 and the decimation factor is 3, FDATool reduces
6/3 to 2/1 when you design the rate changer. But if the
interpolation factor is 8 and the decimation factor is 3,
FDATool designs the filter without change.

Interpolation Factor |Use the up-down control arrows to specify the amount of
interpolation to apply to the signal. Factors range upwards
from 2.
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Option

Description

Decimation Factor

Use the up-down control arrows to specify the amount of
decimation to apply to the signal. Factors range upwards
from 2.

Sampling Frequency

No settings here. Just Units and F's below.

Units

Specify whether F's is specified in Hz, kHz, MHz, GHz, or
Normalized (O to 1) units.

Fs

Set the full scale sampling frequency in the frequency units
you specified in Units. When you select Normal i1zed for
Units, you do not enter a value for Fs.

Design Your Filter

Option

Description

Use current FIR filter

Directs FDATool to use the current FIR filter to design

the multirate filter. If the current filter is an IIR form, you
cannot select this option. You cannot design multirate filters
with ITR structures.

Use a default Nyquist
Filter

Tells FDATool to use the default Nyquist design method
when the current filter in FDATool is not an FIR filter.

Cascaded Integrator-
Comb (CIC)

Design CIC filters using the options provided in the right-
hand area of the multirate design panel.

Hold Interpolator
(Zero-order)

When you design an interpolator, you can specify how

the filter sets interpolated values between signal values.
When you select this option, the interpolator applies the
most recent signal value for each interpolated value until it
processes the next signal value. This is similar to sample-
and-hold techniques. Compare to the Linear Interpolator
option.

Linear Interpolator
(First-order)

When you design an interpolator, you can specify how

the filter sets interpolated values between signal values.
When you select this option, the interpolator applies linear
interpolation between signal value to set the interpolated
value until it processes the next signal value. Compare to
the Linear Interpolator option.
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To see the difference between hold interpolation and linear interpolation, the following
figure presents a sine wave signal s1 in three forms:
* The top subplot in the figure presents signal s1 without interpolation.

*  The middle subplot shows signal s1 interpolated by a linear interpolator with an
interpolation factor of 5.

*  The bottom subplot shows signal s1 interpolated by a hold interpolator with an
interpolation factor of 5.

You see in the bottom figure the sample and hold nature of hold interpolation, and the
first-order linear interpolation applied by the linear interpolator.
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Samples

We used FDATool to create interpolators similar to the following code for the figure:

* Linear interpolator — hm=mFfilt._linearinterp(5)
* Hold interpolator — hm=mFfilt.holdinterp(5)
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Options for Designing CIC Filters |Description

Differential Delay Sets the differential delay for the CIC filter. Usually a value of one

or two 1s appropriate.

Number of Sections Specifies the number of sections in a CIC decimator. The default

number of sections is 2 and the range is any positive integer.
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Design a Fractional Rate Convertor

To introduce the process you use to design a multirate filter in FDATool, this example
uses the options to design a fractional rate convertor which uses 7/3 as the fractional
rate. Begin the design by creating a default lowpass FIR filter in FDATool. You do not
have to begin with this FIR filter, but the default filter works fine.

Launch FDATool.

Select the settings for a minimum-order lowpass FIR filter, using the Equiripple
design method.

When FDATool displays the magnitude response for the filter, click in the side
bar. FDATool switches to multirate filter design mode, showing the multirate design
panel.

To design a fractional rate filter, select Fractional-rate convertor from the
Type list. The Interpolation Factor and Decimation Factor options become
available.

In Interpolation Factor, use the up arrow to set the interpolation factor to 7.
Using the up arrow in Decimation Factor, set 3 as the decimation factor.

Select Use a default Nyquist FIR Filter. You could design the rate convertor
with the current FIR filter as well.

Enter 24000 to set F's.
Click Create Multirate Filter.
After designing the filter, FDATool returns with the specifications for your new filter

displayed in Current Filter Information, and shows the magnitude response of
the filter.
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reating filter ... done.

You can test the filter by exporting it to your workspace and using it to filter a signal. For
information about exporting filters, refer to “Import and Export Quantized Filters” on
page 4-47.

Design a CIC Decimator for 8 Bit Input/Output Data

Another kind of filter you can design in FDATool is Cascaded-Integrator Comb (CIC)
filters. FDATool provides the options needed to configure your CIC to meet your needs.

1 Launch FDATool and design the default FIR lowpass filter. Designing a filter at this
time 1s an optional step.

2
Switch FDATool to multirate design mode by clicking on the side bar.

3 For Type, select Decimator, and set Decimation Factor to 3.

4 To design the decimator using a CIC implementation, select Cascaded-Integrator
Comb (CIC). This enables the CIC-related options on the right of the panel.
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5 Set Differential Delay to 2. Generally, 1 or 2 are good values to use.
Enter 2 for the Number of Sections.
7 Click Create Multirate Filter.

o

FDATool designs the filter, shows the magnitude response in the analysis area,

and updates the current filter information to show that you designed a tenth-order
cascaded-integrator comb decimator with two sections. Notice the source is Multirate
Design, indicating you used the multirate design mode in FDATool to make the
filter. FDATool should look like this now.

— Current Filter Information———— _ Magnitude Response (dB)
Structure: Cascaded
Integratar-Comb .
Decimator o
Rate Change: 1/3 =
Sections: 2 E
Stahle: Yes §
Source: hultirate Design =
Store Filter .. |
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3| 8 e
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Create Multirate Filter |

Designing other multirate filters follows the same pattern.

To design other multirate filters, do one of the following depending on the filter to design:
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+ To design an interpolator, select one of these options.

+ Use a default Nyquist FIR filter

+ Cascaded-Integrator Comb (CIC)
* Hold Interpolator (Zero-order)

+ Linear Interpolator (First-order)

+ To design a decimator, select from these options.

Use a default Nyquist FIR filter
Cascaded-Integrator Comb (CIC)

* To design a fractional-rate convertor, select Use a default Nyquist FIR filter.
Quantize Multirate Filters

After you design a multirate filter in FDATool, the quantization features enable you to
convert your floating-point multirate filter to fixed-point arithmetic.

Note: CIC filters are always fixed-point.

With your multirate filter as the current filter in FDATool, you can quantize your filter
and use the quantization options to specify the fixed-point arithmetic the filter uses.

Quantize and Configure Multirate Filters

Follow these steps to convert your multirate filter to fixed-point arithmetic and set the
fixed-point options.

1 Design or import your multirate filter and make sure it is the current filter in
FDATool.
2 Click the Set Quantization Parameters button on the side bar.

3 From the Filter Arithmetic list on the Filter Arithmetic pane, select Fixed-
point. If your filter is a CIC filter, the Fixed-point option is enabled by default
and you do not set this option.

4 In the quantization panes, set the options for your filter. Set options for
Coefficients, Input/Output, and Filter Internals.

5 Click Apply.
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When you current filter is a CIC filter, the options on the Input/Output and Filter
Internals panes change to provide specific features for CIC filters.

Input/Output

The options that specify how your CIC filter uses input and output values are listed in
the table below.

Option Name Description

Input Word Length Sets the word length used to represent the input to a filter.

Input fraction length Sets the fraction length used to interpret input values to
filter.

Input range (+/-) Lets you set the range the inputs represent. You use this

instead of the Input fraction length option to set the
precision. When you enter a value x, the resulting range is -
x to x. Range must be a positive integer.

Output word length Sets the word length used to represent the output from a
filter.
Avoid overflow Directs the filter to set the fraction length for the input

to prevent the output values from exceeding the available
range as defined by the word length. Clearing this option
lets you set Output fraction length.

Output fraction length Sets the fraction length used to represent output values
from a filter.

Output range (+/-) Lets you set the range the outputs represent. You use this
instead of the Output fraction length option to set the
precision. When you enter a value x, the resulting range is -
x to x. Range must be a positive integer.

The available options change when you change the Filter precision setting. Moving
from Full to Specify all adds increasing control by enabling more input and output
word options.

Filter Internals

With a CIC filter as your current filter, the Filter precision option on the Filter
Internals pane includes modes for controlling the filter word and fraction lengths.

There are four usage modes for this (the same mode you select for the FilterInternals
property in CIC filters at the MATLAB prompt).
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* Full — All word and fraction lengths set to B.x + 1, called B,ccum by Harris in [2].
Full Precision is the default setting.

* Minimum section word lengths — Set the section word lengths to minimum
values that meet roundoff noise and output requirements as defined by Hogenauer in

(3].

+ Specify word lengths — Enables the Section word length option for you to
enter word lengths for each section. Enter either a scalar to use the same value for
every section, or a vector of values, one for each section.

+ Specify all — Enables the Section fraction length option in addition to Section
word length. Now you can provide both the word and fraction lengths for each
section, again using either a scalar or a vector of values.

Export Individual Phase Coefficients of a Polyphase Filter to the Workspace

After designing a polyphase filter in Filter Design Analysis Tool (FDATool), you can
obtain the individual phase coefficients of the filter by:

1  Exporting the filter to an object in the MATLAB workspace.

2 Using the polyphase method to create a matrix of the filter's coefficients.
Export the Polyphase Filter to an Object

To export a polyphase filter to an object in the MATLAB workspace, complete the
following steps.

1 In FDATool, open the File menu and select Export.... This opens the dialog box for
exporting the filter coefficients.

2 In the Export dialog box, for Export To, select Workspace.

3 For Export As, select Object.

4 (Optional) For Variable Names, enter the name of the Multirate Filter object that
will be created in the MATLAB workspace.

5 Click the Export button. The multirate filter object, Hm in this example, appears in
the MATLAB workspace.

Create a Matrix of Coefficients Using the polyphase Method

To create a matrix of the filter's coefficients, enter p=polyphase(Hm) at the command
line. The polyphase method creates a matrix, p, of filter coefficients from the filter
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object, Hm. Each row of p consists of the coefficients of an individual phase subfilter. The
first row contains to the coefficients of the first phase subfilter, the second row contains
those of the second phase subfilter, and so on.

Realize Filters as Simulink Subsystem Blocks

*  “Introduction” on page 4-74
+ “About the Realize Model Panel in FDATool” on page 4-74

Introduction

After you design or import a filter in FDATool, the realize model feature lets you create
a Simulink subsystem block that implements your filter. The generated filter subsystem
block uses either digital filter blocks from the DSP System Toolbox library, or the Delay,
Gain, and Sum blocks in Simulink. If you do not have a Fixed-Point Designer™ license,
FDATool still realizes your model using blocks in fixed-point mode from Simulink, but
you cannot run any model that includes your filter subsystem block in Simulink.

About the Realize Model Panel in FDATool

To access to the Realize Model panel and the options for realizing your quantized filter

as a Simulink subsystem block, switch FDATool to realize model mode by clicking @ on
the sidebar.

The following panel shows the options for configuring how FDATool implements your
filter as a Simulink block.

— Model — Optimization
Block name:  |Fiter Optimize for zero gains
Destination: Current - Optimize: for unity gains
Untitled Optimize for negative gains
|:| Owverwrite generated ‘Fiter' block Optimize delay chains
|:| Build model using basic elements Optimize for unity scale values
Input processing: | Columns as channels (frame based) ~7) Realize Model
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For information on these parameters, see the descriptions on the Filter Realization
Wizard block reference page.

Redlize a Filter Using FDATool

After your quantized filter in FDATool is performing the way you want, with your desired
phase and magnitude response, and with the right coefficients and form, follow these
steps to realize your filter as a subsystem that you can use in a Simulink model.

1 Click Realize Model on the sidebar to change FDATool to realize model mode.
2 From the Destination list under Model, select either:

+ Current model — to add the realized filter subsystem to your current model

New model — to open a new Simulink model window and add your filter
subsystem to the new window

3 Provide a name for your new filter subsystem in the Name field.

4  Decide whether to overwrite an existing block with this new one, and select or clear
the Overwrite generated ‘Filter’ block check box.

5 Select the Build model using basic elements check box to implement your filter
as a subsystem block that consists of Sum, Gain, and Delay blocks.

6 Select or clear the optimizations to apply.

Optimize for zero gains — removes zero gain blocks from the model realization

+ Optimize for unity gains — replaces unity gain blocks with direct connections
to adjacent blocks

+ Optimize for negative gains — replaces negative gain blocks by a change of
sign at the nearest sum block

* Optimize delay chains — replaces cascaded delay blocks with a single delay
block that produces the equivalent gain

*  Optimize for unity scale values — removes all scale value multiplications by 1
from the filter structure

7 Click Realize Model to realize your quantized filter as a subsystem block according
to the settings you selected.

If you double-click the filter block subsystem created by FDATool, you see the filter
implementation in Simulink model form. Depending on the options you chose when you
realized your filter, and the filter you started with, you might see one or more sections, or
different architectures based on the form of your quantized filter. From this point on, the
subsystem filter block acts like any other block that you use in Simulink models.
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Supported Filter Structures

FDATool lets you realize discrete-time and multirate filters from the following forms:

Structure Description
firdecim Decimators based on FIR filters
firtdecim Decimators based on transposed FIR filters

linearinterp

Linear interpolators

firinterp

Interpolators based on FIR filters

multirate polyphase

Multirate filters

holdinterp

Interpolators that use the hold interpolation
algorithm

dfilt.allpass

Discrete-time filters with allpass structure

dfilt.cascadeallpass

dfilt._cascadewdfal lpass

mFilt.iirdecim

Decimators based on IIR filters

mfilt.1irwdfdecim

mFilt.iirinterp

Interpolators based on IIR filters

mFilt.iirwdfinterp

dfilt_wdfallpass
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Digital Frequency Transformations

In this section...

“Details and Methodology” on page 4-77
“Frequency Transformations for Real Filters” on page 4-85

“Frequency Transformations for Complex Filters” on page 4-99

Details and Methodology

+ “Overview of Transformations” on page 4-77
+ “Select Features Subject to Transformation” on page 4-81
+ “Mapping from Prototype Filter to Target Filter” on page 4-83

+ “Summary of Frequency Transformations” on page 4-84
Overview of Transformations

Converting existing FIR or IIR filter designs to a modified IIR form is often done using
allpass frequency transformations. Although the resulting designs can be considerably
more expensive in terms of dimensionality than the prototype (original) filter, their ease
of use in fixed or variable applications is a big advantage.

The general idea of the frequency transformation is to take an existing prototype

filter and produce another filter from it that retains some of the characteristics of the
prototype, in the frequency domain. Transformation functions achieve this by replacing
each delaying element of the prototype filter with an allpass filter carefully designed to
have a prescribed phase characteristic for achieving the modifications requested by the
designer.

The basic form of mapping commonly used is

Hy(2) = H[H,(2)]

The Hx(2) 1s an Nth-order allpass mapping filter given by
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N
2 o

Hy(2)= S =2 - Na)
. Ds(2)
-N+i A
0z
OCO =1
where

H,(z) — Transfer function of the prototype filter
H,(2) — Transfer function of the allpass mapping filter
Hp(z) — Transfer function of the target filter

Let's look at a simple example of the transformation given by

Hyp(z)=H,(-2)

The target filter has its poles and zeroes flipped across the origin of the real and
imaginary axes. For the real filter prototype, it gives a mirror effect against 0.5, which
means that lowpass H,(z) gives rise to a real highpass H7(z). This is shown in the
following figure for the prototype filter designed as a third-order halfband elliptic filter.
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Prototype filter Target filter
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Example of a Simple Mirror Transformation

The choice of an allpass filter to provide the frequency mapping is necessary to provide
the frequency translation of the prototype filter frequency response to the target filter by
changing the frequency position of the features from the prototype filter without affecting
the overall shape of the filter response.

The phase response of the mapping filter normalized to 1z can be interpreted as a
translation function:

H (wnew) = W1

The graphical interpretation of the frequency transformation is shown in the figure
below. The complex multiband transformation takes a real lowpass filter and converts it
into a number of passbands around the unit circle.
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Graphical Interpretation of the Mapping Process

Most of the frequency transformations are based on the second-order allpass mapping
filter:

1+ogz ! +ayz2
Hy(z)=+—L 2

O +O£12_1 +2_2

The two degrees of freedom provided by a; and as choices are not fully used by the usual
restrictive set of “flat-top” classical mappings like lowpass to bandpass. Instead, any

two transfer function features can be migrated to (almost) any two other frequency
locations if a; and as are chosen so as to keep the poles of Hu(2) strictly outside the unit
circle (since Hy(z) is substituted for z in the prototype transfer function). Moreover, as
first pointed out by Constantinides, the selection of the outside sign influences whether
the original feature at zero can be moved (the minus sign, a condition known as “DC
mobility”) or whether the Nyquist frequency can be migrated (the “Nyquist mobility” case
arising when the leading sign is positive).
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All the transformations forming the package are explained in the next sections of the
tutorial. They are separated into those operating on real filters and those generating

or working with complex filters. The choice of transformation ranges from standard
Constantinides first and second-order ones [1][2] up to the real multiband filter by Mullis
and Franchitti [3], and the complex multiband filter and real/complex multipoint ones by
Krukowski, Cain and Kale [4].

Select Features Subject to Transformation

Choosing the appropriate frequency transformation for achieving the required effect

and the correct features of the prototype filter is very important and needs careful
consideration. It is not advisable to use a first-order transformation for controlling more
than one feature. The mapping filter will not give enough flexibility. It is also not good

to use higher order transformation just to change the cutoff frequency of the lowpass
filter. The increase of the filter order would be too big, without considering the additional
replica of the prototype filter that may be created in undesired places.

1B
Prototype filter C=-A

bandedge

0 0.2 0.4 0.6 0.8 1.0
Meormalized Frequency (= rad/sample)

Target filters

i
I
I
I
' I
:mﬂewﬂ Drgyyz
: i

I

|

I

I

I

1

0 0.2 0.4 0.6 0.a 1.0 0 0.2 0.4 0.6 0.8 1.0 0 0.2 0.4 0.6 0a 1.0
MNormalized Frequency  (xn radfsample) Mormalized Frequency (xn rad/sample) Mormalized Frequency (= rad/sarmple)

Left bandedge and DC control Left and right bandedge control DC and right bandedge control

Feature Selection for Real Lowpass to Bandpass Transformation

To illustrate the idea, the second-order real multipoint transformation was applied three
times to the same elliptic halfband filter in order to make it into a bandpass filter. In
each of the three cases, two different features of the prototype filter were selected in
order to obtain a bandpass filter with passband ranging from 0.25 to 0.75. The position of
the DC feature was not important, but it would be advantageous if it were in the middle
between the edges of the passband in the target filter. In the first case the selected
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4-82

features were the left and the right band edges of the lowpass filter passband, in the
second case they were the left band edge and the DC, in the third case they were DC and
the right band edge.

Left & right band-edges (solid) =
Left band-edge and DC (dashed)

\\ DC and right band-edges (dotted) B

-60
0

| |
0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Normalized Frequency (xmtrad/sample)

Result of Choosing Different Features

The results of all three approaches are completely different. For each of them only the
selected features were positioned precisely where they were required. In the first case
the DC is moved toward the left passband edge just like all the other features close to the
left edge being squeezed there. In the second case the right passband edge was pushed
way out of the expected target as the precise position of DC was required. In the third
case the left passband edge was pulled toward the DC in order to position it at the correct
frequency. The conclusion is that if only the DC can be anywhere in the passband, the
edges of the passband should have been selected for the transformation. For most of the
cases requiring the positioning of passbands and stopbands, designers should always
choose the position of the edges of the prototype filter in order to make sure that they get
the edges of the target filter in the correct places. Frequency responses for the three cases
considered are shown in the figure. The prototype filter was a third-order elliptic lowpass
filter with cutoff frequency at 0.5.
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The MATLAB code used to generate the figure is given here.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

In the example the requirements are set to create a real bandpass filter with passband
edges at 0.1 and 0.3 out of the real lowpass filter having the cutoff frequency at 0.5. This
is attempted in three different ways. In the first approach both edges of the passband
are selected, in the second approach the left edge of the passband and the DC are chosen,
while in the third approach the DC and the right edge of the passband are taken:

[numl,denl] = iirlp2xn(b, a, [-0.5, 0.5], [0.1, 0.3]);
[num2,den2] = iirlp2xn(b, a, [-0.5, 0.0], [0.1, 0.2]);
[num3,den3] = iirlp2xn(b, a, [ 0.0, 0.5], [0.2, 0.3]);

Mapping from Prototype Filter to Target Filter

In general the frequency mapping converts the prototype filter, H,(z), to the target
filter, Hy(z), using the N th-order allpass filter, H4(z). The general form of the allpass
mapping filter is given in “Overview of Transformations” on page 4-77. The frequency
mapping is a mathematical operation that replaces each delayer of the prototype filter
with an allpass filter. There are two ways of performing such mapping. The choice of the
approach is dependent on how prototype and target filters are represented.

When the Nth-order prototype filter is given with pole-zero form

N
> (z-%)

H,(z) = —r
Z(z -p;)

the mapping will replace each pole, p;, and each zero, z;, with a number of poles and zeros
equal to the order of the allpass mapping filter:

N ON 0
z ?Zakz -z DZaksz@

_1=1 0
B, =55 va O
QS‘ o,2* - p; DZ akzN k@

=1 k=0
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The root finding needs to be used on the bracketed expressions in order to find the poles
and zeros of the target filter.

When the prototype filter is described in the numerator-denominator form:

N N-1
Bz +BzN 1+ +By|

(onN +0(12N_1 +... +0(N|

Hp(2) =

z=H ,(z)

Then the mapping process will require a number of convolutions in order to calculate the
numerator and denominator of the target filter:

HT(Z) - ﬁlNA(Z)N + ﬂ2NA(Z)N_1DA(2) +... +[3NDA(2)N
BINA@Y + BoNa@N Dy () +...+ By Da@N

For each coefficient a; and f; of the prototype filter the N th-order polynomials must be
convolved N times. Such approach may cause rounding errors for large prototype filters
and/or high order mapping filters. In such a case the user should consider the alternative
of doing the mapping using via poles and zeros.

Summary of Frequency Transformations

Advantages

*  Most frequency transformations are described by closed-form solutions or can be
calculated from the set of linear equations.

* They give predictable and familiar results.

* Ripple heights from the prototype filter are preserved in the target filter.

* They are architecturally appealing for variable and adaptive filters.
Disadvantages

* There are cases when using optimization methods to design the required filter gives
better results.

+ High-order transformations increase the dimensionality of the target filter, which
may give expensive final results.
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+ Starting from fresh designs helps avoid locked-in compromises.

Frequency Transformations for Real Filters

* “Overview” on page 4-85

+  “Real Frequency Shift” on page 4-85

+ “Real Lowpass to Real Lowpass” on page 4-87

+ “Real Lowpass to Real Highpass” on page 4-89

+ “Real Lowpass to Real Bandpass” on page 4-91
+ “Real Lowpass to Real Bandstop” on page 4-93
* “Real Lowpass to Real Multiband” on page 4-95
+ “Real Lowpass to Real Multipoint” on page 4-97

Overview

This section discusses real frequency transformations that take the real lowpass
prototype filter and convert it into a different real target filter. The target filter has its
frequency response modified in respect to the frequency response of the prototype filter
according to the characteristic of the applied frequency transformation.

Real Frequency Shift

Real frequency shift transformation uses a second-order allpass mapping filter. It
performs an exact mapping of one selected feature of the frequency response into its new
location, additionally moving both the Nyquist and DC features. This effectively moves
the whole response of the lowpass filter by the distance specified by the selection of the

feature from the prototype filter and the target filter. As a real transformation, it works
in a similar way for positive and negative frequencies.

|
Hy(2)=z" F-oz _

with a given by
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where
w.1q — Frequency location of the selected feature in the prototype filter
Wnew — Position of the feature originally at w,;; 1n the target filter

The following example shows how this transformation can be used to move the response
of the prototype lowpass filter in either direction. Please note that because the target
filter must also be real, the response of the target filter will inherently be disturbed at
frequencies close to Nyquist and close to DC. Here is the MATLAB code for generating
the example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);
The example transformation moves the feature originally at 0.5 to 0.9:

[num,den] = iirshift(b, a, 0.5, 0.9);
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Example of Real Frequency Shift Mapping

Real Lowpass to Real Lowpass

Real lowpass filter to real lowpass filter transformation uses a first-order allpass
mapping filter. It performs an exact mapping of one feature of the frequency response
into the new location keeping DC and Nyquist features fixed. As a real transformation,
it works in a similar way for positive and negative frequencies. It is important to
mention that using first-order mapping ensures that the order of the filter after the

transformation is the same as it was originally.

—gz 10
I (z):_g oz
A a-z"1 E

with a given by
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. T _
Slng(wold Doy )
a =
. T _
Slng(wold Doy )
where

.1 — Frequency location of the selected feature in the prototype filter
Wnew — Frequency location of the same feature in the target filter

The example below shows how to modify the cutoff frequency of the prototype filter. The
MATLAB code for this example is shown in the following figure.

The prototype filter is a halfband elliptic, real, third-order filter:
[b, a] = ellip(3, 0.1, 30, 0.409);
The cutoff frequency moves from 0.5 to 0.75:

[num,den] = iirlp2lp(b, a, 0.5, 0.75);
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Example of Real Lowpass to Real Lowpass Mapping

Real Lowpass to Real Highpass

Real lowpass filter to real highpass filter transformation uses a first-order allpass
mapping filter. It performs an exact mapping of one feature of the frequency response
into the new location additionally swapping DC and Nyquist features. As a real
transformation, it works in a similar way for positive and negative frequencies. Just like
in the previous transformation because of using a first-order mapping, the order of the

filter before and after the transformation is the same.

_]'I:
+oz
H,(z)=-

A §a+z_1 E

with a given by
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where

.1 — Frequency location of the selected feature in the prototype filter

Wnew — Frequency location of the same feature in the target filter

The example below shows how to convert the lowpass filter into a highpass filter with
arbitrarily chosen cutoff frequency. In the MATLAB code below, the lowpass filter is
converted into a highpass with cutoff frequency shifted from 0.5 to 0.75. Results are

shown in the figure.

The prototype filter is a halfband elliptic, real, third-order filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

The example moves the cutoff frequency from 0.5 to 0.75:

[num,den] = iirlp2hp(b, a, 0.5, 0.75);
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Example of Real Lowpass to Real Highpass Mapping
Real Lowpass to Real Bandpass

Real lowpass filter to real bandpass filter transformation uses a second-order allpass
mapping filter. It performs an exact mapping of two features of the frequency response
into their new location additionally moving a DC feature and keeping the Nyquist feature
fixed. As a real transformation, it works in a similar way for positive and negative
frequencies.

-Bl+wzt -z 2L
a-BA+a)z "t +272 E

Hy(2)=-

with a and S given by
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ﬁ = cOSE(()Onew,l + wnew,Z)

where

.1 — Frequency location of the selected feature in the prototype filter

Onew,1 — Position of the feature originally at (-@,;) in the target filter

Onew,2 — Position of the feature originally at (+w,;y) in the target filter

The example below shows how to move the response of the prototype lowpass filter in
either direction. Please note that because the target filter must also be real, the response
of the target filter will inherently be disturbed at frequencies close to Nyquist and close

to DC. Here is the MATLAB code for generating the example in the figure.
The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates the passband between 0.5 and 0.75:

[num,den] = iirlp2bp(b, a, 0.5, [0.5, 0.75]);
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Example of Real Lowpass to Real Bandpass Mapping
Real Lowpass to Real Bandstop

Real lowpass filter to real bandstop filter transformation uses a second-order allpass
mapping filter. It performs an exact mapping of two features of the frequency response
into their new location additionally moving a Nyquist feature and keeping the DC feature
fixed. This effectively creates a stopband between the selected frequency locations in the
target filter. As a real transformation, it works in a similar way for positive and negative
frequencies.

1-BA+zt +az?
a-pa +a)z 4272

Hy(2)=

with ¢ and S given by
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T
cOsz(zwold * Opeyy 2 _wnew,l)

a =
T
cOsz(zwold = Wnew 2 +wnew,1)

T
ﬁ = cOSE((J‘)new,l + wnew,z)

where

.1 — Frequency location of the selected feature in the prototype filter

Onew,1 — Position of the feature originally at (-@,;) in the target filter

Onew,2 — Position of the feature originally at (+w,;y) in the target filter

The following example shows how this transformation can be used to convert the
prototype lowpass filter with cutoff frequency at 0.5 into a real bandstop filter with the
same passband and stopband ripple structure and stopband positioned between 0.5 and

0.75. Here is the MATLAB code for generating the example in the figure.
The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates a stopband from 0.5 to 0.75:

[num,den] = iirlp2bs(b, a, 0.5, [0.5, 0.75]);
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Example of Real Lowpass to Real Bandstop Mapping
Real Lowpass to Real Multiband

This high-order transformation performs an exact mapping of one selected feature of the
prototype filter frequency response into a number of new locations in the target filter. Its
most common use is to convert a real lowpass with predefined passband and stopband
ripples into a real multiband filter with N arbitrary band edges, where N is the order of
the allpass mapping filter.

N
%2
Hy(2) = S570——

-N+
oz

i

oy =1

The coefficients a are given by
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=1 k=1,..,N

g T

E sinE(Na)new +(—1)kwold)
P = =S

A sin %((N - 20) ey + (-1 1)

where
®oa,. — Frequency location of the first feature in the prototype filter
Onew, . — Position of the feature originally at w4 in the target filter

The mobility factor, S, specifies the mobility or either DC or Nyquist feature:

01 Nyquist
=0

S
1 DC

The example below shows how this transformation can be used to convert the prototype
lowpass filter with cutoff frequency at 0.5 into a filter having a number of bands
positioned at arbitrary edge frequencies 1/5, 2/5, 3/5 and 4/5. Parameter S was such that
there is a passband at DC. Here is the MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates three stopbands, from DC to 0.2, from 0.4 to 0.6 and
from 0.8 to Nyquist:

[num,den] = iirlp2mb(b, a, 0.5, [0.2, 0.4, 0.6, 0.8], “pass”);
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Example of Real Lowpass to Real Multiband Mapping

Real Lowpass to Real Multipoint

This high-order frequency transformation performs an exact mapping of a number of
selected features of the prototype filter frequency response to their new locations in
the target filter. The mapping filter is given by the general IIR polynomial form of the
transfer function as given below.

050:1

For the Nth-order multipoint frequency transformation the coefficients a are
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ON ‘ .
N-i _
Dz ON-i2old k |-_"Lizew,k -S |}newl,k = Rold k -S Bnew,k
=1

o1k = /™o

o .

|:bnew,k = ¢/ e

&=1,.,N
where

®oiar, — Frequency location of the first feature in the prototype filter
Onew,, — Position of the feature originally at w4, in the target filter

The mobility factor, S, specifies the mobility of either DC or Nyquist feature:

01 Nyquist
g=H1 e

1 DC

The example below shows how this transformation can be used to move features of the
prototype lowpass filter originally at -0.5 and 0.5 to their new locations at 0.5 and 0.75,
effectively changing a position of the filter passband. Here is the MATLAB code for
generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);
The example transformation creates a passband from 0.5 to 0.75:

[num,den] = iirlp2xn(b, a, [-0.5, 0.5], [0.5, 0.75], "“pass”);
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Example of Real Lowpass to Real Multipoint Mapping

Frequency Transformations for Complex Filters

“Overview” on page 4-99

“Complex Frequency Shift” on page 4-100

“Real Lowpass to Complex Bandpass” on page 4-101
“Real Lowpass to Complex Bandstop” on page 4-103
“Real Lowpass to Complex Multiband” on page 4-104
“Real Lowpass to Complex Multipoint” on page 4-106
“Complex Bandpass to Complex Bandpass” on page 4-108

Overview

This section discusses complex frequency transformation that take the complex prototype
filter and convert it into a different complex target filter. The target filter has its
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frequency response modified in respect to the frequency response of the prototype filter
according to the characteristic of the applied frequency transformation from:

Complex Frequency Shift

Complex frequency shift transformation is the simplest first-order transformation that
performs an exact mapping of one selected feature of the frequency response into its new
location. At the same time it rotates the whole response of the prototype lowpass filter
by the distance specified by the selection of the feature from the prototype filter and the
target filter.

Hy(2)=azt

with a given by

o= ejzﬂ’- (Vnew _vold)

where
w.1q — Frequency location of the selected feature in the prototype filter
Wnew — Position of the feature originally at w,;g 1n the target filter

A special case of the complex frequency shift is a, so called, Hilbert Transformer. It can
be designed by setting the parameter to |a|=1, that is

0l forward
=0

1 inverse

The example below shows how to apply this transformation to rotate the response of the
prototype lowpass filter in either direction. Please note that because the transformation
can be achieved by a simple phase shift operator, all features of the prototype filter will

be moved by the same amount. Here is the MATLAB code for generating the example in
the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);
The example transformation moves the feature originally at 0.5 to 0.3:

[num,den] = iirshiftc(b, a, 0.5, 0.3);
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Example of Complex Frequency Shift Mapping

Real Lowpass to Complex Bandpass

This first-order transformation performs an exact mapping of one selected feature of the
prototype filter frequency response into two new locations in the target filter creating a
passband between them. Both Nyquist and DC features can be moved with the rest of the

frequency response.

_B-az’
H, (z=P"%%
A 21 -of

with a and £ are given by

. T
Slnz(2wold ~ O 2 + wnew,l)

Sin71'(26()old + Onew,2 _wnew,l)

ﬁ - e‘j”(wnew ~0,,)
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where

w.1q — Frequency location of the selected feature in the prototype filter
Onew,1 — Position of the feature originally at (-@,;y) in the target filter
Onew,2 — Position of the feature originally at (+w,;y) in the target filter

The following example shows the use of such a transformation for converting a real
halfband lowpass filter into a complex bandpass filter with band edges at 0.5 and 0.75.
Here is the MATLAB code for generating the example in the figure.

The prototype filter is a half band elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The transformation creates a passband from 0.5 to 0.75:

[num,den] = iirlp2bpc(b, a, 0.5, [0.5 0.75]);
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Example of Real Lowpass to Complex Bandpass Mapping

4-102



Digital Frequency Transformations

Real Lowpass to Complex Bandstop

This first-order transformation performs an exact mapping of one selected feature of the
prototype filter frequency response into two new locations in the target filter creating a
stopband between them. Both Nyquist and DC features can be moved with the rest of the
frequency response.

B - oz

H,(2) =
A aﬁ—z_l

with a and £ are given by

_ c0S7z'(2wolol +Vnew,2 _vnew,l)

o=
COS7.L'(2wold “View,2 +vnew,1)

ﬁ = e_j”(wnew _a)old)
where
.10 — Frequency location of the selected feature in the prototype filter
@new,1 — Position of the feature originally at (-w,g) in the target filter
Onew,2 — Position of the feature originally at (+w,;y) in the target filter
The example below shows the use of such a transformation for converting a real halfband
lowpass filter into a complex bandstop filter with band edges at 0.5 and 0.75. Here is the

MATLAB code for generating the example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);

The transformation creates a stopband from 0.5 to 0.75:

[num,den] = iirlp2bsc(b, a, 0.5, [0.5 0.75]);
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Example of Real Lowpass to Complex Bandstop Mapping
Real Lowpass to Complex Multiband

This high-order transformation performs an exact mapping of one selected feature of the
prototype filter frequency response into a number of new locations in the target filter. Its
most common use is to convert a real lowpass with predefined passband and stopband
ripples into a multiband filter with arbitrary band edges. The order of the mapping filter
must be even, which corresponds to an even number of band edges in the target filter.
The Nth-order complex allpass mapping filter is given by the following general transfer
function form:

N .
=1
O(iz

Hy(2)= S =0——

zal iZ_N+i
1=0
OCO =1
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The coefficients a are calculated from the system of linear equations:

oN
Oy O(ogl) fos By 5= cos By, H oy L [$in By 4+ sin Py ;5= cos B3,
it
O O(os 0 $in By jm sin g, H- Dog L Epos By 4+ cos Py p H=sinfg ),
£

_ k
1,k — K4 %’old [0-1) +Vnew,k(N _k)E

2k = T @C +Vnew,kkB

PO

il
583,/6 =T H’old m_l)k +Vnew,kNE
k=1..N

where

.1 — Frequency location of the selected feature in the prototype filter
Onew,i — Position of features originally at +@,;; in the target filter

Parameter S is the additional rotation factor by the frequency distance AC, giving the
additional flexibility of achieving the required mapping:

S = /mC

The example shows the use of such a transformation for converting a prototype real
lowpass filter with the cutoff frequency at 0.5 into a multiband complex filter with band
edges at 0.2, 0.4, 0.6 and 0.8, creating two passbands around the unit circle. Here is the
MATLAB code for generating the figure.
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Example of Real Lowpass to Complex Multiband Mapping

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409):

The example transformation creates two complex passbands:

[num,den] = iirlp2mbc(b, a, 0.5, [0.2, 0.4, 0.6, 0.8]);

Real Lowpass to Complex Multipoint

This high-order transformation performs an exact mapping of a number of selected
features of the prototype filter frequency response to their new locations in the target

filter. The Nth-order complex allpass mapping filter is given by the following general
transfer function form.
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1=0
OCO =1

The coefficients a can be calculated from the system of linear equations:
ON
E; 0oyl Fos By j= cos By g, H+ Dl D F$in By p+ sin By, H= cos B3y,
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o Dl [8in By ;- sinfy, H- Olog D os By 4+ cos By ,H=sinfg,

g

T
Lk =Ty Hoid . + Opew 1 (N —R)H

T
_E gAC + wnew’kkH

%I:I O %DD%

T
3k= "5 H%id 1+ Onew N H

|
=

where
®oa,r — Frequency location of the first feature in the prototype filter
Onew,, — Position of the feature originally at wyq . in the target filter

Parameter S is the additional rotation factor by the frequency distance AC, giving the
additional flexibility of achieving the required mapping:

S = /mC

The following example shows how this transformation can be used to move one selected
feature of the prototype lowpass filter originally at -0.5 to two new frequencies -0.5 and
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0.1, and the second feature of the prototype filter from 0.5 to new locations at -0.25 and
0.3. This creates two nonsymmetric passbands around the unit circle, creating a complex
filter. Here is the MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);
The example transformation creates two nonsymmetric passbands:

[num,den] = iirlp2xc(b,a,0.5*[-1,1,-1,1], [-0.5,-0.25,0.1,0.3]);
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Example of Real Lowpass to Complex Multipoint Mapping

Complex Bandpass to Complex Bandpass

This first-order transformation performs an exact mapping of two selected features of the

prototype filter frequency response into two new locations in the target filter. Its most
common use is to adjust the edges of the complex bandpass filter.
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with a and £ are given by

. T
Slnz((a’oldﬁ - wold,l) - (wnew,z “Wpew,1 )

a =
. T
Slnz((a’oldﬁ - wold,l) + (wnew,z ~Whew,l )
o= e‘jﬂ'(woai,z‘ oid,1)
,}/ = e_j”(wnew,Z _wnew,l)
where

®o1q,1 — Frequency location of the first feature in the prototype filter

®oq,2 — Frequency location of the second feature in the prototype filter

Onew,1 — Position of the feature originally at w4 ; in the target filter

Onew,2 — Position of the feature originally at w42 in the target filter

The following example shows how this transformation can be used to modify the position
of the passband of the prototype filter, either real or complex. In the example below

the prototype filter passband spanned from 0.5 to 0.75. It was converted to having a
passband between -0.5 and 0.1. Here is the MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:
[b, a] = ellip(3, 0.1, 30, 0.409);
The example transformation creates a passband from 0.25 to 0.75:

[num,den] = iirbpc2bpc(b, a, [0.25, 0.75], [-0.5, 0.1]);
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Example of Complex Bandpass to Complex Bandpass Mapping
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Digital Filter Design Block

In this section...

“Overview of the Digital Filter Design Block” on page 4-111
“Select a Filter Design Block” on page 4-112
“Create a Lowpass Filter in Simulink” on page 4-113

“Create a Highpass Filter in Simulink” on page 4-114

“Filter High-Frequency Noise in Simulink” on page 4-116

Overview of the Digital Filter Design Block

You can use the Digital Filter Design block to design and implement a digital filter. The
filter you design can filter single-channel or multichannel signals. The Digital Filter
Design block is ideal for simulating the numerical behavior of your filter on a floating-
point system, such as a personal computer or DSP chip. You can use the Simulink Coder
product to generate C code from your filter block. For more information on generating C
code from models, see “Understanding C Code Generation” on page 10-2.

Filter Design and Analysis

You perform all filter design and analysis within the Filter Design and Analysis Tool
(FDATool) GUI, which opens when you double-click the Digital Filter Design block.
FDATool provides extensive filter design parameters and analysis tools such as pole-zero
and impulse response plots.

Filter Implementation

Once you have designed your filter using FDATool, the block automatically realizes the
filter using the filter structure you specify. You can then use the block to filter signals
in your model. You can also fine-tune the filter by changing the filter specification
parameters during a simulation. The outputs of the Digital Filter Design block
numerically match the outputs of the DSP System Toolbox Fi Iter function and the
MATLAB filter function.

Saving, Exporting, and Importing Filters
The Digital Filter Design block allows you to save the filters you design, export filters (to
the MATLAB workspace, MAT-files, etc.), and import filters designed elsewhere.
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To learn how to save your filter designs, see “Saving and Opening Filter Design Sessions”
in the Signal Processing Toolbox documentation. To learn how to import and export your
filter designs, see “Import and Export Quantized Filters”.

Note: You can use the Digital Filter Design block to design and implement a filter. To
implement a pre-designed filter, use the Discrete FIR Filter or Biquad Filter blocks.
Both methods implement a filter design in the same manner and have the same behavior
during simulation and code generation.

See the Digital Filter Design block reference page for more information. For information
on choosing between the Digital Filter Design block and the Filter Realization Wizard,
see “Select a Filter Design Block” on page 4-112.

Select a Filter Design Block

This section explains the similarities and differences between the Digital Filter Design
and Filter Realization Wizard blocks.

Similarities

The Digital Filter Design block and Filter Realization Wizard are similar in the following
ways:

+  Filter design and analysis options — Both blocks use the Filter Design and Analysis
Tool (FDATool) GUI for filter design and analysis.

*  Output values — If the output of both blocks is double-precision floating point, single-
precision floating point, or fixed point, the output values of both blocks numerically
match the output of the Fi lter method of the dfi It object.

Differences

The Digital Filter Design block and Filter Realization Wizard handle the following things
differently:

*  Supported filter structures — Both blocks support many of the same basic filter
structures, but the Filter Realization Wizard supports more structures than the
Digital Filter Design block. This is because the block can implement filters using
Sum, Gain, and Delay blocks. See the Filter Realization Wizard and Digital Filter
Design block reference pages for a list of all the structures they support.
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+ Data type support — The Filter Realization Wizard block supports single- and
double-precision floating-point computation for all filter structures and fixed-point
computation for some filter structures. The Digital Filter Design block only supports
single- and double-precision floating-point computation.

+  Block versus Wizard — The Digital Filter Design block is the filter itself, but the
Filter Realization Wizard block just enables you to create new filters and put them in
an existing model. Thus, the Filter Realization Wizard is not a block that processes
data in your model, it is a wizard that generates filter blocks (or subsystems) which
you can then use to process data in your model.

When to Use Each Block

The following are specific situations where only the Digital Filter Design block or the
Filter Realization Wizard is appropriate.

* Digital Filter Design

+  Use to simulate single- and double-precision floating-point filters.

Use to generate highly optimized ANSI® C code that implements floating-point
filters for embedded systems.

* Filter Realization Wizard
+  Use to simulate numerical behavior of fixed-point filters in a DSP chip, a field-

programmable gate array (FPGA), or an application-specific integrated circuit

(ASIC).

+  Use to simulate single- and double-precision floating-point filters with structures
that the Digital Filter Design block does not support.

Use to visualize the filter structure, as the block can build the filter from Sum,
Gain, and Delay blocks.

*  Use to rapidly generate multiple filter blocks.
See “Filter Realization Wizard” on page 4-121 and the Filter Realization Wizard block
reference page for information.
Create a Lowpass Filter in Simulink

You can use the Digital Filter Design block to design and implement a digital FIR or IIR
filter. In this topic, you use it to create an FIR lowpass filter:

1  Open Simulink and create a new model file.
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2 From the DSP System Toolbox Filtering library, and then from the Filter
Implementations library, click-and-drag a Digital Filter Design block into your
model.

3 Double-click the Digital Filter Design block.

The Filter Design and Analysis Tool (FDATool) GUI opens.
4  Set the parameters as follows, and then click OK:

* Response Type = Lowpass
Design Method = FIR, Equiripple
+ Filter Order =Minimum order
* Units =Normalized (0 to 1)
* wpass=0.2
wstop =0.5
5 Click Design Filter at the bottom of the GUI to design the filter.

Your Digital Filter Design block now represents a filter with the parameters you
specified.

6 From the Edit menu, select Convert Structure.

The Convert Structure dialog box opens.
7 Select Direct-Form FIR Transposed and click OK.
8 Rename your block Digital Filter Design - Lowpass.

The Digital Filter Design block now represents a lowpass filter with a Direct-Form

FIR Transposed structure. The filter passes all frequencies up to 20% of the Nyquist
frequency (half the sampling frequency), and stops frequencies greater than or equal to
50% of the Nyquist frequency as defined by the wpass and wstop parameters. In the
next topic, “Create a Highpass Filter in Simulink” on page 4-114, you use a Digital
Filter Design block to create a highpass filter. For more information about implementing
a pre-designed filter, see “Digital Filter Implementations” on page 4-133.

Create a Highpass Filter in Simulink
In this topic, you create a highpass filter using the Digital Filter Design block:

1 If the model you created in “Create a Lowpass Filter in Simulink” on page 4-113 is
not open on your desktop, you can open an equivalent model by typing
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7
8

ex_Ffilter_ex4

at the MATLAB command prompt.

From the DSP System Toolbox Filtering library, and then from the Filter
Implementations library, click-and-drag a second Digital Filter Design block into
your model.

Double-click the Digital Filter Design block.

The Filter Design and Analysis Tool (FDATool) GUI opens.

Set the parameters as follows:

* Response Type = Highpass
+ Design Method = FIR, Equiripple
Filter Order = Minimum order
Units = Normalized (0O to 1)
* wstop=0.2
* wpass=0.5
Click the Design Filter button at the bottom of the GUI to design the filter.
Your Digital Filter Design block now represents a filter with the parameters you
specified.

In the Edit menu, select Convert Structure.

The Convert Structure dialog box opens.
Select Direct-Form FIR Transposed and click OK.
Rename your block Digital Filter Design - Highpass.

The block now implements a highpass filter with a direct form FIR transpose structure.
The filter passes all frequencies greater than or equal to 50% of the Nyquist frequency
(half the sampling frequency), and stops frequencies less than or equal to 20% of the
Nyquist frequency as defined by the wpass and wstop parameters. This highpass filter
is the opposite of the lowpass filter described in “Create a Lowpass Filter in Simulink”
on page 4-113. The highpass filter passes the frequencies stopped by the lowpass

filter, and stops the frequencies passed by the lowpass filter. In the next topic, “Filter
High-Frequency Noise in Simulink” on page 4-116, you use these Digital Filter

Design blocks to create a model capable of removing high frequency noise from a signal.
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For more information about implementing a pre-designed filter, see “Digital Filter
Implementations” on page 4-133.

Filter High-Frequency Noise in Simulink

In the previous topics, you used Digital Filter Design blocks to create FIR lowpass and
highpass filters. In this topic, you use these blocks to build a model that removes high
frequency noise from a signal. In this model, you use the highpass filter, which is excited
using a uniform random signal, to create high-frequency noise. After you add this noise
to a sine wave, you use the lowpass filter to filter out the high-frequency noise:

1 If the model you created in “Create a Highpass Filter in Simulink” on page 4-114
is not open on your desktop, you can open an equivalent model by typing

ex_Ffilter_ex5

at the MATLAB command prompt.
2 Click-and-drag the following blocks into your model.

Block Library Quantity
Add Simulink Math Operations library 1
Random Source Sources 1
Sine Wave Sources 1
Time Scope Sinks 1

3 Set the parameters for these blocks as indicated in the following table. Leave the
parameters not listed in the table at their default settings.

Parameter Settings for the Other Blocks

Block Parameter Setting

Add + Icon shape = rectangular

* List of signs = ++

Random Source |+ Source type = =Uniform
* Minimum =0

+ Maximum =4

+ Sample mode =Discrete
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Block Parameter Setting

+ Sample time = 1/1000

+ Samples per frame = 50
Sine Wave * Frequency (Hz) =75

+ Sample time = 1/1000

+ Samples per frame = 50

Time Scope

+ File > Number of Input Ports > 3

+ File > Configuration ...

Open the Visuals:Time Domain Options dialog and set
Time span = One frame period

4  Connect the blocks as shown in the following figure. You might need to resize some
of the blocks to accomplish this task.

FDATool
i "/
Random —
Source Cigital
Filter Design - Highpass
|+
FDATool L
> % >
—
Digital Time
|IJ_|_|D5F' Filtler Design - Lowpass Scope
|+

| Ly

Sine Wave

5 From the Simulation menu, select Model Configuration Parameters.
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4-118

10

The Configuration Parameters dialog box opens.

In the Solver pane, set the parameters as follows, and then click OK:

Start time =0
+ Stop time =5
Type = Fixed-step
+ Solver =Discrete (no continuous states)

In the model window, from the Simulation menu, choose Run.

The model simulation begins and the scope displays the three input signals.

After simulation is complete, select View > Legend from the Time Scope menu. The
legend appears in the Time Scope window. You can click-and-drag it anywhere on
the scope display. To change the channel names, double-click inside the legend and
replace the default channel names with the following:
+ Add =Noisy Sine Wave

Digital Filter Design — Lowpass = Filtered Noisy Sine Wave

+ Sine Wave =Original Sine Wave

In the next step, you will set the color, style, and marker of each channel.

In the Time Scope window, select View > Line Properties, and set the following:

Line Style Marker Color
Noisy Sine Wave - None Black
Filtered Noisy Sine |- diamond Red
Wave

Original Sine Wave |None w3 Blue

The Time Scope display should now appear as follows:
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i

File Tools View Simulaton Help kT
B Q&R |4
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=
=
£
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You can see that the lowpass filter filters out the high-frequency noise in the noisy
sine wave.

You have now used Digital Filter Design blocks to build a model that removes high
frequency noise from a signal. For more information about these blocks, see the Digital
Filter Design block reference page. For information on another block capable of designing
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and implementing filters, see “Filter Realization Wizard” on page 4-121. To learn how
to save your filter designs, see “Saving and Opening Filter Design Sessions” in the Signal
Processing Toolbox documentation. To learn how to import and export your filter designs,
see “Import and Export Quantized Filters” in the DSP System Toolbox documentation.
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Filter Realization Wizard

In this section...

“Overview of the Filter Realization Wizard” on page 4-121

“Design and Implement a Fixed-Point Filter in Simulink” on page 4-121
“Set the Filter Structure and Number of Filter Sections” on page 4-130
“Optimize the Filter Structure” on page 4-131

Overview of the Filter Realization Wizard

The Filter Realization Wizard is another DSP System Toolbox block that can be used

to design and implement digital filters. You can use this tool to filter single-channel
floating-point or fixed-point signals. Like the Digital Filter Design block, double-clicking
a Filter Realization Wizard block opens FDATool. Unlike the Digital Filter Design block,
the Filter Realization Wizard starts FDATool with the Realize Model panel selected.
This panel is optimized for use with DSP System Toolbox software.

For more information, see the Filter Realization Wizard block reference page. For
information on choosing between the Digital Filter Design block and the Filter
Realization Wizard, see “Select a Filter Design Block” on page 4-112.

Design and Implement a Fixed-Point Filter in Simulink

In this section, a tutorial guides you through creating a fixed-point filter with the Filter
Realization Wizard. You will use the Filter Realization Wizard to remove noise from a
signal. This tutorial has the following parts:

+ “Part 1 — Create a Signal with Added Noise” on page 4-121

+ “Part 2 — Create a Fixed-Point Filter with the Filter Realization Wizard” on page
4-123

+ “Part 3 — Build a Model to Filter a Signal” on page 4-127
+ “Part 4 — Examine Filtering Results” on page 4-129

Part 1 — Create a Signal with Added Noise

In this section of the tutorial, you will create a signal with added noise. Later in the
tutorial, you will filter this signal with a fixed-point filter that you design with the Filter
Realization Wizard.
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1 Type

load mtlb
soundsc(mtlb,Fs)

at the MATLAB command line. You should hear a voice say “MATLAB.” This is the
signal to which you will add noise.

2 Create a noise signal by typing
noise = cos(2*pi*3*Fs/8*(0:length(mtlb)-1)/Fs)*;
at the command line. You can hear the noise signal by typing

soundsc(noise,Fs)

3 Add the noise to the original signal by typing

u = mtlb + noise;

at the command line.

4  Scale the signal with noise by typing
u = u/max(abs(u));

at the command line. You scale the signal to try to avoid overflows later on. You can
hear the scaled signal with noise by typing

soundsc(u,Fs)

5 View the scaled signal with noise by typing

spectrogram(u,256,[]1,[1,Fs);colorbar
at the command line.

The spectrogram appears as follows.
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B Figure1 [E=% e =X

File Edit View Inset Tools Desktop Window Help E
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1] 500 1000 15EID QDDEI 2500 3000 3500
Frequency (Hz)

In the spectrogram, you can see the noise signal as a line at about 2800 Hz, which is
equal to 3*Fs/8.

Part 2 — Create a Fixed-Point Filter with the Filter Realization Wizard

Next you will create a fixed-point filter using the Filter Realization Wizard. You will
create a filter that reduces the effects of the noise on the signal.

1  Open a new Simulink model, and drag-and-drop a Filter Realization Wizard block
from the Filtering / Filter Implementations library into the model.

Note: You do not have to place a Filter Realization Wizard block in a model in order
to use it. You can open the GUI from within a library. However, for purposes of this
tutorial, we will keep the Filter Realization Wizard block in the model.
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4-124

Double-click the Filter Realization Wizard block in your model. The Realize Model
panel of the Filter Design and Analysis Tool (FDATool) appears.

Click the Design Filter button (E) on the bottom left of FDATool. This brings
forward the Design filter panel of the tool.

Set the following fields in the Design filter panel:

Set Design Method to IR -- Constrained Least Pth-norm
Set Fs to Fs

Set Fpass to 0.2*Fs

Set Fstop to 0.25*Fs

Set Max pole radius to 0.8

Click the Design Filter button

The Design filter panel should now appear as follows.
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5 Click the Set quantization parameters button on the bottom left of FDATool
(). This brings forward the Set quantization parameters panel of the tool.

6 Set the following fields in the Set quantization parameters panel:

+  Select Fixed-point for the Filter arithmetic parameter.
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+  Make sure the Best precision fraction lengths check box is selected on the
Coefficients pane.

The Set quantization parameters panel should appear as follows.

File
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View Window Help

DEeESE 222X T1E N0 BLORE W

[= o ==

— Current Fitter Information — Magnitude Response (dB).
0 I T L
H . Lowpass Equiripple: Quantized
vy 1 | I J ______________ '_ — - — - Lowpass Equiripple: Reference | |
Structure; Direct-Form FIR & -20 : : .
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Click the Realize Model button on the left side of FDATool ( 1@ ). This brings
forward the Realize Model panel of the tool.
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8 Select the Build model using basic elements check box, then click the Realize
Model button on the bottom of FDATool. A subsystem block for the new filter

appears in your model.
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Note: You do not have to keep the Filter Realization Wizard block in the same model
as the generated Filter block. However, for this tutorial, we will keep the blocks in
the same model.

9 Double-click the Filter subsystem block in your model to view the filter
implementation.

Part 3 — Build a Model to Filter a Signal

In this section of the tutorial, you will filter noise from a signal in your Simulink model.
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4-128

Connect a Signal From Workspace block from the Sources library to the input port of
your filter block.

Connect a To Workspace block from the Sinks library to the output port of your filter
block. Your blocks should now be connected as follows.

1:10 e Inpiurt Churtpurt B yout
SﬂnﬂlFrﬂTl Fitter Sﬂl’lﬂlTﬂ
Workspace Workspace

Open the Signal From Workspace block dialog box and set the Signal parameter to
u. Click OK to save your changes and close the dialog box.

Open the Model Configuration Parameters dialog box from the Simulation
menu of the model. In the Solver pane of the dialog, set the following fields:
+ Stop time = length(u)-1

Type = Fixed-step

Click OK to save your changes and close the dialog box.
Run the model.

From the Display menu of the model, select Signals & Ports > Port Data Types.
You can now see that the input to the Filter block is a signal of type double and the
output of the Filter block has a data type of sFix16 Enl1l.
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Part 4 — Examine Filtering Results

Now you can listen to and look at the results of the fixed-point filter you designed and

implemented.
1 Type
soundsc(yout,Fs)

at the command line to hear the output of the filter. You should hear a voice say

“MATLAB.” The noise portion of the signal should be close to inaudible.
2 Type
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figure
spectrogram(yout,256,[],[].Fs);colorbar

at the command line.
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From the colorbars at the side of the input and output spectrograms, you can see that the

noise has been reduced by about 40 dB.

Set the Filter Structure and Number of Filter Sections

The Current Filter Information region of FDATool shows the structure and the

number of second-order sections in your filter.

Change the filter structure and number of filter sections of your filter as follows:

* Select Convert Structure from the Edit menu to open the Convert Structure
dialog box. For details, see “Converting to a New Structure” in the Signal Processing

Toolbox documentation.

* Select Convert to Second-order Sections from the Edit menu to open the
Convert to SOS dialog box. For details, see “Converting to Second-Order Sections” in

the Signal Processing Toolbox documentation.
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Note: You might not be able to directly access some of the supported structures through
the Convert Structure dialog of FDATool. However, you can access all of the structures
by creating a dfi It filter object with the desired structure, and then importing the filter
into FDATool. To learn more about the Import Filter panel, see “Importing a Filter
Design” in the Signal Processing Toolbox documentation.

Optimize the Filter Structure

The Filter Realization Wizard can implement a digital filter using either digital filter
blocks from the DSP System Toolbox library or by creating a subsystem block that
implements the filter using Sum, Gain, and Delay blocks. The following procedure shows
you how to optimize the filter implementation:

1 Open the Realize Model pane of FDATool by clicking the Realize Model button

IEI in the lower-left corner of FDATool.

2 Select the desired optimizations in the Optimization region of the Realize Model
pane. See the following descriptions and illustrations of each optimization option.

[+H
Realize - N
Model Destination: | Current v [¥] Optimize for unity gains

Untitled Optimize for negative gains

'

[7] Overwrite generated ‘Fiter' biock Optimize delay chains

Build medel using basic elements

— Model Optimization
Block name: Filter Optimize for zero gains
Optimize for unity scale values

Input precessing:  |Elements as channels (sample based) x| Realize Model

7| 1 B e B
-

+ Optimize for zero gains — Remove zero-gain paths.

* Optimize for unity gains — Substitute gains equal to one with a wire (short
circuit).

* Optimize for negative gains — Substitute gains equal to -1 with a wire (short
circuit), and change the corresponding sums to subtractions.

4-131



4 Filrer Analysis, Design, and Implementation

+ Optimize delay chains — Substitute any delay chain made up of n unit delays with
a single delay by n.

* Optimize for unity scale values — Remove all scale value multiplications by 1
from the filter structure.

The following diagram illustrates the results of each of these optimizations.
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Digital Filter Implementations

In this section...
“Using Digital Filter Blocks” on page 4-133

“Implement a Lowpass Filter in Simulink” on page 4-133

“Implement a Highpass Filter in Simulink” on page 4-134

“Filter High-Frequency Noise in Simulink” on page 4-135

“Specify Static Filters” on page 4-140

“Specify Time-Varying Filters” on page 4-140

“Specify the SOS Matrix (Biquadratic Filter Coefficients)” on page 4-141

Using Digital Filter Blocks

DSP System Toolbox provides several blocks implementing digital filters, such as
Discrete FIR Filter and Biquad Filter.

Use these blocks if you have already performed the design and analysis and know

your desired filter coefficients. You can use these blocks to filter single-channel and
multichannel signals, and to simulate floating-point and fixed-point filters. Then, you can
use the Simulink Coder product to generate highly optimized C code from your filters.

To implement a filter, you must provide the following basic information about the filter:

* The desired filter structure

* The filter coefficients

Note: Use the Digital Filter Design block to design and implement a filter. Use the
Discrete FIR Filter and Biquad Filter blocks to implement a pre-designed filter. Both
methods implement a filter in the same manner and have the same behavior during
simulation and code generation.

Implement a Lowpass Filter in Simulink
Use the Discrete FIR Filter block to implement a lowpass filter:

1 Define the lowpass filter coefficients in the MATLAB workspace by typing
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4-134

lopassNum = [-0.0021 -0.0108 -0.0274 -0.0409 -0.0266 0.0374
0.1435 0.2465 0.2896 0.2465 0.1435 0.0374 -0.0266 -0.0409 -0.0274
-0.0108 -0.0021];

Open Simulink and create a new model file.

From the DSP System Toolbox Filtering>Filter Implementations library, click-and-
drag a Discrete FIR Filter block into your model.

Double-click the Discrete FIR Filter block. Set the block parameters as follows, and
then click OK:
+ Coefficient source = Dialog parameters
Filter structure = Direct form transposed
+ Coefficients = lopassNum
* Input processing = Columns as channels (frame based)

Initial states =0

Note that you can provide the filter coefficients in several ways:

Type in a variable name from the MATLAB workspace, such as lopassNum.

Type in filter design commands from Signal Processing Toolbox software or DSP
System Toolbox software, such as Firl(5, 0.2, "low").

+ Type in a vector of the filter coefficient values.

5 Rename your block Digital Filter - Lowpass.

The Discrete FIR Filter block in your model now represents a lowpass filter. In the next
topic, “Implement a Highpass Filter in Simulink” on page 4-134, you use a Discrete

FIR Filter block to implement a highpass filter. For more information about the Discrete
FIR Filter block, see the Discrete FIR Filter block reference page. For more information
about designing and implementing a new filter, see “Digital Filter Design Block” on page
4-111.

Implement a Highpass Filter in Simulink

In this topic, you implement a highpass filter using the Discrete FIR Filter block:

If the model you created in “Implement a Lowpass Filter in Simulink” on page
4-133 is not open on your desktop, you can open an equivalent model by typing
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ex_Ffilter_exl

at the MATLAB command prompt.
Define the highpass filter coefficients in the MATLAB workspace by typing

hipassNum = [-0.0051 0.0181 -0.0069 -0.0283 -0.0061 ...
0.0549 0.0579 -0.0826 -0.2992 0.5946 -0.2992 -0.0826 ...
0.0579 0.0549 -0.0061 -0.0283 -0.0069 0.0181 -0.0051];

From the DSP System Toolbox Filtering library, and then from the Filter
Implementations library, click-and-drag a Discrete FIR Filter block into your model.

Double-click the Discrete FIR Filter block. Set the block parameters as follows, and
then click OK:
+ Coefficient source = Dialog parameters
Filter structure = Direct form transposed
+ Coefficients = hipassNum
* Input processing = Columns as channels (frame based)
+ Initial states =0

You can provide the filter coefficients in several ways:

+ Type in a variable name from the MATLAB workspace, such as hipassNum.

Type in filter design commands from Signal Processing Toolbox software or DSP
System Toolbox software, such as firl(5, 0.2, "low").

Type in a vector of the filter coefficient values.

5 Rename your block Digital Filter - Highpass.

You have now successfully implemented a highpass filter. In the next topic, “Filter High-
Frequency Noise in Simulink” on page 4-135, you use these Discrete FIR Filter blocks

to create a model capable of removing high frequency noise from a signal. For more
information about designing and implementing a new filter, see “Digital Filter Design
Block” on page 4-111.

Filter High-Frequency Noise in Simulink

In the previous topics, you used Discrete FIR Filter blocks to implement lowpass and
highpass filters. In this topic, you use these blocks to build a model that removes high
frequency noise from a signal. In this model, you use the highpass filter, which is excited
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using a uniform random signal, to create high-frequency noise. After you add this noise
to a sine wave, you use the lowpass filter to filter out the high-frequency noise:

1 If the model you created in “Implement a Highpass Filter in Simulink” on page
4-134 is not open on your desktop, you can open an equivalent model by typing

ex_Filter_ex2

at the MATLAB command prompt.

2 Ifyou have not already done so, define the lowpass and highpass filter coefficients in
the MATLAB workspace by typing

lopassNum = [-0.0021 -0.0108 -0.0274 -0.0409 -0.0266 ...
0.0374 0.1435 0.2465 0.2896 0.2465 0.1435 0.0374 ...
-0.0266 -0.0409 -0.0274 -0.0108 -0.0021];

hipassNum = [-0.0051 0.0181 -0.0069 -0.0283 -0.0061 ...
0.0549 0.0579 -0.0826 -0.2992 0.5946 -0.2992 -0.0826 ...
0.0579 0.0549 -0.0061 -0.0283 -0.0069 0.0181 -0.0051];

3 Click-and-drag the following blocks into your model file.

Block Library Quantity
Add Simulink / Math Operations library 1
Random Source Sources 1
Sine Wave Sources 1
Time Scope Sinks 1

4  Set the parameters for the rest of the blocks as indicated in the following table. For
any parameters not listed in the table, leave them at their default settings.

Block Parameter Setting

Add * Icon shape = rectangular

* List of signs = ++

Random Source * Source type = Uniform

* Minimum =0

* Maximum =4

+ Sample mode = Discrete
* Sample time = 1/1000
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Block Parameter Setting
+ Samples per frame = 50
Sine Wave * Frequency (Hz) =75

+ Sample time = 1/1000

+ Samples per frame = 50

Time Scope

* File > Number of Input

+ File > Configuration ...

* Open the Visuals:Time Domain Options dialog
and set Time span = One frame period

Ports >3

5 Connect the blocks as shown in the following figure. You may need to resize some of
your blocks to accomplish this task.
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6 From the Simulation menu, select Model Configuration Parameters.
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The Configuration Parameters dialog box opens.
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10

11

4-138

In the Solver pane, set the parameters as follows, and then click OK:

Start time =0
+ Stop time =5
Type = Fixed-step
* Solver =discrete (no continuous states)

In the model window, from the Simulation menu, choose Run.

The model simulation begins and the Scope displays the three input signals.

After simulation is complete, select View > Legend from the Time Scope menu. The
legend appears in the Time Scope window. You can click-and-drag it anywhere on
the scope display. To change the channel names, double-click inside the legend and
replace the current numbered channel names with the following:
+ Add =Noisy Sine Wave

Digital Filter — Lowpass = Filtered Noisy Sine Wave

+ Sine Wave =0Original Sine Wave

In the next step, you will set the color, style, and marker of each channel.

In the Time Scope window, select View > Line Properties, and set the following:
Line Style Marker Color

Noisy Sine Wave - None Black

Filtered Noisy Sine |- diamond Red

Wave

Original Sine Wave |None © Blue

The Time Scope display should now appear as follows:

You can see that the lowpass filter filters out the high-frequency noise in the noisy
sine wave.



Digital Filter Implementations

=10l x|

) Time Scope

File

Help

Simulation
B Q&R |4
C R L

View

Tools

it Rt Stk ittty Rl |

) IR

apnydisy

'
'
'
'
'
'
'
'
'
L ]
' \
' \
' \
' \
' \
' \
' \
' \
' \
dacmccaaa [ S—
i h
' \
' \
' \
' \
' \
' \
' \
' \
' \
demmmman L
1 I
' \
' \
' \
' \
' \
' \
' \
' \
' \
EEEE TR -—
' |
' \
' \
' \
' \
' I
' \
' \
' I
[ TN P [
d i
' I
' \
' \
' I
' \
' \
' I
' \
' \
dacmccaaa [E—
l h
' \
' I
' \
' \
' I
' \
' \
' I
' \
o
=
m
=
w W
LU=
=i =
m _—
= - -
253
v o E
E = W
L =
o
LTI ]
o = =
= b 0
T
] |
o
_ ]

20 25 30 35 40 45 50
Time (ms)

15

10

5.000 (secs) [T=5.000

|offset

Ready

You have now used Discrete FIR Filter blocks to build a model that removes high

frequency noise from a signal. For more information about designing and implementing a

new filter, see “Digital Filter Design Block” on page 4-111.
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Specify Static Filters

You can specify a static filter using the Discrete FIR Filter or Biquad Filter block. To do
so, set the Coefficient source parameter to Dialog parameters.

For the Discrete FIR Filter, set the Coefficients parameter to a row vector of numerator
coefficients. If you set Filter structure to Lattice MA, the Coefficients parameter
represents reflection coefficients.

For the Biquad Filter, set the SOS matrix (Mx6) to an M-by-6 matrix, where M is

the number of sections in the second-order section filter. Each row of the SOS matrix
contains the numerator and denominator coefficients of the corresponding section in
the filter. Set Scale values to a scalar or vector of M+1 scale values used between SOS
stages.

Tuning the Filter Coefficient Values During Simulation

To change the static filter coefficients during simulation, double-click the block, type
in the new filter coefficients, and click OK. You cannot change the filter order, so you
cannot change the number of elements in the matrix of filter coefficients.

Specify Time-Varying Filters

Time-varying filters are filters whose coefficients change with time. You can specify a
time-varying filter that changes once per frame. You can filter multiple channels with
each filter. However, you cannot apply different filters to each channel; all channels use
the same filter.

To specify a time-varying filter using a Biquad Filter block or a Discrete FIR Filter block:

1 Set the Coefficient source parameter to Input port(s), which enables extra
block input ports for the time-varying filter coefficients.

The Discrete FIR Filter block has a Num port for the numerator coefficients.

* The Biquad Filter block has Num and Den ports rather than a single port for
the SOS matrix. Separate ports enable you to use different fraction lengths for
numerator and denominator coefficients. The scale values port, g, is optional.
You can disable the g port by setting Scale values mode to Assume all are
unity and optimize.

2 Provide matrices of filter coefficients to the block input ports.
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+  For Discrete FIR Filter block, the number of filter taps, IV, cannot vary over time.
The input coefficients must be in a 1-by-N vector.

+  For Biquad Filter block, the number of filter sections, IV, cannot vary over
time. The numerator coefficients input, Num, must be a 3-by-IN matrix. The
denominator input coefficients, Den, must be a 2-by-N matrix. The scale values
input, g, must be a 1-by-(IN+1) vector.

Specify the SOS Matrix (Biquadratic Filter Coefficients)

Use the Biquad Filter block to specify a static biquadratic IIR filter (also known as a
second-order section or SOS filter). Set the following parameters:

+ Filter structure — Direct form I,or Direct form 1 transposed, or Direct
form I1,or Direct form 11 transposed

* SOS matrix (Mx6) M-by-6 SOS matrix

The SOS matrix is an M-by-6 matrix, where M is the number of sections in the
second-order section filter. Each row of the SOS matrix contains the numerator and
denominator coefficients (b;, and a;;,) of the corresponding section in the filter.

* Scale values Scalar or vector of M+1 scale values to be used between SOS stages

If you enter a scalar, the value is used as the gain value before the first section of the
second-order filter. The rest of the gain values are set to 1.

If you enter a vector of M+1 values, each value is used for a separate section of the
filter. For example, the first element is the first gain value, the second element is the
second gain value, and so on.

et AE e {E

output
Secale walue 1 Scale walue 2 Scale wvalue hi+1
Sextion 1 Section bl

You can use the ss2s0s and tf2sos functions from Signal Processing Toolbox software
to convert a state-space or transfer function description of your filter into the second-
order section description used by this block.
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The block normalizes each row by ay; to ensure a value of 1 for the zero-delay
denominator coefficients.
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Analog Filter Design Block

The Analog Filter Design block designs and implements analog IIR filters with standard
band configurations. All of the analog filter designs let you specify a filter order. The
other available parameters depend on the filter type and band configuration, as shown in
the following table.

Configuration Butterworth Chebyshev | Chebyshev II Elliptic
Lowpass Q, Q,, R, Q,, Re Qp, Ry, R
Highpass Q, Q, R, Qs, R Qp, Ry, R
Bandpass Qu1, Qo Q1 2, Ry Qq1, Qs2, Rs Qp1, Cp2, Ry, R
Bandstop Qp1, Q2 Qp1, Qpa, Ry Qq1, Qeo, Re Qp1, Lz, Ry, Ry

The table parameters are

Q, — passband edge frequency

Qp1 — lower passband edge frequency
Qp2 — upper cutoff frequency

Q. — stopband edge frequency

Qg1 — lower stopband edge frequency
Qg — upper stopband edge frequency
R, — passband ripple in decibels

R, — stopband attenuation in decibels

For all of the analog filter designs, frequency parameters are in units of radians per
second.

The Analog Filter Design block uses a state-space filter representation, and applies the
filter using the State-Space block in the Simulink Continuous library. All of the design
methods use Signal Processing Toolbox functions to design the filter:

The Butterworth design uses the toolbox function butter.

The Chebyshev type I design uses the toolbox function chebyl.
The Chebyshev type II design uses the toolbox function cheby?2.
The elliptic design uses the toolbox function el lip.
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The Analog Filter Design block is built on the filter design capabilities of Signal
Processing Toolbox software.

Note: The Analog Filter Design block does not work with the Simulink discrete solver,
which is enabled when the Solver list is set to Discrete (no continuous states)
in the Solver pane of the Model Configuration Parameters dialog box. Select one of
the continuous solvers (such as ode4) instead.
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Removing High-Frequency Noise from an ECG Signal

This examples shows you how to filter an ECG signal that has high-freqquency noise,
and remove the noise by low-pass filtering.

% Create one period of ECG signal

X = ecg(500).";
y = sgolayfilt(x,0,5);
Fs = 1000;

[M.N] = size(y);

% Initialize scopes

TS = dsp.-TimeScope("SampleRate” ,Fs, ...
"TimeSpan®,1.5,...
"YLimits",[-1 1], --.
“ShowGrid”® ,true, ...
"NumlnputPorts”®,2, ..
"LayoutDimensions”®,[2 1],---
"Title","Noisy and Filtered Signals®);

% Design lowpass filter
Fpass = 200;

Fstop = 400;

Dpass = 0.05;

Dstop = 0.0001;

F = [0 Fpass Fstop Fs/2])/(Fs/2);
A =[11 0 (0] s

D [Dpass Dstop];
b = firgr("minorder®, F, A, D);
LP = dsp.FIRFilter("Numerator”®,b);

% Design Highpass Filter

Fstop = 200;

Fpass = 400;

Dstop = 0.0001;

Dpass = 0.05;

F = [0 Fstop Fpass Fs/2]/(Fs/2); % Frequency vector
A=1][00 1 1]; % Amplitude vector

D = [Dstop Dpass]; % Deviation (ripple) vector
b = firgr("minord®, F, A, D);

HP = dsp.-FIRFilter("Numerator®, b);

% Stream

tic;
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while toc < 30

end

x = .1 * randn(M,N);

highFregNoise = step(HP,Xx);
noisySignal = y + highFregNoise;
FfilteredSignal = step(LP,noisySignal);
step(TS,noisySignal,filteredSignal);

% Finalize
release(TS)
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Learn how to design and implement adaptive filters.

* “Overview of Adaptive Filters and Applications” on page 5-2

+ “Adaptive Filters in DSP System Toolbox Software” on page 5-9

+ “LMS Adaptive Filters” on page 5-12

+ “RLS Adaptive Filters” on page 5-30

+ “Signal Enhancement Using LMS and Normalized LMS” on page 5-36
+ “Adaptive Filters in Simulink” on page 5-45

+  “Selected Bibliography” on page 5-59
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In this section...

“Introduction to Adaptive Filtering” on page 5-2
“Adaptive Filtering Methodology” on page 5-2
“Choosing an Adaptive Filter” on page 5-4
“System Identification” on page 5-5

“Inverse System Identification” on page 5-6

“Noise or Interference Cancellation” on page 5-7

“Prediction” on page 5-7

Introduction to Adaptive Filtering

Adaptive filtering involves the changing of filter parameters (coefficients) over time,

to adapt to changing signal characteristics. Over the past three decades, digital signal
processors have made great advances in increasing speed and complexity, and reducing
power consumption. As a result, real-time adaptive filtering algorithms are quickly
becoming practical and essential for the future of communications, both wired and
wireless.

For more detailed information about adaptive filters and adaptive filter theory, refer to
the books listed in the “Selected Bibliography” on page 5-59.

Adaptive Filtering Methodology

This section presents a brief description of how adaptive filters work and some of the
applications where they can be useful.

Adaptive filters self learn. As the signal into the filter continues, the adaptive filter
coefficients adjust themselves to achieve the desired result, such as identifying an
unknown filter or canceling noise in the input signal. In the figure below, the shaded box
represents the adaptive filter, comprising the adaptive filter and the adaptive recursive
least squares (RLS) algorithm.
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Desired Signal
19k)

/

Input Signal Output Signal Error Signal
—X&—I’ Adaptive FIR or IIR Digital Filter k e(k);

/

RLS Adaptive Algorithm -t

Block Diagram That Defines the Inputs and Output of a Generic RLS Adaptive Filter
The next figure provides the general adaptive filter setup with inputs and outputs.

Desired Signal
1ak)

/

Input Signal Output Signal Error Signal
—XLI' Adaptive FIR or IIR Digital Filter k e(k);

/

Adapting Algorithm

A

Block Diagram Defining General Adaptive Filter Algorithm Inputs and Outputs

DSP System Toolbox software includes adaptive filters of a broad range of forms, all of
which can be worthwhile for specific needs. Some of the common ones are:

+ Adaptive filters based on least mean squares (LMS) techniques, such as
dsp.LMSFilter and dsp.FilteredXLMSFilter

+ Adaptive filters based on recursive least squares (RLS) techniques, including sign-
data, sign-error, and sign-sign. See dsp.RLSFilter.

+ Adaptive filters based on lattice filters. See dsp.AdaptiveLatticeFilter.
+ Adaptive filters that operate in the frequency domain. See
dsp.FrequencyDomainAdaptiveFilter.

An adaptive filter designs itself based on the characteristics of the input signal to the
filter and a signal that represents the desired behavior of the filter on its input.
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Designing the filter does not require any other frequency response information or
specification. To define the self-learning process the filter uses, you select the adaptive
algorithm used to reduce the error between the output signal y(k) and the desired signal

d(k).

When the LMS performance criterion for e(k) has achieved its minimum value through
the iterations of the adapting algorithm, the adaptive filter is finished and its coefficients
have converged to a solution. Now the output from the adaptive filter matches closely the
desired signal d(k). When you change the input data characteristics, sometimes called
the filter environment, the filter adapts to the new environment by generating a new set
of coefficients for the new data. Notice that when e(k) goes to zero and remains there you
achieve perfect adaptation, the ideal result but not likely in the real world.

The adaptive filter functions in this toolbox implement the shaded portion of the figures,
replacing the adaptive algorithm with an appropriate technique. To use one of the
functions, you provide the input signal or signals and the initial values for the filter.

“Adaptive Filters in DSP System Toolbox Software” on page 5-9 offers details about
the algorithms available and the inputs required to use them in MATLAB.

Choosing an Adaptive Filter

Selecting the adaptive filter that best meets your needs requires careful consideration.
An exhaustive discussion of the criteria for selecting your approach is beyond the scope of
this User's Guide. However, a few guidelines can help you make your choice.

Two main considerations frame the decision — how you plan to use the filter and the
filter algorithm to use.

When you begin to develop an adaptive filter for your needs, most likely the primary
concern is whether using an adaptive filter is a cost-competitive approach to solving your
filtering needs. Generally many areas determine the suitability of adaptive filters (these
areas are common to most filtering and signal processing applications). Four such areas
are

+ Filter consistency — Does your filter performance degrade when the filter coefficients
change slightly as a result of quantization, or you switch to fixed-point arithmetic?
Will excessive noise in the signal hurt the performance of your filter?

+ Filter performance — Does your adaptive filter provide sufficient identification
accuracy or fidelity, or does the filter provide sufficient signal discrimination or noise
cancellation to meet your requirements?
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+ Tools — Do tools exist that make your filter development process easier? Better tools
can make it practical to use more complex adaptive algorithms.

+  DSP requirements — Can your filter perform its job within the constraints of your
application? Does your processor have sufficient memory, throughput, and time to use
your proposed adaptive filtering approach? Can you trade memory for throughput: use
more memory to reduce the throughput requirements or use a faster signal processor?

Of the preceding considerations, characterizing filter consistency or robustness may be
the most difficult.

The simulations in DSP System Toolbox software offers a good first step in

developing and studying these issues. LMS algorithm filters provide both a relatively
straightforward filters to implement and sufficiently powerful tool for evaluating whether
adaptive filtering can be useful for your problem.

Additionally, starting with an LMS approach can form a solid baseline against which
you can study and compare the more complex adaptive filters available in the toolbox.
Finally, your development process should, at some time, test your algorithm and
adaptive filter with real data. For truly testing the value of your work there is no
substitute for actual data.

System Identification

One common adaptive filter application is to use adaptive filters to identify an unknown
system, such as the response of an unknown communications channel or the frequency
response of an auditorium, to pick fairly divergent applications. Other applications
include echo cancellation and channel identification.

In the figure, the unknown system is placed in parallel with the adaptive filter. This

layout represents just one of many possible structures. The shaded area contains the
adaptive filter system.
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Unknown System

/4 d(k)
Y

Y +

x(k) o y(k) i }e(k)
Adaptive Filter > SUM |-—»

Using an Adaptive Filter to Identify an Unknown System

Clearly, when e(k) is very small, the adaptive filter response is close to the response of
the unknown system. In this case the same input feeds both the adaptive filter and the
unknown. If, for example, the unknown system is a modem, the input often represents
white noise, and is a part of the sound you hear from your modem when you log in to your
Internet service provider.

Inverse System Identification

By placing the unknown system in series with your adaptive filter, your filter adapts to
become the inverse of the unknown system as e(k) becomes very small. As shown in the
figure the process requires a delay inserted in the desired signal d(k) path to keep the
data at the summation synchronized. Adding the delay keeps the system causal.

e
ot
%0 |] nknown system || Adaptive Fiter m@“
7

Determining an Inverse Response to an Unknown System

Including the delay to account for the delay caused by the unknown system prevents this
condition.
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Plain old telephone systems (POTS) commonly use inverse system identification to
compensate for the copper transmission medium. When you send data or voice over
telephone lines, the copper wires behave like a filter, having a response that rolls off at
higher frequencies (or data rates) and having other anomalies as well.

Adding an adaptive filter that has a response that is the inverse of the wire response,
and configuring the filter to adapt in real time, lets the filter compensate for the rolloff
and anomalies, increasing the available frequency output range and data rate for the
telephone system.

Noise or Interference Cancellation

In noise cancellation, adaptive filters let you remove noise from a signal in real time.
Here, the desired signal, the one to clean up, combines noise and desired information. To
remove the noise, feed a signal n'(k) to the adaptive filter that represents noise that is
correlated to the noise to remove from the desired signal.

s(k) + n(k)
/4 d(k)
Voo
. x(k) o y(K) e(k)
n'(k) Adaptive Filter » SUM >

Using an Adaptive Filter to Remove Noise from an Unknown System

So long as the input noise to the filter remains correlated to the unwanted noise
accompanying the desired signal, the adaptive filter adjusts its coefficients to reduce the
value of the difference between y(k) and d(k), removing the noise and resulting in a clean
signal in e(k). Notice that in this application, the error signal actually converges to the
input data signal, rather than converging to zero.

Prediction

Predicting signals requires that you make some key assumptions. Assume that the signal
is either steady or slowly varying over time, and periodic over time as well.
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AW

s(k) x(k) y(k) e(k
»  Delay Adaptive Filter SUM\

Predicting Future Values of a Periodic Signal

Accepting these assumptions, the adaptive filter must predict the future values of the
desired signal based on past values. When s(k) is periodic and the filter is long enough to
remember previous values, this structure with the delay in the input signal, can perform
the prediction. You might use this structure to remove a periodic signal from stochastic
noise signals.

Finally, notice that most systems of interest contain elements of more than one of the
four adaptive filter structures. Carefully reviewing the real structure may be required to
determine what the adaptive filter is adapting to.

Also, for clarity in the figures, the analog-to-digital (A/D) and digital-to-analog (D/A)
components do not appear. Since the adaptive filters are assumed to be digital in nature,
and many of the problems produce analog data, converting the input signals to and from
the analog domain is probably necessary.
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Adaptive Filters in DSP System Toolbox Software

In this section...

“Overview of Adaptive Filtering in DSP System Toolbox Software” on page 5-9
“Algorithms” on page 5-9

“Using Adaptive Filter Objects” on page 5-11

Overview of Adaptive Filtering in DSP System Toolbox Software

DSP System Toolbox software contains many objects for constructing and applying
adaptive filters to data. As you see in the tables in the next section, the objects use
various algorithms to determine the weights for the filter coefficients of the adapting
filter. While the algorithms differ in their detail implementations, the LMS and RLS

share a common operational approach — minimizing the error between the filter output
and the desired signal.

Algorithms

For adaptive filter objects, each available algorithm entry appears in one of the tables
along with a brief description of the algorithm. Click on the algorithm in the first column
to get more information about the associated adaptive filter technique.

+  LMS based adaptive filters

*  RLS based adaptive filters

+ Affine projection adaptive filters

+ Adaptive filters in the frequency domain

+ Lattice based adaptive filters

Least Mean Squares (LMS) Based FIR Adaptive Filters

Adaptive Filter Method Adapting Algorithm Used to Generate Filter Coefficients During
Adaptation

dsp.BlockLMSFilter Block LMS FIR adaptive filter algorithm
dsp.FilteredXLMSFi lten Filtered-x LMS FIR adaptive filter algorithm
dsp.LMSFilter LMS FIR adaptive filter algorithm

Normalized LMS FIR adaptive filter algorithm
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Adaptive Filter Method

Adapting Algorithm Used to Generate Filter Coefficients During
Adaptation

Sign-data LMS FIR adaptive filter algorithm

Sign-error LMS FIR adaptive filter algorithm

Sign-sign LMS FIR adaptive filter algorithm

For further information about an adapting algorithm, refer to the reference page for the

algorithm.

Recursive Least Squares (RLS) Based FIR Adaptive Filters

Adaptive Filter Method

Adapting Algorithm Used to Generate Filter Coefficients During
Adaptation

dsp.FastTransversa| Fast transversal least-squares adaptation algorithm

Sliding window FTF adaptation algorithm

dsp.RLSFilter

QR-decomposition RLS adaptation algorithm
Householder RLS adaptation algorithm
Householder SWRLS adaptation algorithm

Recursive-least squares (RLS) adaptation algorithm

Sliding window (SW) RLS adaptation algorithm

For more complete information about an adapting algorithm, refer to the reference page

for the algorithm.

Affine Projection (AP) FIR Adaptive Filters

Adaptive Filter Method

Adapting Algorithm Used to Generate Filter Coefficients During
Adaptation

dsp.AffineProjecti

Affine projection algorithm that uses direct matrix inversion

Affine projection algorithm that uses recursive matrix updating

Block affine projection adaptation algorithm
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To find more information about an adapting algorithm, refer to the reference page for the
algorithm.

FIR Adaptive Filters in the Frequency Domain (FD)

Adaptive Filter Method Description of the Adapting Algorithm Used to Generate Filter
Coefficients During Adaptation

dsp.FrequencyDomainAdg Frequency domain adaptation algorithm

Unconstrained FDAF algorithm for adaptation

For more information about an adapting algorithm, refer to the reference page for the
algorithm.

Lattice-Based (L) FIR Adaptive Filters

Adaptive Filter Method | Description of the Adapting Algorithm Used to Generate Filter
Coefficients During Adaptation

dsp.AdaptivelLattic|Gradient adaptive lattice filter adaptation algorithm

Least squares lattice adaptation algorithm

QR decomposition RLS adaptation algorithm

For more information about an adapting algorithm, refer to the reference page for the
algorithm.

Presenting a detailed derivation of the Wiener-Hopf equation and determining solutions
to it is beyond the scope of this User's Guide. Full descriptions of the theory appear in the
adaptive filter references provided in the “Selected Bibliography” on page 5-59.

Using Adaptive Filter Objects

After you construct an adaptive filter object, how do you apply it to your data or system?
Adaptive filter objects have a step method that you use to apply the filter object to data.
In the following sections, various examples of using LMS and RLS adaptive filters show

you how step works with the objects to apply them to data.

+ “LMS Adaptive Filters” on page 5-12

+  “RLS Adaptive Filters” on page 5-30
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In this section...

“LMS Filter Introductory Examples” on page 5-12

“System Identification Using the LMS Algorithm” on page 5-13

“System Identification Using the Normalized LMS Algorithm” on page 5-17
“Noise Cancellation Using the Sign-Data LMS Algorithm” on page 5-19
“Noise Cancellation Using Sign-Error LMS Algorithm” on page 5-23

“Noise Cancellation Using Sign-Sign LMS Algorithm” on page 5-26

LMS Filter Introductory Examples

This section provides introductory examples using some of the least mean squares (LMS)
adaptive filter functionality in the toolbox.

The toolbox provides dsp.LMSFilter, which is a System object that uses LMS
algorithms to search for the optimal solution to the adaptive filter. The dsp.LMSFilter
object supports these algorithms:

* The LMS algorithm, which solves the Wiener-Hopf equation and finds the filter
coefficients for an adaptive filter

* The normalized variation of the LMS algorithm

* The sign-data variation of the LMS algorithm, where the correction to the filter
weights at each iteration depends on the sign of the input x(k)

+ The sign-error variation of the LMS algorithm, where the correction applied to the
current filter weights for each successive iteration depends on the sign of the error,

e(k)

* The sign-sign variation of the LMS algorithm, where the correction applied to the
current filter weights for each successive iteration depends on both the sign of x(k)
and the sign of e(k).

To demonstrate the differences and similarities among the various LMS algorithms
supplied in the toolbox, the LMS and NLMS adaptive filter examples use the same
filter for the unknown system. The unknown filter is the constrained lowpass filter from
fircband examples.
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[b,err,res]=Fircband(12,[0 0.4 0.5 1], [1 1 0 0], [1 0.2],---
{rw" et p;
fvtool(b,1);

From the figure you see that the filter is indeed lowpass and constrained to 0.2 ripple
in the stopband. With this as the baseline, the adaptive LMS filter examples use the
adaptive LMS algorithms to identify this filter in a system identification role.

To review the general model for system ID mode, look at “System Identification” on page
5-5 for the layout.

u Filter Visualization Tool - Figure 1: Magnitude Response EI@
File Edit Analysis Insert View Debug Desktop Window Help N Ax
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[Flgure 1: Magnitude Response ><]

Magnitude Response

Magnitude

Normalized Frequency (x rad/sample)

For the sign variations of the LMS algorithm, the examples use noise cancellation as the
demonstration application, as opposed to the system identification application used in
the LMS examples.

System Identification Using the LMS Algorithm

To use the adaptive filter functions in the toolbox you need to provide three things:
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* The adaptive LMS algorithm to use. You can select the algorithm of your choice by
setting the Method property of dsp.LMSFi lter to the desired algorithm.

* An unknown system or process to adapt to. In this example, the filter designed by
fircband is the unknown system.

* Appropriate input data to exercise the adaptation process. In terms of the generic
LMS model, these are the desired signal d(k) and the input signal x(%).

Start by defining an input signal X.
X = 0.1*randn(250,1);

The input is broadband noise. For the unknown system filter, use Fircband to create a
twelfth-order lowpass filter:

[b,err,res] = fircband(12,[0 0.4 0.5 1],[1 1 0 0],[1 0.2],{"w","c"});
Although you do not need them here, include the err and res output arguments.

Now filter the signal through the unknown system to get the desired signal.
d = filter(b,1,x);

With the unknown filter designed and the desired signal in place you construct and apply
the adaptive LMS filter object to identify the unknown.

Preparing the adaptive filter object requires that you provide starting values for
estimates of the filter coefficients and the LMS step size. You could start with estimated
coefficients of some set of nonzero values; this example uses zeros for the 12 initial filter
weights. Set the InitialConditions property of dsp.LMSFilter to the desired initial
values of the filter weights.

For the step size, 0.8 is a reasonable value — a good compromise between being large
enough to converge well within the 250 iterations (250 input sample points) and small
enough to create an accurate estimate of the unknown filter.

mu = 0.8;
Ims = dsp.LMSFilter(13, "StepSize”,mu, "WeightsOutputPort",true);

Finally, using the dsp.LMSFi lter object Ims, desired signal, d, and the input to
the filter, X, run the adaptive filter to determine the unknown system and plot the
results, comparing the actual coefficients from Fircband to the coefficients found by
dsp.LMSFilter.
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Ly.e,w] = step(Ims,x,d);;

stem([b." w])

title("System ldentification by Adaptive LMS Algorithm®)

legend("Actual Filter Weights®, "Estimated Filter Weights™, ...
"Location”, "NorthEast"®)

System Identification by Adaptive LMS Algorithm
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As an experiment, try changing the step size to 0.2. Repeating the example with mu =
0.2 results in the following stem plot. The estimated weights fail to approximate the
actual weights closely.

mu = 0.2;

Ims = dsp.LMSFilter(13, "StepSize”,mu, "WeightsOutputPort",true);

[y.e,w] = step(lms,x,d);

stem([b-." w])

title("System ldentification by Adaptive LMS Algorithm®)

legend("Actual Filter Weights", "Estimated Filter Weights™, ...
"Location”, "NorthEast"®)
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System Identification by Adaptive LMS Algorithm
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Since this may be because you did not iterate over the LMS algorithm enough times, try
using 1000 samples. With 1000 samples, the stem plot, shown in the next figure, looks
much better, albeit at the expense of much more computation. Clearly you should take
care to select the step size with both the computation required and the fidelity of the
estimated filter in mind.

for index = 1:4

X = 0.1*randn(250,1);

d = filter(b,1,x);

Ly.e.,w] = step(Ims,x,d);
end

stem([b-" w])

title("System ldentification by Adaptive LMS Algorithm®)

legend("Actual Filter Weights®, "Estimated Filter Weights~, ...
"Location”, "NorthEast*®)
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System Identification Using the Normalized LMS Algorithm

To improve the convergence performance of the LMS algorithm, the normalized variant
(NLMS) uses an adaptive step size based on the signal power. As the input signal power
changes, the algorithm calculates the input power and adjusts the step size to maintain
an appropriate value. Thus the step size changes with time.

As a result, the normalized algorithm converges more quickly with fewer samples in
many cases. For input signals that change slowly over time, the normalized LMS can
represent a more efficient LMS approach.

In the normalized LMS algorithm example, you used Fircband to create the filter that
you would identify. So you can compare the results, you use the same filter, and set the
Method property on dsp.LMSFilter to "Normalized LMS". to use the normalized
LMS algorithm variation. You should see better convergence with similar fidelity.

First, generate the input signal and the unknown filter.

X = 0.1*randn(500,1);

[b,err,res] = fircband(12,[0 0.4 0.5 1], [11 0 0], [1 0.2],---
TR OF

d = filter(b,1,x);
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Again d represents the desired signal d(x) as you defined it earlier and b contains the
filter coefficients for your unknown filter.

Ims = dsp.LMSFilter(13, "StepSize®,mu, "Method™, ...
"Normalized LMS","WeightsOutputPort",true);

You use the preceding code to initialize the normalized LMS algorithm. For more
information about the optional input arguments, refer to dsp.LMSFilter.

Running the system identification process is a matter of using the dsp.LMSFilter
object with the desired signal, the input signal, and the initial filter coefficients and
conditions specified in S as input arguments. Then plot the results to compare the
adapted filter to the actual filter.

Ly.e,w] = step(lms,x,d);

stem([b-" w])

title("System ldentification by Normalized LMS Algorithm®)

legend("Actual Filter Weights", "Estimated Filter Weights™, ...
"Location”, "NorthEast"®)

As shown in the following stem plot (a convenient way to compare the estimated and
actual filter coefficients), the two are nearly identical.

System Identification by Normalized LMS Algorithm

0.6 T T
— Actual Filter Weights
05l — Estimated Filter Weights
o]
04r b
03k ] ] i
02y b

01 I I I I
0
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If you compare the convergence performance of the regular LMS algorithm to the
normalized LMS variant, you see the normalized version adapts in far fewer iterations to
a result almost as good as the nonnormalized version.

Ims_normalized = dsp.LMSFilter(13, "StepSize®,mu, ...
"Method", "Normalized LMS®,*WeightsOutputPort",true);
Ims_nonnormalized = dsp.LMSFilter(13, "StepSize®,mu, ...
"Method", "LMS", "WeightsOutputPort”,true);
[~.,el,~] = step(Ims_normalized,x,d);
[~.e2,~] = step(Ims_nonnormalized,x,d);
plot([el,e2]);
title("Comparing the LMS and NLMS Conversion Performance®);
legend("NLMS Derived Filter Weights”,
"LMS Derived Filter Weights®,"Location”, "NorthEast");

Comparing the LMS and NLMS Conversion Performance

—— MNLMS Derived Filter Weights
— LMS Derived Filter Weights

_0_2 1 1 1 1 1 1 1 1 1
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Noise Cancellation Using the Sign-Data LMS Algorithm
When the amount of computation required to derive an adaptive filter drives your
development process, the sign-data variant of the LMS (SDLMS) algorithm may be a

very good choice as demonstrated in this example.

Fortunately, the current state of digital signal processor (DSP) design has relaxed
the need to minimize the operations count by making DSPs whose multiply and shift
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operations are as fast as add operations. Thus some of the impetus for the sign-data
algorithm (and the sign-error and sign-sign variations) has been lost to DSP technology
improvements.

In the standard and normalized variations of the LMS adaptive filter, coefficients for
the adapting filter arise from the mean square error between the desired signal and the
output signal from the unknown system. Using the sign-data algorithm changes the
mean square error calculation by using the sign of the input data to change the filter
coefficients.

When the error is positive, the new coefficients are the previous coefficients plus the
error multiplied by the step size u. If the error is negative, the new coefficients are again
the previous coefficients minus the error multiplied by 4 — note the sign change.

When the input is zero, the new coefficients are the same as the previous set.

In vector form, the sign-data LMS algorithm is

w(k+1) =w(k) + pe(k)sgn[x(k)],
1, x(k)> 0
sgn (k)] = 0,x(k) =0
H1,x(k) <0

with vector w containing the weights applied to the filter coefficients and vector x
containing the input data. e(k) (equal to desired signal - filtered signal) is the error at
time & and is the quantity the SDLMS algorithm seeks to minimize. 4 (mu) is the step
size.

As you specify mu smaller, the correction to the filter weights gets smaller for each
sample and the SDLMS error falls more slowly. Larger mu changes the weights more for
each step so the error falls more rapidly, but the resulting error does not approach the
ideal solution as closely. To ensure good convergence rate and stability, select mu within
the following practical bounds

1

0< u<
N {InputSignalPower}

where N is the number of samples in the signal. Also, define mu as a power of two for
efficient computing.
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Note How you set the initial conditions of the sign-data algorithm profoundly influences
the effectiveness of the adaptation. Because the algorithm essentially quantizes the input
signal, the algorithm can become unstable easily.

A series of large input values, coupled with the quantization process may result in the
error growing beyond all bounds. You restrain the tendency of the sign-data algorithm to
get out of control by choosing a small step size (u<< 1) and setting the initial conditions
for the algorithm to nonzero positive and negative values.

In this noise cancellation example, set dsp.LMSFi lter Method property to "Sign-Data
LMS*®. This example requires two input data sets:

* Data containing a signal corrupted by noise. In Using an Adaptive Filter to
Remove Noise from an Unknown System, this is d(k), the desired signal. The noise
cancellation process removes the noise, leaving the signal.

* Data containing random noise (x(%k) in Using an Adaptive Filter to Remove Noise
from an Unknown System) that is correlated with the noise that corrupts the signal
data. Without the correlation between the noise data, the adapting algorithm cannot
remove the noise from the signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000 elements.
signal = sin(2*pi*0.055*[0:1000-1]");

Now, add correlated white noise to signal. To ensure that the noise is correlated, pass
the noise through a lowpass FIR filter, and then add the filtered noise to the signal.

noise randn(1000,1);

nfilt = firl(11,0.4); % Eleventh order lowpass filter
fnoise = filter(nfilt,1,noise); % Correlated noise data
d = signal + fnoise;

fnoise is the correlated noise and d is now the desired input to the sign-data algorithm.

To prepare the dsp.LMSFi lter object for processing, set the weight initial conditions
(InitialConditions) and mu (StepSize) for the object. As noted earlier in this
section, the values you set for coeffs and mu determine whether the adaptive filter can
remove the noise from the signal path.

In “System Identification Using the LMS Algorithm” on page 5-13, you constructed
a default filter that sets the filter coefficients to zeros. In most cases that approach does
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not work for the sign-data algorithm. The closer you set your initial filter coefficients to
the expected values, the more likely it is that the algorithm remains well behaved and
converges to a filter solution that removes the noise effectively.

For this example, start with the coefficients in the filter you used to filter the noise
(nFilt), and modify them slightly so the algorithm has to adapt.

coeffs = nfilt." -0.01; % Set the filter initial conditions.
mu = 0.05; % Set the step size for algorithm updating.

With the required input arguments for dsp.LMSFi lter prepared, construct the LMS
filter object, run the adaptation, and view the results.

Ims = dsp.LMSFilter(12, "Method", "Sign-Data LMS", ...
"StepSize",mu, "InitialConditions”,coeffs);

[~,e] = step(Ims,noise,d);

L = 200;

plot(0:L-1,signal(1:L),0:L-1,e(1:L));

title("Noise Cancellation by the Sign-Data Algorithm®);

legend("Actual Signal®,"Result of Noise Cancellation”, ...

"Location”, "NorthEast");

When dsp.LMSFilter runs, it uses far fewer multiply operations than either of the
LMS algorithms. Also, performing the sign-data adaptation requires only bit shifting
multiplies when the step size is a power of two.

Although the performance of the sign-data algorithm as shown in the next figure is quite
good, the sign-data algorithm is much less stable than the standard LMS variations. In
this noise cancellation example, the signal after processing is a very good match to the
input signal, but the algorithm could very easily grow without bound rather than achieve
good performance.

Changing InitialConditions, mu, or even the lowpass filter you used to create the
correlated noise can cause noise cancellation to fail and the algorithm to become useless.
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MNoise Cancellation by the Sign-Data Algorithm
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Noise Cancellation Using Sign-Error LMS Algorithm

In some cases, the sign-error variant of the LMS algorithm (SELMS) may be a very good
choice for an adaptive filter application.

In the standard and normalized variations of the LMS adaptive filter, the coefficients
for the adapting filter arise from calculating the mean square error between the desired
signal and the output signal from the unknown system, and applying the result to the
current filter coefficients. Using the sign-error algorithm replaces the mean square error
calculation by using the sign of the error to modify the filter coefficients.

When the error is positive, the new coefficients are the previous coefficients plus the
error multiplied by the step size u. If the error is negative, the new coefficients are again
the previous coefficients minus the error multiplied by # — note the sign change. When
the input is zero, the new coefficients are the same as the previous set.

In vector form, the sign-error LMS algorithm is
w(k+1) =w(k) + psgn[e(k)][ x(%) ,
l,e(k)>0 E
sgn[e(k)] = Eo,e(k) =0 [

H-1,e®) <0H
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with vector w containing the weights applied to the filter coefficients and vector x
containing the input data. e(k) (equal to desired signal - filtered signal) is the error at
time %k and is the quantity the SELMS algorithm seeks to minimize. g (mu) is the step
size. As you specify mu smaller, the correction to the filter weights gets smaller for each
sample and the SELMS error falls more slowly.

Larger mu changes the weights more for each step so the error falls more rapidly, but
the resulting error does not approach the ideal solution as closely. To ensure good
convergence rate and stability, select mu within the following practical bounds

1

0< u<
N {InputSignalPower}

where N i1s the number of samples in the signal. Also, define mu as a power of two for
efficient computation.

Note How you set the initial conditions of the sign-data algorithm profoundly influences
the effectiveness of the adaptation. Because the algorithm essentially quantizes the error
signal, the algorithm can become unstable easily.

A series of large error values, coupled with the quantization process may result in the
error growing beyond all bounds. You restrain the tendency of the sign-error algorithm to
get out of control by choosing a small step size (u<< I) and setting the initial conditions
for the algorithm to nonzero positive and negative values.

In this noise cancellation example, the dsp.LMSFi lter object requires two input data
sets:

* Data containing a signal corrupted by noise. In Using an Adaptive Filter to
Remove Noise from an Unknown System, this is d(k), the desired signal. The noise
cancellation process removes the noise, leaving the signal.

+ Data containing random noise (x(%k) in Using an Adaptive Filter to Remove Noise
from an Unknown System) that is correlated with the noise that corrupts the signal
data. Without the correlation between the noise data, the adapting algorithm cannot
remove the noise from the signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000 elements.

signal = sin(2*pi*0.055*[0:1000-1]");
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Now, add correlated white noise to signal. To ensure that the noise is correlated, pass
the noise through a lowpass FIR filter, then add the filtered noise to the signal.

noise randn(1000,1);

nfilt = firl(11,0.4); % Eleventh order lowpass filter.
fnoise = filter(nfilt,1,noise); % Correlated noise data.
d = signal + fnoise;

fnoise is the correlated noise and d is now the desired input to the sign-data algorithm.

To prepare the dsp.LMSFi lter object for processing, set the weight initial conditions
(InitialConditions) and mu (StepSize) for the object. As noted earlier in this
section, the values you set for coeffs and mu determine whether the adaptive filter
can remove the noise from the signal path. In “System Identification Using the LMS
Algorithm” on page 5-13, you constructed a default filter that sets the filter
coefficients to zeros.

Setting the coefficients to zero often does not work for the sign-error algorithm. The
closer you set your initial filter coefficients to the expected values, the more likely it is
that the algorithm remains well behaved and converges to a filter solution that removes
the noise effectively.

For this example, you start with the coefficients in the filter you used to filter the noise
(nFilt), and modify them slightly so the algorithm has to adapt.

coeffs = nfilt." -0.01; % Set the filter initial conditions.
mu = 0.05; % Set step size for algorithm update.

With the required input arguments for dsp . LMSFi l'ter prepared, run the adaptation
and view the results.
Ims = dsp.LMSFilter(12, "Method", "Sign-Error LMS®, ...
"StepSize”,mu, "InitialConditions”,coeffs);
[~.e] = step(lIms,noise,d);
L = 200;
plot(0:199,signal (1:200),0:199,e(1:200));
title("Noise Cancellation Performance by the Sign-Error LMS Algorithm®);

legend("Actual Signal®,"Error After Noise Reduction”,...
"Location”, "NorthEast™)

When the sign-error LMS algorithm runs, it uses far fewer multiply operations than
either of the LMS algorithms. Also, performing the sign-error adaptation requires only
bit shifting multiplies when the step size is a power of two.

Although the performance of the sign-data algorithm as shown in the next figure is quite
good, the sign-data algorithm is much less stable than the standard LMS variations. In
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this noise cancellation example, the signal after processing is a very good match to the
input signal, but the algorithm could very easily become unstable rather than achieve
good performance.

Changing the weight initial conditions (InitialConditions) and mu (StepSize),
or even the lowpass filter you used to create the correlated noise can cause noise
cancellation to fail and the algorithm to become useless.

Noise Cancellation Performance bythe S|gn -Error LMS Algonthm
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Noise Cancellation Using Sign-Sign LMS Algorithm

One more example of a variation of the LMS algorithm in the toolbox is the sign-sign
variant (SSLMS). The rationale for this version matches those for the sign-data and
sign-error algorithms presented in preceding sections. For more details, refer to “Noise
Cancellation Using the Sign-Data LMS Algorithm” on page 5-19.

The sign-sign algorithm (SSLMS) replaces the mean square error calculation with using
the sign of the input data to change the filter coefficients. When the error is positive, the
new coefficients are the previous coefficients plus the error multiplied by the step size u.

If the error is negative, the new coefficients are again the previous coefficients minus the

error multiplied by u — note the sign change. When the input is zero, the new coefficients
are the same as the previous set.
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In essence, the algorithm quantizes both the error and the input by applying the sign
operator to them.

In vector form, the sign-sign LMS algorithm is

w(k+1) =w(k) + psgne(k)] sgn| x(k)
1, 2(k) > 0
sgn[z(k)] = 0,200 = 0
H-1,2(k) <0

where
2(k) =[e(k)]sgn [x(k)]

Vector w contains the weights applied to the filter coefficients and vector x contains
the input data. e(k) (= desired signal - filtered signal) is the error at time & and is the
quantity the SSLMS algorithm seeks to minimize. u(mu) is the step size. As you specify
mu smaller, the correction to the filter weights gets smaller for each sample and the
SSLMS error falls more slowly.

Larger mu changes the weights more for each step so the error falls more rapidly, but
the resulting error does not approach the ideal solution as closely. To ensure good
convergence rate and stability, select mu within the following practical bounds

1

O<u<
N { Inp utSignalPower}

where N is the number of samples in the signal. Also, define mu as a power of two for
efficient computation.

Note How you set the initial conditions of the sign-sign algorithm profoundly influences
the effectiveness of the adaptation. Because the algorithm essentially quantizes the input
signal and the error signal, the algorithm can become unstable easily.

A series of large error values, coupled with the quantization process may result in the
error growing beyond all bounds. You restrain the tendency of the sign-sign algorithm to
get out of control by choosing a small step size (u<< I) and setting the initial conditions
for the algorithm to nonzero positive and negative values.
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In this noise cancellation example, dsp.LMSFi lter object requires two input data sets:

* Data containing a signal corrupted by noise. In Using an Adaptive Filter to
Remove Noise from an Unknown System, this is d(k), the desired signal. The noise
cancellation process removes the noise, leaving the cleaned signal as the content of
the error signal.

+ Data containing random noise (x(%k) in Using an Adaptive Filter to Remove Noise from
an Unknown System) that is correlated with the noise that corrupts the signal data,
called. Without the correlation between the noise data, the adapting algorithm cannot
remove the noise from the signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000 elements.
signal = sin(2*pi*0.055*[0:1000-1]");

Now, add correlated white noise to signal. To ensure that the noise is correlated, pass
the noise through a lowpass FIR filter, then add the filtered noise to the signal.

noise randn(1000,1);

nfilt = firl(11,0.4); % Eleventh order lowpass filter
fnoise = filter(nfilt,1,noise); % Correlated noise data
d = signal + fnoise;

fnoise is the correlated noise and d is now the desired input to the sign-data algorithm.

To prepare the dsp.LMSFi lter object for processing, set the weight initial conditions
(InitialConditions) and mu (StepSize) for the object. As noted earlier in this
section, the values you set for coeffs and mu determine whether the adaptive filter
can remove the noise from the signal path. In “System Identification Using the LMS
Algorithm” on page 5-13, you constructed a default filter that sets the filter
coefficients to zeros. Usually that approach does not work for the sign-sign algorithm.

The closer you set your initial filter coefficients to the expected values, the more likely
it is that the algorithm remains well behaved and converges to a filter solution that
removes the noise effectively. For this example, you start with the coefficients in the
filter you used to filter the noise (nfi lt), and modify them slightly so the algorithm has
to adapt.

coeffs = nfilt." -0.01; % Set the filter initial conditions.
mu = 0.05; % Set the step size for algorithm updating.

With the required input arguments for dsp.LMSFi lter prepared, run the adaptation
and view the results.
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Ims = dsp.LMSFilter(12, "Method", "Sign-Sign LMS*",

"StepSize”,mu, "InitialConditions”,coeffs);
[~.e] = step(lIms,noise,d);
L = 200;
plot(0:199,signal (1:200),0:199,e(1:200));
title("Noise Cancellation Performance by the Sign-Error LMS Algorithm®);
legend("Actual Signal®,"Error After Noise Reduction”,

"Location”, "NorthEast")

When dsp.LMSFilter runs, it uses far fewer multiply operations than either of the
LMS algorithms. Also, performing the sign-sign adaptation requires only bit shifting
multiplies when the step size is a power of two.

Although the performance of the sign-sign algorithm as shown in the next figure is quite
good, the sign-sign algorithm is much less stable than the standard LMS variations. In
this noise cancellation example, the signal after processing is a very good match to the
input signal, but the algorithm could very easily become unstable rather than achieve
good performance.

Changing the weight initial conditions (InitialConditions) and mu (StepSize),
or even the lowpass filter you used to create the correlated noise can cause noise
cancellation to fail and the algorithm to become useless.

Moise Cancellation Performance of the Sign-Sign LMS Algorithm
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As an aside, the sign-sign LMS algorithm is part of the international CCITT standard for
32 Kb/s ADPCM telephony.
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In this section...
“Compare RLS and LMS Adaptive Filter Algorithms” on page 5-30
“Inverse System Identification Using dsp.RLSFilter” on page 5-31

Compare RLS and LMS Adaptive Filter Algorithms

This section provides an introductory example that uses the RLS adaptive filter System
object dsp.RLSFI Iter.

If LMS algorithms represent the simplest and most easily applied adaptive algorithms,
the recursive least squares (RLS) algorithms represents increased complexity,
computational cost, and fidelity. In performance, RLS approaches the Kalman filter in
adaptive filtering applications, at somewhat reduced required throughput in the signal
processor.

Compared to the LMS algorithm, the RLS approach offers faster convergence and
smaller error with respect to the unknown system, at the expense of requiring more
computations.

In contrast to the least mean squares algorithm, from which it can be derived, the RLS
adaptive algorithm minimizes the total squared error between the desired signal and the
output from the unknown system.

Note that the signal paths and identifications are the same whether the filter uses RLS
or LMS. The difference lies in the adapting portion.

Within limits, you can use any of the adaptive filter algorithms to solve an adaptive filter
problem by replacing the adaptive portion of the application with a new algorithm.

Examples of the sign variants of the LMS algorithms demonstrated this feature to

demonstrate the differences between the sign-data, sign-error, and sign-sign variations of
the LMS algorithm.

One interesting input option that applies to RLS algorithms is not present in the LMS
processes — a forgetting factor, A, that determines how the algorithm treats past data
input to the algorithm.
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When the LMS algorithm looks at the error to minimize, it considers only the current
error value. In the RLS method, the error considered is the total error from the beginning
to the current data point.

Said another way, the RLS algorithm has infinite memory — all error data is given the
same consideration in the total error. In cases where the error value might come from a
spurious input data point or points, the forgetting factor lets the RLS algorithm reduce
the value of older error data by multiplying the old data by the forgetting factor.

Since 0 <A< I, applying the factor is equivalent to weighting the older error. When A = 1,
all previous error is considered of equal weight in the total error.

As A approaches zero, the past errors play a smaller role in the total. For example, when
A = 0.9, the RLS algorithm multiplies an error value from 50 samples in the past by an
attenuation factor of 0.9°° = 5.15 x 10°%, considerably deemphasizing the influence of the
past error on the current total error.

Inverse System Identification Using dsp.RLSFilter

Rather than use a system identification application to demonstrate the RLS adaptive
algorithm, or a noise cancellation model, this example use the inverse system
identification model shown in here.

Unknown System

/4 d(k)
Y

Y +

x(k) - y(k) < }e{k)
Adaptive Filter > SUM +—»

Cascading the adaptive filter with the unknown filter causes the adaptive filter to
converge to a solution that is the inverse of the unknown system.

If the transfer function of the unknown is H(z) and the adaptive filter transfer function
is G(2), the error measured between the desired signal and the signal from the cascaded
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system reaches its minimum when the product of H(z) and G(z) is 1, G(z)*H(z) = 1. For
this relation to be true, G(z) must equal 1/H(z), the inverse of the transfer function of the
unknown system.

To demonstrate that this is true, create a signal to input to the cascaded filter pair.

X = randn(3000,1);

In the cascaded filters case, the unknown filter results in a delay in the signal arriving at
the summation point after both filters. To prevent the adaptive filter from trying to adapt
to a signal it has not yet seen (equivalent to predicting the future), delay the desired
signal by 32 samples, the order of the unknown system.

Generally, you do not know the order of the system you are trying to identify. In that
case, delay the desired signal by the number of samples equal to half the order of the
adaptive filter. Delaying the input requires prepending 12 zero-values samples to X.

delay = zeros(12,1);
d = [delay; x(1:2988)]; % Concatenate the delay and the signal.

You have to keep the desired signal vector d the same length as X, hence adjust the
signal element count to allow for the delay samples.

Although not generally true, for this example you know the order of the unknown filter,
so you add a delay equal to the order of the unknown filter.

For the unknown system, use a lowpass, 12th-order FIR filter.

ufilt = firl(12,0.55,"low");

Filtering X provides the input data signal for the adaptive algorithm function.
xdata = Filter(ufilt,1,x);

To set the RLS algorithm, instatiate a dsp.RLSFi lter object and set its Length,
ForgettingFactor, and Initial InverserCovariance properties.

For more information about the input conditions to prepare the RLS algorithm object,
refer to dsp.RLSFilter.

pOo = 2 * eye(13);
lambda = 0.99;
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rls = dsp.RLSFilter(13, "ForgettingFactor”, lambda, - ..
"InitiallnverseCovariance®,p0);

Most of the process to this point is the same as the preceding examples. However, since
this example seeks to develop an inverse solution, you need to be careful about which
signal carries the data and which is the desired signal.

Earlier examples of adaptive filters use the filtered noise as the desired signal. In this
case, the filtered noise (xdata) carries the unknown system information. With Gaussian
distribution and variance of 1, the unfiltered noise d is the desired signal. The code to
run this adaptive filter example is

[y.e] = step(rls,xdata,d);

where y returns the filtered output and e contains the error signal as the filter adapts
to find the inverse of the unknown system. To view the estimated coefficient of the RLS
filter, type rls.Coefficients.

The next figure presents the results of the adaptation. In the figure, the magnitude
response curves for the unknown and adapted filters show. As a reminder, the unknown
filter was a lowpass filter with cutoff at 0.55, on the normalized frequency scale from 0 to
1.
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Comparing the Inverse Filter to the Unknown System
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Viewed alone (refer to the following figure), the inverse system looks like a fair
compensator for the unknown lowpass filter — a high pass filter with linear phase.
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Signal Enhancement Using LMS and Normalized LMS
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In this section...

“Create the Signals for Adaptation” on page 5-36

“Construct Two Adaptive Filters” on page 5-37

“Choose the Step Size” on page 5-38

“Set the Adapting Filter Step Size” on page 5-38

“Filter with the Adaptive Filters” on page 5-39

“Compute the Optimal Solution” on page 5-39

“Plot the Results” on page 5-39

“Compare the Final Coefficients” on page 5-41

“Reset the Filter Before Filtering” on page 5-42

“Investigate Convergence Through Learning Curves” on page 5-42

“Compute the Learning Curves” on page 5-42

“Compute the Theoretical Learning Curves” on page 5-43

This example illustrates one way to use a few of the adaptive filter algorithms provided
in the toolbox. In this example, a signal enhancement application is used as an
illustration. While there are about 30 different adaptive filtering algorithms included
with the toolbox, this example demonstrates two algorithms — least means square (LMS)
and normalized LMS. Both of these algorithms are available with the dsp.LMSFilter
System object.

Create the Signals for Adaptation

The goal is to use an adaptive filter to extract a desired signal from a noise-corrupted
signal by filtering out the noise. The desired signal (the output from the process) is a
sinusoid with 1000 samples.

n
S

(1:1000)";
sin(0.075*pi*n);

To perform adaptation requires two signals:

+ areference signal




Signal Enhancement Using LMS and Normalized LMS

* anoisy signal that contains both the desired signal and an added noise component.
Generate the Noise Signal

To create a noise signal, assume that the noise v1 is autoregressive, meaning that
the value of the noise at time ¢ depends only on its previous values and on a random
disturbance.

v = 0.8*randn(1000,1); % Random noise part.

ar = [1,1/2]; % Autoregression coefficients.
vl = filter(l,ar,v); % Noise signal. Applies a 1-D digital
% Filter.

Corrupt the Desired Signal to Create a Noisy Signal

To generate the noisy signal that contains both the desired signal and the noise, add the
noise signal V1 to the desired signal s. The noise-corrupted sinusoid X is

X = s + vl;

where s is the desired signal and the noise is v1. Adaptive filter processing seeks to
recover S from X by removing v1. To complete the signals needed to perform adaptive
filtering, the adaptation process requires a reference signal.

Create a Reference Signal

Define a moving average signal v2 that is correlated with v1. This v2 is the reference
signal for the examples.

ma
v2

[1, -0.8, 0.4 , -0.2];
filter(ma,1,v);

Construct Two Adaptive Filters

Two similar adaptive filters — LMS and NLMS — form the basis of this example, both
sixth order. Set the order as a variable in MATLAB and create the filters.

L=7;

Ims = dsp.LMSFilter(L, "Method", "LMS",
"WeightOutputPort®,true);

nlms = dsp.LMSFilter(L, "Method", *Normalized LMS", ...
"WeightOutputPort®,true);
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Choose the Step Size

LMS-like algorithms have a step size that determines the amount of correction applied as
the filter adapts from one iteration to the next. Choosing the appropriate step size is not
always easy, usually requiring experience in adaptive filter design.

* A step size that is too small increases the time for the filter to converge on a set of
coefficients. This becomes an issue of speed and accuracy.

*  One that is too large may cause the adapting filter to diverge, never reaching
convergence. In this case, the issue is stability — the resulting filter might not be
stable.

As a rule of thumb, smaller step sizes improve the accuracy of the convergence of the
filter to match the characteristics of the unknown, at the expense of the time it takes to
adapt.

The toolbox includes an algorithm — maxstep — to determine the maximum step size
suitable for each LMS adaptive filter algorithm that still ensures that the filter converges
to a solution. Often, the notation for the step size is p.

[mumaxIms ,mumaxmse Ims]
[mumaxnIms,mumaxmsenlims]

maxstep(Ims,x)
maxstep(nlms);

mumaxlims =
0.2096

mumaxmselms =

0.1261

Set the Adapting Filter Step Size

The first output of maxstep is the value needed for the mean of the coefficients to
converge while the second is the value needed for the mean squared coefficients to
converge. Choosing a large step size often causes large variations from the convergence
values, so choose smaller step sizes generally.

Ims._StepSize
nlms.StepSize

mumaxmse Ims/30;
mumaxmsenlms/20;

If you know the step size to use, you can set the step size value when you create the
object. For example,
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Ims = dsp.LMSFilter(L, "Method", "LMS", "StepSize~,0.2);

Filter with the Adaptive Filters

Now you have set up the parameters of the adaptive filters and you are ready to filter the
noisy signal. The reference signal, v2, is the input to the adaptive filters. X is the desired
signal in this configuration.

Through adaptation, y, the output of the filters, tries to emulate X as closely as possible.
Since V2 is correlated only with the noise component v1 of X, it can only really emulate

v1. The error signal (the desired X), minus the actual output y, constitutes an estimate of
the part of x that is not correlated with v2 — s, the signal to extract from x.

[yIms,elms,wlms] = step(Ims,v2,x);
[ynlms,enlms,wnlms] = step(nlms,v2,x);

Compute the Optimal Solution

For comparison, compute the optimal FIR Wiener filter.

bw = firwiener(L-1,v2,x); % Optimal FIR Wiener filter
yw = Filter(bw,1,v2); % Estimate of x using Wiener filter
ew = X - yw; % Estimate of actual sinusoid

Plot the Results

Plot the resulting denoised sinusoid for each filter — the Wiener filter, the LMS adaptive
filter, and the NLMS adaptive filter — to compare the performance of the various
techniques.

plot(n(900:end), [ew(900:end), elms(900:end),enlms(900:end)]);
legend("Wiener filter denoised sinusoid®, ...
"LMS denoised sinusoid®, "NLMS denoised sinusoid®);
xlabel ("Time index (n)");
ylabel ("Amplitude™);
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1.5 T T T T T T T T T
— Wiener filter denoised sinusoid

— LMS denoised sinusoid
— MNLMS denoised sinusoid
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As a reference point, include the noisy signal as a dotted line in the plot.

hold on
plot(n(900:end),x(900:end), "k:=")
xlabel ("Time index (n)");

ylabel ("Amplitude™);

hold off
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Compare the Final Coefficients

Finally, compare the Wiener filter coefficients with the coefficients of the adaptive filters.
While adapting, the adaptive filters try to converge to the Wiener coefficients.

[bw." wims wnlms]

ans =
1.0317 0.8879 1.0712
0.3555 0.1359 0.4070
0.1500 0.0036 0.1539
0.0848 0.0023 0.0549
0.1624 0.0810 0.1098
0.1079 0.0184 0.0521
0.0492 -0.0001 0.0041
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Reset the Filter Before Filtering

You can reset the internal filter states at any time by calling the reset method on the
filter object.

For instance, the following successive calls produce the same output after resetting the
object.

[yIms,elms,wlms] = step(Ims,v2,Xx);
[ynlms,enlms,wnims] = step(nlms,v2,x);

If you do not reset the filter object, the filter uses the final states and coefficients from
the previous run as the initial conditions for the next run and set of data.

Investigate Convergence Through Learning Curves

To analyze the convergence of the adaptive filters, look at the learning curves. The
toolbox provides methods to generate the learning curves, but you need more than one
iteration of the experiment to obtain significant results.

This demonstration uses 25 sample realizations of the noisy sinusoids.

n = (1:5000)";
s = sin(0.075*pi*n);
nr = 25;

v = 0.8*randn(5000,nr);
vl = filter(1,ar,v);
X = repmat(s,1l,nr) + vi;
v2 = filter(ma,1,v);

Compute the Learning Curves

Now compute the mean-square error. To speed things up, compute the error every 10
samples.

First, reset the adaptive filters to avoid using the coefficients it has already computed
and the states it has stored.

reset(Ims);
reset(nims);
M = 10; % Decimation factor
mselms = msesim(Ims,v2,x,M);
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msenlms = msesim(nlms,v2,x,M);

plot(1:M:n(end), [mselms,msenlms])

legend("LMS learning curve®,"NLMS learning curve-®)
xlabel ("Time index (n)");

ylabel (*"MSE") ;

In the next plot you see the calculated learning curves for the LMS and NLMS adaptive
filters.

2.5 T T T T T T T T T
— LMS learning curve
— NLMS learning curve
2 - .
15} .
w
73]
=
1

(LTI

500 1000 1500 20[]0 25[]0 3000 3500 4000 4500 5000
Time index (n)

Compute the Theoretical Learning Curves

For the LMS and NLMS algorithms, functions in the toolbox help you compute the
theoretical learning curves, along with the minimum mean-square error (MMSE) the
excess mean-square error (EMSE) and the mean value of the coefficients.

MATLAB may take some time to calculate the curves. The figure shown after the code
plots the predicted and actual LMS curves.

reset(Ims);
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[mmselms,emselms,meanwlms,pmselms] = msepred(Ims,v2,x,M);

plot(1:M:n(end), [mmselms*ones(500,1),emselms*ones(500,1), . -.

pmselms,mselms])
legend("MMSE" , "EMSE", "predicted LMS learning curve®,

"LMS learning curve®)

xlabel ("Time index (n)");

ylabel (*"MSE") ;
1.8 T T T T T T T T T
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predicted LMS learning curve
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Adaptive Filters in Simulink

In this section...

“Create an Acoustic Environment in Simulink” on page 5-45

“LMS Filter Configuration for Adaptive Noise Cancellation” on page 5-47
“Modify Adaptive Filter Parameters During Model Simulation” on page 5-53
“Adaptive Filtering Examples” on page 5-58

Create an Acoustic Environment in Simulink

Adaptive filters are filters whose coefficients or weights change over time to adapt to
the statistics of a signal. They are used in a variety of fields including communications,
controls, radar, sonar, seismology, and biomedical engineering.

In this topic, you learn how to create an acoustic environment that simulates both white

noise and colored noise added to an input signal. You later use this environment to build
a model capable of adaptive noise cancellation using adaptive filtering:

1 At the MATLAB command line, type dspanc.

The DSP System Toolbox Acoustic Noise Cancellation example opens.
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2 Copy and paste the subsystem called Acoustic Environment into a new model.

3 Double-click the Acoustic Environment subsystem.

Gaussian noise 1s used to create the signal sent to the Exterior Mic output port. If
the input to the Filter port changes from O to 1, the Digital Filter block changes from
a lowpass filter to a bandpass filter. The filtered noise output from the Digital Filter
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block is added to signal coming from a .wav file to produce the signal sent to the
Pilot's Mic output port.

You have now created an acoustic environment. In the following topics, you use this
acoustic environment to produce a model capable of adaptive noise cancellation.

LMS Filter Configuration for Adaptive Noise Cancellation

In the previous topic, “Create an Acoustic Environment in Simulink” on page 5-45,

you created a system that produced two output signals. The signal output at the Exterior
Mic port is composed of white noise. The signal output at the Pilot's Mic port is composed
of colored noise added to a signal from a .wav file. In this topic, you create an adaptive
filter to remove the noise from the Pilot's Mic signal. This topic assumes that you are
working on a Windows operating system:

1

If the model you created in “Create an Acoustic Environment in Simulink” on page
5-45 is not open on your desktop, you can open an equivalent model by typing

ex_adaptl_audio

at the MATLAB command prompt.

From the DSP System Toolbox Filtering library, and then from the Adaptive Filters
library, click-and-drag an LMS Filter block into the model that contains the Acoustic
Environment subsystem.

Double-click the LMS Filter block. Set the block parameters as follows, and then
click OK:
Algorithm = Normalized LMS
+ Filter length = 40
Step size (mu) =0.002
+ Leakage factor (0to1) =1

The block uses the normalized LMS algorithm to calculate the forty filter
coefficients. Setting the Leakage factor (0 to 1) parameter to 1 means that the
current filter coefficient values depend on the filter's initial conditions and all of the
previous input values.

Click-and-drag the following blocks into your model.
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Block Library Quantity
Constant Simulink/Sources 2
Manual Switch Simulink/Signal Routing 1
Terminator Simulink/Sinks 1
Downsample Signal Operations 1
To Audio Device Sinks 1
Waterfall Scope Sinks 1

5 Connect the blocks so that your model resembles the following figure.
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6  Double-click the Constant block. Set the Constant value parameter to O and then

click OK.

7 Double-click the Downsample block. Set the Downsample factor, K parameter to

32. Click OK.
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The filter weights are being updated so often that there is very little change from one
update to the next. To see a more noticeable change, you need to downsample the
output from the Wts port.

8 Double-click the Waterfall Scope block. The Waterfall scope window opens.
9@ Click the Scope parameters button.
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The Parameters window opens.
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10 Click the Axes tab. Set the parameters as follows:

* YMin=-0.188
* YMax=0.179
11 Click the Data history tab. Set the parameters as follows:

History traces = 50
+ Data logging = All visible

12 Close the Parameters window leaving all other parameters at their default values.

You might need to adjust the axes in the Waterfall scope window in order to view
the plots.

13 Click the Fit to view button in the Waterfall scope window. Then, click-and-drag
the axes until they resemble the following figure.
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14
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16
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In the model window, from the Simulation menu, select Model Configuration
Parameters. In the Select pane, click Solver. Set the parameters as follows, and
then click OK:

Stop time = Iinf
+ Type = Fixed-step
Solver =Discrete (no continuous states)

Run the simulation and view the results in the Waterfall scope window. You can
also listen to the simulation using the speakers attached to your computer.

Experiment with changing the Manual Switch so that the input to the Acoustic
Environment subsystem 1is either O or 1.

When the value is 0, the Gaussian noise in the signal is being filtered by a lowpass
filter. When the value is 1, the noise is being filtered by a bandpass filter. The
adaptive filter can remove the noise in both cases.
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You have now created a model capable of adaptive noise cancellation. The adaptive filter
in your model is able to filter out both low frequency noise and noise within a frequency
range. In the next topic, “Modify Adaptive Filter Parameters During Model Simulation”
on page 5-53, you modify the LMS Filter block and change its parameters during
simulation.

Modify Adaptive Filter Parameters During Model Simulation

In the previous topic, “LMS Filter Configuration for Adaptive Noise Cancellation” on
page 5-47, you created an adaptive filter and used it to remove the noise generated

by the Acoustic Environment subsystem. In this topic, you modify the adaptive filter and
adjust its parameters during simulation. This topic assumes that you are working on a
Windows operating system:

1  If the model you created in “Create an Acoustic Environment in Simulink” on page
5-45 is not open on your desktop, you can open an equivalent model by typing

ex_adapt2_audio

at the MATLAB command prompt.
2 Double-click the LMS filter block. Set the block parameters as follows, and then click
OK:
* Specify step size via = Input port
Initial value of filter weights = 0
+  Select the Adapt port check box.
Reset port = Non-zero sample

The Block Parameters: LMS Filter dialog box should now look similar to the
following figure.
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Function Block Parameters: LMS Filter @
LMS Filter

Adapts the filter weights based on the chosen algorithm for filtering of the
input signal.

Select the Adapt port check box to create an Adapt port on the block.
When the input to this port is nonzero, the block continuously updates the
filter weights. When the input to this port is zero, the filter weights remain
constant.

If the Reset port is enabled and a reset event occurs, the block resets the
filter weights to their initial values.

Main Data Types

Parameters

Algorithm: [Normalized LMS "l

Filter length: 40

Specify step size via: [I.nput port "l

Leakage factor (0 to 1): 1.0

Initial value of filter weights: 0

Adapt port

Reset port: ’Non—zero sample ~

Output filter weights

,} [ oK H Cancel H Help ] Apply

Step-size, Adapt, and Reset ports appear on the LMS Filter block.
3 Click-and-drag the following blocks into your model.
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6

Constant Simulink/Sources

Manual Switch Simulink/Signal Routing

4  Connect the blocks as shown in the following figure.
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10
11

12

13

14

Double-click the Constant2 block. Set the block parameters as follows, and then click
OK:
Constant value = 0.002
+  Select the Interpret vector parameters as 1-D check box.
+ Sample time (-1 for inherited) = inf
Output data type mode = Inherit via back propagation
Double-click the Constant3 block. Set the block parameters as follows, and then click
OK:
Constant value = 0.04
+  Select the Interpret vector parameters as 1-D check box.
+ Sample time (-1 for inherited) = inf
Output data type mode = Inherit via back propagation

Double-click the Constant4 block. Set the Constant value parameter to O and then
click OK.

Double-click the Constant6 block. Set the Constant value parameter to 0 and then
click OK.

In the model window, from the Display menu, point to Signals & Ports, and select
Wide Nonscalar Lines and Signal Dimensions.

Double-click Manual Switch2 so that the input to the Adapt port is 1.

Run the simulation and view the results in the Waterfall scope window. You can
also listen to the simulation using the speakers attached to your computer.

Double-click the Manual Switch block so that the input to the Acoustic Environment
subsystem is 1. Then, double-click Manual Switch2 so that the input to the Adapt
port to 0.

The filter weights displayed in the Waterfall scope window remain constant. When
the input to the Adapt port is 0, the filter weights are not updated.
Double-click Manual Switch2 so that the input to the Adapt port is 1.

The LMS Filter block updates the coefficients.

Connect the Manual Switch1 block to the Constant block that represents 0.002.
Then, change the input to the Acoustic Environment subsystem. Repeat this
procedure with the Constant block that represents 0.04.
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You can see that the system reaches steady state faster when the step size is larger.

15 Double-click the Manual Switch3 block so that the input to the Reset port is 1.
The block resets the filter weights to their initial values. In the Block Parameters:

LMS Filter dialog box, from the Reset port list, you chose Non-zero sample. This
means that any nonzero input to the Reset port triggers a reset operation.

You have now experimented with adaptive noise cancellation using the LMS Filter
block. You adjusted the parameters of your adaptive filter and viewed the effects of your
changes while the model was running.

For more information about adaptive filters, see the following block reference pages:
+  LMS Filter
*  RLS Filter

+ Block LMS Filter
*  Fast Block LMS Filter

Adaptive Filtering Examples

DSP System Toolbox software provides a collection of adaptive filtering examples that
illustrate typical applications of the adaptive filtering blocks, listed in the following table.

Adaptive Filtering Examples Commands for Opening Examples in MATLAB
LMS Adaptive Equalization Imsadeq

LMS Adaptive Time-Delay Imsadtde

Estimation

Nonstationary Channel Estimation |dspchanest

RLS Adaptive Noise Cancellation |rlsdemo
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Learn how to analyze, design, and implement multirate and multistage filters in

MATLAB and Simulink.

“Multirate Filters” on page 6-2

“Multistage Filters” on page 6-6

“Example Case for Multirate/Multistage Filters” on page 6-7
“Filter Banks” on page 6-11

“Multirate Filtering in Simulink” on page 6-19
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6-2

In this section...

“Why Are Multirate Filters Needed?” on page 6-2

“Overview of Multirate Filters” on page 6-2

Why Are Multirate Filters Needed?

Multirate filters can bring efficiency to a particular filter implementation. In general,
multirate filters are filters in which different parts of the filter operate at different rates.
The most obvious application of such a filter is when the input sample rate and output
sample rate need to differ (decimation or interpolation) — however, multirate filters are
also often used in designs where this is not the case. For example you may have a system
where the input sample rate and output sample rate are the same, but internally there is
decimation and interpolation occurring in a series of filters, such that the final output of
the system has the same sample rate as the input. Such a design may exhibit lower cost
than could be achieved with a single-rate filter for various reasons. For more information
about the relative cost benefit of using multirate filters, see Harris, Fredric J., Multirate
Signal Processing for Communication Systems, Prentice Hall PTR, 2004.

Overview of Multirate Filters

A filter that reduces the input rate is called a decimator. A filter that increases the input
rate is called an interpolator. To visualize this process, examine the following figure,
which illustrates the processes of interpolation and decimation in the time domain.
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Interpolation I
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If you start with the top signal, sampled at a frequency Fs, then the bottom signal is
sampled at Fs/2 frequency. In this case, the decimation factor, or M, is 2.

The following figure illustrates effect of decimation in the frequency domain.
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In the first graphic in the figure you can see a signal that is critically sampled, i.e.
the sample rate is equal to two times the highest frequency component of the sampled
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6-4

signal. As such the period of the signal in the frequency domain is no greater than

the bandwidth of the sampling frequency. When reduce the sampling frequency
(decimation), aliasing can occur, where the magnitudes at the frequencies near the
edges of the original period become indistinguishable, and the information about these
values becomes lost. To work around this problem, the signal can be filtered before the
decimation process, avoiding overlap of the signal spectra at Fs/2.
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An analogous approach must be taken to avoid imaging when performing interpolation
on a sampled signal. For more information about the effects of decimation and
interpolation on a sampled signal, see “References — Multirate Filters”.

The following list summarizes some guidelines and general requirements regarding
decimation and interpolation:

* By the Nyquist Theorem, for band-limited signals, the sampling frequency must be at
least twice the bandwidth of the signal. For example, if you have a lowpass filter with
the highest frequency of 10 MHz, and a sampling frequency of 60 MHz, the highest
frequency that can be handled by the system without aliasing is 60/2=30, which is
greater than 10. You could safely set M=2 in this case, since (60/2)/2=15, which is still
greater than 10.

+ If you wish to decimate a signal which does not meet the frequency criteria, you can
either:

+ Interpolate first, and then decimate
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+  When decimating, you should apply the filter first, then perform the decimation.
When interpolating a signal, you should interpolate first, then filter the signal.

* Typically in decimation of a signal a filter is applied first, thereby allowing decimation
without aliasing, as shown in the following figure:

ol
Dioven Sample

—* FIR

Y

+  Conversely, a filter is typically applied after interpolation to avoid imaging:

1
Up Sample

FIR —>

v

* M must be an integer. Although, if you wish to obtain an M of 4/5, you could
interpolate by 4, and then decimate by 5, provided that frequency restrictions are
met. This type of multirate filter will be referred to as a sample rate converter in the
documentation that follows.

Multirate filters are most often used in stages. This technique is introduced in the
following section.
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Multistage Filters

In this section...

“Why Are Multistage Filters Needed?” on page 6-6
“Optimal Multistage Filters in DSP System Toolbox” on page 6-6

Why Are Multistage Filters Needed?

Typically used with multirate filters, multistage filters can bring efficiency to a particular
filter implementation. Multistage filters are composed of several filters. These different
parts of the mulitstage filter, called stages, are connected in a cascade or in parallel.
However such a design can conserve resources in many cases. There are many different
uses for a multistage filter. One of these is a filter requirement that includes a very
narrow transition width. For example, you need to design a lowpass filter where the
difference between the pass frequency and the stop frequency is .01 (normalized).

For such a requirement it is possible to design a single filter, but it will be very long
(containing many coefficients) and very costly (having many multiplications and
additions per input sample). Thus, this single filter may be so costly and require so much
memory, that it may be impractical to implement in certain applications where there

are strict hardware requirements. In such cases, a multistage filter is a great solution.
Another application of a multistage filter is for a mulitrate system, where there is a
decimator or an interpolator with a large factor. In these cases, it is usually wise to
break up the filter into several multirate stages, each comprising a multiple of the total
decimation/interpolation factor.

Optimal Multistage Filters in DSP System Toolbox

As described in the previous section, within a multirate filter each interconnected filter
is called a stage. While it is possible to design a multistage filter manually, it is also
possible to perform automatic optimization of a multistage filter automatically. When
designing a filter manually it can be difficult to guess how many stages would provide
an optimal design, optimize each stage, and then optimize all the stages together. DSP
System Toolbox software enables you to create a Specifications Object, and then design a
filter using multistage as an option. The rest of the work is done automatically. Not only
does DSP System Toolbox software determine the optimal number of stages, but it also
optimizes the total filter solution.
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Example Case for Multirate/Multistage Filters

In this section...

“Example Overview” on page 6-7
“Single-Rate/Single-Stage Equiripple Design” on page 6-7
“Reduce Computational Cost Using Mulitrate/Multistage Design” on page 6-8

“Compare the Responses” on page 6-8

“Further Performance Comparison” on page 6-9

Example Overview

This example shows the efficiency gains that are possible when using multirate and
multistage filters for certain applications. In this case a distinct advantage is achieved
over regular linear-phase equiripple design when a narrow transition-band width is
required. A more detailed treatment of the key points made here can be found in the
example entitled Efficient Narrow Transition-Band FIR Filter Design.

Single-Rate/Single-Stage Equiripple Design

Consider the following design specifications for a lowpass filter (where the ripples are
given in linear units):

Fpass = 0.13; % Passband edge

Fstop = 0.14; % Stopband edge

Rpass = 0.001; % Passband ripple, 0.0174 dB peak to peak

Rstop = 0.0005; % Stopband ripple, 66.0206 dB minimum attenuation

Hf = fdesign.lowpass(Fpass,Fstop,Rpass,Rstop, "linear®);

A regular linear-phase equiripple design using these specifications can be designed by
evaluating the following:

Hd = design(HF, "equiripple®);

When you determine the cost of this design, you can see that 695 multipliers are
required.

cost(Hd)
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6-8

Reduce Computational Cost Using Mulitrate/Multistage Design

The number of multipliers required by a filter using a single state, single rate equiripple
design is 694. This number can be reduced using multirate/multistage techniques. In
any single-rate design, the number of multiplications required by each input sample is
equal to the number of non-zero multipliers in the implementation. However, by using a
multirate/multistage design, decimation and interpolation can be combined to lessen the
computation required. For decimators, the average number of multiplications required
per input sample is given by the number of multipliers divided by the decimation factor.

Hd_multi = design(HFf, "multistage”);

You can then view the cost of the filter created using this design step, and you can see
that a significant cost advantage has been achieved.

cost(Hd_multi)

Compare the Responses

You can compare the responses of the equiripple design and this multirate/multistage
design using fvtool:

hfvt = fvtool (Hd,Hd_multi);
legend(hfvt, "Equiripple design®, “Multirate/multistage design-)
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Notice that the stopband attenuation for the multistage design is about twice that of the
other designs. This is because the decimators must attenuate out-of-band components
by 66 dB in order to avoid aliasing that would violate the specifications. Similarly, the
interpolators must attenuate images by 66 dB. You can also see that the passband gain
for this design is no longer 0 dB, because each interpolator has a nominal gain (in linear
units) equal to its interpolation factor, and the total interpolation factor for the three
interpolators is 6.

Further Performance Comparison

You can check the performance of the multirate/multistage design by plotting the power
spectral densities of the input and the various outputs, and you can see that the sinusoid
at 0.4r is attenuated comparably by both the equiripple design and the multirate/
multistage design.

0:1799;

sin(0.1*pi*n®) + 2*sin(0.15*pi*n~);
filter(Hd,x);

filter(Hd_multi,x);
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[Pxx,w] = periodogram(x);

Pyy = periodogram(y);

Pyy_multi = periodogram(y_multi);

plot(w/pi,10*10og1l0([Pxx,Pyy,Pyy multi]));

xlabel ("Normalized Frequency (xX\pi rad/sample)”);

ylabel ("Power density (dB/rad/sample)”);

legend("Input signal PSD","Equiripple output PSD", ...
"Multirate/multistage output PSD")

axis([0 1 -50 301)

grid on

SD ! T T T
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Filter Banks

Multirate filters alter the sample rate of the input signal during the filtering process.
Such filters are useful in both rate conversion and filter bank applications.

The Dyadic Analysis Filter Bank block decomposes a broadband signal into a collection of
subbands with smaller bandwidths and slower sample rates. The Dyadic Synthesis Filter
Bank block reconstructs a signal decomposed by the Dyadic Analysis Filter Bank block.

To use a dyadic synthesis filter bank to perfectly reconstruct the output of a dyadic
analysis filter bank, the number of levels and tree structures of both filter banks must
be the same. In addition, the filters in the synthesis filter bank must be designed

to perfectly reconstruct the outputs of the analysis filter bank. Otherwise, the
reconstruction will not be perfect.

Dyadic Analysis Filter Banks

Dyadic analysis filter banks are constructed from the following basic unit. The unit
can be cascaded to construct dyadic analysis filter banks with either a symmetric or
asymmetric tree structure.

Wide-band input 4|: HP +— |3 ——=High-frequency subband

[P +—= |3 +—= low-frequency subband
Each unit consists of a lowpass (LP) and highpass (HP) FIR filter pair, followed by a
decimation by a factor of 2. The filters are halfband filters with a cutoff frequency of

F,/ 4, a quarter of the input sampling frequency. Each filter passes the frequency band
that the other filter stops.

The unit decomposes its input into adjacent high-frequency and low-frequency subbands.
Compared to the input, each subband has half the bandwidth (due to the half-band
filters) and half the sample rate (due to the decimation by 2).

Note The following figures illustrate the concept of a filter bank, but not how the block
implements a filter bank; the block uses a more efficient polyphase implementation.
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Level 1 Leve! 2 Level 3 Level n
I 11 I C
u HP 2 Iy —y
|:{LF 12 }—[ W | 2 1y =y
P {12 EHF — 11 By —y;
L e 0 i o L e B 1 e L0t
|Inpu15umple perind = Ty |
P2 —1bli—¥op
HP: highpuss Filter with £~ 1,/4 of F, -
LP: lowpuss filter with £.~1/4 of F, Output sample periad = 2(T,) for output yy, 1 =k <
L2 downsample by 2 Output sample period = 2%(T;) for output ¥,y g

n-Level Asymmetric Dyadic Analysis Filter Bank

Use the above figure and the following figure to compare the two tree structures of the
dyadic analysis filter bank. Note that the asymmetric structure decomposes only the low-
frequency output from each level, while the symmetric structure decomposes the high-
and low-frequency subbands output from each level.
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Leveln

Level 1 level 2
| . |
HE —|]3
S HP 1
LE ]2
u_
HE —|]3
L [P
LE ]2

[ Input sample period = T, |

HP: highpuss filter with f_~1/4 of F,
LP: lowpass filter with f_1/4 of F,
12 downsample by 2

L 1P — lg —— Yyn

Outputsample perind = 2°{T) for all 2™ sutputs

n-Level Symmetric Dyadic Analysis Filter Bank
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The following table summarizes the key characteristics of the symmetric and asymmetric
dyadic analysis filter bank.

Notable Characteristics of Asymmetric and Symmetric Dyadic Analysis Filter Banks

Characteristic

N-Level Symmetric

N-Level Asymmetric

Low- and High-
Frequency Subband
Decomposition

All the low-frequency
and high-frequency
subbands in a level are
decomposed in the next
level.

Each level's low-frequency subband is
decomposed in the next level, and each level's
high-frequency band is an output of the filter
bank.

Number of Output
Subbands

211

n+1

Bandwidth and
Number of Samples
in Output Subbands

For an input with
bandwidth BW
and N samples,
all outputs have

bandwidth BW/ 2" and
N/ 2" samples.

For an input with bandwidth BW and N samples,
yr has the bandwidth BW,, and N, samples,
where

BW/28 (1<k<n)

BW, =
BW/2" (k=n+1

N/2k (a<ks<
Nk={ 1<k<n)

N/2" (k=n+1)

The bandwidth of, and number of samples in
each subband (except the last) is half those of the
previous subband. The last two subbands have
the same bandwidth and number of samples since
they originate from the same level in the filter
bank.

Output Sample
Period

6-14

All output subbands
have a sample period of

2n(Tsi)

Sample period of kth output

|2k asksn
2"(T,;) (k=n+1)




Filter Banks

Characteristic

N-Level Symmetric

N-Level Asymmetric

Due to the decimations by 2, the sample period of
each subband (except the last) is twice that of the
previous subband. The last two subbands have
the same sample period since they originate from
the same level in the filter bank.

Total Number of
Output Samples

The total number of samples in all of the output subbands is equal to the
number of samples in the input (due to the of decimations by 2 at each

level).

Wavelet
Applications

In wavelet applications, the highpass and lowpass wavelet-based filters
are designed so that the aliasing introduced by the decimations are exactly

canceled in reconstruction.

Dyadic Synthesis Filter Banks

Dyadic synthesis filter banks are constructed from the following basic unit. The unit

can be cascaded to construct dyadic synthesis filter banks with either a asymmetric or
symmetric tree structure as illustrated in the figures entitled n-Level Asymmetric Dyadic
Synthesis Filter Bank and n-Level Symmetric Dyadic Synthesis Filter Bank.

High-frequency subband— T1 ++He j— Wide-band autput

Low-frequency subband —— g 1H{LP

Each unit consists of a lowpass (ILP) and highpass (HP) FIR filter pair, preceded by an
interpolation by a factor of 2. The filters are halfband filters with a cutoff frequency of

F,/ 4, a quarter of the input sampling frequency. Each filter passes the frequency band
that the other filter stops.

The unit takes in adjacent high-frequency and low-frequency subbands, and reconstructs
them into a wide-band signal. Compared to each subband input, the output has twice the
bandwidth and twice the sample rate.

Note The following figures illustrate the concept of a filter bank, but not how the block
implements a filter bank; the block uses a more efficient polyphase implementation.
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Level n level 3 Level 2 level 1
C 1 I |
Subband with — 12T, s 19 falup ¥
highest frequencies
1—4T,. 2|12 {a{Hp 112 fo{1r
13— +| 1 P{HP T7 1=|Lp j

Y

Subband with

kowest frequencies

"n_] E'Tsc-" Ta 1A HP '@— c—Te P

u|1+1_] E'Tszl_" T2 r|Lp j

Input sumple perind = 2<(T,) far input uy, 1< k<

Inputsample period = 2(T,) far input v,

n-Level Asymmetric Dyadic Synthesis Filter Bank
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| Output sumple perind = T |

HP: highpuss fifter with f_= 1,/4 of F,
LP: lowpnss filter with f.=1,/4 of F,
12: upsomple by 2

Use the above figure and the following figure to compare the two tree structures of the
dyadic synthesis filter bank. Note that in the asymmetric structure, the low-frequency
subband input to each level is the output of the previous level, while the high-frequency
subband input to each level is an input to the filter bank. In the symmetric structure,
both the low- and high-frequency subband inputs to each level are outputs from the

previous level.
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Subband with (I}
highest frequencies
I
y
iy
I
I
| J "
Subband with

bwest frequencies U0

leveln

—N

—T2

—2

—* HP

ISEae

#T1

uits

Level 2 y level |
T1 —{HF |

T1 —r[HF 1
Ta LP

&

T1 —{HF |

T2l
19 i | |Du1pu15ump|n per'lud=Tm|

Input sample period = 2°{T_) for all 2™ inputs |

n-Level Symmetric Dyadic Synthesis Filter Bank

HP: high poss Filter with f, = 1/4 of F,
LP: lowpass filter with . =1,/4 of F,
T2 upsample by 2

The following table summarizes the key characteristics of symmetric and asymmetric
dyadic synthesis filter banks.

Notable Characteristics of Asymmetric and Symmetric Dyadic Synthesis Filter Banks

Characteristic N-Level Symmetric N-Level Asymmetric

Input Paths Both the high-frequency and low- |The low-frequency subband input
Through the frequency input subbands to each |to each level (except the first) is the
Filter Bank level (except the first) are the output of the previous level. The low-

outputs of the previous level. The

inputs to the first level are the

inputs to the filter bank.

frequency subband input to the first
level, and the high-frequency subband
input to each level, are inputs to the
filter bank.
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Characteristic N-Level Symmetric N-Level Asymmetric

Number of Input |9n n+1

Subbands

Bandwidth All inputs subbands have For an output with bandwidth BW and

and Number of
Samples in Input
Subbands

bandwidth BW /2" and N/ 2"
samples, where the output has
bandwidth BW and N samples.

N samples, the kth input subband has
the following bandwidth and number of
samples.

BW/ 2
BW /2"

(1<k<n)
BW), =
k=n+1)
N/2¥ 1<k<n)
N, =
N/2" (k=n+1)

Input Sample
Periods

All input subbands have a sample

period of 2%(T,), where the output
sample period is T%,.

Sample period of kth input subband

o'(T,) (1<k<n)
oMT,) (k=n+1)

where the output sample period is T%,.

Total Number of
Input Samples

The number of samples in the output is always equal to the total number of

samples in all of the input subbands.

Wavelet
Applications

In wavelet applications, the highpass and lowpass wavelet-based filters are
carefully selected so that the aliasing introduced by the decimation in the
dyadic analysis filter bank is exactly canceled in the reconstruction of the
signal in the dyadic synthesis filter bank.

For more information, see Dyadic Synthesis Filter Bank.
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Multirate Filtering in Simulink

DSP System Toolbox software provides a collection of multirate filtering examples that
illustrate typical applications of the multirate filtering blocks.

Multirate Filtering | Description Command for Opening
Examples Examples in MATLAB
Audio Sample Illustrates sample rate conversion of an audio signal |dspaudiosrc

Rate Conversion |from 22.050 kHz to 8 kHz using a multirate FIR rate
conversion approach

Sigma-Delta A/D |Illustrates analog-to-digital conversion using a sigma-|dspsdadc

Converter delta algorithm implementation

Wavelet Uses the Dyadic Analysis Filter Bank and Dyadic dspwavelet
Reconstruction Synthesis Filter Bank blocks to show both the

and Noise perfect reconstruction property of wavelets and an

Reduction application for noise reduction
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Transforms, Estimation, and Spectral
Analysis

Learn about transforms, estimation and spectral analysis.

* “Transform Time-Domain Data into Frequency Domain” on page 7-2

* “Transform Frequency-Domain Data into Time Domain” on page 7-7

+  “Linear and Bit-Reversed Output Order” on page 7-12

+ “Calculate Channel Latencies Required for Wavelet Reconstruction” on page 7-14
+ “Spectral Analysis” on page 7-23

+ “Power Spectrum Estimates” on page 7-24

+ “Spectrograms” on page 7-35
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Transform Time-Domain Data into Frequency Domain

7-2

When you want to transform time-domain data into the frequency domain, use the FFT
block.

In this example, you use the Sine Wave block to generate two sinusoids, one at 15 Hz

and the other at 40 Hz. You sum the sinusoids point-by-point to generate the compound
sinusoid

u =sin (307xt) + sin (807t)

Then, you transform this sinusoid into the frequency domain using an FFT block:

1 At the MATLAB command prompt, type ex_Fft_tut.

The FFT Example opens.



Transform Time-Domain Data into Frequency Domain

v

L e fft_tut E=5|ECH ==

File Edit View Display Diagram Simulation Analysis  Code Tools  Help
-8 2 we-BE 4dOPb - @ »Q- @@
ex_fft_tut

@® ex_fft_tut
Q | FFT Exampl e | In this example, the frequency content of 8 summed sinusoid is viewed on 8 scope.
=
OsP
||J_'-| lnzaxz] ) [128:x1] [128:x1]
g | FFT Jul
| Ll_rl Co— Freq
: Matrie FFT mp
Sine Wave Sum Magnitude-Angle Vectr
Scope
Copyright 2004-2010 The MathiW orks, Inc.
3

2 Double-click the Sine Wave block. The Block Parameters: Sine Wave dialog box
opens.

3  Set the block parameters as follows:
+ Amplitude =1
* Frequency = [15 40]
* Phase offset =0
+ Sample time = 0.001
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7-4

11

+ Samples per frame = 128

Based on these parameters, the Sine Wave block outputs two sinusoidal signals with
identical amplitudes, phases, and sample times. One sinusoid oscillates at 15 Hz and
the other at 40 Hz.

Save these parameters and close the dialog box by clicking OK.

Double-click the Matrix Sum block. The Block Parameters: Matrix Sum dialog
box opens.

Set the Sum over parameter to Specified dimension and the Dimension
parameter to 2. Click OK to save your changes.

Because each column represents a different signal, you need to sum along the
individual rows in order to add the values of the sinusoids at each time step.

Double-click the Complex to Magnitude-Angle block. The Block Parameters:
Complex to Magnitude-Angle dialog box opens.

Set the Output parameter to Magnitude, and then click OK.

This block takes the complex output of the FFT block and converts this output to
magnitude.

Double-click the Vector Scope block.
Set the block parameters as follows, and then click OK:

*  Click the Scope Properties tab.
* Input domain = Frequency
Click the Axis Properties tab.
* Frequency units = Hertz (This corresponds to the units of the input signals.)
* Frequency range = [0...Fs/2]
+ Select the Inherit sample time from input check box.
+ Amplitude scaling = Magnitude
Run the model.

The scope shows the two peaks at 15 and 40 Hz, as expected.
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ey

ex_fft_tut/Vector Scope EI@
File View Axes Channels Window Help &
BB 0K
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You have now transformed two sinusoidal signals from the time domain to the
frequency domain.

Note that the sequence of FFT, Complex to Magnitude-Angle, and Vector Scope blocks
could be replaced by a single Spectrum Analyzer block, which computes the magnitude
FFT internally. Other blocks that compute the FFT internally are the blocks in the
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Power Spectrum Estimation library. See “Spectral Analysis” on page 7-23 for more
information about these blocks.
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Transform Frequency-Domain Data into Time Domain

When you want to transform frequency-domain data into the time domain, use the IFFT
block.

In this example, you use the Sine Wave block to generate two sinusoids, one at 15 Hz
and the other at 40 Hz. You sum the sinusoids point-by-point to generate the compound

sinusoid, u =sin(307¢)+sin(807¢) . You transform this sinusoid into the frequency

domain using an FFT block, and then immediately transform the frequency-domain
signal back to the time domain using the IFFT block. Lastly, you plot the difference
between the original time-domain signal and transformed time-domain signal using a
scope:

1 At the MATLAB command prompt, type ex_ifft_tut.

The IFFT Example opens.
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2 Double-click the Sine Wave block. The Block Parameters: Sine Wave dialog box

opens.

3  Set the block parameters as follows:

+ Amplitude=1

Frequency = [15 40]

+ Phase offset =0
Sample time = 0.001

+ Samples per frame =

128
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11
12

13

Based on these parameters, the Sine Wave block outputs two sinusoidal signals with
identical amplitudes, phases, and sample times. One sinusoid oscillates at 15 Hz and
the other at 40 Hz.

Save these parameters and close the dialog box by clicking OK.

Double-click the Matrix Sum block. The Block Parameters: Matrix Sum dialog
box opens.

Set the Sum over parameter to Specified dimension and the Dimension
parameter to 2. Click OK to save your changes.

Because each column represents a different signal, you need to sum along the
individual rows in order to add the values of the sinusoids at each time step.

Double-click the FFT block. The Block Parameters: FFT dialog box opens.
Select the Output in bit-reversed order check box., and then click OK.
Double-click the IFFT block. The Block Parameters: IFFT dialog box opens.
Set the block parameters as follows, and then click OK:

+ Select the Input is in bit-reversed order check box.
*  Select the Input is conjugate symmetric check box.
Because the original sinusoidal signal is real valued, the output of the FFT block is

conjugate symmetric. By conveying this information to the IFFT block, you optimize
its operation.

Note that the Sum block subtracts the original signal from the output of the IFFT
block, which is the estimation of the original signal.

Double-click the Vector Scope block.

Set the block parameters as follows, and then click OK:

* Click the Scope Properties tab.
+ Input domain =Time
Run the model.
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ey

ex_ifft_tut/Vector Scope EI@

File View Axes Channels Window Help &

BB DX

10

Amplitude

0 20 40 g0 20 100 120
Frame: 1040 Time {ms)

The flat line on the scope suggests that there is no difference between the original
signal and the estimate of the original signal. Therefore, the IFFT block has
accurately reconstructed the original time-domain signal from the frequency-domain
input.

14 Right-click in the Vector Scope window, and select Autoscale.
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In actuality, the two signals are identical to within round-off error. The previous
figure shows the enlarged trace. The differences between the two signals is on the

order of 10°%,
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Linear and Bit-Reversed Output Order

7-12

In this section...

“FFT and IFFT Blocks Data Order” on page 7-12
“Find the Bit-Reversed Order of Your Frequency Indices” on page 7-12

FFT and IFFT Blocks Data Order

The FFT block enables you to output the frequency indices in linear or bit-reversed order.
Because linear ordering of the frequency indices requires a bit-reversal operation, the
FFT block may run more quickly when the output frequencies are in bit-reversed order.

The input to the IFFT block can be in linear or bit-reversed order. Therefore, you do
not have to alter the ordering of your data before transforming it back into the time
domain. However, the IFFT block may run more quickly when the input is provided in
bit-reversed order.

Find the Bit-Reversed Order of Your Frequency Indices

Two numbers are bit-reversed values of each other when the binary representation of one
1s the mirror image of the binary representation of the other. For example, in a three-

bit system, one and four are bit-reversed values of each other, since the three-bit binary
representation of one, 001, is the mirror image of the three-bit binary representation of
four, 100. In the diagram below, the frequency indices are in linear order. To put them in
bit-reversed order

1 Translate the indices into their binary representation with the minimum number
of bits. In this example, the minimum number of bits is three because the binary
representation of 7 is 111.

2 Find the mirror image of each binary entry, and write it beside the original binary
representation.

3 Translate the indices back to their decimal representation.

The frequency indices are now in bit-reversed order.



Linear and Bit-Reversed Output Order

Step 2: Find mirrar image of

each entry.
Linear Order
] ooo = Qo0
1 oo 100
2 Stepl:Tronslste. ™0 =010
R
5 representation. 101 101
] 110 011
7 111 —==111

Bit-Reversed Order
[Ina three bit system)

Step 3:Trans kte
back to decimal
represenfafion.

=l Wi = mmp o

The next diagram illustrates the linear and bit-reversed outputs of the FFT block. The

output values are the same, but they appear in different order.

Linearly ordered

frequency indices

Input to FFT block
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S B b e b =
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Calculate Channel Latencies Required for Wavelet Reconstruction
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In this section...

“Analyze Your Model” on page 7-14

“Calculate the Group Delay of Your Filters” on page 7-16
“Reconstruct the Filter Bank System” on page 7-18
“Equalize the Delay on Each Filter Path” on page 7-18
“Update and Run the Model” on page 7-21

“References” on page 7-22

Analyze Your Model

The following sections guide you through the process of calculating the channel latencies
required for perfect wavelet reconstruction. This example uses the ex_wavelets model,
but you can apply the process to perform perfect wavelet reconstruction in any model. To
open the example model, type ex_wavelets at the MATLAB command line.

Note: You must have a Wavelet Toolbox™ product license to run the ex_wavelets
model.
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Before you can begin calculating the latencies required for perfect wavelet reconstruction,
you must know the types of filters being used in your model.

The Dyadic Analysis Filter Bank and the Dyadic Synthesis Filter Bank blocks in the
ex_wavelets model have the following settings:

+ Filter = Biorthogonal

* Filter order [synthesis/analysis] = [3/5]

* Number of levels =3

* Tree structure = Asymmetric

+ Input=Multiple ports

Based on these settings, the Dyadic Analysis Filter Bank and the Dyadic Synthesis Filter
Bank blocks construct biorthogonal filters using the Wavelet Toolbox wfi lters function.
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Calculate the Group Delay of Your Filters

Once you know the types of filters being used by the Dyadic Analysis and Dyadic
Synthesis Filter Bank blocks, you need to calculate the group delay of those filters. To do
so, you can use the Signal Processing Toolbox fvtool.

Before you can use fvtool, you must first reconstruct the filters in the MATLAB
workspace. To do so, type the following code at the MATLAB command line:

[Lo D, Hi_D, Lo R, Hi_R] = wFilters("bior3.5%)

Where Lo_D and Hi_D represent the low- and high-pass filters used by the Dyadic
Analysis Filter Bank block, and Lo_R and Hi_R represent the low- and high-pass filters
used by the Dyadic Synthesis Filter Bank block.

After you construct the filters in the MATLAB workspace, you can use fvtool to
determine the group delay of the filters. To analyze the low-pass biorthogonal filter used
by the Dyadic Analysis Filter Bank block, you must do the following:

* Type Fvtool (Lo_D) at the MATLAB command line to launch the Filter
Visualization Tool.

When the Filter Visualization Tool opens, click the Group delay response button (it )

on the toolbar, or select Group Delay Response from the Analysis menu.

Based on the Filter Visualization Tool's analysis, you can see that the group delay of the
Dyadic Analysis Filter Bank block's low-pass biorthogonal filter is 5.5.
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model. This section does not show the results for each filter in the ex wavelets model

Note: Repeat this procedure to analyze the group delay of each of the filters in your
because all wavelet filters in this particular example have the same group delay.
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Reconstruct the Filter Bank System

To determine the delay introduced by the analysis and synthesis filter bank system, you
must reconstruct the tree structures of the Dyadic Analysis Filter Bank and the Dyadic
Synthesis Filter Bank blocks. To learn more about constructing tree structures for the
Dyadic Analysis Filter Bank and Dyadic Synthesis Filter Bank blocks, see the following
sections of the DSP System Toolbox User's Guide:

+  “Dyadic Analysis Filter Banks”
+ “Dyadic Synthesis Filter Banks”
Because the filter blocks in the ex_wavelets model use biorthogonal filters with three

levels and an asymmetric tree structure, the filter bank system appears as shown in the
following figure.

—| F1

—| FO

—| FO

—| FO

19 »| Delay N » t9 | G1 | Path4
Lol PPl »| Delay M » T2 [ Gl | T2 | GO | Path3
lapPl PPl Pl Pl M 1o G {12 | GO {12 || GO | Path2
labl ol la ] F0 Pl 2 » T2 [ GO [~ T2 | GO [~ T2 [ GO | Path1
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FO = Delay due to low-pass filter of Dyadic Analysis Filter Bank
F1 = Delay due to high-pass filter of Dyadic Analysis Filter Bank
GO = Delay due to low-pass filter of Dyadic Synthesis Filter Bank
G1 =Delay due to high-pass filter of Dyadic Synthesis Filter Bank

The extra delay values of M and N on paths 3 and 4 in the previous figure ensure that
the total delay on each of the four filter paths is identical.

Equalize the Delay on Each Filter Path

Now that you have reconstructed the filter bank system, you can calculate the delay on
each filter path. To do so, use the following Noble identities:
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First Noble ldentity

—| z2 || |y > Equivalentto —| |5 [»| 21 |

Second Noble Identity

—{ 1, || z2 | Equivalentto —| z1 || 1, [~

You can apply the Noble identities by summing the delay on each signal path from right
to left. The first Noble identity indicates that moving a delay of 1 before a downsample of
2 is equivalent to multiplying that delay value by 2. Similarly, the second Noble identity
indicates that moving a delay of 2 before an upsample of 2 is equivalent to dividing that
delay value by 2.

The fvtool analysis in step 1 found that both the low- and high-pass filters of the
analysis filter bank have the same group delay (Fy = F; = 5.5). Thus, you can use F'to
represent the group delay of the analysis filter bank. Similarly, the group delay of the
low- and high-pass filters of the synthesis filter bank is the same (G,=G;=5.5), so you can
use G to represent the group delay of the synthesis filter bank.

The following figure shows the filter bank system with the intermediate delay sums
displayed below each path.
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F = Delay due to Dyadic Analysis Filter Bank
G = Delay due to Dyadic Synthesis Filter Bank

You can see from the previous figure that the signal delays on paths 1 and 2 are
identical: 7(F+G). Because each path of the filter bank system has identical delay, you
can equate the delay equations for paths 3 and 4 with the delay equation for paths 1 and
2. After constructing these equations, you can solve for M and N, respectively:

Path3=Pathl =24M+3F+ G =7F +G)
=>M=F+G

Path4=Pathl1=2N+F +G) =71F+G)
=>N=3F+G)

The Fvtool analysis in step 1 found the group delay of each biorthogonal wavelet filter
in this model to be 5.5 samples. Therefore, F'= 5.5 and G = 5.5. By inserting these values
into the two previous equations, you get M = 11 and N = 33. Because the total delay on
each filter path must be the same, you can find the overall delay of the filter bank system
by inserting F' = 5.5 and G = 5.5 into the delay equation for any of the four filter paths.
Inserting the values of F and G into 7(F+G) yields an overall delay of 77 samples for the
filter bank system of the ex_wavelets model.
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Update and Run the Model

Now that you know the latencies required for perfect wavelet reconstruction, you can
incorporate those delay values into the model. The ex_wavelets model has already been
updated with the correct delay values (M =11, N = 33, Quverall = 77), so it is ready to run.
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After you run the model, examine the reconstruction error in the Difference scope. To
further examine any particular areas of interest, use the zoom tools available on the
toolbar of the scope window or from the View menu.
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Spectral Analysis

The Power Spectrum Estimation library provides a number of blocks for spectral
analysis. Many of them have correlates in Signal Processing Toolbox software, which are
shown in parentheses:

*  Burg Method (pburg)

+ Covariance Method (pcov)

* Magnitude FFT (periodogram)

*  Modified Covariance Method (pmcov)

*  Short-Time FFT

* Yule-Walker Method (pyulear)

See “Spectral Analysis” in the Signal Processing Toolbox documentation for an overview
of spectral analysis theory and a discussion of the above methods.

DSP System Toolbox software provides two examples that illustrate the spectral analysis
blocks:

* A Comparison of Spectral Analysis Techniques (dspsacomp)
* Spectral Analysis: Short-Time FFT (dspstfft)
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Power Spectrum Estimates

7-24

In this section...

“Create the Block Diagram” on page 7-24
“Set the Model Parameters” on page 7-25

“View the Power Spectrum Estimates” on page 7-32

Create the Block Diagram

Up until now, you have been dealing with signals in the time domain. The DSP System
Toolbox product is also capable of working with signals in the frequency domain. You can
use the software to perform fast Fourier transforms (FFTs), power spectrum analysis,
short-time FFTs, and many other frequency-domain applications.

The power spectrum of a signal represents the contribution of every frequency of

the spectrum to the power of the overall signal. It is useful because many signal
processing applications, such as noise cancellation and system identification, are based
on frequency-specific modifications of signals.

First, assemble and connect the blocks needed to calculate the power spectrum of your
speech signal:
Open a new Simulink model.

2 Add the following blocks to your model. Subsequent topics describe how to use these
blocks.

Block Library

Signal From Workspace Sources

Buffer Signal Management / Buffers
Periodogram Estimation / Power Spectrum Estimation
Vector Scope Sinks

3 Connect the blocks as shown in the next figure.
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Once you have assembled the blocks needed to calculate the power spectrum of your
speech signal, you can set the block parameters.

Set the Model Parameters

Now that you have assembled the blocks needed to calculate the power spectrum of your
speech signal, you need to set the block parameters. These parameter values ensure that
the model calculates the power spectrum of your signal accurately:

1 If the model you created in “Create the Block Diagram” on page 7-24 is not open
on your desktop, you can open an equivalent model by typing

ex_gstut9

at the MATLAB command prompt.

2 Load the speech signal into the MATLAB workspace by typing load mtlb at

the MATLAB command prompt. This speech signal is a woman's voice saying
“MATLAB.”
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3 Use the Signal From Workspace block to import the speech signal from the MATLAB
workspace into your Simulink model. Open the Signal From Workspace dialog box by
double-clicking the block. Set the block parameters as follows:

+ Signal =mtlb

+ Sample time = 1/8000

+ Samples per frame = 80

* Form output after final data value by = Setting to zero

Once you are done setting these parameters, the Signal From Workspace dialog box
should look similar to the figure below. Click OK to apply your changes.

signal arrays.

Parameters

Signal:

Source Block Parameters: Signal From Workspace
Signal From Workspace (mask) (link)

Output signal samples obtained from the MATLAB workspace at successive
sample times. A signal matrix is interpreted as having one channel per
column. Signal columns may be buffered into frames by specifying a
number of samples per frame greater than 1.

An M x N x P signal array outputs M x N matrices at successive sample
times. The samples per frame must be equal to 1 for three-dimensional

[l

mtlh

Sample time:

1/8000

Samples per frame:

80

Form output after final data value by: |Setting to zero

J 0K

H Cancel ||

Apply
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The DSP System Toolbox product is capable of frame-based processing. In other
words, DSP System Toolbox blocks can process multiple samples of data at one time.
This improves the computational speed of your model. In this case, by setting the
Samples per frame parameter to 80, you are telling the Signal From Workspace
block to output a frame that contains 80 signal samples at each simulation time step.
Note that the sample period of the input signal is 1/8000 seconds. Also, after the
block outputs the final signal value, all other outputs are zero.

Use the Buffer block to buffer the input signal into frames that contain 128 samples.
Open the Buffer dialog box by double-clicking the block. Set the block parameters as
follows:
*  Output buffer size (per channel) = 128

Buffer overlap = 48
+ Initial conditions =0

Treat Mx1 and unoriented sample-based signals as = One channel

Once you are done setting these parameters, the Buffer dialog box should look
similar to the figure below. Click OK to apply your changes.

Function Block Parameters: Buffer @

Buffer

Convert scalar samples to a frame output at a lower rate. You can also convert a frame to a smaller or larger size
with optional overlap. For calculation of sample delay, see the rebuffer_delay function.

Parameters

Output buffer size (per channel):

128

Buffer overlap:

48

Initial conditions:

]

Treat Mx1 and unoriented sample-based signals as: |One channel -

J

OK H Cancel || Help Apply
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Based on these parameters, the first output frame contains 48 initial condition
values followed by the first 80 samples from the first input frame. The second output
frame contains the last 48 values from the previous frame followed by the second 80
samples from the second input frame, and so on. You are buffering your input signal
into an output signal with 128 samples per frame to minimize the estimation noise
added to your signal. Because 128 is a power of 2, this operation also enables the
Periodogram block to perform an FFT on the signal.

Use the Periodogram block to compute a nonparametric estimate of the power
spectrum of the speech signal. Open the Periodogram dialog box by double-clicking
the block and set the block parameters as follows:

Measurement = Power spectral density
* Window = Hamming
* Window sampling = Periodic
+  Select the Inherit FFT length from input dimensions check box.

Number of spectral averages = 2

Once you are done setting these parameters, the Periodogram dialog box should look
similar to the figure below. Click OK to apply your changes.
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Function Block Parameters: Pericdogram
Periodogram (mask) (link)

[l

Power spectral density and mean-square power spectrum estimation via
the periodogram method and Welch's averaged, modified periodogram

method.

Parameters

Measurement: ’Power spectral density

wWindow: ’Hamming

window sampling: [Periodic

FFT implementation: ’Auto

Inherit FFT length from input dimensions
FFT length:
256

Number of spectral averages:
2

Inherit sample time from input

J [ 0K H Cancel ”

Help ] Apply

Based on these parameters, the block applies a Hamming window periodically to the
input speech signal and averages two spectra at one time. The length of the FFT is
assumed to be 128, which is the number of samples per frame being output from the

Buffer block.

Use the Vector Scope block to view the power spectrum of the speech signal. Open
the Vector Scope dialog box by double-clicking the block. Set the block parameters as

follows:

Input domain = Frequency
Click the Axis Properties tab.

Clear the Inherit sample time from input check box.
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+ Sample time of original time series = 1/8000

Y-axis label = Magnitude-squared, dB

Once you are done setting these parameters, the Axis Properties pane of the Vector
Scope dialog box should look similar to the figure below. As you can see by the Y-
axis scaling parameter, the decibel amplitude is plotted in a vector scope window.
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Sink Block Parameters: Vector Scope @
Vector Scope

Display a vector or matrix of time-domain, frequency-domain, or user-
specified data. Each column of a 2-D input matrix is plotted as a separate
data channel. 1-D inputs are assumed to be a single data channel.

For frequency-domain operation, input should come from a source such as
the Magnitude FFT block, or a block with equivalent data organization.

Scope Froperties | Display Froperties | Axis Properties Line Pro * 1¥

Farameters
Freguency units: [Herlz *]
Frequency range: [[n...stz] *]

[ Inherit sample time from input

Sample time of original time series: 1/8000

Frequency display limits: [huto *]

-axis scaling: [dB *]

Minimum Y-limit: -10
Maximum Y-limit: 10

Y-axis label: Magnitude-squared, dB

u,}' [ OK ][ Cancel H Help Apply
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Because you are buffering the input with a nonzero overlap, you have altered the
sample time of the signal. As a result, you need to specify the sample time of the

original time series. Otherwise, the overlapping buffer samples lead the block to

believe that the sample time is shorter than it actually is.

After you have set the block parameter values, you can calculate and view the power
spectrum of the speech signal.

View the Power Spectrum Estimates

In the previous topics, you created a power spectrum model and set its parameters. In
this topic, you simulate the model and view the power spectrum of your speech signal:

1 If the model you created in “Set the Model Parameters” on page 7-25 is not open
on your desktop, you can open an equivalent model by typing

ex_gstutlo

at the MATLAB command prompt.

2 Set the configuration parameters. Open the Configuration Parameters dialog box by
selecting Model Configuration Parameters from the Simulation menu. Select
Solver from the menu on the left side of the dialog box, and set the parameters as
follows:

+ Stop time=0.5
Type = Fixed-step

+ Solver =Discrete (no continuous states)
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Select: Simulation time

- Solver

~Data Import/Export
+- Optimization
+-Diagnostics
i~Hardware Implementat... Type: IFixed-step '] Solver: Idiscrete (no continuous states) ~
~Model Referencing
+-Simulation Target Fixed-step size (fundamental sample time): auto
- Code Generation

Start time: 0.0 Stop time: 0.5

Solver options

Tasking and sample time options

Periodic sample time constraint: Iunconstralned 'J

Tasking mode for periodic sample times: ISingIeTasking 'J

[C] Automatically handle rate transition for data transfer

[7] Higher priority value indicates higher task priority

J I OK H Cancel H Help I Apply

LS‘;_E Configuration Parameters: ex_gstutl0/Configuration (Active) @

m

Apply these parameters and close the Configuration Parameters dialog box by
clicking OK. These parameters are saved only when you save your model.

If you have not already done so, load the speech signal into the MATLAB workspace
by typing load mtlb.

Run the model to open the Vector Scope window. The data is not immediately visible
at the end of the simulation. To autoscale the y-axis to fit the data, in the Vector
Scope window, right-click and choose Autoscale. The following figure shows the
data displayed in the Vector Scope window.
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During the simulation, the Vector Scope window displays a series of frames output from
the Periodogram block. Each of these frames corresponds to a window of the original
speech signal. The data in each frame represents the power spectrum, or contribution of
every frequency to the power of the original speech signal, for a given window.

In the next section, “Spectrograms” on page 7-35, you use these power spectra to
create a spectrogram of the speech signal.
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Spectrograms

In this section...
“Modify the Block Diagram” on page 7-35
“Set the Model Parameters” on page 7-37

“View the Spectrogram of the Speech Signal” on page 7-41

Modify the Block Diagram

Spectrograms are color-based visualizations of the evolution of the power spectrum of a
speech signal as this signal is swept through time. Spectrograms use the periodogram
power spectrum estimation method and are widely used by speech and audio engineers.
You can use them to develop a visual understanding of the frequency content of your
speech signal while a particular sound is being vocalized.

In the previous section, you built a model capable of calculating the power spectrum of a
speech signal that represents a woman saying “MATLAB.” In this topic, you modify this
model to view the spectrogram of your signal:

1 If the model you created in “View the Power Spectrum Estimates” on page 7-32 is not
open on your desktop, you can open an equivalent model by typing

ex_gstutll

at the MATLAB command prompt.
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2 Add the following blocks to your model. Subsequent topics describe how to use these

blocks.

Block Library

Selector Simulink / Signal Routing

dB Conversion Math Functions / Math Operations
Buffer Signal Management / Buffers
Reshape Simulink / Math Operations
Matrix Viewer Sinks

3 Connect the blocks as shown in the figure below. These blocks extract the positive
frequencies of each power spectrum and concatenate them into a matrix that
represents the spectrogram of the speech signal.
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Once you have assembled the blocks needed to view the spectrogram of your speech
signal, you can set the block parameters.

Set the Model Parameters

In the previous topic, you assembled the blocks you need to view the spectrogram of your
speech signal. Now you must set the block parameters:

1 If the model you created in “Modify the Block Diagram” on page 7-35 is not open
on your desktop, you can open an equivalent model by typing

ex_gstutl?2

at the MATLAB command prompt.

2 Use the Selector block to extract the first 64 elements, or the positive frequencies, of
each power spectrum. Open the Selector dialog box by double-clicking the block. Set
the block parameters as follows:

Number of input dimensions =1
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* Index mode = One-based
Index option = Index vector (dialog)
* Index=1:64
* Input port size = 128
At each time instance, the input to the Selector block is a vector of 128 elements. The
block assigns one-based indices to these elements and extracts the first 64. Once you

are done setting these parameters, the Selector dialog box should look similar to the
figure below. To apply your changes, click OK.

Function Block Parameters: Selector @
Selector

Select or reorder specified elements of a multidimensional input signal.
The index to each element is identified from an input port or this dialog.
You can choose the indexing method for each dimension by using the
"Index Option" parameter.

Parameters

Number of input dimensions: 1

Index mode: [On&based -
Index Option | Index | Qutput Size
1 I Index vector (dialog) ~ I 1:64  |Inherit from "Index"

Input port size: 128

[ DK H Cancel H Help J Apply

3 The dB Conversion block converts the magnitude of the input FFT signal to decibels.
Leave this block at its default parameters.

4  Use the Bufferl block to buffer up the individual power spectrums. Open the Bufferl
dialog box by double-clicking the block. Set the block parameters as follows:

*  Output buffer size (per channel) = 64*48
+ Buffer overlap = 64*46
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+ Initial conditions = -70

Treat Mx1 and unoriented sample-based signals as = One channel

Once you are done setting these parameters, the Bufferl dialog box should look
similar to the following figure. To apply your changes, click OK.

Function Block Parameters: Bufferl @
Buffer

Convert scalar samples to a frame output at a lower rate. You can also convert a frame to a smaller or larger size
with optional overlap. For calculation of sample delay, see the rebuffer_delay function.

Parameters
Output buffer size (per channel):

54+48

Buffer overlap:
54746
Initial conditions:

-70

Treat Mx1 and unoriented sample-based signals as: |One channel -

o [ oK H Cancel || Help | Apply

Setting the value of the Buffer overlap parameter slightly less than the value of
the Output buffer size (per channel) parameter ensures that your spectrogram
represents smooth movement through time. The Initial conditions parameter
represents the initial values in the buffer; -70 represents silence.

5 Use the Reshape block to reshape the input signal into a 64-by-48 matrix. To do so,

set the Output dimensionality to Customize and the Output dimensions to [64

48].

6 The Matrix Viewer enables you to view the spectrogram of the speech signal. Open
the Matrix Viewer dialog box by double-clicking the block. Set the block parameters
as follows:

Click the Image Properties tab.
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+ Colormap matrix = jet(256)

* Minimum input value = -150

* Maximum input value = -65

+  Select the Display colorbar check box.

Once you are done setting these parameters, the Image Properties pane should
look similar to the figure below.

Sink Block Parameters: Matrix Viewer @
Matrix Viewer

Display a matrix as an image, scaling the colormap to the specified input
data range. Colormap must be an Nx3 matrix of RGB values. Type "help
graph3d" at the MATLAB prompt for a list of predefined colormaps.

Image Properties | Axis Properties |

Parameters
Colormap matrix:  jet(256)
Minimum input value: -150

Maximum input value: -65

Display colorbar

o [ ok || cancel || Help Apply

+ Click the Axis Properties tab.

+ Axis origin = Lower left corner
+ X-axis title = Time Index

+ Y-axis title = Frequency Index

+ Colorbar title = dB Magnitude
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In this case, you are assuming that the power spectrum values do not exceed -65 dB.
Once you are done setting these parameters, the Axis Properties pane should look
similar to the figure below. To apply your changes, click OK.

Sink Block Parameters: Matrix Viewer @

Matrix Viewer

Display a matrix as an image, scaling the colormap to the specified input
data range. Colormap must be an Mx3 matrix of RGB values. Type "help
graph3d" at the MATLAB prompt for a list of predefined colormaps.

Image Properties | Axis Properties

Parameters

Axis origin: [Lower left corner -

¥-axis title:  Time Index
Y-axis title:  Frequency Index
Colorbar title: dB Magnitude

Figure position, [x y width height]: [650 53 560 420]

[[] Axis zoom

J [ OK H Cancel H Help I Apply

After you have set the parameter values, you can calculate and view the spectrogram of
the speech signal.

View the Spectrogram of the Speech Signal

In the topic “View the Power Spectrum Estimates” on page 7-32, you used a Vector
Scope block to display the power spectrum of your speech signal. In this topic, you view

the spectrogram of your speech signal using a Matrix Viewer block. The speech signal
represents a woman's voice saying “MATLAB”:

1 If the model you created in “Set the Model Parameters” on page 7-37 is not open
on your desktop, you can open an equivalent model by typing
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ex_gstutl3

at the MATLAB command prompt.

Py ex gstutl3 [o o =)
File Edit View Display Diagram Simulation Analysis  Code Tools  Help
- @ B EG-EGOP - @« os . @ - -
ex_gstutl3
® |[*a ex_gstutld -
@
E3
Welch

= il - »lU v - dB - Matrizx

v E v |1 ehmj v E Viewer
Signal From Selecor B Comvarsion Reshape

Buffer Pericdogram Buffer Matric

Workspace

Viewer

Freq

Vector
Scope

Copyright 2008- 2010 The MathW orks, Inc.

»

2 Run the model. During the simulation, the Vector Scope window displays a sequence
of power spectrums, one for each window of the original speech signal. The power
spectrum is the contribution of every frequency to the power of the speech signal.
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ex_gstutl3/Vector Scope

File View Axes

oL P XK

-35

Channels

-40

-45

Magnitude-squared, dB

0 05 1
Frame: 51

Window

15

Help

2
Frequency (kHz)

o]l sl

25 3 20T

The Matrix Viewer window, shown below, displays the spectrogram of the speech
signal. This spectrogram is calculated using the Periodogram power spectrum
estimation method. Note the harmonics that are visible in the signal when the
vowels are spoken. Most of the signal's energy is concentrated in these harmonics;
therefore, two distinct peaks are visible in the spectrogram.
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In this example, you viewed the spectrogram of your speech signal using a Matrix
Viewer block. You can find additional DSP System Toolbox product examples in the Help
browser. To access these examples, click the Contents tab, double-click DSP System
Toolbox, and then click Examples. A list of the examples in the DSP System Toolbox
documentation appears in the right pane of the Help browser.
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Learn about statistics and linear algebra.

+  “Statistics” on page 8-2

* “Linear Algebra and Least Squares” on page 8-6
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Statistics

8-2

In this section...

“Statistics Blocks” on page 8-2
“Basic Operations” on page 8-2

“Running Operations” on page 8-3

Statistics Blocks

The Statistics library provides fundamental statistical operations such as minimum,
maximum, mean, variance, and standard deviation. Most blocks in the Statistics library
support two types of operations; basic and running.

The blocks listed below toggle between basic and running modes using the Running
check box in the parameter dialog box:

* Histogram
* Mean
+ RMS

+ Standard Deviation

* Variance

An unselected Running check box means that the block is operating in basic mode,
while a selected Running box means that the block is operating in running mode.

The Maximum and Minimum blocks are slightly different from the blocks above, and
provide a Mode parameter in the block dialog box to select the type of operation. The
Value and Index, Value, and Index options in the Mode menu all specify basic
operation, in each case enabling a different set of output ports on the block. The Running
option in the Mode menu selects running operation.

Basic Operations

A basic operation is one that processes each input independently of previous and
subsequent inputs. For example, in basic mode (with Value and Index selected, for
example) the Maximum block finds the maximum value in each column of the current
input, and returns this result at the top output (Val). Each consecutive Val output
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therefore has the same number of columns as the input, but only one row. Furthermore,
the values in a given output only depend on the values in the corresponding input. The
block repeats this operation for each successive input.

This type of operation is exactly equivalent to the MATLAB command
val = max(u) % Equivalent MATLAB code

which computes the maximum of each column in input u.

The next section is an example of a basic statistical operation.

Create a Sliding Window

You can use the basic statistics operations in conjunction with the Buffer block to
implement basic sliding window statistics operations. A sliding window is like a stencil
that you move along a data stream, exposing only a set number of data points at one
time.

For example, you may want to process data in 128-sample frames, moving the window
along by one sample point for each operation. One way to implement such a sliding
window is shown in the following ex_mean_tut model.

il‘ 28]
1:258 - E i } | dsp_examples yout
Signal From Mean To Workspace
Workspace Buffer

The Buffer block's Buffer size (M,) parameter determines the size of the window. The
Buffer overlap (L) parameter defines the “slide factor” for the window. At each sample
instant, the window slides by M,-L points. The Buffer overlap is often M,-1, so that a
new statistic is computed for every new signal sample.

Running Operations

A running operation is one that processes successive inputs, and computes a result that
reflects both current and past inputs. In this mode, you must use the Input processing
parameter to specify whether the block performs sample- or frame-based processing on
the inputs. A reset port enables you to restart this tracking at any time. The running
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statistic is computed for each input channel independently, so the block's output is the
same size as the input.

For example, in running mode (Running selected from the Mode parameter) the
Maximum block outputs a record of the input's maximum value over time.
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The following figure illustrates how a Maximum block in running mode operates on a
3-by-2 matrix input, U, when the Input processing parameter is set to Columns as
channels (frame based). The running maximum is reset at =2 by an impulse to the
block's optional RSt port.

In Rst Dutput
l:hl—| r thl thl—| r th2
) 61 6 1]
IF"” — lral =0 0 First output — |a 3
input 10 & o
7 3] 6 ]
24| —i=l o 69
5 1 In 16 ]
il
_ = I .
= 86 - s 6
__E 03 1=7 ; flazcirum = sl —— Reset
= L 5] = &)
£

30 s 6
z 4 =3 0 6
L 17 817
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Linear Algebra and Least Squares

8-6

In this section...

“Linear Algebra Blocks” on page 8-6
“Linear System Solvers” on page 8-6

“Matrix Factorizations” on page 8-8

“Matrix Inverses” on page 8-9

Linear Algebra Blocks

The Matrices and Linear Algebra library provides three large sublibraries containing
blocks for linear algebra; Linear System Solvers, Matrix Factorizations, and Matrix
Inverses. A fourth library, Matrix Operations, provides other essential blocks for working
with matrices.

Linear System Solvers

The Linear System Solvers library provides the following blocks for solving the system of
linear equations AX = B:

* Autocorrelation LPC

+ Cholesky Solver

*  Forward Substitution

+ LDL Solver

* Levinson-Durbin

+ LU Solver

* QR Solver

+ SVD Solver

Some of the blocks offer particular strengths for certain classes of problems. For example,
the Cholesky Solver block is particularly adapted for a square Hermitian positive definite
matrix A, whereas the Backward Substitution block is particularly suited for an upper
triangular matrix A.
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Solve AX=B Using the LU Solver Block

In the following ex_lusolver_tut model, the LU Solver block solves the equation Ax = b,
where

1 -2 3 1
A=(4 0 6| b=|-2
2 -1 3 -1

and finds x to be the vector [-2 0 1]°".

WBX: pF;E[mxmj [ 1]

LU Sobver Dienizy

Constanti

You can verify the solution by using the Matrix Multiply block to perform the
multiplication Ax, as shown in the following ex_matrixmultiply_tutl model.

Constant LZ Matrix [ > E
Multiply
[_E ] IBKZ ' Mstric Muttiply —
1

JI
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Matrix Factorizations

The Matrix Factorizations library provides the following blocks for factoring various
kinds of matrices:

+  Cholesky Factorization

* LDL Factorization

* LU Factorization

* QR Factorization

* Singular Value Decomposition

Some of the blocks offer particular strengths for certain classes of problems. For example,
the Cholesky Factorization block is particularly suited to factoring a Hermitian positive
definite matrix into triangular components, whereas the QR Factorization is particularly
suited to factoring a rectangular matrix into unitary and upper triangular components.

Factor a Matrix into Upper and Lower Submatrices Using the LU Factorization Block

In the following ex_lufactorization_tut model, the LU Factorization block factors a matrix
A, into upper and lower triangular submatrices U and L, where A, is row equivalent to
input matrix A, where

1
N
1 )
|
—
[ ] [
| IS
o
1=
n
-
[
-
[
h

| ] q g

: ' | I

4 o A 05 05 -0.75

- A\ | || || |
DEpEY

Constant LU Factorization

.

Doty
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The lower output of the LU Factorization, P, is the permutation index vector, which

indicates that the factored matrix A, is generated from A by interchanging the first and
second rows.

4 0 6
A,=|1 -2 3
2 -1 3

The upper output of the LU Factorization, LU, is a composite matrix containing the two
submatrix factors, U and L, whose product LU is equal to A,,.

4 0 6 1 0 O
U=0 -2 15 L=(025 1 0
0 0 -075 05 05 1

You can check that LU = A, with the Matrix Multiply block, as shown in the following
ex_matrixmultiply_tut2 model.

—| 4 0 [i]
Constant Eﬂé‘i Matrix [ LI 1” -E” E'l
p| Multiply v =
(A | 2] 3| g
- a a e IB}G: Viatroe Multiphy T
a -2 1.5
Lo o -0 "-'EJ
Constant1

Matrix Inverses

The Matrix Inverses library provides the following blocks for inverting various kinds of
matrices:

* Cholesky Inverse
* LDL Inverse
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*+ LU Inverse

* Pseudoinverse
Find the Inverse of a Matrix Using the LU Inverse Block

In the following ex_luinverse_tut model, the LU Inverse block computes the inverse of
input matrix A, where

1 2 3
A=(4 0 6
2 -1 3

and then forms the product A”A, which yields the identity matrix of order 3, as expected.

General I | -1 ” _5_5.” gl
1 -2 2 ] Inverse 3]
|:3 0 e] er:‘-‘ 1 ['_’.:dﬂ 0| 05| 1|
= |1 o a 0.6667]| o =
Constant LU Inverse CEnEy
—. | ] ] q
. Mat_nx - .'L"| [I” 1” 5'|
5| Multiply
| ] ] ]
Vatrbe Multiphy =

As shown above, the computed inverse is

1 05 2
Al=| o 05 -1
0.6667 0.5 -1.333
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Fixed-Point Design

Learn about fixed-point data types and how to convert floating-point models to fixed-
point.

“Fixed-Point Signal Processing” on page 9-2

“Fixed-Point Concepts and Terminology” on page 9-4

“Arithmetic Operations” on page 9-9

“Fixed-Point Support for MATLAB System Objects” on page 9-19

“Using the Fixed-Point Converter App with System Objects” on page 9-25
“Use the Fixed-Point Converter App with a System object” on page 9-26
“Specify Fixed-Point Attributes for Blocks” on page 9-33

“Quantizers” on page 9-55

“Fixed-Point Filter Design” on page 9-69



Q  Fixed-Point Design

Fixed-Point Signal Processing

9-2

In this section...

“Fixed-Point Features” on page 9-2

“Benefits of Fixed-Point Hardware” on page 9-2

“Benefits of Fixed-Point Design with System Toolboxes Software” on page 9-3

Note: To take full advantage of fixed-point support in System Toolbox software, you must
install Fixed-Point Designer software.

Fixed-Point Features

Many of the blocks in this product have fixed-point support, so you can design signal
processing systems that use fixed-point arithmetic. Fixed-point support in DSP System
Toolbox software includes

* Signed two's complement and unsigned fixed-point data types
* Word lengths from 2 to 128 bits in simulation

* Word lengths from 2 to the size of a long on the Simulink Coder C code-generation
target

*  Overflow handling and rounding methods

* C code generation for deployment on a fixed-point embedded processor, with Simulink
Coder code generation software. The generated code uses all allowed data types
supported by the embedded target, and automatically includes all necessary shift and
scaling operations

Benefits of Fixed-Point Hardware

There are both benefits and trade-offs to using fixed-point hardware rather than floating-
point hardware for signal processing development. Many signal processing applications
require low-power and cost-effective circuitry, which makes fixed-point hardware a
natural choice. Fixed-point hardware tends to be simpler and smaller. As a result, these
units require less power and cost less to produce than floating-point circuitry.

Floating-point hardware is usually larger because it demands functionality and ease of
development. Floating-point hardware can accurately represent real-world numbers, and
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its large dynamic range reduces the risk of overflow, quantization errors, and the need
for scaling. In contrast, the smaller dynamic range of fixed-point hardware that allows
for low-power, inexpensive units brings the possibility of these problems. Therefore,
fixed-point development must minimize the negative effects of these factors, while
exploiting the benefits of fixed-point hardware; cost- and size-effective units, less power
and memory usage, and fast real-time processing.

Benefits of Fixed-Point Design with System Toolboxes Software

Simulating your fixed-point development choices before implementing them in hardware
saves time and money. The built-in fixed-point operations provided by the System
Toolboxes software save time in simulation and allow you to generate code automatically.

This software allows you to easily run multiple simulations with different word length,
scaling, overflow handling, and rounding method choices to see the consequences of
various fixed-point designs before committing to hardware. The traditional risks of fixed-
point development, such as quantization errors and overflow, can be simulated and
mitigated in software before going to hardware.

Fixed-point C code generation with System Toolbox software and Simulink Coder code
generation software produces code ready for execution on a fixed-point processor. All
the choices you make in simulation in terms of scaling, overflow handling, and rounding
methods are automatically optimized in the generated code, without necessitating time-
consuming and costly hand-optimized code.
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Fixed-Point Concepts and Terminology

9-4

In this section...

“Fixed-Point Data Types” on page 9-4
“Scaling” on page 9-5

“Precision and Range” on page 9-6

Note: The “Glossary” defines much of the vocabulary used in these sections. For more
information on these subjects, see the “Fixed-Point Designer” documentation.

Fixed-Point Data Types

In digital hardware, numbers are stored in binary words. A binary word is a fixed-length
sequence of bits (1's and 0's). How hardware components or software functions interpret
this sequence of 1's and 0's is defined by the data type.

Binary numbers are represented as either fixed-point or floating-point data types. In this
section, we discuss many terms and concepts relating to fixed-point numbers, data types,
and mathematics.

A fixed-point data type is characterized by the word length in bits, the position of the
binary point, and whether it is signed or unsigned. The position of the binary point is the
means by which fixed-point values are scaled and interpreted.

For example, a binary representation of a generalized fixed-point number (either signed
or unsigned) is shown below:

b b2 bs | by | by | Ba | By | By

MSB T LSB
binary point

where

b; is the i'® binary digit.
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*  wl is the word length in bits.

* by 1s the location of the most significant, or highest, bit (MSB).

* by is the location of the least significant, or lowest, bit (LSB).

* The binary point is shown four places to the left of the LSB. In this example,
therefore, the number is said to have four fractional bits, or a fraction length of four.

Fixed-point data types can be either signed or unsigned. Signed binary fixed-point
numbers are typically represented in one of three ways:

+ Sign/magnitude

* One's complement

+ Two's complement

Two's complement is the most common representation of signed fixed-point numbers and

is used by System Toolbox software. See “T'wo's Complement” on page 9-10 for more
information.

Scaling
Fixed-point numbers can be encoded according to the scheme

real-world value = (slopex integer) + bias
where the slope can be expressed as
slope = slope adjustment x 2°*Ponent

The integer is sometimes called the stored integer. This is the raw binary number, in
which the binary point assumed to be at the far right of the word. In System Toolboxes,
the negative of the exponent is often referred to as the fraction length.

The slope and bias together represent the scaling of the fixed-point number. In a number
with zero bias, only the slope affects the scaling. A fixed-point number that is only scaled
by binary point position is equivalent to a number in the Fixed-Point Designer [Slope
Bias] representation that has a bias equal to zero and a slope adjustment equal to one.
This is referred to as binary point-only scaling or power-of-two scaling:

Zexponent

real-world value = X integer
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or

9~ fraction length

real-world value = X integer

In System Toolbox software, you can define a fixed-point data type and scaling for the
output or the parameters of many blocks by specifying the word length and fraction
length of the quantity. The word length and fraction length define the whole of the data
type and scaling information for binary-point only signals.

All System Toolbox blocks that support fixed-point data types support signals with
binary-point only scaling. Many fixed-point blocks that do not perform arithmetic
operations but merely rearrange data, such as Delay and Matrix Transpose, also support
signals with [Slope Bias] scaling.

Precision and Range

You must pay attention to the precision and range of the fixed-point data types and
scalings you choose for the blocks in your simulations, in order to know whether rounding
methods will be invoked or if overflows will occur.

Range

The range is the span of numbers that a fixed-point data type and scaling can represent.
The range of representable numbers for a two's complement fixed-point number of word
length wl, scaling S, and bias B is illustrated below:

A _ewl-1 feel-1
S ( lzw ]+B F S (2 | 1)+B
I I |
negative numbers positive numbers

For both signed and unsigned fixed-point numbers of any data type, the number of
different bit patterns is 2wl.

For example, in two's complement, negative numbers must be represented as well as

zero, so the maximum value is 2wl ™. Because there is only one representation for zero,
there are an unequal number of positive and negative numbers. This means there is a

representation for -2wl™* but not for 2wl ~:

9-6
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For slope = 1 and bias = 0:

_21{.'1—1 l]- zwi—l _ 1

negative numbers positive numbers

Overflow Handling

Because a fixed-point data type represents numbers within a finite range, overflows can
occur if the result of an operation is larger or smaller than the numbers in that range.

System Toolbox software does not allow you to add guard bits to a data type on-the-fly

in order to avoid overflows. Any guard bits must be allocated upon model initialization.
However, the software does allow you to either saturate or wrap overflows. Saturation
represents positive overflows as the largest positive number in the range being used, and
negative overflows as the largest negative number in the range being used. Wrapping
uses modulo arithmetic to cast an overflow back into the representable range of the data
type. See “Modulo Arithmetic” on page 9-9 for more information.

Precision

The precision of a fixed-point number is the difference between successive values
representable by its data type and scaling, which is equal to the value of its least
significant bit. The value of the least significant bit, and therefore the precision of the
number, is determined by the number of fractional bits. A fixed-point value can be
represented to within half of the precision of its data type and scaling.

For example, a fixed-point representation with four bits to the right of the binary point
has a precision of 2™* or 0.0625, which is the value of its least significant bit. Any number
within the range of this data type and scaling can be represented to within (2%)/2 or

0.03125, which is half the precision. This is an example of representing a number with
finite precision.

Rounding Modes

When you represent numbers with finite precision, not every number in the available
range can be represented exactly. If a number cannot be represented exactly by the
specified data type and scaling, it is rounded to a representable number. Although
precision is always lost in the rounding operation, the cost of the operation and the
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amount of bias that is introduced depends on the rounding mode itself. To provide you
with greater flexibility in the trade-off between cost and bias, DSP System Toolbox
software currently supports the following rounding modes:

Ceiling rounds the result of a calculation to the closest representable number in the
direction of positive infinity.

Convergent rounds the result of a calculation to the closest representable number.
In the case of a tie, Convergent rounds to the nearest even number. This is the least
biased rounding mode provided by the toolbox.

Floor, which is equivalent to truncation, rounds the result of a calculation to the
closest representable number in the direction of negative infinity.

Nearest rounds the result of a calculation to the closest representable number. In the
case of a tie, Nearest rounds to the closest representable number in the direction of
positive infinity.

Round rounds the result of a calculation to the closest representable number. In the
case of a tie, Round rounds positive numbers to the closest representable number
in the direction of positive infinity, and rounds negative numbers to the closest
representable number in the direction of negative infinity.

Simplest rounds the result of a calculation using the rounding mode (Floor or
Zero) that adds the least amount of extra rounding code to your generated code.
For more information, see “Rounding Mode: Simplest” in the Fixed-Point Designer
documentation.

Zero rounds the result of a calculation to the closest representable number in the
direction of zero.

To learn more about each of these rounding modes, see “Rounding” in the Fixed-Point
Designer documentation.

For a direct comparison of the rounding modes, see “Choosing a Rounding Method” in the
Fixed-Point Designer documentation.
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Arithmetic Operations

In this section...

“Modulo Arithmetic” on page 9-9

“Two's Complement” on page 9-10
“Addition and Subtraction” on page 9-11
“Multiplication” on page 9-12

“Casts” on page 9-14

Note: These sections will help you understand what data type and scaling choices result
in overflows or a loss of precision.

Modulo Arithmetic

Binary math is based on modulo arithmetic. Modulo arithmetic uses only a finite set of
numbers, wrapping the results of any calculations that fall outside the given set back
into the set.

For example, the common everyday clock uses modulo 12 arithmetic. Numbers in this
system can only be 1 through 12. Therefore, in the “clock” system, 9 plus 9 equals 6. This
can be more easily visualized as a number circle:

9-9



Q  Fixed-Point Design

9-10

9.. ... plus 9 more ...

... equals 6.

Similarly, binary math can only use the numbers 0 and 1, and any arithmetic results
that fall outside this range are wrapped “around the circle” to either O or 1.

Two's Complement

Two's complement is a way to interpret a binary number. In two's complement, positive
numbers always start with a 0 and negative numbers always start with a 1. If the
leading bit of a two's complement number is 0, the value is obtained by calculating the
standard binary value of the number. If the leading bit of a two's complement number
is 1, the value is obtained by assuming that the leftmost bit is negative, and then
calculating the binary value of the number. For example,

01=0+2%=1

11=(=2H+2%) = (2+1) =-1

To compute the negative of a binary number using two's complement,

1 Take the one's complement, or “flip the bits.”

2 Add a 1 using binary math.
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3 Discard any bits carried beyond the original word length.

For example, consider taking the negative of 11010 (-6). First, take the one's complement
of the number, or flip the bits:

11010 — 00101
Next, add a 1, wrapping all numbers to 0 or 1:

00101
+1
00110 (6)

Addition and Subtraction

The addition of fixed-point numbers requires that the binary points of the addends be
aligned. The addition is then performed using binary arithmetic so that no number other
than 0 or 1 is used.

For example, consider the addition of 010010.1 (18.5) with 0110.110 (6.75):

010010.1  (18.5)
+0110.110 (6.75)
011001.010 (25.25)

Fixed-point subtraction is equivalent to adding while using the two's complement value
for any negative values. In subtraction, the addends must be sign extended to match each
other's length. For example, consider subtracting 0110.110 (6.75) from 010010.1 (18.5):

010010.100 (18.5) _— 010010.100 {18.5)
- 0110110 (8.75) fwos compemE! 411001010 (-8.75)

and sign exension

/IDDIDIIL 110 (11.75)

Carry bitis
dicarded.

Most fixed-point DSP System Toolbox blocks that perform addition cast the adder inputs
to an accumulator data type before performing the addition. Therefore, no further
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shifting is necessary during the addition to line up the binary points. See “Casts” on page
9-14 for more information.

Multiplication
The multiplication of two's complement fixed-point numbers is directly analogous to
regular decimal multiplication, with the exception that the intermediate results must be

sign extended so that their left sides align before you add them together.

For example, consider the multiplication of 10.11 (-1.25) with 011 (3):

10,11 (-1.25)
The extra 1 011 (3)
is the resuITnf-xm
Necessary sign
exfension. ﬁ
1100.01 (-3.758)

The number of fractianal bits of the
result & the sum of the number of
fractional bits of the factars.

Multiplication Data Types

The following diagrams show the data types used for fixed-point multiplication in the
System Toolbox software. The diagrams illustrate the differences between the data types
used for real-real, complex-real, and complex-complex multiplication. See individual
reference pages to determine whether a particular block accepts complex fixed-point
inputs.

In most cases, you can set the data types used during multiplication in the block mask.
See Accumulator Parameters, Intermediate Product Parameters, Product Output
Parameters, and Output Parameters. These data types are defined in “Casts” on page
9-14.

Note: The following diagrams show the use of fixed-point data types in multiplication in
System Toolbox software. They do not represent actual subsystems used by the software
to perform multiplication.
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Real-Real Multiplication

The following diagram shows the data types used in the multiplication of two real
numbers in System Toolbox software. The software returns the output of this operation
in the product output data type, as the next figure shows.

:jr;p;tt: 8 Product output

P » data type
| MULTIPLIER " »
Input ¢ I

data type

Real-Complex Multiplication

The following diagram shows the data types used in the multiplication of a real and a
complex fixed-point number in System Toolbox software. Real-complex and complex-real
multiplication are equivalent. The software returns the output of this operation in the
product output data type, as the next figure shows.

Input a
data type a
* MULTIPLIER }—‘“ Product
—* output
dat
aawpetﬂex ac+adi
_/’_
Input c+di »|Im
data type .
——* MULTIPLIER 5

Complex-Complex Multiplication

The following diagram shows the multiplication of two complex fixed-point numbers in
System Toolbox software. Note that the software returns the output of this operation in
the accumulator output data type, as the next figure shows.
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Imput
a+hi
data type

Imput
c+di
data type

9-14

Product
output
data type
fac-bd)
_Re 2 9y ac *
~Im b . MULTIPLIER CAST [, (ad+be)i
[ -
—‘ SUBTRACTOR [ 2624
b, [ cAsT JX
.| MULTIPLIER bd
d Accumulator Re —~_ L,
data type Im ="
a ad
- MULTIPLIER [ CAST -[|'
ADDER
5 CAST | ad+be
c 1 2
_—FRe o MULTIPLIER bo
“—Im d
Product
output
data type

System Toolbox blocks cast to the accumulator data type before performing addition or
subtraction operations. In the preceding diagram, this is equivalent to the C code

acc=ac;
acc-=bd;

for the subtractor, and

acc=ad;
acc+=bc;

for the adder, where acc is the accumulator.

Casts

Many fixed-point System Toolbox blocks that perform arithmetic operations allow you
to specify the accumulator, intermediate product, and product output data types, as
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applicable, as well as the output data type of the block. This section gives an overview of
the casts to these data types, so that you can tell if the data types you select will invoke
sign extension, padding with zeros, rounding, and/or overflow.

Casts to the Accumulator Data Type

For most fixed-point System Toolbox blocks that perform addition or subtraction, the
operands are first cast to an accumulator data type. Most of the time, you can specify
the accumulator data type on the block mask. See Accumulator Parameters. Since the
addends are both cast to the same accumulator data type before they are added together,
no extra shift is necessary to insure that their binary points align. The result of the
addition remains in the accumulator data type, with the possibility of overflow.

Casts to the Intermediate Product or Product Output Data Type

For System Toolbox blocks that perform multiplication, the output of the multiplier is
placed into a product output data type. Blocks that then feed the product output back
into the multiplier might first cast it to an intermediate product data type. Most of the
time, you can specify these data types on the block mask. See Intermediate Product
Parameters and Product Output Parameters.

Casts to the Output Data Type

Many fixed-point System Toolbox blocks allow you to specify the data type and scaling of
the block output on the mask. Remember that the software does not allow mixed types
on the input and output ports of its blocks. Therefore, if you would like to specify a fixed-
point output data type and scaling for a System Toolbox block that supports fixed-point
data types, you must feed the input port of that block with a fixed-point signal. The final
cast made by a fixed-point System Toolbox block is to the output data type of the block.

Note that although you can not mix fixed-point and floating-point signals on the input
and output ports of blocks, you can have fixed-point signals with different word and
fraction lengths on the ports of blocks that support fixed-point signals.

Casting Examples

It is important to keep in mind the ramifications of each cast when selecting these
intermediate data types, as well as any other intermediate fixed-point data types that
are allowed by a particular block. Depending upon the data types you select, overflow
and/or rounding might occur. The following two examples demonstrate cases where
overflow and rounding can occur.
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Cast from a Shorter Data Type to a Longer Data Type

Consider the cast of a nonzero number, represented by a four-bit data type with two
fractional bits, to an eight-bit data type with seven fractional bits:

.

source The source bits must be shifted up to match the
binary point position of the destination data type.

L1 & L
/ \_/,_\/\_j

Th£ ..hf';llls' nwnnl;uﬁesﬁ%rﬁeeggt&m These bits of the destination
me shift up. Overflow might occur. g%t%r e e padded with
The result will saturate or wrap. .

As the diagram shows, the source bits are shifted up so that the binary point matches
the destination binary point position. The highest source bit does not fit, so overflow
might occur and the result can saturate or wrap. The empty bits at the low end of the
destination data type are padded with either 0's or 1's:

If overflow does not occur, the empty bits are padded with 0's.

If wrapping occurs, the empty bits are padded with 0's.

+ If saturation occurs,

The empty bits of a positive number are padded with 1's.

The empty bits of a negative number are padded with O's.
You can see that even with a cast from a shorter data type to a longer data type, overflow

might still occur. This can happen when the integer length of the source data type (in
this case two) is longer than the integer length of the destination data type (in this case
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one). Similarly, rounding might be necessary even when casting from a shorter data type
to a longer data type, if the destination data type and scaling has fewer fractional bits
than the source.

Cast from a Longer Data Type to a Shorter Data Type

Consider the cast of a nonzero number, represented by an eight-bit data type with seven
fractional bits, to a four-bit data type with two fractional bits:

.

source \ The source bits must be shifted down to match the

binary point position of the destination data type.

destination
r—T~-T~-T~-7T™1
. ‘ | I I I I IR
These bits from the source
) do not fit into the destination

There is no value for this bit data type. The result is rounded.
from the source, so the result
must be sign-extended to fill
the destination data type.

As the diagram shows, the source bits are shifted down so that the binary point matches
the destination binary point position. There is no value for the highest bit from the
source, so the result is sign extended to fill the integer portion of the destination

data type. The bottom five bits of the source do not fit into the fraction length of the
destination. Therefore, precision can be lost as the result is rounded.

In this case, even though the cast is from a longer data type to a shorter data type, all
the integer bits are maintained. Conversely, full precision can be maintained even if you
cast to a shorter data type, as long as the fraction length of the destination data type is
the same length or longer than the fraction length of the source data type. In that case,
however, bits are lost from the high end of the result and overflow might occur.
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The worst case occurs when both the integer length and the fraction length of the
destination data type are shorter than those of the source data type and scaling. In that
case, both overflow and a loss of precision can occur.
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Fixed-Point Support for MATLAB System Objects

In this section...

“Get Information About Fixed-Point System Objects” on page 9-19
“Display Fixed-Point Properties for System Objects” on page 9-22
“Set System Object Fixed-Point Properties” on page 9-23

“Full Precision for Fixed-Point System Objects” on page 9-24

Get Information About Fixed-Point System Obijects

System objects that support fixed-point data processing have fixed-

point properties, which you can display for a particular object by typing
dsp.<ObjectName>_helpFixedPoint at the command line. See “ Display Fixed-Point
Properties for System Objects” to set the display of System object fixed-point properties.

DSP System Toolbox System Obijects that Support Fixed Point

Object Description

Estimation

dsp.LevinsonSolver Solve linear system of equations using Levinson-
Durbin recursion

Filters

dsp.AllpoleFilter IIR Filter with no zeros

dsp.BiquadFilter Model biquadratic IR (SOS) filters

dsp.CICCompensationDecimator Compensate for CIC filter using a FIR decimator
dsp.ClCCompensationlnterpolgCompensate for CIC filter using a FIR interpolator

dsp.CICDecimator Decimate inputs using a Cascaded Integrator-Comb
(CIC) filter

dsp.CIClnterpolator Interpolate inputs using a Cascaded Integrator-
Comb (CIC) filter

dsp.DigitalFilter Filter each channel of input over time using
discrete-time filter implementations

dsp.FIRDecimator Filter and downsample input signals
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Object

Description

dsp.FIRFilter

Static or time-varying FIR filter

dsp.FIRInterpolator

Upsample and filter input signals

dsp.FIRRateConverter

Upsample, filter and downsample input signals

dsp.l1IRFilter

Infinite Impulse Response (IIR) filter

dsp.LMSFilter

Compute output, error, and weights using LMS
adaptive algorithm

dsp.SubbandAnalysisFilter

Decompose signal into high-frequency and low-
frequency subbands

dsp.SubbandSynthesisFilter

Reconstruct a signal from high-frequency and low-
frequency subbands

Math Functions

dsp.ArrayVectorAdder

Add vector to array along specified dimension

dsp.ArrayVectorDivider

Divide array by vector along specified dimension

dsp.ArrayVectorMultiplier

Multiply array by vector along specified dimension

dsp.-ArrayVectorSubtractor

Subtract vector from array along specified
dimension

dsp.CumulativeProduct

Compute cumulative product of channel, column, or
row elements

dsp.CumulativeSum

Compute cumulative sum of channel, column, or
row elements

dsp.LDLFactor

Factor square Hermitian positive definite matrices
into lower, upper, and diagonal components

dsp.LevinsonSolver

Solve linear system of equations using Levinson-
Durbin recursion

dsp.LowerTriangularSolver

Solve LX = B for X when L is lower triangular
matrix

dsp.LUFactor

Factor square matrix into lower and upper
triangular matrices

dsp-Normalizer

Normalize input

dsp.UpperTriangularSolver

Solve UX = B for X when U is upper triangular
matrix
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Object

Description

Quantizers

dsp.ScalarQuantizerDecoder

Convert each index value into quantized output
value

dsp.ScalarQuantizerEncoder

Perform scalar quantization encoding

dsp.VectorQuantizerDecoder

Find vector quantizer codeword for given index
value

dsp.VectorQuantizerEncoder

Perform vector quantization encoding

Signal Management

dsp.Buffer

Buffer an input signal

dsp.Counter

Count up or down through specified range of
numbers

Signal Operations

dsp.Convolver

Compute convolution of two inputs

dsp.DigitalDownConverter

Digitally down convert the input signal

dsp.DigitalUpConverter

Digitally up convert the input signal

dsp.HDLNCO

Generate real or complex sinusoidal signals —
optimized for HDL code generation

dsp-NCO

Generate real or complex sinusoidal signals

dsp.PeakFinder

Determine extrema (maxima or minima) in input
signal

dsp.VariableFractionalDelay

Delay input by time-varying fractional number of
sample periods

dsp.-Window

Window object

Sinks

dsp.SignalSink

Log MATLAB simulation data

dsp.TimeScope

Display time-domain signals

Sources

dsp.SignalSource

Import a variable from the MATLAB workspace

dsp.SineWave

Generate discrete sine wave
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Object

Description

Statistics

dsp.Autocorrelator

Compute autocorrelation of vector inputs

dsp.Crosscorrelator

Compute cross-correlation of two inputs

dsp.Histogram

Output histogram of an input or sequence of inputs

dsp.Maximum

Compute maximum value in input

dsp.Mean

Compute average or mean value in input

dsp-Median

Compute median value in input

dsp.Minimum

Compute minimum value in input

dsp.Variance

Compute variance of input or sequence of inputs

Transforms

dsp.DCT Compute discrete cosine transform (DCT) of input
dsp.FFT Compute fast Fourier transform (FFT) of input
dsp .HDLFFT Compute fast Fourier transform (FFT) of input —

optimized for HDL Code generation

dsp.HDLIFFT

Compute inverse fast Fourier transform (IFFT) of
input — optimized for HDL Code generation

dsp. IDCT Compute inverse discrete cosine transform (IDCT)
of input
dsp. IFFT Compute inverse fast Fourier transform (IFFT) of

input

Display Fixed-Point Properties for System Objects

You can control whether the software displays fixed-point properties with either of the

following commands:

+ matlab.system.showFixedPointProperties

+ matlab.system.hideFixedPointProperties

at the MATLAB command line. These commands set the Show fixed-point properties
display option. You can also set the display option directly via the MATLAB preferences
dialog box. Click Preferences on the MATLAB Toolstrip. The Preferences dialog box
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opens. Scroll down and select System Objects. Finally, select or deselect Show fixed-

point properties.

A\ Preferences

e ~Editor/Debugger

----- Variable Editar
----- Workspace

----- Tirme Series Tools
+-Figure Copy Template
----- Compiler

----- Report Generator

----- SysternTest

----- Bicinfarmatics Tools

----- Database Toolbox
----- DSP Systern Toolbox
----- Image Acquisition
----- Image Processing

----- Instrument Control

----- Simulink

----- Simscape
#-Simulink 30 Animation
“-Simulink Contrel Design

----- Computer Vision Systemn Toolbo:

~

m

E=5 BoB =<5
System Objects Preferences
Display cptions
Show fixed-peoint properties
oK ] | Cancel | | Apply | | Help

If an object supports fixed-point data processing, its fixed-point properties are active
regardless of whether they are displayed or not.

Set System Obiject Fixed-Point Properties

A number of properties affect the fixed-point data processing used by a System object.
Objects perform fixed-point processing and use the current fixed-point property settings
when they receive fixed-point input.

You change the values of fixed-point properties in the same way as you change any
System object property value. See “Configure Components for Your System”. You also use
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the Fixed-Point Designer numerictype object to specify the desired data type as fixed-
point, the signedness, and the word- and fraction-lengths. System objects support these
values of DataTypeMode: Boolean, Double, Single, and Fixed-point: binary
point scaling.

In the same way as for blocks, the data type properties of many System objects can set
the appropriate word lengths and scalings automatically by using full precision. System
objects assume that the target specified on the Configuration Parameters Hardware
Implementation target is ASIC/FPGA.

If you have not set the property that activates a dependent property and you attempt
to change that dependent property, a warning message displays. For example, for the
dsp.FFT object, before you set CustomOutputDataType to numerictype(l,32,30)
you must set OutputDataType to "Custom”.

Note: System objects do not support fixed-point word lengths greater than 128 bits.

For any System object provided in the Toolbox, the fimath settings for any fimath
attached to a fi input or a fi property are ignored. Outputs from a System object never
have an attached fimath.

Full Precision for Fixed-Point System Objects

FullPrecisionOverride is a convenience property that, when you set to true,
automatically sets the appropriate properties for an object to use full-precision to process
fixed-point input. For System objects, full precision, fixed-point operation refers to
growing just enough additional bits to compute the ideal full precision result. This
operation has no minimum or maximum range overflow nor any precision loss due to
rounding or underflow. It is also independent of any hardware-specific settings. The
data types chosen are based only on known data type ranges and not on actual numeric
values. Unlike full precision for dfi It objects, full precision for System objects does not
optimize coefficient values.

When you set the Ful lPrecisionOverride property to true, the other fixed-point
properties it controls no longer apply and any of their non-default values are ignored.
These properties are also hidden. To specify individual fixed-point properties, you must
first set Ful lPrecisionOverride to false.
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Using the Fixed-Point Converter App with System Objects

You can use the Fixed-Point Converter app to automatically propose and apply
data types for commonly used system objects. The proposed data types are based on
simulation data from the System object.

Automated conversion is available for these DSP System Toolbox System Objects:

dsp.ArrayVectorAdder
dsp.BiquadFilter
dsp.FIRDecimator
dsp.FIRInterpolator
dsp.FIRFilter (Direct Form and Direct Form Transposed only)
dsp.FIRRateConverter
dsp.LowerTriangularSolver
dsp.LUFactor
dsp.UpperTriangularSolver
dsp.VariableFractionalDelay
dsp.-Window

The Fixed-Point Converter app can display simulation minimum and maximum values,
whole number information, and histogram data.

You cannot propose data types for these System objects based on static range data.
You must configure the System object to use "Custom” fixed-point settings.

The app applies the proposed data types only if the input signal is floating point, not
fixed-point.

The app treats scaled doubles as fixed-point. The scaled doubles workflow for System
objects is the same as that for regular variables.

The app ignores the Default word length setting in the Settings menu. The app
also ignores specified rounding and overflow modes. Data-type proposals are based on
the settings of the System object.

Related Examples

“Use the Fixed-Point Converter App with a System object”
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Use the Fixed-Point Converter App with a System object

This example converts a dsp.FIRFilter System object, which filters a high-frequency
sinusoid signal, to fixed-point using the Fixed-Point Converter app. This example
requires Fixed-Point Designer and DSP System Toolbox licenses.

Create DSP Filter Function and Test Bench
Create a myFIRFi lter function from a dsp.FIRFilter System object.

By default, System objects are configured to use full-precision fixed-point arithmetic.
To gather range data and get data type proposals from the Fixed-Point Converter app,
configure the System object to use ‘Custom’ settings.

Save the function to a local writable folder.
function output = myFIRFilter(input, num)

persistent lowpassFIR;
iT isempty(lowpassFIR)

lowpassFIR = dsp.FIRFilter("NumeratorSource®, "lInput port-,
“FullPrecisionOverride®, false,
"ProductDataType®, "Full precision®, ... % default

*AccumulatorDataType®, “Custom®,
“CustomAccumulatorDataType®, numerictype(l,16,4),
"OutputDataType®, "Custom”,
“CustomOutputDataType®, numerictype(1,8,2));

end

output = step(lowpassFIR, input, num);

end
Create a test bench, myFIRFi lter_tb, for the filter. The test bench generates a signal
that gathers range information for conversion. Save the test bench.

% Test bench for myFIRFilter
% Remove high-frequency sinusoid using an FIR filter.

% Initialize

1 = 1000;
2 = 3000;
Fs = 8000;

Fcutoff = 2000;
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% Generate input
SR = dsp.SineWave("Frequency”®, [fl,¥f2], "SampleRate”,Fs, . ..
"SamplesPerFrame®,1024);

% Filter coefficients
num = Firl(130,Fcutoff/(Fs/2));

% Visualize input and output spectra

plot = dsp.SpectrumAnalyzer("SampleRate”,Fs, "PlotAsTwoSidedSpectrum”®, ...
false, "ShowLegend® ,true, "YLiImits",[-120 30],---
"Title", " Input Signal (Channel 1) Output Signal (Channel 2)%);

% Stream

for k = 1:100
input = sum(step(SR),2); % Add the two sinusoids together
FfilteredOutput = myFIRFilter(input, num); % Filter
step(plot, [input,filteredOutput]); % Visualize

end

Convert the Function to Fixed-Point

1  Open the Fixed-Point Converter app.

+ MATLAB Toolstrip: On the Apps tab, under Code Generation, click the app
icon.

+ MATLAB command prompt: Enter
FfixedPointConverter

2 To add the entry-point function myFIRFi Iter to the project, browse to the file
myFIRFilter.m, and then click Open.

By default, the app saves information and settings for this project in the current
folder in a file named myFirFilter.prj.
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5% Fixed-Point Converter - myFIRFilter.prj (== =]

Fixed-Point Converter

Entry-Point Functions:

myFIRFilter & X

+ Add Entry-Point Function l

Project location: |C\codetmyFIRFilter.prj

3 Click Next to go to the Define Input Types step.

The app screens myFIRFi lter.m for code violations and readiness issues. The app
does not find issues in myFIRFilter._m.

4 On the Define Input Types page, to add myFIRFilter_tb as a test file, browse to
myFIRFilter_tb.m, and then click Autodefine Input Types.

The app determines from the test file that the type of input is double(1024 x 1)
and the type of numis double(1 x 131).
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1% Fixed-Point Converter - myFIRFilter.prj EI@
D> Define Input Types

To convert MATLAB to fixed-point, you must define the type of each input for
every entry point function. Learn more

To automatically define input types, call myFIRFilter or enter a script that calls
myFIRFilter in the MATLAB prompt below:

>> myFIRFilter_tb v 1

Autodefine Input Types

fﬂ myFIRFilter.m
input double{l024x 1)
num doubleil x131)

Does this code use global variables? @ No () Yes

€ Back Next ¥

Click Next to go to the Check for Run-Time Issues step. On the Check for Run-
Times Issues page, the app populates the test file field with myFIRFilter_tb, the
test file that you used to define the input types.

Click Check for Issues. The app generates instrumented MEX function. It runs

the test file myFIRFi lter_tb replacing calls to myFIRFi lter with calls to the
generated MEX. If the app finds issues, it provides warning and error messages. You
can click a message to highlight the problematic code in a window where you can edit
the code. In this example, the app does not detect issues.

Click Next to go to the Convert to Fixed Point step.

On the Convert to Fixed Point page, click Simulate to collect range information.

The Variables tab displays the collected range information and type proposals.
Manually edit the data type proposals as needed.
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L&m Fixed-Point Corverter - myFIRFilter,pr EI@

PP Convert to Fixed Paint SETTINGS v  SIMULATEw  DERIVE v CONVERT ®E
v 5 C E 1 function output = myFIRFilter (input, num)
4
3 persistent lowpassFIR;
4 if isempty(lowpassFIR)
5 lowpassFIR = dsp.FIRFilter ('NumeratorSource', 'Input port', ...
[ 'FullPrecisionCverride', false, ...
7 'ProductbataType', 'Full precision', ... % default
a8 'AecumulatorDataType' , 'Custom' , ...
a 'CustombccwmilatorbataType' . nuwerictype(l,16,.4), ...
10 "OutputDataType', 'Custom', ...
11 'CustomoucpuchataType ', humerictype(l,8,2)):
1z end
13 output = stepilowvpassFIE, input, nwum);
14
15 end

Simulation Qutput | Wariables | Function Replacernents

Variable Type Sirm Min - Sim Max  Static Min - Static Max Whole Nu..  Proposed Type
=
input 1024 x 1 dauble -1.41 141 Mo numerictypeil, 16, 14)
numm 1131 double -0.11 0.5 Mo numetictype(l, 16, 16)
=]
output 1024 x 1 dauble -1.01 1 Mo numerictypeil, 16, 14)
=
=
CustomProductDataType -0.71 0.7l Mo Full precizion
CustamiccurnulatorDataT... -11 11 Mo numetictypeil, 16, 14)
CustomOutputDataType 101 1 Mo numerictype(l, 8, 6)

In the Variables tab, the Proposed Type field for
lowpassFIR.CustomProductDataType is Full Precision. The Fixed-
Point Converter app did not propose a data type for this field because its
"ProductDataType” setting is not set to "Custom®.

Click Convert to apply the proposed data types to the function.

The Fixed-Point Converter app applies the proposed data types and generates a
fixed-point function, myFIRFilter_fixpt.
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@ Fixed-Point Corverter - myFIRFilter,pr EI@
PP Convert to Fixed Paint SETTINGS v DERIVE v CONVERT  TEST v ®E

€3] rryFIRFilter

sHcodegen
function output = myFIRFilter fixpt(input, num)

fm = fimath('RoundingMethod', 'Floor', 'Cverflowliction', 'Wrap', 'ProductMode’', 'FullPrecisi

10 =
11 persiscent lowpassFIR; 1
1z if isewptv(lowpassFIR)
13 lowpassFIR = dsp.FIRFilter ('NuwneratorSource', 'Input port', ...
14 'FullPrecisionCverride', false, ...
15 'ProductbataType', 'Full precision', ... % defasult
1a "AocumilatorDataType ', 'Custom' , ...
17 'CustombccunnilatorbataType ', numerictype(l, 16, 14), ...
1a 'OucputDataType', 'Custcom', ...
19 'CustomOutputbataType', numwerictype(l, &, a)); L
an end
ry 21 output = filstep(lowpassFIR, input, num), 1, 16, 14, fm);:
=) miFIRFilter wrapper fixpt.m 2z -
(@] myFIRFilter fizpt_reparthtml 4 . | +
ﬂ ryFIRFilter_report.htrnl
H retFIRFilter_fiept_args.mat Type Validation Output  ~ | Wariables | Function Replacements
[ e FIRFitter_fipt_extval.mat ‘ariahle Type Sirn Min Sirn hax Static Min Static Max  Whole Nu..  Proposed Type
ﬂ ryFIRFilter_float_mex mexnt4 B Input L
() myFIRFilter_wrapper_fixpt_mesrm w
input 1024 x 1 double -1.41 141 Mo nurmerictype(l, 16, 14)
hum 1x 131 double -0.11 0.5 Mo numerictype(l, 16, 16) E
= Output
output 1024 x 1 double -1.01 1 Mo nurmerictype(l, 16, 14)
B Persistent
< | LI | b B lowpassFIR dspcodegen. FIRFilt... <

€ Back

function output = myFIRFilter_fixpt(input,num)

fm = fimath("RoundingMethod®, "Floor", ...
"OverflowAction®™, "Wrap®", "ProductMode®, "FullPrecision®,...
"MaxProductWordLength®, 128, ...
"SumMode®, “FullPrecision®, "MaxSumWordLength®, 128);
persistent lowpassFIR
if isempty( lowpassFIR )
lowpassFIR = dsp.FIRFilter( "NumeratorSource®, "lnput port®,...

"FullPrecisionOverride”, false, "ProductDataType®, "Full precision®, ...

"AccumulatorDataType®, “Custom”,...
"CustomAccumulatorDataType®, numerictype(l, 16, 14),...

"OutputDataType®, "Custom®, "CustomOutputDataType®, numerictype(l, 8, ¢

% default
end
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output = Ffi(step( lowpassFIR, input, num ), 1, 16, 14, fm);
end

More About

. “Using the Fixed-Point Converter App with System Objects”
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Specify Fixed-Point Atiributes for Blocks

In this section...
“Fixed-Point Block Parameters” on page 9-33

“Specify System-Level Settings” on page 9-36
“Inherit via Internal Rule” on page 9-37
“Specify Data Types for Fixed-Point Blocks” on page 9-47

Fixed-Point Block Parameters

System Toolbox blocks that have fixed-point support usually allow you to specify fixed-
point characteristics through block parameters. By specifying data type and scaling
information for these fixed-point parameters, you can simulate your target hardware
more closely.

Note: Floating-point inheritance takes precedence over the settings discussed in this
section. When the block has floating-point input, all block data types match the input.

You can find most fixed-point parameters on the Data Types pane of System Toolbox
blocks. The following figure shows a typical Data Types pane.

9-33



Q  Fixed-Point Design

Data Types

Fixed-poi

signed fixe

Sine table:

Output:

Lock da

nt operational parameters

Rounding mode: | Floor

d point.
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ta type settings against changes by the fixed-point tools

All System Toolbox blocks with fixed-point capabilities share a set of common
parameters, but each block can have a different subset of these fixed-point parameters.
The following table provides an overview of the most common fixed-point block

parameters.

Fixed-Point Data Type
Parameter

Description

Rounding Mode

Specifies the rounding mode for the block to use when the
specified data type and scaling cannot exactly represent the
result of a fixed-point calculation.

See “Rounding Modes” on page 9-7 for more information on the
available options.

Overflow Mode

Specifies the overflow mode to use when the result of a fixed-
point calculation does not fit into the representable range of
the specified data type.

See “Overflow Handling” on page 9-7 for more information on
the available options.
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Fixed-Point Data Type
Parameter

Description

Intermediate Product

Specifies the data type and scaling of the intermediate product
for fixed-point blocks. Blocks that feed multiplication results
back to the input of the multiplier use the intermediate
product data type.

See the reference page of a specific block to learn about the
intermediate product data type for that block.

Product Output

Specifies the data type and scaling of the product output for
fixed-point blocks that must compute multiplication results.

See the reference page of a specific block to learn about the
product output data type for that block. For or complex-
complex multiplication, the multiplication result is in the
accumulator data type. See “Multiplication Data Types”
on page 9-12 for more information on complex fixed-point
multiplication in System toolbox software.

Accumulator

Specifies the data type and scaling of the accumulator (sum)
for fixed-point blocks that must hold summation results for
further calculation. Most such blocks cast to the accumulator
data type before performing the add operations (summation).

See the reference page of a specific block for details on the
accumulator data type of that block.

Output

Specifies the output data type and scaling for blocks.

Using the Data Type Assistant

The Data Type Assistant is an interactive graphical tool available on the Data Types
pane of some fixed-point System Toolbox blocks.

To learn more about using the Data Type Assistant to help you specify block data type
parameters, see the following section of the Simulink documentation:
“Specify Data Types Using Data Type Assistant”
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Checking Signal Ranges

Some fixed-point System Toolbox blocks have Minimum and Maximum parameters on
the Data Types pane. When a fixed-point data type has these parameters, you can use
them to specify appropriate minimum and maximum values for range checking purposes.

To learn how to specify signal ranges and enable signal range checking, see “Signal
Ranges” in the Simulink documentation.

Specify System-Level Settings

You can monitor and control fixed-point settings for System Toolbox blocks at a system or
subsystem level with the Fixed-Point Tool. For additional information on these subjects,
see

* The fxptdlg reference page — A reference page on the Fixed-Point Tool in the
Simulink documentation

* “Fixed-Point Tool” — A tutorial that highlights the use of the Fixed-Point Tool in the
Fixed-Point Designer software documentation

Logging

The Fixed-Point Tool logs overflows, saturations, and simulation minimums and
maximums for fixed-point System Toolbox blocks. The Fixed-Point Tool does not log
overflows and saturations when the Data overflow line in the Diagnostics > Data
Integrity pane of the Configuration Parameters dialog box is set to None.

Autoscaling

You can use the Fixed-Point Tool autoscaling feature to set the scaling for System
Toolbox fixed-point data types.

Data type override

System Toolbox blocks obey the Use local settings, Double, Single, and

OFf modes of the Data type override parameter in the Fixed-Point Tool. The

Scaled double mode is also supported for System Toolboxes source and byte-shuffling
blocks, and for some arithmetic blocks such as Difference and Normalization.
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Inherit via Internal Rule

Selecting appropriate word lengths and scalings for the fixed-point parameters in your
model can be challenging. To aid you, an Inherit via internal rule choice is often
available for fixed-point block data type parameters, such as the Accumulator and
Product output signals. The following sections describe how the word and fraction
lengths are selected for you when you choose Inherit via internal rule for a fixed-
point block data type parameter in System Toolbox software:

*  “Internal Rule for Accumulator Data Types” on page 9-37
*  “Internal Rule for Product Data Types” on page 9-38
*  “Internal Rule for Output Data Types” on page 9-38

*  “The Effect of the Hardware Implementation Pane on the Internal Rule” on page
9-38

*  “Internal Rule Examples” on page 9-40

Note: In the equations in the following sections, WL = word length and FL = fraction
length.

Internal Rule for Accumulator Data Types

The internal rule for accumulator data types first calculates the ideal, full-precision
result. Where N is the number of addends:

WLideal accumulator = WLinput to accumulator + ﬂoor(logz(N -D)+1

FLideal accumulator = FLinp ut to accumulator

For example, consider summing all the elements of a vector of length 6 and data type
sfix10_En8. The ideal, full-precision result has a word length of 13 and a fraction length
of 8.

The accumulator can be real or complex. The preceding equations are used for both the

real and imaginary parts of the accumulator. For any calculation, after the full-precision
result is calculated, the final word and fraction lengths set by the internal rule are
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affected by your particular hardware. See “The Effect of the Hardware Implementation
Pane on the Internal Rule” on page 9-38 for more information.

Internal Rule for Product Data Types

The internal rule for product data types first calculates the ideal, full-precision result:

WL, geas product = WLinput 1+t WLinput 2

FLickealproduct = FLinputI + FLinput2

For e